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4.1.1.5.6
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4.1.1.5.7
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ISO 20022 | Expense regulations incorporated for
payments from abroad

4.1.1.5.8
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4.1.1.9.3

125Bug fixes4.1.1.10
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4.1.1.10.
1.1
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125
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2.1

125
Process Payroll | Foreign currency |
Calculation of FC rate for part-time

4.1.1.10.
2.2
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Net/Gross calculation | Incorrect sign when
offsetting for KTG/UVGZ

4.1.1.10.
2.3
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2.4
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Provisional cost submission | automatic
transfer after Salary posting | down-payment
process

4.1.1.10.
2.5

126
Provisional cost submission | FIBU
interface file not written

4.1.1.10.
2.6

126
Sending Paycheck as PDF | completion
nofification streamlined

4.1.1.10.
2.7

126Salary Declaration4.1.1.10.3

126
ELM | Error message in case of a child
without date of birth

4.1.1.10.
3.1

126Reports | Interfaces4.1.1.10.4

126
WebClient | Fibu posting journal | Label
enhanced

4.1.1.10.
4.1

126
Salary and absence statistic | Assessments
for printing revised

4.1.1.10.
4.2

126
Rate fluctuation | Wrongly calculated
opening balance

4.1.1.10.
4.3

127
BVG Accounting | Revision4.1.1.10.

4.4

127
KTG Accounting | Bug in the company
address fixed

4.1.1.10.
4.5

127
Human Resources (PIS)4.1.1.10.

4.6

127
PIS-Sheet | Rounding of years of service4.1.1.10.

4.1

127
PIS-Sheet | Staffing4.1.1.10.

4.2
127Administration4.1.1.10.5

127
Post Payroll | Individual posting texts
corrected

4.1.1.10.
5.1

127
User name | Field length adjusted4.1.1.10.

5.2

127
WebClient | Exporting Work calendar into
Excel

4.1.1.10.
5.3

128SwissSalary Direct4.1.1.10.6

128
SwissSalary Direct | Error 500 | Translation
missing

4.1.1.10.
6.1

128SwissSalary EasyRapport4.1.1.10.7

128
Target time posting | Consideration of
precents by position on the time axis

4.1.1.10.
7.1

128
NAV 2009 RTC | Target/Actual time display
supressed

4.1.1.10.
7.2

128Notices for our partners4.1.1.11

128Allocation Group-Filter | New Codeunit created4.1.1.11.1

129Organization | Test clients | Fire all employees4.1.1.11.2

129
PDFCreator | Newer Versions support | Removal of
Codeunit

4.1.1.11.3

129
New Codeunit 309210 SwS Bulk Report
Management

4.1.1.11.4

130Dataports removed from Classic Versions4.1.1.11.5

130Initialization | New fields added4.1.1.11.6

130Excel-Import Buffer | Text field cut to 250 characters4.1.1.11.7

131
Codeunit 3009089 SwS Refresh Salary Declaration
removed

4.1.1.11.8

131
Deleted Fields and Values from Tables after Update
5052.000

4.1.1.11.9

131Update 5053.000 (25.10.2018)4.1.2
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131Introduction4.1.2.1

133Improvements4.1.2.2

133Employee Templates4.1.2.2.1

134
Income Tax | Partner information obligatory as of
January 1, 2019

4.1.2.2.2

134
Liability to Income Tax | TimeMachine for retroactive
reimbursement or subsequent charge

4.1.2.2.3

135
Income Tax calculation | Retroactive rate correction
after residence permit receipt

4.1.2.2.4

135
Enhancement of notification | Staff Bank and
personnel Dimension (s)

4.1.2.2.5

136Dossier | New document | Layout completely revised4.1.2.2.6

136
Following Salary Type | Setting from/until times |
Automatic calculation of night hours

4.1.2.2.7

136
Management Rapport Journal & Allocated Salary |
Following Salary Type are now displayed

4.1.2.2.8

136TapBoard | from-/until times can be recorded4.1.2.2.9

137Employee4.1.2.3

137
Income Tax | Removal of assignments if the
employee is no longer subject to it

4.1.2.3.1

137IBAN Number | Extension to 50 characters4.1.2.3.2

137Bank List | SWIFT/BIC display4.1.2.3.3

137
Copying Employee | Dimensions are copied if
identical

4.1.2.3.4

137
Dossier | Mailing List Template | Using the
employee's language

4.1.2.3.5

138Salary Types4.1.2.4

138
Following Salary Type | Limit amounts validation (per
event or per month/year)

4.1.2.4.1

138Pay Process4.1.2.5

138
Management Rapport Journal | New Infobox: Salary
Entry

4.1.2.5.1

138Payroll Process | TimeMachine input after resignation4.1.2.5.2

138
Payroll Process | Automatic transition from additional
income to pensioner

4.1.2.5.3

138
Payroll Process | ISO 20022 | Validation in the
address field

4.1.2.5.4

139Post Payroll | Missing Payment file note4.1.2.5.5

139Administration4.1.2.6

139Payroll Setup | Age limit for KTG and UVGZ4.1.2.6.1

140Workgroup | new field locked4.1.2.6.2

140
Report types | Activating target time lower and upper
limit on group title

4.1.2.6.3

140Reports | Interfaces4.1.2.7

140
Attestation of Employer ALV | Employment periods of
the last two years

4.1.2.7.1

140
Intermediate certificate of profit ALV | Paragraph 10
adjusted based on the refunding of absences

4.1.2.7.2

141Rate Fluctation | Selection field added4.1.2.7.3

141
Difference list | Percents by position and
recruitment/resignation date added

4.1.2.7.4

141FIBU Interface with Abacus | Version 2012.004.1.2.7.5

141DTA Payment order | Display on a single page4.1.2.7.6

141
BESTA Employment statistics | Reference period
consideration

4.1.2.7.7

142
Sunet plus Interface | Setting Payroll area filter for the
user

4.1.2.7.8
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142SwissSalary Direct4.1.2.8

142
Send documents | Data upload via Webclient
became possible

4.1.2.8.1

142
Subdomain incorrectly entered | Error message
readable

4.1.2.8.2

142SwissSalary EasyRapport4.1.2.9

142Double entry of Logins in several clients4.1.2.9.1

142
SwissSalary EasyRapport | HTTP transfer mode
removed

4.1.2.9.2

143Bug fixes4.1.2.10

143Employee4.1.2.10.1

143
Role Center | Persons without recruitment
date | Display in recruitment

4.1.2.10.
1.1

143
NAV 2017 | Employee Card cannot be
mutated

4.1.2.10.
1.2

143
PIS | Payroll area filter for qualification
matrix

4.1.2.10.
1.3

143Pay Process4.1.2.10.2

143
Income Tax calculation | Salary after
resignation | Adjustments

4.1.2.10.
2.1

143

Management Rapport Journal | Error
message in case of locked dimension
value

4.1.2.10.
2.2

143

Management Rapport Journal | Child
allowance correction | assignment field
cannot be opened

4.1.2.10.
2.3

144
Management Rapport Journal | "Cost
Center" Infobox for cross-client cc selection

4.1.2.10.
2.4

144

Down-Payment process for haurly wage |
Calculating surcharges for resulting
Following Salary Type

4.1.2.10.
2.5

144
Payroll Process | Prevent zero division or
output with message

4.1.2.10.
2.6

144
Post Payroll | FIBU Posting | Placeholder
without date values

4.1.2.10.
2.7

144Reports | Interfaces4.1.2.10.3

144
Attestation of Employer ALV | Display error
in paragraph 19

4.1.2.10.
3.1

144
A4H/A4Q Employee list statistics | only one
person in displayed

4.1.2.10.
3.2

145
PIS sheet | Show comments about relatives4.1.2.10.

3.3

145
Paycheck | Fields extended and view
improved

4.1.2.10.
3.4

145
Salary certificate | Setting free transportation
to work during ELM submission

4.1.2.10.
3.5

145Administration4.1.2.10.4

145
User name | Field length adjusted4.1.2.10.

4.1
145Notices for our partners4.1.2.11

145
System tables converted to existing SwissSalary
tables (ZIP Code and banks)

4.1.2.11.1

146
ELM Management (Beta) | Refactoring and relocation
of the XML functions

4.1.2.11.2

146
Username > 30 characters | Problems with Excel
Export

4.1.2.11.3

146
Excel-Import-/Export | Excel Buffer Table with
temporary records (no logging)

4.1.2.11.4

146NSP | 'DTA created' field removed4.1.2.11.5
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146Update 5053.000 Systemadmin4.2

146SwissSalary Homepage | Update-Download4.2.1

146Instructions (4)4.2.1.1

148Downloading / Refreshing Updates and PreUpdates4.2.2

148Instructions (4)4.2.2.1

152Access Autorisations and Roles4.2.3

152Instructions (4)4.2.3.1

5 Update 5052.000

156Update 5052.000 User5.1

156PreUpdate 5051.100 (10.05.2017)5.1.1

156INTRODUCTION (3)5.1.1.1

156NEW FEATURES5.1.1.2

156SwissSalary Budget | New Module5.1.1.2.1

156
ISO 20022 | New Interface for Wage Payments Using
Banks

5.1.1.2.2

157Printing Payslips | From – Till5.1.1.2.3

158Calculation of Daily Allowance Estimate (UVG)5.1.1.2.4

159
Request to Parifonds for Benefit Payment Starting
From April 1, 2017

5.1.1.2.5

159
FIBU Registration Journal Import | Default Import
Interface for Dynamics NAV

5.1.1.2.6

159SOMED Interface5.1.1.2.7

159Hospital Statistics5.1.1.2.8

160EMPLOYEE5.1.1.3

160New Infobox Employee Comment5.1.1.3.1

160Image | New Area in Dynamics NAV 20175.1.1.3.2

160Search Term | Update via SmartPort5.1.1.3.3

161Personnel Dimension | Display Last/First Name5.1.1.3.4

161
Department | Responsible Staff Members and
Deputies

5.1.1.3.5

161TimeMachine | Display Changes Only5.1.1.3.6

161Children | Show Comments5.1.1.3.7

161
Income Tax | New Validation When Setting ‘Subject to
Income Tax’ Check Mark

5.1.1.3.8

161
Allocated Salary | Allocation for Family Allowance
Correction (Current Year)

5.1.1.3.9

162
Pay Process List | Columns Recruitment and
Resignation Displayed

5.1.1.3.10

162
Pay Process List | Column Comments and
Comments 2 Editable

5.1.1.3.11

162SALARY TYPES5.1.1.4

162
Following Salary Type | ShortCut Changed to
CTRL+O

5.1.1.4.1

162
Following Salary Types | Application for Automated
Calculations As Well

5.1.1.4.2

162Project Posting | Line Type Can be Set on Salary Type5.1.1.4.3

163PAYROLL SETUP5.1.1.5

163
BVG Calculation | BVG Deduction until Pension Month
(AHV)

5.1.1.5.1

163Provisions | Minus Hours Do Not Reset for FIBU5.1.1.5.2
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163
First-day Amount (CC) on Project Items | New Option
for Calculation

5.1.1.5.3

163Work Group | Copy Function5.1.1.5.4

164PAYROLL LOG5.1.1.6

164PAYROLL5.1.1.6.1

164
Error Message During Data Import |
Hours-Days Conversion

5.1.1.6.1.
1

164
Import From Excel | Empty Cells Not
Imported

5.1.1.6.1.
2

164
Import From Excel | Importing Projects and
Project Tasks

5.1.1.6.1.
3

164
Employee Details Infobox | Display
Language Code

5.1.1.6.1.
4

165TAPBOARD5.1.1.6.2

165
Opening TapBoard in the Web Client
Directly

5.1.1.6.2.
1

165PROCESS PAYROLL5.1.1.6.3

165
Nationality Code | Validation During Wage
Accounting

5.1.1.6.3.
1

165
Pay Process | Additional Information about
Payment

5.1.1.6.3.
2

165POST PAYROLL5.1.1.6.4

165
Cost Accounting | Wage Posting Completely
Revised

5.1.1.6.4.
1

166SALARY DECLARATION5.1.1.7

166ELM | Test Certificate | Check Before Submission5.1.1.7.1

166Salary certificate | Number of Shift Days5.1.1.7.2

166
Liechtenstein Salary certificate | Swiss Income Tax -
Suppressing Texts

5.1.1.7.3

167BVG ELM Submission per Month5.1.1.7.4

167BUG FIXES5.1.1.8

167GENERAL5.1.1.8.1

167
SwissSalary Direct | PDF Files Cannot
Open After Uploading

5.1.1.8.1.
1

167
SwissSalary Direct | Synchronization at
Slow Document Sending

5.1.1.8.1.
2

167
Translations Into IT | Figli Instead of
Bambini

5.1.1.8.1.
3

167EMPLOYEE5.1.1.8.2

167
Employee Banks | Column Salary Type
Filter Can Be Selected

5.1.1.8.2.
1

167
Statistics | Column Naming (Hours/Days)5.1.1.8.2.

2
168PAYROLL SETUP5.1.1.8.3

168

Years of service | Year-of-service Period
Type Can Be Changed | After Change to Pro
Rata

5.1.1.8.3.
1

168PROCESS PAYROLL5.1.1.8.4

168
Report Journal / TapBoard | Link in the Staff
Card

5.1.1.8.4.
1

168
Color Rendering Optimized In RTC5.1.1.8.4.

2

168
Web Client | Create DTA5.1.1.8.4.

3

168
Write DTA File | NAV 2013 R2 |
Troubleshooting

5.1.1.8.4.
4

168
Correction of Immediate Curtailment | Error
Message Upn Exit Fixed

5.1.1.8.4.
5
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169

Automatic BVG Calculation | Adjustment of
Percents by Position and Wage Rate Value
via TimeMachine

5.1.1.8.4.
6

169
Calculation of Holiday Correction |
Age/Years of Service Accumulation

5.1.1.8.4.
7

169
Provisional Cost Accounting Submission |
SWS TEMP Items are Deleted Correctly

5.1.1.8.4.
8

169SALARY DECLARATION5.1.1.8.5

169
Error Message When Writing 2D Bar Code |
Incorrect Country Code In Workplace

5.1.1.8.5.
1

169
ELM | 2-digit Insurance Code Validation5.1.1.8.5.

2

169
ELM | Faulty XML For Multiple Retroactive
Corrections

5.1.1.8.5.
3

170
ELM | Canton of VD Withholding Tax Rate
Notices

5.1.1.8.5.
4

170
Wage Reporting | Optimizations (RTC Client
Only)

5.1.1.8.5.
5

170ADMINISTRATION5.1.1.8.6

170
Payroll Area | Balance Display in
EasyRapport

5.1.1.8.6.
1

170
Open interface | Logic Improved When
Prefix/Suffix is Deleted

5.1.1.8.6.
2

170REPORTS | INTERFACES5.1.1.8.7

170
Employee List | Number of Employees
Totalizing Error

5.1.1.8.7.
1

171
Child Allowances/Education Benefits
Procedure | Layout Revision

5.1.1.8.7.
2

171
Raise Salary List | Wrong Output Based On
the Role In Excel

5.1.1.8.7.
3

171
Annual Employee Statement A4I |
Performance Greatly Improved (2)

5.1.1.8.7.
4

171
Annual Employee Statement A4I and Salary
Entry | Translation to EN Adjusted

5.1.1.8.7.
5

171
Annual Employee Statement A4I | Layout
Revision

5.1.1.8.7.
6

171
Salary certificate | Text Overflow for Long
User Names

5.1.1.8.7.
7

171
Salary certificate | Field Service Calculation
at Federal Level >100%

5.1.1.8.7.
8

171
Employee History | Layout Revision5.1.1.8.7.

9

172

Attestation of Employer ALV and
Intermediate certificate of profit ALV | Texts &
Layout Revised

5.1.1.8.7.
10

172
Vacation Control & Vacation List | Sorting by
Department

5.1.1.8.7.
11

172
Human Resources | Alternative Addresses |
Sorting

5.1.1.8.7.
12

172
Report Journal | Layout Revision5.1.1.8.7.

13

172
EasyRapport Card | Optimizations In Other
Languages

5.1.1.8.7.
14

172
Payroll Journal | Layout Revision5.1.1.8.7.

15

172
BVG-DTA List | Layout Revision5.1.1.8.7.

16

172
Hour Statement | Multiple Row Titles
Revised

5.1.1.8.7.
17

172
Payroll Setup | Header Missing In Preview5.1.1.8.7.

18
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173
ARGE Re-invoicing | Report Does Not
Display Overheads In Percents

5.1.1.8.7.
19

173
ARGE Re-invoicing | Administrative and
Cost of Funds Overhead Not Calculated

5.1.1.8.7.
20

173NOTICES FOR OUR PARTNERS5.1.1.8.8

173
Organization | Update Outdated Data5.1.1.8.8.

1

173
ELM Transmitter | Log File Created Instead
of ErrorMessage [1024]

5.1.1.8.8.
2

173
.NET Assemblies | Usage Check During
Deletion

5.1.1.8.8.
3

173
SwissSalary Store | Accepting Proxy
Settings

5.1.1.8.8.
4

174
Deleted Table Fields5.1.1.8.8.

5

174
ADMINISTRATION5.1.1.8.8.

6

174
SwissSalary Store | Reset Updates5.1.1.8.8.

1

174
PDFCreator | Using New Versions5.1.1.8.8.

2

175
Payroll Area | Monthly Parts | Default Value5.1.1.8.8.

3

175
Open Data Import Interface | Row Skipping5.1.1.8.8.

4
175REPORTS | INTERFACES5.1.1.9

175
Attestation of Employer ALV | Company Address from
Payroll Area

5.1.1.9.1

175
Employer's Certificate ALV (int) | Adjustment of
Paragraph 16 + 17 Calculation

5.1.1.9.2

176Allocated Salary | Excel Export Optimized5.1.1.9.3

176
Salary Type List | Search Term and UserText
Displayed in Bold

5.1.1.9.4

176Payroll Journal | Now Includes Excel Export5.1.1.9.5

176Difference List | Gross Wage5.1.1.9.6

176FAK Banks | New XML Interface Definition5.1.1.9.7

176
Sending Salary Certificate | Via Mail, IncaMail or
PrivaSphere

5.1.1.9.8

177Sending Payslip | Via Mail, IncaMail or PrivaSphere5.1.1.9.9

177Account Reconciliation | Excel Export Optimized5.1.1.9.10

178
Income Tax Wage Statement for the Canton of FR |
Report Removed

5.1.1.9.11

178
Sunet Interfaces | Accident Details and Insured Wage
Claim

5.1.1.9.12

178Sunet Interface 4.00-1081 | Removed5.1.1.9.13

178
UKA Interfaces | Accident Details and Insured Wage
Claim

5.1.1.9.14

178
UKA Import Interface | Document Date Based On File
Value

5.1.1.9.15

179PreUpdate 5051.200 (31.08.2017)5.1.2

179INTRODUCTION5.1.2.1

179NEW FEATURES5.1.2.2

179
Daily Allowance Calculation | Now Also for Daily
Sickness Benefits

5.1.2.2.1

179
Personnel Dossier | Automatic Import of Link
Documents into Database

5.1.2.2.2

179
Fibu Interface | Import Feature for External NAV
Database

5.1.2.2.3
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180
Dynamics 365 for Finance and Operations | New
FIBU/Wage Interface

5.1.2.2.4

180
Office 365 Integration | SharePoint Connection
Settings

5.1.2.2.5

181EMPLOYEE5.1.2.3

181ID | Field Will Be Checked if Already Available5.1.2.3.1

181
Employment Relationship | Apprentice and Trainee |
Field Content Relocated

5.1.2.3.2

181
Infobox Personnel Dimension | Display Current
Dimensions Only

5.1.2.3.3

181
Base Wage Matrix | Revised Completely in RTC
Versions

5.1.2.3.4

181PAYROLL LOG5.1.2.4

181TAPBOARD5.1.2.4.1

181
TapBoard | Simplified Cost Center
Selection and Acquisition

5.1.2.4.1.
1

182
TapBoard | Entering Comments for
Employees

5.1.2.4.1.
2

182PROCESS PAYROLL5.1.2.4.2

182
Export Payment Files | Windows Explorer
Not Opened Anymore

5.1.2.4.2.
1

182POST PAYROLL5.1.2.4.3

182
Wage Posting Routine Revised for the
Whole Area

5.1.2.4.3.
1

182SALARY DECLARATION5.1.2.5

182ELM | Comments are Provided | New Report Button5.1.2.5.1

182
ELM | WT Reporting | CHF 0 Reporting When an
Employee Has Not Worked

5.1.2.5.2

183ELM | Child Allowance From/To Date Improved5.1.2.5.3

183ADMINISTRATION5.1.2.6

183Payroll Area | Credit Balance Inhibited In EasyRapport5.1.2.6.1

183REPORTS | INTERFACES5.1.2.7

183
Cover Letter, Short Letter & Fax | Consideration of
TimeMachine When Changing Address

5.1.2.7.1

183
Intermediate certificate of profit ALV | Other Wage
Components| Now CHF or %

5.1.2.7.2

183
Wage Allocation (Allocation Salary) | Excel Export
Improved

5.1.2.7.3

183
Salary certificate | Private & Confidential In Front of the
Address

5.1.2.7.4

184FIBU Posting Journal | Time Balance Provisions5.1.2.7.5

184BAU | BauBit Pro Interface | Settings5.1.2.7.6

184SWISSSALARY DIRECT5.1.2.8

184
Document Delivery Generally from the Dossier |
Continue After Abort

5.1.2.8.1

184Share Documents from Dossier | Partial Automation5.1.2.8.2

185
Set Up Task Queue for Scheduled Synchronization
(Auto-Sync)

5.1.2.8.3

185
Newly Registered Employees No Longer Receive
Paper Payroll

5.1.2.8.4

185
Reset Synchronization | Feature Hidden In the Menu
Bar

5.1.2.8.5

186BUG FIXES5.1.2.9

186EMPLOYEE5.1.2.9.1

186

TimeMachine | Address Changes after the
Working Date Displayed In Personnel
Card/List

5.1.2.9.1.
1
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186
Personnel Dimensions | ShortCut Changed5.1.2.9.1.

2

186

Copy Personnel Feature | Personnel
Statistics | Copying Employee Groups
Correctly

5.1.2.9.1.
3

186PAYROLL LOG5.1.2.9.2

186
ISO 20022 | International NAV DB | Table
11500 was not found

5.1.2.9.2.
1

186
Report Journal | Document Date Earlier
Than 01/01/1800 Cannot be Recorded

5.1.2.9.2.
2

186
BAU | Retrospective Pay Change with
TimeMachine | Load Fibu Cost Type

5.1.2.9.2.
3

186SALARY DECLARATION5.1.2.9.3

186
ELM | Company Data | Name 2 Causes
XML Validation Error

5.1.2.9.3.
1

187
ELM | Spaces in WT Payroll Number (SSL
Number)

5.1.2.9.3.
2

187
ELM | NAV 5.0 | Feedback From Distributor
(Error) is Now Displayed Correctly

5.1.2.9.3.
3

187
ELM | Retroactive Canton Change With
Complete WT Repayment In the Same Year

5.1.2.9.3.
4

187ADMINISTRATION5.1.2.9.4

187
Time Types | Translations In All Clients
Deleted If Time Type is Deleted

5.1.2.9.4.
1

187REPORTS | INTERFACES5.1.2.9.5

187
Personnel File | Header Row is Displayed
Correctly (RTC)

5.1.2.9.5.
1

187
Personnel File | Years of Service and
Apprenticeship Date Corrected

5.1.2.9.5.
2

188
Personnel Year of Service Details | Display
Error Corrected

5.1.2.9.5.
3

188
Payroll Setup | Date Format Corrected In
Two Fields

5.1.2.9.5.
4

188
ISO 20022 | Payment Order | Debit Bank Not
Printed

5.1.2.9.5.
5

188
Open Data Import Interface | WebClient |
Data Import via Excel

5.1.2.9.5.
6

188
Payslip as PDF Export | Placeholder %3 ID
Activated Again

5.1.2.9.5.
7

188
Payslip PDF via Email/SwissSalary Direct |
PDFCreator Time-Out | Empty Payslips

5.1.2.9.5.
8

188NOTICES FOR OUR PARTNERS5.1.2.10

188
Organization | SwissSalary Store Also Fully
Functional In the WebClient

5.1.2.10.1

189Migration Report for NAV 2009 in NAV 5 Removed5.1.2.10.2

189Update 5052.000 (26.10.2017)5.1.3

189INTRODUCTION5.1.3.1

190SALARY TYPES5.1.3.2

190
Following Salary Type Now With Limit Amounts
(Minimum/Maximum)

5.1.3.2.1

190PAYROLL LOG5.1.3.3

190REPORTING5.1.3.3.1

190
Payroll Journal | Periode of time column5.1.3.3.1.

1
191SALARY DECLARATION5.1.3.4

191
ELM | Long Feedback From Data Recipients
Generates an Error Message

5.1.3.4.1

191SWISSSALARY DIRECT5.1.3.5
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191
Preparing Payslips for “Unregistered Employees” for
Printing After Delivery

5.1.3.5.1

191
Send Documents to | Setting the Default Value to
Registered Employees Only

5.1.3.5.2

191Test Mode | Upload via Dossier5.1.3.5.3

191
SmartPort | Changed Bank Details Transferred to the
Staff Card Correctly

5.1.3.5.4

192REPORTS | INTERFACES5.1.3.6

192Personnel File | Personnel Dimensions Output5.1.3.6.1

192
ALV Temporary Employment Certificate | Digit 11
Corrected

5.1.3.6.2

192Salary Certificate | Language Selection In Workplace5.1.3.6.3

192
BESTA Statistics | Preview Similar to Print Preview In
RTC Versions

5.1.3.6.4

192
Account Reconciliation | Excel Export With Account
Layout

5.1.3.6.5

193Update 5052.000 Systemadmin5.2

193SwissSalary Homepage | Update-Download5.2.1

193Instructions (3)5.2.1.1

194Downloading / Refreshing Updates and PreUpdates5.2.2

194Instructions (3)5.2.2.1

198Access Autorisations and Roles5.2.3

198Instructions (3)5.2.3.1

6 Update 5051.000

201Update 5051.000 User6.1

201PreUpdate 5050.1006.1.1

201Introduction6.1.1.1

202Improvements6.1.1.2

202Salary certificate (Form. 11) | Activity external work (3)6.1.1.2.1

203
Absence Claim | Automatic Holiday and
Work-in-Advance Days Entitlement (3)

6.1.1.2.2

204PP Franking | Payslip (3)6.1.1.2.3

204
SwissSalary Direct | Independent Creation of New
Access (3)

6.1.1.2.4

205SwissSalary Store | Direct File Download (3)6.1.1.2.5

206RTC-Versions | Graphs and Charts (3)6.1.1.2.6

207
RTC-Versions | Salary Types and Payroll Setup are
Started as View (3)

6.1.1.2.7

207Creating New Company Using the Setup Wizard (3)6.1.1.2.8

207New Support for PDFCreator Version 2.x (3)6.1.1.2.9

208
One-time Installation of .NET Assemblies for 2
D-Barcodes on Wage Statement (3)

6.1.1.2.10

210Personnel6.1.1.3

210TimeMachine | Asterisk Like in the Classic-Client (3)6.1.1.3.1

210
TimeMachine-Entries | New Factbox in the
RTC-Client (3)

6.1.1.3.2

210
Holiday Payment and Holiday Remuneration Order
(3)

6.1.1.3.3

211Personnel Dimension | Totalizing (3)6.1.1.3.4

211
Social Services Control | More Columns Similar to
Classic-Clients (3)

6.1.1.3.5
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211
General Reports | Assigning Reports to Individual
Users (3)

6.1.1.3.6

211Salary Types6.1.1.4

211
New Field | Posted Salary Types (Payroll Setup
Analysis)

6.1.1.4.1

212Payroll Setup6.1.1.5

212Tab 'BVG'6.1.1.5.1

212
BVG fictitious monthly rouding of
Contributions (3)

6.1.1.5.1.
1

212

Pay Rise as of January 1 | Annual BVG
Wage Fictitiously Calculated Even at Zero
Rounding (3)

6.1.1.5.1.
2

213
BVG Calculation on the Hourly Wage Base
(3)

6.1.1.5.1.
3

213
BVG Maximum Percent by Position | Turned
into Selection Field (3)

6.1.1.5.1.
4

214Payroll Log6.1.1.6

214Reporting6.1.1.6.1

214
Wage Rate Taken into Account Based on
the Change in the TimeMachine (3)

6.1.1.6.1.
1

214
TapBoard | Launching the Correct Report
Journal (3)

6.1.1.6.1.
2

214
Plausibility Check | Daily our Monthly Check
(3)

6.1.1.6.1.
3

214Post Payroll6.1.1.6.2

214
Accounting Details | Additional Information
in Factbox (3)

6.1.1.6.2.
1

215
Project Items | Document Date and Detailed
Text (3)

6.1.1.6.2.
2

215Salary Declaration6.1.1.7

215Income Tax Statements (3)6.1.1.7.1

215Reports6.1.1.8

215
Attestation of Employer ALV | Also without Date of
Resignation (4)

6.1.1.8.1

215
Short message and Accompanying Letter | Full Name
(3)

6.1.1.8.2

216
Payslip with SwissSalary Direct | Placeholder %8 for
URL (3)

6.1.1.8.3

216
Employee Salary Statement A4L | Can be Accessed
in Pay Process (3)

6.1.1.8.4

216
Salary Type List A4P and A4L Expanded with Quantity
(3)

6.1.1.8.5

216Salary Summery Holding | New 'Canton' Column (3)6.1.1.8.6

216Administration SwissSalary6.1.1.9

216DTA/EZAG Setup | Now Under Administration (3)6.1.1.9.1

216Allocation Group | Tab Labels Revised (3)6.1.1.9.2

217
RTC-Versions | SmartPort can be Opened Now via
Departments (3)

6.1.1.9.3

217
Automatic Execution of EasyRapport Transfer After
Post Payroll (3)

6.1.1.9.4

217
EasyRapport/TapBoard | Rapport Types | Extended
Option "hide" (3)

6.1.1.9.5

217SmartPort6.1.1.10

217SmartPort | Display Fields Last Name/First Name6.1.1.10.1

218SmartPort | More Fields can be imported (3)6.1.1.10.2

218Bug fixes6.1.1.11

218Various Reports Revised (3)6.1.1.11.1
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219
Personnel History with Error Message in Case of
Multiple Changes (3)

6.1.1.11.2

219Salary declaration ELM | Improvements (4)6.1.1.11.3

219
Salary Certificate without Gross Wage, but with
Flatrate Expenses (3)

6.1.1.11.4

220
TimeMachine | Change of Percents by Position
During the Month (3)

6.1.1.11.5

220TimeMachine | Text in Multiple Languages (3)6.1.1.11.6

220
Payroll Journal | Notice When an Employee Had
Resigned (3)

6.1.1.11.7

220Payroll Journal | Too Long Salary Type Translation (3)6.1.1.11.8

220
Working Time Calendar | Settings | Days/Hours
Column Designations (3)

6.1.1.11.9

220
FIBU CC Matrix | Now Always Active (3)6.1.1.11.1

0

220
BAU | Personnel Dimension | CC Cannot be
Recorded (3)

6.1.1.11.1
1

221Notes for our SwissSalary NAV partners6.1.1.12

221
System Initialization | Extension of Net Wage
Compensation (3)

6.1.1.12.1

221BAU | UVG Cost Centers (BUV) Eliminated (3)6.1.1.12.2

221
SwissSalary Module S | Integrated into License
Verification (3)

6.1.1.12.3

221SwissSalary User with GetUserName (3)6.1.1.12.4

222Revision of Fields | Deleted and Obsolete Fields (3)6.1.1.12.5

222PreUpdate 5050.2006.1.2

223Introduction6.1.2.1

223Improvements6.1.2.2

223
ELM Transmitter | Communication and Submission
Now Made in the NAV Client Directly (3)

6.1.2.2.1

225
ELM Transmitter Installation | RTC Versions
| NAV 2009 SP1 RTC up to NAV 2016 (3)

6.1.2.2.1.
1

227

ELM Transmitter Installation | Classic
Versions | NAV 4.00 SP2 - NAV 2009 R2
Classic (3)

6.1.2.2.1.
2

229
Proxy Server Support for Outbound
Connections (3)

6.1.2.2.1.
3

229SmartPort | Completely Revised and Enhanced (3)6.1.2.2.2

232
New Fields | XML Schema (XSD) Extended
(3)

6.1.2.2.2.
1

233
Preview of Mutations in Factbox (3)6.1.2.2.2.

2

233
Editing and Ignoring Fields (3)6.1.2.2.2.

3

233
Mutation Confirmation Order Controlled (3)6.1.2.2.2.

4

233
Records Accepted Without Manual
Confirmation (3)

6.1.2.2.2.
5

233
Original Value is Saved and Displayed in
the Log (3)

6.1.2.2.2.
6

233
Deleting Employees via SmartPort (3)6.1.2.2.2.

7

234
Mutation Description (3)6.1.2.2.2.

8
234Following Salary Type | Enhancement6.1.2.2.3

235SwissSalary Direct6.1.2.2.4

235
No Email Notification Sending (3)6.1.2.2.4.

1
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236
Employee Documents Synchronization (3)6.1.2.2.4.

2

237
Dossier Batch Import (via Folder) (3)6.1.2.2.4.

3

238
Automatic Synchronization via Job Queue
(3)

6.1.2.2.4.
4

239

Documents are Dispatched and Logged
Immediately (even in the case of partial
delivery) (3)

6.1.2.2.4.
5

239
Company Name Filter | Preventing Incorrect
Test Client Synchronizations (3)

6.1.2.2.4.
6

240
Synchronization Rollback (3)6.1.2.2.4.

7
240Employee6.1.2.3

240Employee Address | TimeMachine (3)6.1.2.3.1

240
Pay Process List | Changing Additional Fields for WT
ELM Submission (3)

6.1.2.3.2

241
Personnel List and Personnel Card | New ‘Payroll
Journal Row’ Factbox (3)

6.1.2.3.3

242
Income Tax Calculation | TimeMachine Also
Balanced with Year + Year Calculation Type (3)

6.1.2.3.4

242Wage Items | Creating Test Billing (3)6.1.2.3.5

242Payroll Setup6.1.2.4

242
Family Allowances | Calculation/Rounding in Case of
Employment During the Month (3)

6.1.2.4.1

243Salary Declaration6.1.2.5

243
Year-end Statements Filtered Using the Recorded
Values (3)

6.1.2.5.1

243
Salary Certificate | Field Service Share |
Distinguishing Between Federal and Cantona (3)

6.1.2.5.2

245
Salary Certificate | Field Service Share | Acquiring
Days in the Amount Field (3)

6.1.2.5.3

245
Salary Certificate | Employee's Individual Comments
(3)

6.1.2.5.4

245
Social Unit | Headers Missing On Subsequent Pages
(3)

6.1.2.5.5

245
ELM | Marriage Date 0001-01-01 During IT ELM
Submission (3)

6.1.2.5.6

245
ELM | XML File Misspelled When a IT Canton
Exclusively Receives Corrections (3)

6.1.2.5.7

246
ELM | IT ELM Error Message in Case of Clean
Additional Pay Processes (3)

6.1.2.5.8

246
ELM | Validation Error When TimeMachine Entries
Created in Version 5050.000 (3)

6.1.2.5.9

246Reports6.1.2.6

246History | TimeMachine Entries Considered (3)6.1.2.6.1

246
Attestation of Employeur ALV | Para 20: Pension Fund
Name (3)

6.1.2.6.2

246
Intermediate certificate of profit ALV | Holiday Pay for
Monthly Wages Produces False Wages  (3)

6.1.2.6.3

247Plausibility Check | Report Revised Completely (3)6.1.2.6.4

247
Paycheck | Second On-account Payment Not
Displayed On Payslip

6.1.2.6.5

247
Paycheck | In Case of 2 ESR Banks Only 1 ESR
Payment is Taken into Account (3)

6.1.2.6.6

247
Paycheck | Classic Client | Displaying the Number of
Employees per Pay Process (3)

6.1.2.6.7

247
General Ledger Log | Excel Export with Period
Specified (3)

6.1.2.6.8
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248
HI / UVG / UVG Additional Summary | Insurer Name
Displayed (3)

6.1.2.6.9

248
Employee Salary Statement A4L Personal Wage
Account Adjusted (3)

6.1.2.6.10

248Payroll Setup | Field ‘AHV Administrative Costs' (3)6.1.2.6.11

248Rate Fluctuation | Report Revised (3)6.1.2.6.12

249Administration SwissSalary6.1.2.7

249
Payroll Setup | Personnel Master Data History Always
Written (3)

6.1.2.7.1

249
Allocation Group | Social Benefits Presets Expanded
with the Wage Type Field (3)

6.1.2.7.2

249
Allocation Group | Display for Balances | Payroll and
EasyRapport are Separate (3)

6.1.2.7.3

249Bug Fixes6.1.2.8

249
Copy Employee | Error in Case of Client Names with
“(” (3)

6.1.2.8.1

249
Years of Service Calculation | Evaluation and
Calculation (Leap Year) Validated and Corrected (3)

6.1.2.8.2

250
Payroll Journal | Cursor Jump within Resulting Salary
Types (3)

6.1.2.8.3

250Plausibility Report | Character Number Error (3)6.1.2.8.4

250
‘Fetch EasyRapport Items’ Function With a New
Notice (3)

6.1.2.8.5

250
Paycheck | IT Deduction, Even If No Time Reported
for Hourly Wage Recipients (3)

6.1.2.8.6

250
Paycheck | Additional Pay Process with CHF 0
Triggers IT Calculation (3)

6.1.2.8.7

251
Paycheck | Wrong First/Last Name On the Next Page
(3)

6.1.2.8.8

251
Paycheck | NAV 2009 | Error If Address Is Set "To the
Left” (3)

6.1.2.8.9

251
Paycheck Email Delivery Without SwissSalary Direct
(3)

6.1.2.8.10

251
DTA File | Completion Notification Shows Wrong
Currency Code (3)

6.1.2.8.11

251

Post Payroll | Error in Case of
Recruitment/Resignation During the Same Month,
But Not in the Same Year (3)

6.1.2.8.12

252
Social Unit | Additional Income Limit Taken into
Account (3)

6.1.2.8.13

252
IT Calculation Error | Salary Types Without Rate
Determination with Extrapolation (3)

6.1.2.8.14

252
A4Q Personnel List Statistics | Excel Export with Error
Message (3)

6.1.2.8.15

252
Salary Certificate | Windows Access Control with 2D
Barcode (3)

6.1.2.8.16

253SmartPort | Records Not Reported Were Deleted (3)6.1.2.8.17

253Notes for our SwissSalary NAV partners6.1.2.9

253TimeMachine History | Subpage Deleted by User (3)6.1.2.9.1

253
Error Message During ZIP Code Loading (missing LI
entry) (3)

6.1.2.9.2

253
SwissSalary Store | Lock Updates When SwissSalary
Version is Outdated (3)

6.1.2.9.3

253
swissdec Code Unit | Converted from COM to .NET
Components (3)

6.1.2.9.4

254
SwissSalary Direct | Error Code 1001 Displayed
Incorrectly (3)

6.1.2.9.5

254SmartPort | Placing BLOB Field (3)6.1.2.9.6

255Update 5051.0006.1.3
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255Introduction6.1.3.1

255Improvements6.1.3.2

255Salary certificate (Form. 11) | Activity external work6.1.3.2.1

256Following Salary Type | Enhancement6.1.3.2.2

258
Absence Claim | Automatic Holiday and
Work-in-Advance Days Entitlement

6.1.3.2.3

259PP Franking | Paycheck6.1.3.2.4

260SwissSalary Store | Direct File Download6.1.3.2.5

261RTC-Versions | Graphs and Charts6.1.3.2.6

262
RTC-Versions | Salary Types and Payroll Setup are
Started as View

6.1.3.2.7

262BAU Version | Links in the Role Center6.1.3.2.8

262Creating New Company Using the Setup Wizard6.1.3.2.9

262New Support for PDFCreator Version 2.x6.1.3.2.10

263Expense Receipts | Export/Import Feature6.1.3.2.11

263
Work Calendar | Work Group | Limits per Percent by
Position to be Considered

6.1.3.2.12

264
ELM Transmitter | Communication and Submission
Now Made in the NAV Client Directly

6.1.3.2.13

265
One-time Installation of .NET Assemblies
for 2 D-Barcodes on Wage Statement

6.1.3.2.1
3.1

268
ELM Transmitter Installation | RTC Versions
| NAV 2009 SP1 RTC up to NAV 2016

6.1.3.2.1
3.2

269

ELM Transmitter Installation | Classic
Versions | NAV 4.00 SP2 - NAV 2009 R2
Classic

6.1.3.2.1
3.3

271
Proxy Server Support for Outbound
Connections

6.1.3.2.1
3.4

272SwissSalary Direct6.1.3.2.14

272
SwissSalary Direct | Independent Creation
of New Access

6.1.3.2.1
4.1

273
No Email Notification Sending6.1.3.2.1

4.2

274
Employee Documents Synchronization6.1.3.2.1

4.3

274
Dossier Batch Import (via Folder)6.1.3.2.1

4.4

276
Automatic Synchronization via Job Queue6.1.3.2.1

4.5

277

Documents are Dispatched and Logged
Immediately (even in the case of partial
delivery)

6.1.3.2.1
4.6

277
Company Name Filter | Preventing Incorrect
Test Client Synchronizations

6.1.3.2.1
4.7

277
Synchronization Rollback6.1.3.2.1

4.8
278SmartPort | Completely Revised and Enhanced6.1.3.2.15

280
SmartPort | Display Fields Last Name/First
Name

6.1.3.2.1
5.1

281
New Fields | XML Schema (XSD) Extended6.1.3.2.1

5.2

281
Preview of Mutations in Factbox6.1.3.2.1

5.3

281
SmartPort | More Fields can be imported6.1.3.2.1

5.4

282
Editing and Ignoring Fields6.1.3.2.1

5.5

282
Mutation Confirmation Order Controlled6.1.3.2.1

5.6
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282
Records Accepted Without Manual
Confirmation

6.1.3.2.1
5.7

282
Original Value is Saved and Displayed in
the Log

6.1.3.2.1
5.8

282
Deleting Employees via SmartPort6.1.3.2.1

5.9

283
Mutation Description6.1.3.2.1

5.10
283Personnel6.1.3.3

283
Employee List and Employee Card | New ‘Payroll
Journal Row’ Factbox

6.1.3.3.1

283Employee Address | TimeMachine6.1.3.3.2

284TimeMachine | Asterisk Like in the Classic-Client6.1.3.3.3

284
TimeMachine-Entries | New Factbox in the
RTC-Client

6.1.3.3.4

284
TimeMachine | Warning in Case of Missing Monthly
Parts

6.1.3.3.5

284
Income Tax Calculation | TimeMachine Also
Balanced with Year + Year Calculation Type

6.1.3.3.6

285Wage Items | Creating Test Billing6.1.3.3.7

285Holiday Payment and Holiday Remuneration Order6.1.3.3.8

286
Pay Process List | Changing Additional Fields for WT
ELM Submission

6.1.3.3.9

286Personnel Dimension | Totalizing6.1.3.3.10

286
Social Services Control | More Columns Similar to
Classic-Clients

6.1.3.3.11

287PIS | Tab ‘Pass’ in the RTC6.1.3.3.12

287
General Reports | Assigning Reports to Individual
Users

6.1.3.3.13

287Salary Types6.1.3.4

287
Resulting Following Salary Types | More Decimals
After Comma

6.1.3.4.1

287
Copy Salary Type | Resulting Wage Type is Not
Copied as Well

6.1.3.4.2

288Payroll Setup6.1.3.5

288
Family Allowances | Calculation/Rounding in Case of
Employment During the Month

6.1.3.5.1

288
Payroll Setup | Personnel Master Data History Always
Written

6.1.3.5.2

288General | DTA Relevant Fields Relocated6.1.3.5.3

289
Paycheck | Subtotals Can Be Hidden in the RTC
Payslip

6.1.3.5.4

289Tab 'BVG'6.1.3.5.5

289
BVG fictitious monthly rouding of
Contributions

6.1.3.5.5.
1

289

Pay Rise as of January 1 | Annual BVG
Wage Fictitiously Calculated Even at Zero
Rounding

6.1.3.5.5.
2

290
BVG Calculation on the Hourly Wage Base6.1.3.5.5.

3

290
BVG Maximum Percent by Position | Turned
into Selection Field

6.1.3.5.5.
4

291Payroll Log6.1.3.6

291Reporting6.1.3.6.1

291
Wage Rate Taken into Account Based on
the Change in the TimeMachine

6.1.3.6.1.
1

291
TapBoard | Launching the Correct Report
Journal

6.1.3.6.1.
2
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291
Plausibility Check | Daily our Monthly Check6.1.3.6.1.

3
291Post Payroll6.1.3.6.2

291
Accounting Details | Additional Information
in Factbox

6.1.3.6.2.
1

292
Project Items | Document Date and Detailed
Text

6.1.3.6.2.
2

292Salary Declaration6.1.3.7

292
Year-end Statements Filtered Using the Recorded
Values

6.1.3.7.1

292
Salary Certificate | Field Service Share |
Distinguishing Between Federal and Cantona

6.1.3.7.2

294
Salary Certificate | Field Service Share | Acquiring
Days in the Amount Field

6.1.3.7.3

294Salary Certificate | Employee's Individual Comments6.1.3.7.4

294Income Tax Statements6.1.3.7.5

294Social Unit | Headers Missing On Subsequent Pages6.1.3.7.6

294
ELM | Marriage Date 0001-01-01 During IT ELM
Submission

6.1.3.7.7

295
ELM | XML File Misspelled When a IT Canton
Exclusively Receives Corrections

6.1.3.7.8

295
ELM | IT ELM Error Message in Case of Clean
Additional Pay Processes

6.1.3.7.9

295
ELM | Validation Error When TimeMachine Entries
Created in Version 5050.000

6.1.3.7.10

295
ELM | Text Overflow During IT Rate Reporting for the
Canton of VD

6.1.3.7.11

296Administration SwissSalary6.1.3.8

296
Allocation Group | Social Benefits Presets Expanded
with the Wage Type Field

6.1.3.8.1

296
Allocation Group | Display for Balances | Payroll and
EasyRapport are Separate

6.1.3.8.2

296Allocation Group | Tab Labels Revised6.1.3.8.3

296DTA/EZAG Setup | Now Under Administration6.1.3.8.4

296
RTC-Versions | SmartPort can be Opened Now via
Departments

6.1.3.8.5

297
Automatic Execution of EasyRapport Transfer After
Post Payroll

6.1.3.8.6

297
EasyRapport/TapBoard | Rapport Types | Extended
Option "hide"

6.1.3.8.7

297
EasyRapport/TapBoard | Report Types | Salary Type
Check and ‘hide’ Taken into Account

6.1.3.8.8

298Reports6.1.3.9

298Paycheck6.1.3.9.1

298
Paycheck with SwissSalary Direct |
Placeholder %8 for URL

6.1.3.9.1.
1

298
Paycheck | Second On-account Payment
Not Displayed On Paycheck

6.1.3.9.1.
2

298
Paycheck | In Case of 2 ESR Banks Only 1
ESR Payment is Taken into Account

6.1.3.9.1.
3

298
Paycheck | Classic Client | Displaying the
Number of Employees per Pay Process

6.1.3.9.1.
4

299
Attestation of Employer ALV | Also without Date of
Resignation (2)

6.1.3.9.2

299
Attestation of Employeur ALV | Para 20: Pension Fund
Name

6.1.3.9.3

299
Intermediate certificate of profit ALV | Holiday Pay for
Monthly Wages Produces False Wages

6.1.3.9.4

299
SBV Earnings Survey | Report is Now in BAU (NAV
2015)

6.1.3.9.5
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299History | TimeMachine Entries Considered6.1.3.9.6

299Short message and Accompanying Letter | Full Name6.1.3.9.7

300
General Ledger Log | Excel Export with Period
Specified

6.1.3.9.8

300
Employment Statistics | New Profiling File per
Employee

6.1.3.9.9

300
Employee Salary Statement A4L Personal Wage
Account Adjusted

6.1.3.9.10

300
Employee Salary Statement A4L | Can be Accessed
in Pay Process

6.1.3.9.11

300
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6.1.3.9.12

301Salary Type List A4P and A4L Expanded with Quantity6.1.3.9.13

301Payroll Setup | Field ‘AHV Administrative Costs'6.1.3.9.14

301Rate Fluctuation | Report Revised6.1.3.9.15

301Salary Summery Holding | New 'Canton' Column6.1.3.9.16

301GastroSocial Interface Extended6.1.3.9.17

301Plausibility Check | Report Revised Completely6.1.3.9.18

302LOGIB Version 3.06.1.3.9.19

302Bug fixes6.1.3.10

302Various Reports Revised6.1.3.10.1

303
Copy Employee | Error in Case of Client Names with
“(”

6.1.3.10.2

303
Personnel History with Error Message in Case of
Multiple Changes

6.1.3.10.3

303Alternative Address | Error Message6.1.3.10.4

303
Years of Service Calculation | Evaluation and
Calculation (Leap Year) Validated and Corrected

6.1.3.10.5

304
Zero Division of the Income Tax Calculation in Case
of Recruitment On Day 31 of the Month

6.1.3.10.6

304Salary declaration ELM | Improvements (2)6.1.3.10.7

304
Salary Certificate without Gross Wage, but with
Flatrate Expenses

6.1.3.10.8

304
Salary Certificate | Windows Access Control with 2D
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6.1.3.10.9

305
TimeMachine | Change of Percents by Position
During the Month

6.1.3.10.1
0

305
TimeMachine | Text in Multiple Languages6.1.3.10.1

1

305
Balances in Personnel File Do Not Show6.1.3.10.1

2

305
Payroll Journal | Notice When an Employee Had
Resigned

6.1.3.10.1
3

305
Payroll Journal | Too Long Salary Type Translation6.1.3.10.1

4

306
Payroll Journal | Cursor Jump within Resulting Salary
Types

6.1.3.10.1
5

306
Function Keys in TapBoard6.1.3.10.1

6
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‘Fetch EasyRapport Items’ Function With a New
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6.1.3.10.1
7

306
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6.1.3.10.1
8
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6.1.3.10.1
9

307
Paycheck | Wrong First/Last Name On the Next Page6.1.3.10.2

0

307
Paycheck | NAV 2009 | Error If Address Is Set "To the
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6.1.3.10.2
1
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307
Paycheck Email Delivery Without SwissSalary Direct6.1.3.10.2

2

307
SwissSalary Direct Delivery | Error 500 When
Sending Certain PDF Files

6.1.3.10.2
3

307
DTA File | Completion Notification Shows Wrong
Currency Code

6.1.3.10.2
4

307

Post Payroll | Error in Case of
Recruitment/Resignation During the Same Month,
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6.1.3.10.2
5

308
IT Calculation Error | Salary Types Without Rate
Determination with Extrapolation

6.1.3.10.2
6

308
Social Unit | Additional Income Limit Taken into
Account

6.1.3.10.2
7

308
A4Q Personnel List Statistics | Excel Export with Error
Message

6.1.3.10.2
8

308
Working Time Calendar | Settings | Days/Hours
Column Designations

6.1.3.10.2
9

308
FIBU CC Matrix | Now Always Active6.1.3.10.3

0

309
SmartPort | Records Not Reported Were Deleted6.1.3.10.3

1

309
BAU | Personnel Dimension | CC Cannot be
Recorded

6.1.3.10.3
2

309
Plausibility Report | Character Number Error6.1.3.10.3

3

309
Reporting On Project Items | Sale Price Written to
Items

6.1.3.10.3
4

309
Pay Process | Payroll Number Taken into Filter
Correctly

6.1.3.10.3
5

310Notes for our SwissSalary NAV partners6.1.3.11

310
System Initialization | Extension of Net Wage
Compensation

6.1.3.11.1

310BAU | UVG Cost Centers (BUV) Eliminated6.1.3.11.2

310TimeMachine History | Subpage Deleted by User6.1.3.11.3

310
SwissSalary Direct | Error Code 1001 Displayed
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6.1.3.11.4

311
SwissSalary Module S | Integrated into License
Verification

6.1.3.11.5

311SwissSalary User with GetUserName6.1.3.11.6

311
swissdec Code Unit | Converted from COM to .NET
Components

6.1.3.11.7

311
SwissSalary Store | Lock Updates When SwissSalary
Version is Outdated

6.1.3.11.8

312SmartPort | Placing BLOB Field6.1.3.11.9

312
Error Message During ZIP Code Loading (missing LI
entry)

6.1.3.11.1
0

312
Revision of Fields | Deleted and Obsolete Fields6.1.3.11.1

1

313Update 5051.000 Systemadmin6.2

313SwissSalary Homepage | Update-Download6.2.1

313Instructions (2)6.2.1.1

315Downloading / Refreshing Updates and PreUpdates6.2.2

315Instructions (2)6.2.2.1

319Access Autorisations and Roles6.2.3

319Instructions (2)6.2.3.1

7 Update 5050.000
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1    Update 5057.000

1.1    Hotfix 5057.002 (July 14, 2021)

Introduction
Hotfix 5057.002 was released on July 14, 2021 for our onPrem customers (installed version). The hotfix is
automatically available for our SwissSalary 365 SaaS customers a few days later and can be imported via
‘Business Central admin center’ -> ‘Apps’.

Task #10004 | 5057.002
Logib interface | Allowances and Special bonuses columns  
Value output correction. Payments of the previous 12 months are now taken into account and the value of
1/12 is output. Adjustments have also been made to working hours and employment contracts.  

Task #10691 | 5057.002
PEKA interface | Number format without delimiters  
In newer NAV versions, thousands separators were included in number format in the interface file. This was
corrected and the output has no delimiters. 

Task #10713 | 5057.002
SAP Business by Design interface | Adjustment for provisions 
During provision calculation or reversal, incorrect booking occurred because the formation and reversal of
the provisions took place on the same day. This bug has been fixed. 

Task #10714 | 5057.002
Personnel history | Output on due date
Entries were incorrectly displayed when the output was filtered on a working day. The entries were
displayed when filtering was applied to a longer period. This bug has been fixed. 

Task #10705 | 5057.002
Employee bank | Filter triggers errors due to field length
Depending on the was filters were set up and recorded, the employee bank could no longer be retrieved
and edited. This bug has been fixed. 

Task #10725 | 5057.002
Payslip | Second page output
It was possible with update 5057.000 to create a second page for payslip. However, this second page was
completely blank. The error has been corrected and a second page is only generated if it has values to
display and there is not enough space for them on a single page. 

Task #10695 | 5057.002
SwissSalary Budget: budget structure error message 
An error message was displayed in the budget structure when the Add employee function was executed in
SwissSalary Budget. This is the case if the same cost center was assigned to the employee twice. This bug
has been fixed. 

Task #10762 | 5057.002
EasyRapport: Transfer | Synchronization duration in all clients
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Cross-client settings were changed with update 5057.000. They are now stored for each client. As a result,
the synchronization took a long time. We were able to fix this. 

Task #10638 | 5057.002
SwissSalary NSP | Personnel position visa fields  
To apply SwissSalary NSP, visa fields for EasyRapport have been expanded to include personnel position.

Task #10750 | 5057.002
SwissSalary users | Department permissions
In addition to the filter for individual payroll areas, users can also set a filter for departments. Nevertheless,
evaluations could display people that could not be edited with the recorded filter. This bug has been fixed.  

Task #10751 | 5057.002
SwissSalary users | Permissions 
Indirect permissions have been added for the SwissSalary Direct settings table and SwissSalary user
settings. 

Task #10775 | 5057.002
SUA certificate | Special characters in client names
An SUA certificate must be released to use KLE. Special characters in client names triggered error messages.
Adjustments have been made here so that the certificates can be released with special characters in the
client name and in company data.

Task #10664 | 5057.002
Income tax | The end of WT obligation during the year calculated incorrectly for the cantons with
annual billing
If a person was released from withholding tax during the year, a rate-determining income was still
calculated in cantons with the annual accounting method and the withholding tax deduction was
calculated. This bug has been fixed. Manual corrections for incorrect deductions need to be checked. 

Task #10743 | 5057.002
Income tax | Incorrect calculation for retrospective corrections in rate-determining income
extrapolation
The rate-determining value was not correctly taken into account during retroactive rate adjustments. This is
the case if an extrapolation had to be made in the month concerned due to a recruitment during the
month. This bug has been fixed.

Task #10708 | 5057.002
Income tax | Calculation for a new back payment after resignation
If several back payments were triggered after resignation, the withholding tax amount was not calculated
correctly with update 5056.002 when retroactive calculation was excluded. This bug has been fixed. 

Task #10769 | 5057.002
Income tax | Back payment without retroactive calculation information in the Payroll Head table
When task 10708 was being solved, it became apparent that this system table requires an adjustment. The
value is now archived in the table. 

Task #10668 | 5057.002
Income tax reporting | Missing canton
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Since update 5057.000, the error message occurred during submission when people were retroactively
accounted for withholding tax. This bug has been fixed. 

Task #8851 | 5057.002
Income tax reporting | Missing canton
The error message occurred during submission if the rate or WT canton were deleted by mistake if a person
is no longer subject to withholding tax. We were able to rectify this, although the message can still appear
due to the archived value. 

Task #10770 | 5057.002
Income tax accounting | Correction of evaluation
The base is taken from wage items and not recalculated when the report is prepared. 

Task #10724 | 5057.002
Income tax accounting | Allowances and one-time payments
All wage types billed aperiodically are now taken into account. The column heading has been changed to
aperiodic.

1.2    Hotfix 5057.001 (June 11, 2021) | Users

Introduction
Hotfix 5057.001 was released on June 11, 2021 for our onPrem customers (installed version). The hotfix was
automatically available for our SwissSalary 365 SaaS customers a few days later and can since be imported
via ‘Business Central admin center’ -> ‘Apps’.

Hotfix 5057.001 contains the developments and corrections listed below:

The “Wage Data Import via Excel” report did not work after update 5057.000. This bug has been fixed. 

Task #10560 | 5057.001
Back payment at resignation due to regular retirement | Missing ALV burden  
In the event of back payments at resignation due to regular retirement, no ALV was settled for the back
payment. This bug has been fixed.

Task #10633 | 5057.001
Back payment in the years following the resignation | Wrong AHV pension allowance  
The pension allowance was not taken into account correctly in the event of back payments to people who
have benefited from a pension allowance during their employment. A new pension allowance was
generated for payments settled in the second year after resignation from the company. This bug has been
fixed.

Task #10488 | 5057.001
Payslip preparation | Filtering by language code 
Payslips can now be filtered by language code. Language code was transferred to the pay process table for
this purpose, also to ensure its availability retrospectively. 

Task #10688 | 5057.001
Payslip preparation | Copy displayed despite not being selected
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It was possible as of NAV 2017 that a copy was displayed in the payslip, although this was deactivated
beforehand. This bug has been fixed. 

Task #9259 | 5057.001
Report card | Totals output on the Report card and in EasyRapport
Depending on the settings, the totals for the report card and for EasyRapport were calculated differently.
This has been fixed and the output is always identical after billing. 

Task #10562 | 5057.001
Report card | Employee's translation language code in line with Company language
The report card should be issued in the employee’s language code if output in the company language is
not activated. 

Task #10683 | 5057.001
SwissSalary Cloud: A4H and A4Q wage type list | Selection field are not displayed in Excel  
Selection fields were not displayed in the cloud environment if the report was created in Excel. The values
were displayed when a PDF was created. This bug has been fixed. 

Task #10666 | 5057.001
BusinessCentral 18 SwissSalary Cloud: Payslip | Proof run of values based on placeholders  
In the cloud environment, values defined by placeholders were not correctly imprinted. This bug has been
fixed. 

Task #10641 | 5057.001
BusinessCentral 18 SwissSalary Cloud: personnel file | PDF and ZIP import  
Sometimes a document could no longer be opened in the cloud environment. The file is now correctly
named again and can also be opened. 

Task #10602 | 5057.001
Logib | Field length extension
Up to now, 100 characters could be entered in the filter. This filter has been expanded to make longer filters
possible in the future. Field length was extended to 1024 characters.  

Task #10639 | 5057.001
Landolt & Mächler Wage comparison | Special bonuses per year
The value for one month was exported. The value is calculated correctly based on the previous 12 months. 

Task #10690 | 5057.001
Income tax calculation | Consideration if no wages are posted
In cantons with annual billing, the smoothed value is calculated even if no wage payment is triggered in a
month of appointment. Starting from version 5056.004, it was not calculated if no wages were paid in a
month. 

Task #10759 | 5057.001
Income tax reporting | Rate-determining value indication
Starting from the beginning of the year, the rate-determining value has to be reported in the ELM file. The
rate-determining value of the accounting month was reported. It can deviate from the relevant value,
especially in cantons with annual billing. The smoothed calculated value is now always transmitted. 

Task #10692 | 5057.001
Income tax reporting | Display of corrections
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In the event of retrospective corrections, the deduction credited was not clearly displayed during the
correction. Retrospective corrections submission has been improved with this task. 

Task #10647 | 5057.001
Income tax calculation | Maximum value of other known income sources
A maximum of 100% could be recorded for other income sources. This value was increased to a maximum
of 200%. 

1.3    Update 5057.000 (06.05.2021) | User

1.3.1    Update 5057 | Introduction

Dear SwissSalary Customers,
Dear SwissSalary Partners,

We present to you the manual for SwissSalary Update 5057.000 of 5/06/2021. It also includes documentation
on 5056.001 - 5056.004 hotfixes. Your SwissSalary will be up to date after installing this update. In addition to
great new features and improvements in SwissSalary, we have also further developed our bi-directional
interfaces to the existing add-ons

- SwissSalary Direct
- SwissSalary EasyRapport

and to our latest solution 

- SwissSalary Insights.

IMPORTANT NOTES

q Basic requirement
q Please make sure that SwissSalary version 5056.000 or newer of October 29, 2020 was installed before this

update. If your Dynamics 365 has implemented company-specific changes to your SwissSalary standard
objects, you must contact your Dynamics 365 partner prior to installing the objects.

q Please make sure that you always work with the latest version. We support the latest and most recent
SwissSalary version.

q Please note that with this update we introduce major modifications and input actions. This means that the
update process takes much longer than usual, especially for long-term and larger customers. This process
can take from a few seconds/minutes to > 1 hour. Please apply this update in off-peak times. For more
information, please go to:
- Posting Salary Entry with actual time
- Employee Changelog

q Comprehensive update with all available objects
The main updates will be released in April and October similar to the Microsoft Dynamics 365 Business
Central release cycle. Each individual version must be installed chronologically. No update versions may be
omitted (except hotfixes). The client must be restarted after the installation of each version for the update
process to run and the latest version to appear under ‘Organization’.

q SwissSalary 365 | Microsoft Dynamics 365 Business Central | Microsoft SaaS-Cloud
The SwissSalary 365 app is always up-to-date with the latest versions of Microsoft Dynamics 365 Business
Central and SwissSalary. The app is updated with just a few clicks directly via the admin center (see our video
tutorial).

https://www.youtube.com/watch?v=Le5o_pxsh6w&t=14s
https://www.youtube.com/watch?v=Le5o_pxsh6w&t=14s
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q SwissSalary onPrem | Dynamics 365 Business Central
SwissSalary Update 5057 is available for the following Business Central versions (onPrem/private cloud):
- new Dynamics 365 Business Central 2021 Wave 1 - version 18 (AL)
- Dynamics 365 Business Central 2020 Wave 2 - version 17 (AL)

- Dynamics 365 Business Central Spring' 19 - Version 14 (C/AL)
- Dynamics 365 Business Central Fall' 18 - Version 13 (C/AL)

The new ‘AL’ versions of Dynamics 365 Business Central are controlled by the new Microsoft life cycle
concept. We support the latest version. This concerns, for example, the next release 5058.000 of Oc-tober
2021:
- new Dynamics 365 Business Central 2021 Wave 2 - version 19 (October 2021)
- Dynamics 365 Business Central 2021 Wave 1 - version 18 (April 2021) 

‘Dynamics 365 Business Central 2020 Wave 1 - version 16 (AL)’ is no longer supported with this update
5057.000!
Please update your solution to Business Central 2021 Wave 1 - Version 18 as soon as possible!

q SwissSalary onPrem | Dynamics NAV
SwissSalary Update 5057 is available for Dynamics NAV versions below (onPrem/private cloud):
- Dynamics NAV 2018
- Dynamics NAV 2017

- *Dynamics NAV 2016
- *Dynamics NAV 2015
- *Dynamics NAV 2013 R2
- *Dynamics NAV 2013

*Please note that the support for Dynamics NAV versions 2013, 2013 R2, 2015 and 2016 is expected to be
discontinued as of SwissSalary Update 5059 (April 2022). Please plan today with your Dynamics 365 partner
the upgrade to the latest Business Central version (onPrem/private cloud) or in Microsoft SaaS cloud.

q SwissSalary BAU customers
Customers using SwissSalary BAU solution receive this update for ‘Dynamics 365 Business Central Spring’
19 - Version 14 (C/AL)’ only. Older versions are no longer supported.

q Income Tax, ZIP codes and bank master data, and SwissSalary default permissions (roles)
Please always stay up to date. SwissSalary regularly publishes the latest rates and master data in
SwissSalary Store. This data can be updated via Organization with just one click.

q Role Center
SwissSalary Role Center | RTC clients from NAV 2013 to Business Central Spring’ 19 - Version 14 (C/AL)
Since the introduction of the RTC Client, SwissSalary has been using a clearly arranged and intuitive Role
Center. System Administrator Manual contains important information thereto.We hope you will enjoy the
latest version of SwissSalary and thank you for the valuable improvement suggestions we could implement
for you.

Your SwissSalary Team

1.3.2    SwissSalary Insights

We are very pleased to offer you another great add-on from the SwissSalary family, as it was announced in the
update 5057.000 newsletter on May 6, 2021.
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With SwissSalary Insights you get the best possible overview of movements in your company. You can
evaluate and compare data more easily than ever before. With the web-based solution, you always have an
overview, regardless of whether you are at home, on the go or in the office.

Did we catch your interest? Then please read on here or at swisssalary.ch/insights.

1.3.3    KLE

At the end of April 2021, we were the first payroll manufacturer to receive partial Swissdec certification
(accident) for the new claim notice submission. KLE stands for ‘Customer-integrated Service Process from
Claim to Provision’. It enables quick and easy recording and transmission of incident reports to the insurer,
even if, for example, the course of events and the exact date of the accident are not yet known.

The claims process is designed for accidents, supplementary accidents and illnesses. At the moment the
process runs exclusively with accident insurer Suva, and some SwissSalary customers already submit their
claim reports online. SwissSalary has already implemented all types of reports. However, since no private
insurer has yet implemented the solution, current partial certification for accident reports (without
supplementary accident) remains.

Would you also like to submit your accident claim reports online via SwissSalary? Then please contact your
Dynamics 365 partner.
You need the latest SwissSalary version and SwissSalary Plus license.

For more information, please follow this Link or go to swisssalary.ch/kle.

1.3.4    Income Tax 2021

1.3.4.1    Income Tax 2021 | 2021 Calculation

5056.002

The new fields for the new Income Tax calculation applicable as of January 1, 2021 are provided in Update
5056.000. The new Income Tax calculation was released in hotfix 5056.002 of December 21, 2020. It was
mandatory to import this hotfix before the first pay process in January 2021. Starting from January 1, 2021, the
calculations are to be made based on the new rules, the reporting via ELM shall continue by following the
earlier Swissdec 4.0 rules until Swissdec 5.0 certification (approx. fall/winter 2021). This equally applies to all
payroll accounting solution manufacturers, since the certification test cases will be available only as of
Q2/2021.

Payslip was also delivered again with hotfix 5056.002, since the withholding tax deduction looks slightly
different than before.
Since the calculations are based on provisional calculation examples from Swissdec and withholding tax
offices and feedback from trustees and Swissdec partners, it cannot be ruled out that the calculation will have
to be improved in the months to come.

A small adjustment has also been made to the ‘Income Tax / Canton / Year’ report to correct the display of the
entitlement provision.

5056.004

Over the past two months we have received various reports that one or another feature was not yet working
properly in correction and special calculation cases. We have fixed the aspects below (already delivered in
hotfix 5056.004 of the beginning of March 2021):

- Retroactive Income Tax rate corrections as of January (deduction/credit of discounts applied)

https://swisssalary.ch/en/products/swisssalary-insights
https://swisssalary.ch/en/kle
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- rate determination adjustment if daily allowances with net wage compensation and aperiodic benefit are
processed in a pay process
- Correction of Income Tax-entitlement provision when rate corrections are processed
- Additional pay process for hourly wages: Calculation of the rate-determining income for other occupations
- Correction via additional pay process: Credit cleanup for withholding tax deduction

The aspects below have not yet been automated:
- Median salary
- Retrospective correction of other occupations

NOTE
Aperiodic salary types were defined in update 5056.000 based on the entries from the ‘Extrapolation’ table
(Payroll Setup - IT settings -> Income Tax ribbon -> Projection). If there are assignments in a canton (remove
system filter from ‘Canton’), then you can confidently delete the entries that are no longer needed.

1.3.4.2    Income Tax | Rate-determining income in XML (ELM) always accounted for

Task #10155 | 5057.000

For Income Tax offices to check monthly ELM reports correctly (new 2021 Income Tax reform; however,
reports continue to be submitted via Swissdec 4.0 version), the rate-determining income must always be
reported in XML, even if the Income tax salary base and the rate-determining income are identical.

This rule was already included in hotfix 5056.002 of December 2020 and improved once more in update
5057.000.

1.3.4.3    Payroll Setup | Field 'IT Base one-time payments ST' renamed

Task #10204 | Added to version 5056.000

In the course of the new 2021 Income tax reform, the name for assignment of the salary type ‘IT base one-time
payments ST’ has been changed in the Payroll Setup -> Income Tax tab to

DE = QST Basis aperiodisch LA
FR = GS Salaire IS apériodique
IT = Salario IF aperiodico TS.

1.3.4.4    Payroll Setup | new field 'Actual Working Day abroad ST' created

Task #10205 | Added to version 5056.000

In the course of the new 2021 Income Tax reform, the new field ‘Actual Working Day abroad ST’ was created in
the Payroll Setup -> Income Tax tab. This field is used to record monthly days actually worked abroad for the
calculation of correct Income Tax deduction.

The days worked abroad each month reduce the Income Tax base, but not the rate-determining income. The
calculation is done every month on a 20-working-days base. If an employee subject to Income Tax has worked
abroad for 5 days, the IT salary base is reduced by 25%.

1.3.4.5    Payroll Setup | new field 'Tax at Source Working days CH' created

Task #10206 | Nachtrag zur Version 5056.000
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The new field ‘Workdays in CH’ was created in ‘Payroll Setup -> Income Tax tab’ to record workdays in
Switzerland (usually 20). The correct Income Tax deduction is calculated in conjunction with working days
actually worked abroad.

1.3.4.6    Income Tax | Calculation on minimum deduction

Task #10503 | 5056.004

Around half of the cantons still have a minimum Income Tax deduction. For example, CHF 2.00 or CHF 5.00
are effected if the calculated value is below this minimum deduction. This minimum deduction is controversial
and is also under controversial discussion within the Swissdec Income Tax group.

At the beginning of March 2021, these cantons had to completely revise their rates again in 2021, since some
rates did not correctly reflect minimum deductions. We have adjusted our calculation logic for each calculation
to verify whether minimum deduction was reached or not. This adjustment has already been delivered in
5056.004 hotfix.

1.3.4.7    Income Tax | Rate-determining Income from Hourly Salary

Tasks #10130 + 10131 | Added to version 5056.000 resp. 5056.002

The aim of this change in Income Tax regulations is to make so that rate determination is based on the total
level of employment.

In case of multiple jobs on hourly pay, monthly percents by position with your own employer as well as
percents by position with other employers must be determined. For hourly salary earners, most customers
record, for example, 100% or an average percentage applicable according to the employment contract in the
Percents by position field under the Wages tab. To calculate rate-determining income, workload should be
determined every month based on the hours worked (actual hours). 

Rate-determining income is only converted if employee also works for another employer.

To make the calculation, SwissSalary takes into account average monthly hours (monthly parts) and the
‘actual hours’ worked during the month.

Example:
On average, an employee works 182 hours for employer A. 182 hours are entered in the ‘Salary’ tab under
‘Monthly parts’. In May, the employee works 35 hours for CHF 25.00/hour. For employer B, the employee
works for 30% of working time.

To determine the workload in May, the calculation is as follows:

100 / monthly parts x actual hours
= 100 / 182 x 35 = 19.23%

The total workload is 49.23% for May (employer A = 19.23% + employer B = 30%).

The income earned from employer A is now converted into total workload for rate-determining income:

actual time worked for employer A x hourly rate / percents by position with employer A x total workload
= 35h x CHF 25.00 = CHF 875 / 19.23% x 49.23% = CHF 2'240.05

The rate is searched for in the rates table based on the rate-determining income of CHF 2'240.05. Income Tax
deduction of CHF 875.00 is then made from the wage subject to Income Tax using the calculated percentage.
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NOTES
- Make sure that your salary types (reported number of hours and absences) are always set up correctly with
assignment to correct time type and ‘actual time’ balancing.
- Employees are obliged to quickly report changes in workload with other employers to their main employer so
that correct extrapolation can be made.
- If the workload or workloads with another employer or other employers are unknown and cannot be
determined, just check the ‘Other known income sources’ box.

IMPORTANT: In this case, the rate-determining income is ALWAYS extrapolated to a workload of 100%,
which in most cases is not in employee’s interests.
- Workloads or percents by position determined this way have nothing to do with the indication of part-time
employment in a regular wage statement. The percentage recorded in the Personnel card will be shown on the
wage statement as of December 31 or taken into account as of the date of resignation.

1.3.4.8    Additional Pay Processes without entitlement to Income Tax | No Income Tax recalculation

Task #10494 | 5056.004

If, for example, only expenses or time that is not subject to Income Tax are accounted for in an additional pay
process regarding an employee subject to Income Tax, a recalculation of withholding tax (plus/minus) was
done anyway. It is not a technical or computational problem, but it leads to a lack of understanding among
many customers and employees and to many queries from our support team. We have made adjustments so
that retroactive accounting is no longer carried out for additional pay processes, provided that no wage types
subject to withholding tax are affected. The adjustment has already been delivered with 5056.004 hotfix.

1.3.4.9    Income Tax | Annual model | multiple cerdits if the new deduction is CHF 0

Task #10574 | 5057.000

Several customers have reported that a refund also occurs in subsequent months in the annual billing model if
the Income tax deduction is CHF 0.00.

With the annual model a rate-determining income recalculation always takes place retrospectively as of
January 1 of the current year or as of recruitment date during the year. The newly calculated amount is
deducted and the amount is credited from the previous month. The difference shows the actual deduction. If a
smoothing calculation now falls under the first rate level, no Income Tax is correctly deducted and the amount
is credited once from the previous month. Unfortunately, this credit also occurred repeatedly in subsequent
months.

We analyzed this case in detail and solved it. Multiple credits no longer occur.

1.3.5    Employee

1.3.5.1    ZIP Tax Community | Validation after the Place of work was recorded

Task #10545 | 5057.000

Only ‘Swiss’ postal codes/locations may be entered in the ‘ZIP Tax Community’ fields. This means that
workplace (CH address) must be entered under ZIP Tax Community, for example, for cross-border workers
subject to income tax and those who have a foreign address. Up until now, it could be entered incorrectly
because the workplace is only assigned to Job after the input of postal code/city of municipality.

We have improved the validation so that when the Place of work is entered, the content of ‘ZIP Tax Community’
is checked again. This data can be automatically and correctly adjusted with a security prompt. Incorrectly
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stored postal codes/cities of municipalities lead to error messages when withholding tax is reported in ELM at
the latest.

1.3.5.2    Children | show fields 'Name' and 'Gender' by default

Task #10544 | 5057.000

The two fields ‘Name’ and ‘Gender’ of child are now always shown by default.

1.3.5.3    Blocked Employees | new Notification

Task #10383 | 5057.000

This task  was only implemented for SwissSalary NSP customers (public municipalities and cantons)!

If an employee is blocked in the Employee card (box ‘Blocked’ in Job), the user should be informed with a
corresponding message when there are changes in the Employee card.

1.3.5.4    Control of social security benefits | Maximum number of social insurers increased from 32 to
50

Task #10543 | 5057.000

The ‘Control of social security benefits' matrix can display up to 32 social and private insurers. The evaluation
is used to control the assignments of insurance companies to employees. This option has now been expanded
to include up to 50 insurers.

1.3.5.5    Employee dosssier | new 'Replace file' feature

Task #10530 | 5057.000

No document can be replaced in the Personnel file. The only option so far was to import a new document and
delete the old document. 

The new ‘Replace’ feature has been developed and is available for an existing document replacement.

1.3.5.6    Employee statistics | new columns updated at, updated by

Task #10073 | 5057.000

You can add two new columns in ‘Personnel statistics’:

- Updated at
- Updated by

You can check this way who made the last update. These two columns are hidden by default.

1.3.5.7    Employee statistics | new columns Date and Valid until

Task #10324 | 5057.000

To be able to use Employee statistics even better, they need additional columns. There are two new columns:
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- Date (can be used for an activation date or for ‘Assignment as of’)
- Valid until (for example, can be used for ID cards with an expiry date)

The ‘Date’ column is permanently displayed, the ‘Valid until’ column can be added and used if required via
‘Personalize -> Field’. The ‘Statistics’ infobox has also been expanded to include these two columns.

1.3.5.8    Personnel dimension | new columns Updated at, Updated by

Task #10074 | 5057.000

You can add two new columns in ‘Personnel dimension’:

- Updated at
- Updated by

You can check this way who made the last update. These two columns are hidden by default.

1.3.5.9    Human Resources (PIS)

1.3.5.9.1    Career | Clear the restricted Payroll area filter

Task #8984 | 5057.000

This adjustment affects our SwissSalary BAU customers only.

Users with restricted permissions in payroll areas could not clear the filters set by the system in the Career
table. An error message with a reference to the restricted permissions was displayed. The objects have now
been adjusted so that these users can see data records they are allowed to edit.

1.3.6    Salary Types

1.3.6.1    Factor Field | Decimal value extended from 5 to 6 digts

Task #10378 | 5057.000

The maximum decimal value in the ‘Factor’ field has now been extended to 6 digits (was 5 before).

1.3.6.2    Following Salary Type | Limit amount calculation field renamed

Task #10400 | 5057.000

The existing ‘Limit amount calculation’ field in the ‘Resulting salary’ table has been renamed to ‘Limit
calculation’, since it does not only contain option values for amounts, but also for a number.

1.3.7    Payroll

1.3.7.1    Salary entry | New field 'Actual time' for calculations

Task #10548 | 5057.000

We do not have information on the actual time per month and employee for calculations in KLE, Easy-Rapport
and also 2021 Withholding tax sections. We have decided to expand the wage items with the new ‘Actual
time’ field. The value of the Number field of Wage types that are assigned to ‘Actual time’ in time types, is now
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added to wage items. This means that important extrapolations for hourly wage earn-ers can be made, for
example, for 2021 withholding tax.

IMPORTANT INFORMATION
During the update process, this data is rewritten for all previous pay processes or wage items. For larger
companies with several clients and many pay processes, the update can take up to an hour or even long-er.
For small and medium-sized companies, the process takes a little longer than usual. Please note that you
should carry out the update at off-peak time! Please do not interrupt this update process!

1.3.7.2    Payroll | New integrity check for successive recruitments/resignations

Task #10028 | 5056.002

A preliminary check of the successive recruitment’s and resignations will now also be taken into account
during wage accounting. There are always cases where a re-recruitment date is set for an employee with-out
the resignation date being set beforehand.

You can eliminate this error yourself by analyzing the recruitment/resignation data in pay process list and
setting the correct data in the corresponding pay process. It is important that you first delete the date of
resignation in the Personnel card and only then start processing it in the pay process. When the changes are
made, you can enter the current date of resignation again.

NOTES
Please note that you should always enter all known resignation data before wage accounting and not set it
later (after the pay process). Incorrectly set resignation dates affect the correct wage calculation (particularly
for resignations during the month: incorrect withholding tax extrapolation, incorrect maximum limits
consideration, etc.). In case of re-recruitment at the company, please remove the date of resignation first and
then set the new re-recruitment date via ‘Recruitment date payroll accounting’. If the date of resignation was
incorrectly taken into account in the pay process list, you can also correct it directly in the pay process list.

1.3.7.3    Consideration of future TimeMachine entries when converting hours into days

Task #10395 | 5056.003

Absences are usually recorded in hours and can also be converted to days via parametrization on wage type.
This way, absences can be evaluated, on the one hand, in hours and, on the other hand, in days.

If workload has to be changed for an employee in the future and it has already been recorded in TimeMachine,
it was not taken into account in future data collections and the current workload was taken into account. This
has been adjusted and improved. This adjustment has already been delivered to our customers with 5056.003
hotfix.

1.3.7.4    Payslip | Show month-shifted time posting in monthly reporting

Task #9978 | 5057.000

‘Monthly reporting’ (movements of the time in the month) and ‘Balancing’ can be displayed on the payslip at
the end of the document. Monthly reporting display is managed in time types and that of balancing in payroll
area.

Monthly reporting display is always related to payroll period. This means that if, for example, holidays were
recorded on a day in May 2021, this movement will be shown on the payslip of May 2021. However, some
customers work with month-shifted period for time recording. If no down-payment payroll process is created
(recommended when time postings used and integrated), holiday pays starting from the end of May 2021
(document date is decisive) will not appear in the payslip of May 2021, since it will be created on May 20,
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2021. This means that these holiday pays will neither be shown on the payslip of May 2021 nor on the June
statement.

There is the ‘Period Start Day’ field in payroll area under the ‘Installments’ tab.

Example:
The definitive pay process is created on the 20th of the month. Hourly bookings from the 18th of the previous
month to the 17th of the current month are taken into account from time recording. Please set the ‘Period start
day’ to ‘18’. Only time postings with the document date of 18th of the previous month to the 17th of the current
month are taken into account during wage accounting.

If the movements of the whole previous month are to be taken into account, set the value to ‘1’.

Customers that create a down-payment and a definitive pay process do not have to take these settings into
account, since time recording and wage period always match 1:1.

1.3.8    Administration

1.3.8.1    SwissSalary video tutorials integrated in the Role center starting from Dynamics NAV 2017

Task #10566 | 5057.000

Starting from Dynamics NAV 2017, it is possible to provide videos directly in the Role center. In the future, we
want to regularly publish video tutorials on important processes. There is currently a video showing the update
process of SwissSalary 365 in the SaaS environment and how to update the SwissSalary store.

Have you already seen the first video? The video can also be found on our YouTube channel or via this Link.

1.3.8.2    Organization | Create demo base Data

Task #10265 | 5057.000

This task  affects SwissSalary onPrem and our SwissSalary 365 SaaS cloud customers (currently no support
for SwissSalary BAU and SwissSalary NSP).

There is a new ‘Create demo master data’ feature in ‘Organization’. It is primarily intended for our partners for
provision of demo environment as quickly as possible.

IMPORTANT:
This feature can only be used if there is no setup data in other modules either. If this feature is used, all
existing SwissSalary settings and some settings in other modules (Financial accounting, Projects, etc.) are
deleted beforehand. That is why SwissSalary checks whether setup data is already available. If this is the
case, an error message appears and processing is aborted. This way we ensure that the function is not
accidentally executed in a ‘wrong client’. If there are customer-specific developments with access to
SwissSalary standard objects, these individual functions are not taken into account.

In addition to regular initialization data (payroll master data, wage types, time types, etc.), the data and
settings below are now created as well:
· 10 employees in Personnel master data including social security, personnel dimensions, payment details,

children and wages
· Two items of personnel statistics including employee assignments
· (Note: The selection options for the ‘Landolt & Mächler wage comparison’ personnel statistics can change

from year to year)
· Budget settings

https://www.youtube.com/watch?v=Le5o_pxsh6w
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· Budget structures including rows
· Budget column layout including rows
· VACANCIES number series including the rows for vacancies in the budget module
· Settings of the TIME open interface
· TIME-ARCH number series including rows for saving the file imported from the TIME open inter-face
· TIME-IMPORT report journal including the connection to the TIME open interface
· TIME-IMP booking trace code including assignment in the TIME-IMPORT report journal
· Other modules
o e.g., financial chart of accounts
o e.g., fiscal periods
o e.g., a demo debtor is created for the project
o e.g., dimensions and dimension values
o e.g., a demo project including a task
o e.g., VAT posting categories

NOTE:
As usual, you can import withholding tax rates separately (also via Organization).

1.3.8.3    Organization | only display the number in the first line in the 'History' field

Task #10394 | 5057.000

The number of already imported SwissSalary updates is displayed in the ‘History’ field of Organization. Details
appear when a number is clicked. This display relates exclusively to SwissSalary updates and not to the other
store items. Therefore, the number is now only displayed in the ‘SwissSalary NAV’ line.

TIP
Would you like to know which withholding tax file you have already imported?
Position the cursor on the ‘Swiss withholding tax rate’ line and press the keyboard shortcut ‘CTRL+ALT+F1’.
‘Page review’ (known as ‘Zoom’ in older versions) will open. You can see the date and time of items available in
SwissSalary Store in the ‘Item data and time (Store)’ fields. Below you will see the ‘Item date and time (Client)’
field. It shows your installed value. As long as the status in Organization is ‘up-to-date’, this data is always
identical. If, for example, withholding tax rates for Switzerland are ‘out of date’, you can check the version
currently installed and the one available in SwissSalary Store.

We recommend that you check the store regularly and keep all values “up-to-date”. Over the past few months
alone, withholding tax rates have been re-delivered five times by the Federal Tax Administration.

1.3.8.4    Payroll Setup | Enter SUVA customer number more easily

Task #10244 | 5057.000

SUVA customer number consists of two parts:

- Customer number, e.g., 302-12345.0
- Sub-number, e.g., 01

Up to now, the customer number + sub-number had to be entered in the ‘Customer number’ field as fol-lows:

customer number + space + sub-number + Enter

After pressing ‘Enter’, the sub-number was automatically moved to the Contract number column.

Customer number in the Customer number field and sub-number in the Contract number field can now be
entered separately or as by the previous rule.
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NOTE
Private accident insurers are not familiar with this topic, since they always have a customer number and a
contract number.

1.3.8.5    Payroll Setup | Swissdec 5.0 | Switcher built in

Task #9915 | 5057.000

We have been working continuously on Swissdec 5.0 implementation since spring 2020. After the new certified
version has been delivered, it may be necessary to carry out various processes with version 4.0 and some
others with version 5.0. For this purpose, a switch was built into the Payroll master data in Swissdec settings
to be able to split up the versions and also the processes in the background. For the time being, we will only
work with version 4.0.

You will regularly receive more information about Swissdec 5.0 in our news in the SwissSalary Role center or
for our partners in the Yammer channel.

1.3.8.6    Payroll Setup | Error Message for missing salary types

Task #9804 | 5057.000

After a new social or private insurance is implemented in the Payroll Setup, not all salary types are recorded
correctly from time to time. The following note appears during wage accounting: ‘Not all salary types have been
defined in Payroll Setup (Salary ST)’. 

These notes and error messages have now been implemented in a more ‘meaningful’ way for all social and
private insurers so that the missing salary types can be found quickly.

1.3.8.7    SmartPort | Import of Employees photos

Task #10213 | 5056.001

Data from third-party systems (e.g., external HR solution) or data from SwissSalary Direct are imported into
SwissSalary via SmartPort in a standardized and validated form. Image files can now also be imported and
then displayed in Employee photo of the personnel card and in Human resources (PIS).

1.3.8.8    SmartPort | new 'EasyRapport Employee Visa' field

Task #10524 | 5057.000

SmartPort has been expanded with the new ‘EasyRapport employee visa’ field.

1.3.8.9    ARGE Settlement | new 'non-billable' optioner settlement group

Task #10485 | 5057.000

This improvement concerns our SwissSalary BAU partners exclusively!

There is a new ‘non-billable’ option in ARGE settlement. This means that individual groups (e.g., site
managers) can be defined as ‘non-billable’. When a pay process is settled, this property is transferred to
‘ARGE items’. In turn, the report filters out these items. 
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1.3.9    Reports and Interfaces

1.3.9.1    Payslip | Display of the 13th and 14the salary

Task #10559 | 5057.000

In individual cases, the base for the 13th and 14th salary was incorrectly displayed on the payslip if the
payment was not made once or regularly. We have improved this display so that the correct numbers are
always displayed for the base.

1.3.9.2    ISAB Interface | now available for all versions starting from Dynamics NAV 2017

Task #10591 | 5057.000

We have developed an interface to ISAB (Construction Alliance Information System) for our SwissSalary BAU
customers. At first, they were just company-specific developments. We now provide a standard interface to all
customers.

You can open the interface via ‘General reports’ and the report with the ID ‘3009247 SwS Interface ISAB’.

1. First log into the ISAB portal with your login data and create an Excel file for bulk import. You can find a
corresponding video tutorial at https://isab-siac.ch/support/.

2. Then import this Excel into our report and fill in other data.
3. SwissSalary creates an Excel that you can then upload to ISAB again.

Are you interested?
Then please read more on this topic in the manual for update 5056.000.

1.3.9.3    Payment Order | now Payment order (summarized)

Tasks #10332 und 10385 | 5056.002

‘DTA payment order’ or the reference to it was hidden with update 5056.000. However, this report is still used
by numerous customers, if it is not for the actual purpose of the DTA. Reasons behind this are, for example,
controls, payments/information for corporations, information requirements to foreign companies, etc.

‘DTA payment order’ is back with hotfix 5056.002 and has the new name ‘Payment order (summarized)’. The
old ‘Payment order’ is now called ‘Payment order (detailed)’.

By mistake, the request page was only displayed in English. This was also corrected in hotfix 5056.002.

1.3.9.4    Logib | Salary Type filter extended to 1024 characters

Task #10150 | 5057.000

Several salary types can be filtered in fields ‘Base salary types’, ‘Allowance wage types’ and ‘Special bonus
ST’ in the Logib Evaluation selection window. The filter has been extended to the maximum number of 1024
characters, since some companies need to select a large number of wage types.

1.3.9.5    Logib | Employee N° with  spacesare adjusted during export

Task #10221 | 5057.000

https://isab-siac.ch/support/
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When the Excel file is created, the ‘Serial number’ column with ‘Client name’ and ‘Employee number’ is
automatically generated by SwissSalary as follows: ClientName_personnelNumber.

This format is not accepted and shown as invalid if the Employee number as a space. The personnel number
can also be alphanumeric, but cannot contain any spaces. The export has been adjusted so that ‘incorrect’
Employee numbers are corrected during export.

1.3.9.6    Salary comparison Landolt & Mächler | new template for equal pay validation

Task #10444 | 5057.000

The ‘Landolt & Mächler salary comparison’ interface can now also be used to export the information required
for ‘equal pay’ (male/female). The new interface is called ‘Wage comparison - Landolt & Mächler equal pay’.
Columns A-J in the exported file are only needed for ‘wage comparison’. The newly exported columns A-L are
required for ‘equal pay’. It should be noted that all columns are always exported. The ‘F’ column in the
exported file is calculated identically both for ‘Salary comparison’ and ‘Equal pay’.

1.3.9.7    SAP Business One FIBU Interface | Cost Center taken into account

5056.004

If used, SAP Business One Fibu interface is now filled with a cost center or split.

1.3.9.8    Modern Client | Landscape address list without sort fonction

Task #10101 | 5057.000

Sort function was no longer available in the report ‘Landscape address list’ in ‘Modern client’ (web client). It
was incorporated similar to the role-based client (RTC).

1.3.9.9    Modern Client | Salary certificate and other reports can be sorted again

Task #10298 | 5056.003

It was no longer possible to sort documents in the Modern client (web client). We have incorporated this option
again in the reports below, similar to the payslip:

- Salary certificate
- Employee Salary Statement A4P and A4L
- Difference list

1.3.9.10    Business Central 17 | Reports via previewdo not work correctly

Tasks #10273, 10450 and 10465 | 5056.001, 5056.004 and 5057.000

In its major release of October 2020 (Business Central version 17), Microsoft changed the report preparation
logic. It also impacted our SwissSalary reports. Customers have notified us that despite entering a date from
the previous year, the billing for the current year was always processed.

The most important reports have been corrected and redelivered in hotfix 5056.001. In the meantime, we have
revised all SwissSalary reports and they are now delivered with version 5057.000.
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1.3.10    SwissSalary Direct

1.3.10.1    Payslip | QR Code for first login

Task #10513 | 5057.000

To make onboarding for SwissSalary Direct easier for employees, the payslip will have a QR code. This code
can be photographed using mobile phone. The correct registration URL opens automatically. As soon as the
employee is registered and SwissSalary is synchronized with SwissSalary Direct, the QR and registration
code disappear from the payslip.

You can find video instructions for employees on our YouTube channel or directly by following this Link.
Provide this video to your employees to simplify registration and minimize queries to the HR department.

1.3.10.2    Synchronization of resigned employees durong SwisssSalary Direct Setup

Task #9342 | 5056.004

When SwissSalary Direct is set up for the first time, only currently active employees are synchronized
between SwissSalary and SwissSalary Direct. It has occasionally caused problems in the past if payslips
and/or wage statements for employees that had previously resigned needed to be uploaded. With a
workaround, the setup date had to be changed manually.

All employees active as of the setup date as well as all employees who have already resigned by January 1 of
the previous year are synchronized.

1.3.10.3    File ZIP archive import | Filter 'registered employees only' does not apply

Task #9737 | 5057.000

Using the ‘File ZIP archive import’ feature, all ZIP archives can be imported directly into the personnel file and
then transferred directly to SwissSalary Direct (only PDF files). This function is suitable, e.g., for mass upload
of personalized documents like company-specific hour card. A prerequisite for this is that personnel number
with an ‘underline’ goes first in the file name.

Example:
sending of the hour card for employee 1001 of August 2021.

File:
1001_Stundenkarte 2021-08.pdf

Using SwissSalary Direct settings, ‘Send documents to’ option can be used to choose whether documents
should always be sent to ‘All employees’ or to ‘Registered employees’ only (SwissSalary Direct). We have
improved the filter for the ‘registered employees’ option.

1.3.10.4    No E-Mail notification are sent per document type

Task #9553 | 5057.000

Email notification to employees can generally be switched off in SwissSalary Direct settings (field ‘No email
notification’). This is useful, for example, when several documents are sent one after the other, but the
employee is only notified once by email.

https://youtu.be/yVR73MT0L4M
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We have now created the possibility to control this for each document type with document types ‘Payslip’,
‘Wage statement’ and ‘Report card’ for File ZIP archive import as well as for sending of documents in general.
In addition to the existing options ‘Direct delivery’, ‘Directly visible from’, you will now also find another option
‘No direct email notification’. If this option is switched off, employees will be informed via email as before.

1.3.10.5    Synchronization support for spanish and portuguese

Task #10581 | 5057.000

With the synchronization, both ‘Spanish’ and ‘Portuguese’ were reset to ‘German’. This means that the
employee then had to switch the language in SwissSalary Direct to their own language every time. We now
also correctly support these two languages when the systems are synchronized.

1.3.10.6    Salary certificate | Check the 'Gross Salary to Recompute' box when sending to Direct

Task #10411 | 5056.003

The ‘Subject to tax’ box on the salary type defines whether the amounts of this salary type are included in the
gross salary (section 8) of the Salary certificate or not. The taxable salary total is also recorded for each pay
process in fictitious salary type in wage items.

In individual cases, salary types are not set up correctly with regard to this obligation. If this box is checked
again or even removed during the year, wage items already posted remain unchanged. This is also the base for
creating wage statement. There is currently the option of overriding this calculation using the ‘Gross Salary to
Recompute’ box on the salary statement. This means that the current box ‘Subject to tax’ is taken into
account for the preparation of the wage statement, and not wage items written at the time.

When sending the wage statement to SwissSalary Direct, it was found that this box was not taken into
account. This was corrected in hotfix 5056.003.

Note
The customer is responsible for data quality and salary types settings. Our partners and consultants will gladly
support you in this process.

1.3.11    SwissSalary EasyRapport

1.3.11.1    EasyRapport Setup per client (no longer cross-client)

Task #10377 | 5057.000

EasyRapport settings have been completely renewed. On the one hand, all fields that can also be man-aged
via admin access in EasyRapport have been removed from SwissSalary. The biggest innovation is that the
settings are now created for each client and they are no longer cross-client. This way we respond to a major
request by partners and customers. We have more and more larger companies with a wide variety of clients
and therefore different needs. In addition, we have more and more trustees who offer EasyRapport to their
customers. That is why cross-client settings reached their limits (e.g., when reporting on different dimensions
for each client, etc.).

From update 5057.000 onwards, EasyRapport settings appear massively purified and EasyRapport trans-fer is
now carried out per client.

Existing customers do not need to adjust their settings. However, there is now the option of setting up various
EasyRapport instances, if desired.
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1.3.11.2    EasyRapport Setup | WebService path remains empty

Task #9611 | 5057.000

Among other things, web service path is set up in EasyRapport settings. It remained empty during
EasyRapport Setup. The process has been adjusted so that every time EasyRapport settings are opened, it is
checked whether this path exists. If not, it will be filled in automatically.

1.3.11.3    Setup | 'Employee info with parked lines to' field removed

Task #10152 | 5057.000

We constantly work not only to further develop our solutions, but also to remove old fields and old code from
the existing solutions. ‘Employee info with parked lines to’ field was removed from EasyRapport settings

1.3.11.4    EasyRapport Groups | Card and Report Types pooled together

Task #10310 | 5057.000

You can get to the EasyRapport groups setup via ‘EasyRapport/TapBoard -> Groups’. Up until now, the card
with other settings and report types had to be opened separately in the ribbon. We have pooled them together
now. 

With ‘Manage’ and ‘Edit’ or ‘View’ you can now go directly to the card AND the report types. This way,
individual EasyRapport groups can be revised more efficiently and concisely.

1.3.11.5    Report Types | Field 'Description' must be mandatory

Task #10492 | 5057.000

If the text in the ‘Name’ field is missing in the report types, the corresponding lines are hidden in Easy-Rapport
and cannot be displayed. The ‘Name’ field must always be filled in now.

1.3.11.6    Management Rapport Journal | Transfer Journal | Delete duplicate UniqueRecordID

Task #10021 | 5057.000

When data is recorded in EasyRapport, a socalled ‘UniqueRecordID’ is assigned to each data record. This
means that we can always identify a data record, even if this entry is later corrected or endorsed by the
manager.

It is important that the recording period in EasyRapport is correctly closed prior to starting wage processing.
This is achieved by setting the correct ‘Postings admitted from/to’ (please make sure to make an EasyRapport
transfer after setting the data). After that, the period in EasyRapport is correctly closed and neither employees
nor his/her superiors can change this data.

If this recording period is not closed correctly, employees can still make adjustments to data records in
EasyRapport that have already been used in a pay process. This means that these data records are later
transferred back to SwissSalary. When EasyRapport data is imported into the Report journal, the mes-sage
appears that this import is impossible because there are still UniqueRecordIDs data records that have already
been booked. These cases almost always reach our support and are time-consuming to resolve.

We have now simplified the display and deletion of new incorrect, duplicate lines with a push of a button. This
way customers can eliminate these duplicate sentences themselves.



Seite 55

We recommend checking data records in each case and manually taking into account any newly recorded
reports.

1.3.12    Bug fixes

1.3.12.1    Employee Card | TimeMachine | Correct consideration of ZIP Tax Community

Task #10512 | 5057.000

If a new postal code or location is entered in TimeMachine for an employee and there are several locations for
the same postal code, then the place stored in the table as the first place in the table was always taken over
at the time of transfer activation. The error has been corrected.

1.3.12.2    Employee photos import | Checking whether data record already exists

Task #10233 | 5057.000

We have implemented a feature for SwissSalary to check whether the image already exists (also with the
‘Migrate pictures’ feature). There were problems in a few cases when a photo was imported from an already
existing data record.

1.3.12.3    Notification | Notice improved if the child's date of birth is not filled in

Task #10220 | 5057.000

Notifications (notices of data acquisition) have been improved and made more meaningful. E.g., when recording
a child without entering the date of birth.

1.3.12.4    Payroll | Income Tax deduction when using net salary compensation

5056.001

A bug crept in update 5056.000. If an employee received a net salary compensation in a pay process due to
daily allowance correction, no Income Tax was deducted for employees liable to pay Income Tax. This was
corrected.

1.3.12.5    Modern Client | Bank details cannot be entered via notification

Task #10305 | 5057.000

see also Task #10327

It is checked when a personnel card is entered as well as during wage accounting whether employee has a
personnel bank. If no data record is available, a notification is displayed (Please enter an employee’s bank -
Open the context-related record here).

This link will take you to the personnel bank. It disappears upon IBAN address input. This bug has been fixed.

1.3.12.6    Modern Client | Personnel dimensioncannot be entered via notification link

Tasks #10327 und 10456 | 5057.000
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see also Task #10305

It is checked when a personnel card is entered as well as during wage accounting whether employee has a
personnel dimension (provided that it was defined as a ‘mandatory dimension’ in payroll master data). If no
data record is available, a notification is displayed (Please enter the required dimension ‘COST CENTER’ for
personnel number ‘xxx’ - Open the context-related record here).

With this link, you are taken now to the personnel dimension directly.

1.3.12.7    Payroll Setup | Tab Gross for Net | Gross for  net offsetting with NBUV

Task #10392 | 5056.004

In a very rare configuration, the NBUV employer’s wage total was not correctly taken into account in a ‘Gross
for net’ offsetting. This bug was analyzed and fixed.

1.3.12.8    FIBU Interfaces | Blob error messagif the amount is zeo

Task #10461 | 5057.000

Do you work with a default Fibu interface activated in ‘Payroll Setup -> tab Setup -> field Interface’? If so, an
error message ‘Blob must contain a value in ‘Blob items’...’ was displayed if an additional pay process was to
be posted that should not write any amounts into financial accounting (correction pay processes only with
number and without amounts, e.g., time postings). The error has been corrected.

1.3.12.9    Open data import interface | Row skipping

Task #10462 | 5057.000

If several data mappings are entered in the settings row, e.g., personnel and salary type number and a ‘skip’ is
entered for the personnel number, then the salary type mapping is canceled because of this ‘skip’. The error
has been corrected.

1.3.12.10    SmartPort | Dimensions are imported incorrectly

Task #10283 | 5056.001

If dimension values are transmitted via SmartPort, dimensions are always recorded as new, i.e. not recognized
as a change and a new dimension is created therefore, even if the same values are acquired via SmartPort for
the second time. This bug has been fixed.

1.3.12.11    The fields of totals in TapBoard and in evaluations revised

Task #10344 | 5056.004

Some customers have reported to us that the fields of totals in the report card and in TapBoard are no longer
displayed correctly after update 5056.000 (not at all or even twice). This bug has already been fixed with hotfix
5056.004 and the fix is now included in update 5057.000.

1.3.12.12    Payslip | Income Tax rate code is no longer printed at deduction

Task #10466 | 5056.003

This report concerns SwissSalary BAU customers exclusively!
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Some customers have reported that in individual cases the three-digit Income Tax rate code was no longer
pulled in Business Central v14. This bug has been fixed and the fix was already delivered with hotfix 5056.003.

1.3.12.13    ELM | Income Tax reporting | Adjust error message

Task #10475 | 5056.004

An illegible error message briefly appeared during withholding tax reporting via ELM if the place of work
(canton) was not recorded for the partner. The error message was corrected to make it legible and this fix was
already delivered with hotfix 5056.004.

1.3.12.14    ELM | Salary certificate | section 3 | Text overflow when 2D Barcode is generated

Task #10483 | 5057.000

If many wage types are assigned to Wage statement Section 3 and employees use many different salary
types with this assignment over the year, then a text overflow would occur in rare cases when 2D barcode is
written. The field was expanded accordingly and the task completed this way.

1.3.12.15    Salary certificate | Placeholders do not work when PDFs ar sent

Task #10474 | 5057.000

When wage statements are sent in an unencrypted form via PDF, placeholders (e.g., salutation) no longer
worked. However, when payslips are sent via PDF, placeholders do work. This bug was analyzed and fixed.

1.3.12.16    Payroll Journal | Error when processing after client change

Task #10471 | 5056.004

see also tasks #10359 and #10587

Pay process filter had not been cleared in Payroll journal when client was subsequently changed. This bug has
been fixed and the fix was already delivered with hotfix 5056.004.

1.3.12.17    Payment orders | Bank filter is not cleared when client is changed

Task #10359 | 5056.003

see also tasks #10471 and #10587

Bank filter had not been cleared in Payment orders when client was subsequently changed.

Example:
If the report was initiated in client ‘A’, e.g., with ‘UBS’ bank and then the client was set to ‘B’, ‘UBS’ bank was
still available for selection, although it did not exist in client ‘B’. This bug was fixed in hotfix 5056.003 and the
fix is therefore also published in update 5057.000.

1.3.12.18    General Ledger Log | Pay Process filter is not cleared when client is changed

Task #10587 | 5057.000

see also tasks Tasks #10471 and #10359
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Pay process filter had not been cleared in General Ledger Log when client was subsequently changed. The
error has been corrected.

1.3.12.19    FIBU Import interface for old NAV versions | Dimension 2 validation

Task #10507 | 5057.000

When SwissSalary default FIBU import journal (report 3009271) is used in ‘old’ Dynamics NAV versions
(SwissSalary is used in the cloud or in another database), there was an error if the file did not include a value
of ‘Dimension 2’. The preset Dimension 2 (default value) on the Fibu account was deleted or, if there is a value
in the FIBU import journal, was overwritten with it. Both situations are incorrect.

FIBU import interface has been corrected accordingly.

1.3.12.20    Payroll Holding | Different values depending on the filter

Task #10091 | 5057.000

A customer informed that holiday payment credit is not displayed in Payroll holding. The error has been
corrected.

1.3.12.21    Attestation of Employer ALV | Section 10.2 was adapted

Task #10484 | 5057.000

When employment relationship is terminated, it can be selected in Section 10.2 whether the termination was
verbal or in writing. This field can also be left blank if it is unknown. In spite of this, the word ‘verbally’ was
printed on the ALV employer certificate by mistake, even if it was ‘empty’. The error has been corrected.

1.3.12.22    Anniversary List | Request Page and Report in the Web client were adapted

Task #10180 | 5056.001

The request page in the web client has been completely revised for the selection options to be operated
normally again. In addition, the output was slightly revised and the report was generally adapted to the new
regime starting from Business Central 17.

1.3.12.23    UKA Import Interface 8.9 | Wrong import formats

Task #10307 | 5056.001

Customers have reported to us that the UKA import interface was causing an error. After our review, we found
that the data in the file sent was created with 6 digits and leading zeros. Customer files had to be temporarily
revised manually by our support so that they could be imported.

We have revised the import interface and redelivered it with hotfix 5056.001.

1.3.12.24    SBV quarterly survey | Company name variable too short

Task #10445 | 5057.000
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‘SBV quarterly survey’ report has been slightly revised. The variable for transferring company name to the
report was too short. This was adjusted.

1.3.12.25    Writing Base Salary | Correction for new base salary writing

Task #10174 | 5057.000

The ‘Write base wage’ feature has been improved.

1.3.12.26    Employee File | 'Date created' is not written

Task #10573 | 5057.000

When payslips, wage statements, etc. are uploaded to the personnel file and then directly to SwissSalary
Direct, the date was not written in the ‘Date created’ field. The error has been corrected.

1.3.12.27    System initializationfile | Export/Import feature as XML now

5056.001

With Update 5056.000 we have completely rebuilt the system initialization files from text to XML files. File
content has also been adjusted.
When social insurance was written for each employee, employee numbers were also transferred from one
client to another. In addition, ‘time’ requirements ‘00:00:00’ for resulting salary types are not written anymore.
This bug has been fixed.

1.3.13    Technical Partner and Customer information

1.3.13.1    Employee History | Changelog modified

Task #10556 | 5057.000

Up until now, if employee was changed, a data record with the current date/time and the name of the user who
made the current change was recorded in the change log table. But with ‘BEFORE the current change’ status.
This means that during changelog table interpretation the date/user/time of the previous record always
matched the data. History report and various interfaces were implemented to take this into account.

However, this repeatedly led to errors in new implementations and existing codes maintenance or during data
import via e.g., RapidStart.
 
The most recent employee’s data record in the changelog table should always be a copy of the currently valid
data record.

IMPORTANT INFORMATION
This data is rewritten during the update process for all history entries. For larger companies, the update can
take up to an hour or even longer. For small and medium-sized companies, the process takes a little longer
than usual. Please note that you should carry out the update at off-peak time! Please do not interrupt
this update process!

1.3.13.2    Personnel banks via RapidStart | Position cannot be 0

Task #10276 | 5057.000
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A position number is recorded during personnel banks import via RapidStart (configuration packages). When a
personnel bank is entered manually, it starts with number 1. If this number was not defined using ‘1’ in
RapidStart Excel, position number ‘0’ was read in. This led to error messages during wage accounting.

This task has been corrected and the position number is always imported with ‘1’. If this number already
exists, the existing number is continued with +1.

1.3.13.3    Organization | Hide 'Generate missing Payroll Setup'

Task #10518 | 5057.000

There is menu item ‘Generate missing Payroll Setup’ in Organization. This function can be used for new or still
empty clients, for example, to create missing Fibu accounts for the area of wages. Default payroll master data,
default wage types, etc. are also generated.

Unfortunately, a few customers pressed this button in productive instances. This button has now been
removed, but it can be displayed again at any time for specific users via ‘Personalize’.

1.3.13.4    Data Migration | Image export and import implemented

Task #10408 | 5056.003

Old Dynamics NAV versions up to and including Dynamics NAV 2016 saved images in the form of a ‘blob’ in
‘5200 Employee’ table. Starting from Dynamics NAV 2017, images have been saved in ‘Media’ format. Since
the old ‘Blob’ field disappears with the release of Business Central 2021, Wave 1 (BC18), a solution is needed
to migrate images retrospectively, e.g., if a customer wants to upgrade directly from Dynamics NAV 2013 to
Business Central 18.

There is already a workaround today
Upgrade to Business Central 14, migrate the images there and then upgrade to Business Central version 18.

In Dynamics NAV 2013 - 2016, you can export images directly via ‘SwissSalary Organization’. This feature
exports all images from the blob field in table 5200 from all clients to a ZIP file. A folder is created for each
client in ‘Bilder.zip’ file. You can ‘import images’ in Dynamics NAV versions from v. 17 onwards, and again, via
‘SwissSalary Organization’. 

IMPORTANT NOTES:
- Only the images of the current client are imported! This means that this import must be carried out separately
in each client (technical limitation).
- If an image for an employee already exists, it will not be overwritten.
- After the import, a log is displayed where you can see whether individual images have been imported.

1.3.13.5    Advanced E-Mail features starting from Business Central Version 17.1 (November 2020)

Task #10341 | 5057.000

Microsoft released a new email feature with Business Central version 17.1 of November 2020. This is briefly
presented in  this video (only available in English). We implement this feature in SwissSalary as follows:

- Business Central version 17.x (Release 2020, Wave 2) | Support for the previous solution only
- Business Central version 18.x (Release 2021, Wave 1) | Support for the previous and for the new solution
- Business Central version 19.x (Release 2021, Wave 2) | Support for the new solution only

The new feature is (activated) via ‘Feature management’, menu item: ‘Feature update: advanced email
features’.

https://www.microsoft.com/en-us/videoplayer/embed/RE4JsUk
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Implementation in SwissSalary:
If you click ‘Smtp mail setup’ in ‘Mail settings’, you will get to email account setup. There, the user can use
‘Navigate’ -> ‘Email scenarios’ to save SwissSalary scenario for an email account. If ‘SwissSalary’ scenario is
not selected, the emails are sent using the ‘Default’ account.

Note:
We point out that the sending is unencrypted and therefore insecure. We recommend secure dispatch with
SwissSalary Direct.

1.3.13.6    SwissSalary 365 | SwissSalary APP activation | Tenant Store Key

Task #10551 | 5057.000

It sometimes happens that partners activate several productive instances (probably by creating and/or deleting
instances). Some have three or more of them. It is difficult to know which instance is the correct one to
activate the SwissSalary app. If we have not yet approved the SwissSalary app, a message appears stating
that the customer/partner must contact our support. This error message has been expanded to include ‘Tenant
Store Key’.

IMPORTANT:
If we have approved the tenant, SwissSalary Organization (Store) must be opened in the corresponding tenant
to update the data. Only then will the tenant be activated. So do this first before posting the salary.

1.3.13.7    Personnel file | WebService integration with Base64

Task #10351 | 5057.000

This new option was implemented in the Personnel file so that companies that want to access the documents
in the Personnel file in the future via WebService also get the Base64 string for the document. The new
‘Base64’ column can be displayed via ‘Personalize’ -> ‘Field’.

1.3.13.8    Free SwissSalary objets marked as obsolete

5056.004

‘SwS Free’ objects have been marked for Business Central 17 as obsolete = outstanding so that these objects
are available again for new developments.

1.4    Update 5057.000 (06.05.2021) | Systemadmin

1.4.1    SwissSalary Website | Objects and app download (2)

I work in SaaS cloud from Microsoft Dynamics 365 Business Central (online). Do I have to download
the objects from the website and install?

No. 
You will only find on our website the objects and apps for the installed versions (onPremise). You can update
your app directly within the SaaS solution. 

How is SwissSalary customer area accessed?
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You can go to our website via https://swisssalary.ch Click Login at the top right.

Log in using your company-specific login data. Then click the Update NAV button (SwissSalary BC/NAV
customers) or the Update BAU button (SwissSalary BAU customers).

You will be offered the latest Updates and Hotfixes for download.

Which documents can you additionally download?

In addition to the latest Update, the latest Hotfixes (if any) can be downloaded and installed in SwissSala-ry.
This way, your object status will always be up to date (recommended).

The library of current manuals and further information about SwissSalary is constantly updated, expanded and
published at https://docs.swisssalary.ch.

How is a file downloaded from the Internet?

Click the corresponding icon with your mouse and the download starts (you will find the file under “Down-
loads”):

Will I be informed about improvements to SwissSalary?

We use different communication channels, e.g. Yammer (SwissSalary Partner Network), via newsletters,
website and via news in the Role Center.

Will the updates no longer be emailed?

As a rule, the Updates are only available on the Internet. In case of emails, there were often problems with
some providers due to the size of the files and spam/junk filters.

Do you have questions about our website or downloading?

Send us an email at support@swisssalary.ch or contact your Dynamics 365 partner or our hotline +41 (0)31 /
950 07 77. We will be pleased to advise you!

1.4.2    Importing/updating Updates and Hotfixes (2)

These explanations only concern customers with installed versions (onPremise).

1.Download the objects as described in Chapter SwissSalary-Homepage | Download der Objekte und App.

IMPORTANT NOTES:
q The User Manual can be found at https://docs.swisssalary.ch.
q Make sure that update version B5055.000 (BAU) / N5055.000 (BC/NAV) is installed on your system. Check

this in SwissSalary under RTC client under Role Center -> Organization.

https://swisssalary.ch
https://docs.swisssalary.ch
mailto:support@swisssalary.ch
https://docs.swisssalary.ch
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IF A VERSION EARLIER THAN B5055.000 / N5055.000 IS INSTALLED, THEN INTERRUPT THE INSTAL-
LATION AND NOTIFY YOUR PARTNER OR US!

TIP:
We recommend that you make a backup before the update. It is usually unnecessary, but makes sense for
security reasons.

2. Unzip the app/object file using WinZip.

3. Open Dynamics 365 Business Central / Microsoft Dynamics NAV and switch to the Object Designer by
pressing Shift+F12 (Extras -> Object Designer).

You can see now all objects available for you in the BC/NAV database.

4. Go to File -> Import.

5. Enter the path to your saved APP/FOB file. The system will try now to import the file.

6. You will see info now that MUST be confirmed with OK or No.

NOTE:
ALWAYS open the import worksheet!

7. The import worksheet will open.

IMPORTANT NOTE:
It is IMPERATIVE that you click REPLACE ALL here! Finally, click OK to continue the import process!
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The following message also appears in the RTC client (starting from NAV 2015) (confirm it by selecting
“Force”):

Synchronization is automatically requested in the RTC client (starting from NAV 2015), please confirm this
message with YES:

8. The objects are now imported into your database. After a successful installation, you will get the following
completion message:
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IMPORTANT NOTES:

We recommend that you compile the SwissSalary objects after import (F11). Please set a filter (F7) in the
version list to SwS* and make sure that “All” is selected on the left-hand side. Please note that it is pref-erable
to restart the BC/NAV service. As a rule, only the administrator with relevant permissions can do it (please
execute during off-hours only when no users are logged in anymore).

9. Update Process

After a successful import of the objects, please switch to the SwissSalary main menu or Role Center.

Click the Personnel menu item (Personnel card). The system begins the update process automatically. A
person with administrator rights only should open the main Update menu. Otherwise, the update will fail. Once
the process is completed successfully, you will receive a completion message.

You will find an update history under Role Center -> Organization where all successfully imported update
versions are logged.

The update process must be performed after every Update/PreUpdate.

You will see in the Excel file the objects that have been newly created or modified.

Explanation of the types:

1 = Table
3 = Report
4 = Dataport
5 = Codeunit
6 = XMLport
7 = MenuSuite
8 = Page
9 = Query

If you have any questions, please contact your partner or our support directly.

1.4.3    Access Rights and Permissions (2)

Permission roles description:
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Group ID Name Description

SWS-ALL SwissSalary - All
Users

The only user role that must be assigned to every SwissSalary user.
The “Wage Accounting Process” feature requires that the system
should obtain “indirect” information about all clients (license check,
how many employees are currently accounted for in the entire data-
base. Of course, the payroll staff member cannot see any data of the
restricted clients).

SWS-CONS /
SWS
INVOICING
(nur
SwissSalary
BAU)

SwissSalary -
Consortium
SwissSalary -
Invoicing

This role is used for working in the ARGE module. This permission role
allows full access to ARGE items and ARGE posting journals. This
role is suitable for employees that are only allowed to operate ARGE in
payroll accounting.

SWS-EE-
EDIT

SwissSalary - Edit
Employees

This role is the classical assignment for payroll staff members that
need to use all features of payroll accounting. The user can edit,
delete, enter data in SwissSalary; however, s/he cannot change pay-
roll master data.

SWS-EE
READ

SwissSalary - Read
Employees

Similar to the SWS-EE EDIT role, with the exception that data can be
viewed only, and not changed (read-only rights).

SWS-HR
EDIT

SwissSalary - HR
Edit Employee

PIS (Personal Information System) add-on module. A user with this
role can modify, delete and enter data in PIS.

SWS-HR
READ

SwissSalary - HR
Read Employee

PIS (Personal Information System) add-on module. Read-only rights.

SWS-HR
SETUP

SwissSalary - HR
Setup

PIS (Personal Information System) add-on module. A user with this
role can change settings in PIS. Classical HR wage administrator.

SWS-POST
(nur
SwissSalary
NAV)

SwissSalary -
Posting

In accordance with the SOX guidelines, payroll staff member is not
allowed to 'post wages'.
This user role can be assigned to an employee in the FIBU that is
exclusively responsible for wage posting.
IMPORTANT: Of course, this employee must be also activated in
SwissSalary under Company -> Settings -> Users or in the RTC ver-
sion under SwissSalary Administration -> Users.

SWS-SETUP SwissSalary - Setup Classical authorization role for wage administrator.

SWS-ST
EDIT

SwissSalary - Edit
Salary Type

Full access for editing wage types. A user with this role can create,
modify and delete wage types.

SWS-
BUDGET-
EDIT

SwissSalary Budget
- Edit

SWS-
BUDGET-
READ

SwissSalary Budget
- Read

SWS-
BUDGET-
SETUP

SwissSalary Budget
- Setup

After each Update/PreUpdate the modified permission roles must be adjusted in SwissSalary (new tables
access, etc.)

IMPORTANT NOTE:
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q If you made individual adjustments in the Default “SWS-*” permission roles, please bear in mind that they
are overwritten with the automatic import of the “default” roles.

q Be sure to add these new tables to the relevant permission roles before releasing the system for the users!

Current permission roles can be found in the protected area of our website under BAU Update or NAV Update.

The import process is started in the RTC client Role Center-> Organization-> Permissions. Select the SWS-*
value under Group ID or Role ID.

Select relevant path for the ZIP file in the Options tab and choose Import under Direction. Then click OK,
default user roles are adjusted in SwissSalary.

If you made changes to our default user roles or want to manually maintain user roles, you can do so below or
under Extras -> Security -> Roles. Click the relevant role and add the new tables under Role -> Access rights.
This setting can be found in the RTC client under Departments -> Administration -> IT ad-ministration ->
General -> Sets of rights. If you have any questions about these settings, contact the partner responsible for
you.

The tables below have been rebuilt and must be added to the relevant roles (if already used):

Update
Version

Table
No.

Lösung Table Name

5057.000 300925
4

All SwS EasyRapport Company Setup

5057.000 304921
0

All SwS Product Video Buffer

5057.000 304946
0

All SwS INS User

5057.000 304946
1

All SwS INS Permission Set

5057.000 304946
2

All SwS INS Insights Group

5057.000 304946
3

All SwS INS Dashboard Group
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5057.000 304946
4

All SwS INS Insights/Dashboard

5057.000 304946
5

All SwS INS Company WS Tmp

5057.000 304946
6

All SwS INS Permission Set WS Tmp

5057.000 304941
8

All SwS KLE Contact Insurance

5057.000 304944
6

All SwS KLE Part Dialog Line

5057.000 304944
7

All SwS KLE Part Process Control

5057.000 500418
4

BAU Gültige KSt-Kostenart

SwissSalary Role Center
Each NAV module has its own role center. For this purpose, SwissSalary has developed the SwS Payroll Role
Center. We recommend that you work with this role center in the area of wages. You can also import the role
center (XML file is included with the update objects).
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2    Update 5056.000

2.1    Hotfix 5056.002 (December 21, 2020) | Users

2021 Withholding Tax Calculation
Update 5056.000 provided the new fields for the new withholding tax calculation applicable as of January 1,
2021. We are now also delivering the new withholding tax calculation with hotfix 5056.002 of December 21,
2020. It is mandatory to import this hotfix before the first pay process in January 2021. Starting from January 1,
2021, the calculations are to be made based on the new rules, the reporting via ELM shall continue by
following the earlier Swissdec 4.0 rules until Swissdec 5.0 certification (approx. summer/autumn 2021). This
equally applies to all payroll accounting solution manufacturers, since the certification test cases will be
available starting from Q1/2021 at the earliest.

Payslip is also delivered with hotfix 5056.002, since the withholding tax deduction looks slightly differently than
before.
Since the calculations are based on provisional calculation examples from Swissdec and withholding tax
offices and feedback from trustees and Swissdec partners, it cannot be ruled out that the calculation will have
to be improved in the months to come.

A small adjustment has also been made to the ‘Withholding Tax / Canton / Year’ report to correct the display
of the entitlement provision.

Task #10028 | 5056.002
New Integrity Check for Successive Recruitments/Resignations
A preliminary check of the successive recruitments and resignations will now also be carried out during wage
accounting. There are always cases where a re-recruitment date is set for an employee without a resignation
date being set beforehand.

Translations
Hotfix adjustments have been translated. Various minor adjustments from the update.

2.2    Hotfix 5056.001 (December 04, 2020) | Users

Tasks #10273 & 10332 | 5056.001
Business Central, latest version 17 (October 2020) | Correction of Various Reports
In its latest release of October 2020 (version 17), Microsoft changed the report preparation logic. It also
impacts some SwissSalary reports. Customers have noticed that despite entering a date from the previous
year, the billing for the current year was always processed. The following reports have been revised and
delivered again:

- Anniversary List (Report 3009096 | SwS Anniversary list)
- Payment Order (Report 3009124 | SwS Payment Order)
- DTA Payment Order (Report 3009126 | SwS DTA Payment Order)
- FIBU Posting Journal (Report 3009131 | SwS General Ledger Log)
- FAK Annual Statement (Report 3009150 | SwS FAK Summary)
- Withholding Tax Accounting / Canton (Report 3009152 | SwS Income Tax / County)
- Withholding Tax Accounting / Canton / Year (Report 3009153 | SwS Income Tax / County / Year)
- A4H Personal Annual Wage Account (Report 3009159 | SwS Employee Salary StatementP)
- A4Q Personal Annual Wage Account (Report 3009160 | SwS Employee Salary StatementL)
- Payroll Journal (Report 3009200 | SwS Salary Journal)
- ALV Employer Certificate (Report 3009214 | SwS Attestation of EmployerALV)
- ALV Temporary Employment Certificate (Report 3009215 | SwS Certificate of profit ALV)
- Difference List (Report 3009227 | SwS Difference List)
- International ALV Employer Certificate (Report 3009214 | SwS Employers certificate int)
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Task #10283 | 5056.001
SmartPort | Correct Processing of Dimensions
New dimensions are correctly imported via SmartPort. Instead of writing new data records, the existing data
record is now adjusted.

System Initialization File | Export/Import Capability
With Update 5056.000 we have completely rebuilt the system initialization files from text to XML files. File
content has also been adjusted.
When social insurance was written for each employee, employee numbers were also transferred from one
client to another. This has been fixed.
In addition, ‘time’ requirements ‘00:00:00’ for resulting wage types are not written anymore.

Task #10321 | 5056.001
SwissSalary 365 SaaS | 10-day Testing Notice (previously 30 days)
Our SwissSalary 365 payroll app can be tested in the cloud. It was 30 days before, it is 10 days now. This
notice has been adjusted to suit the order form.

Employee Photos Import via SmartPort
As of this hotfix, employee images can also be imported via SmartPort.

Task #10307 | 5056.001
UKA Data Import | Calendar Days of Absence Corrected During Import
‘Calendar days of absence’ (XML element ‘absenceCalendarDays’) were imported incorrectly during the UKA
import. This is corrected.

Wage Accounting | Withholding Tax Deduction When Using Net Wage Compensation
An error crept in with Update 5056.000: if an employee received a net wage compensation in the November pay
process due to daily allowance correction, no withholding tax was deducted for employees liable to pay
withholding tax. This was corrected.

New Withholding Tax Calculation | Percents by Position are Correctly Interpreted
Percents by position are now correctly calculated for hourly wage earners.

SwissSalary Organization | Corrected History Filter
The last updates were no longer displayed correctly in the ‘History’ column organization. This has been fixed.

Task #10332 |5056.001
DTA Payment Order is Displayed Again in the Menu Ribbon
DTA payment order was removed from the menu with Update 5056.000. In response to repeated requests from
our customers, this compact summary of all payments is available again in the menu ribbon.

Missing translations from update 5056.000 have been fixed
A few translations have been corrected or created.

2.3    Update 5056 | Introduction

Dear SwissSalary Customers,
Dear SwissSalary Partners,

We present to you the manual for SwissSalary Update 5056.000 of October 29, 2020. It also includes
documentation on 5055.001 - 5055.004 hotfixes. Your SwissSalary will be up to date after installing this
update.

IMPORTANT NOTES
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q Basic requirement
Please make sure that a version not older than 5055.000 of April 23, 2020 was installed before this up-date. If
your Dynamics 365 has implemented company-specific changes to your SwissSalary standard objects, you
must contact your Dynamics 365 partner prior to installing the objects.
Please always make sure that you are working with the latest version. We always support only the
latest and most recent SwissSalary version.

q Cumulative update with all available objects
Beginning from Update 5055.000 of April 23, 2020, all objects (C/AL) and apps (AL) will always be re-leased in
April and October similar to the Microsoft Dynamics 365 Business Central release cycle. There are still
updates and Hotfixes, no PreUpdates though.
Each individual version must be installed chronologically. No update versions may be omitted (except hotfixes).
The client must be restarted after the installation of each version for the update process to run and the latest
version to appear under ‘Organization’.

q SwissSalary 365 | Microsoft Dynamics 365 Business Central | SaaS Cloud
The SwissSalary 365 app is always up-to-date with the latest versions of Microsoft Dynamics 365 Busi-ness
Central and SwissSalary.

q SwissSalary onPrem | Dynamics 365 Business Central
SwissSalary Update 5056 is available for the following Business Central versions (onPrem/private cloud):
- new Dynamics 365 Business Central 2020 Wave 2 - Version 17 (AL)
- Dynamics 365 Business Central 2020 Wave 1 - Version 16 (AL)

- Dynamics 365 Business Central Spring' 19 - Version 14 (C/AL)
- Dynamics 365 Business Central Fall' 18 - Version 13 (C/AL)

Microsoft's new lifecycle concept applies to the new ‘AL’ versions of Dynamics 365 Business Central. We
support the latest version. This concerns, for example, the next release 5057.000 of April 2021:
- new Dynamics 365 Business Central 2021 Wave 1 - Version 18 (April 2021)
- Dynamics 365 Business Central 2020 Wave 2 - Version 17 (October 2020) 

With this update 5056.000, ‘Dynamics 365 Business Central 2019 Wave 2 - Version 15 (AL)’ is no longer
supported and is therefore also not available for the new 2021 withholding tax calculation!
Please update your solution to Business Central 2020 Wave 2 - Version 17 as soon as possible!

q SwissSalary onPrem | Dynamics NAV
SwissSalary Update 5056 is available for the following Dynamics NAV versions (onPrem/private cloud):
- Dynamics NAV 2018
- Dynamics NAV 2017

- *Dynamics NAV 2016
- *Dynamics NAV 2015
- *Dynamics NAV 2013 R2
- *Dynamics NAV 2013

*Please note that the support for Dynamics NAV versions 2013, 2013 R2, 2015 and 2016 is expected to be
discontinued as of SwissSalary Update 5059 (April 2022). Please plan today with your Dynamics 365 partner
the upgrade to the latest Business Central version (onPrem/private cloud) or in the SaaS cloud.

q SwissSalary BAU Customers
Customers using SwissSalary BAU solution receive this update for ‘Dynamics 365 Business Central Spring' 19
- Version 14 (C/AL)’ only. The old versions of Dynamics NAV 2015 + 2018 are no longer supported.

q Role Center
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SwissSalary Role Center | RTC Clients starting from Dynamics NAV 2013 up to Business Central Spring’ 19 -
Version 14 (C/AL)
Since the introduction of the RTC Client, SwissSalary has been using a clearly arranged and intuitive Role
Center. System Administrator Manual contains important information thereto.

We hope you will enjoy the latest version of SwissSalary and thank you for the valuable improvement
suggestions we could implement for you.

Your SwissSalary Team

2.4    Update 5056.000 (29.10.2020) | User

2.4.1    Income Tax 2021

The federal law on revision of withholding tax on earned income passed on December 16, 2016, comes into
force on January 1, 2021 together with several changes to the regulations based on it. The Federal Council
made a decision on this at its meeting on April 11, 2018.

IMPORTANT NOTE
In a hotfix (published approximately at the beginning of December 2020), we will deliver the new calcula-tion
logic applicable from January 1, 2021. The new 2021 withholding tax calculation is an important part of the new
Swissdec 5.0. Since the definitive certification test cases will only be available in Q1/2021, certification before
the end of Q2/2021 is impossible. The implementation of the new withholding tax cal-culation is based on
several Swissdec test cases technically approved by the Swissdec tax group. ELM submission in January
2021 will still be based on Swissdec 4.0. The new fields and other detailed data will only be submitted after
payroll manufacturers’ or their customers’ certification to Swissdec 5.0.

With this update (5056.000) we provide all additional fields for correct withholding tax calculation as of January
1, 2021.

We will specifically release a detailed manual on 2021 withholding tax in November 2021. Make sure to visit
our online training courses in November 2020.

2.4.1.1    Additional personal data | Other income sources and the level of employment

Tasks #9881 und #10056 | 5056.000

The Income Tax tab in the personnel master data includes the new fields ‘Other known income sources’ and
‘Level of employment at other income sources’. If a withholding tax payer (ITP) is employed by other employers
or has substitute income sources, the ‘Other known income sources’ field must be activated. If the ITP’s level
of employment at the other employer is also known, you must enter it in the ‘Level of employment at other
income sources’ field. If the ITP has several other employers, the total of the level of employment must be
recorded for all other employers.

Both these fields are also on the timeline (TimeMachine) and are also written to the Pay Process Header table
(pay process list) during wage accounting, but cannot be changed there.

This information will be required starting from January 1, 2021 to determine the rate-determining wage subject
to withholding tax.

2.4.1.2    Calculation of rate-determining income for several employers

Tasks #10114 & #10117 | 5056.000
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Nothing changes for part-time employees who have no other employer or substitute income sources in the new
2021 withholding tax regulation. Your reduced workload has no influence on the rate-determining income.
For part-time employees with one or more other employers and/or substitute income sources, this workload
must be reported to their employer. If the level of employment at the other employers is unknown, the rate-
determining income is always calculated at 100%, which is usually the worst solution for the employee.

Example A
Part-time employee with a workload of 80%, no other employers or substitute income sources
The rate-determining income corresponds to the withholding tax base.
Other known income sources | deactivated
Level of employment at other income sources | 0.00

Example B
Part-time employee with a workload of 80% and another employer (workload with the other employer un-
known)
Withholding tax base is converted to 100% for the rate-determining income.
Withholding tax base / 80% x 100%
Other known income sources | activated
Level of employment at other income sources | 0.00

Example C
Part-time employee with a workload of 80% and another employer (workload with the other employer is 10%)
Withholding tax base is converted to 90% for the rate-determining income.
Withholding tax base / 80% x 90%
Other known income sources | activated
Level of employment at other income sources | 10.00

Example D
Part-time employee with a workload of 80% and another employer (workload with the other employer is 30%)
Withholding tax base is converted to 110% for the rate-determining income.
Withholding tax base / 80% x 110%
Other known income sources | activated
Level of employment at other income sources | 30.00

If the level of employment at the other employer is unknown, but the amount of the wage and/or the substitute
income source is known, the level of employment must be determined (converted) in relation to the main
occupation. If the employee has several other employers, various levels of employment (workloads) must be
added up and entered in the ‘Level of employment at other income sources’ field.

2.4.1.3    Rate codes for the married | Validation of partner data similar to rates B and C

Task #10139 | 5056.000

Data integrity validation is currently already being used to check whether employees who are married or live in
a registered partnership and are withholding tax payers with rates B or C have all of the partner data recorded.
This validation has been expanded to include similar rates below:

- M - Cross-border worker DE, married sole earner
- N - Cross-border worker DE, dual earner
- S - Cross-border worker TI, married sole earner
- T - Cross-border worker TI, dual earner

If the partner data is not completely available, a corresponding error message is displayed.
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2.4.1.4    Cross-border Workers Agreement | Additional personal data for cross-border workers

Task #10141 | 5056.000

With Swissdec 5.0, cross-border workers can or must submit additional information via ELM. The registra-tion
is optional for German and French cross-border workers and mandatory for Italian cross-border workers. The
three fields below are affected:

Birthplace of the withholding tax payer (WTP)
-> Employee card -> tab Private -> field ‘Birthplace’

WTP’s tax identification number in the state of residence
-> Employee card -> tab Income tax -> new field ‘Tax identification number in the country of origin'

Date the person became a cross-border worker
-> Employee card -> tab Income tax -> field Entry date

NOTE
Please collect and store this information for Italian cross-border workers. Starting from the introduction of
Swissdec 5.0 (around autumn 2021), this information will be mandatory.

2.4.1.5    Salary types | New field ‘Aperiodic WT rate determination'

Task #10122 | 5056.000

There is the new ‘Aperiodic WT rate determination’ field in the Obligations tab of Payroll master data.

Check this box if no extrapolation for calculating rate-determining income is to be made for this wage type in
case of recruitment's and resignations during the month (e.g. vacation pay, overtime pay, seniority allowances,
bonus payments, 13th wage payment, etc.). This allocation is also taken into account when calculating rate-
determining income for part-time employees having other income sources.

The salary types that you have previously entered in the Payroll Setup - Income tax settings - Income tax -
Extrapolation by canton are automatically activated as aperiodic during the migration process of SwissSalary
Update 5056.000.

IMPORTANT
Please check that the salary types are set up after installing the update. This check must be carried out before
the January 2021 pay process.

2.4.2    Employee

2.4.2.1    Employee card | Fax number field removed

Task #10100 | 5056.000

The ‘Fax number’ field on the Employee card has been hidden and will be completely deleted with the next
Update.

2.4.2.2    Resignation | Deletion of TimeMachine entries in the future

Task #10162 | 5056.000
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If you had ‘TimeMachine’ entries in any field (wage adjustments, addresses, IT data, etc.) at the time of
resignation (set the date of resignation), a prompt appears now asking whether they can be deleted. By
selecting ‘Yes’, you can delete all entries in the future.

2.4.2.3    Refunding of absences | Display on the 13th/14th wage payslip (number/rate) can be
selected

Task #10061 | 5056.000

With the last update 5055.000 of April 23, 2020, in response to multiple customer requests, we made the
‘number’ and the ‘rate’ of the 13th and 14th wage displayed on the payslip. We received much customer
feedback, where some thanked for this improvement while others wanted to revert to the state that had been
before the adjustment.

We have now made that it can be selected for each refunding of absences. In ‘Refunding of absences’, there
are new fields ‘Print 13th monthly wage rate & number’ and ‘Print 14th monthly wage rate & number‘ in the
‘13th Monthly Wage’ and ‘14th Monthly Wage’ tab. These two fields are activated by default, but they can be
deactivated, if necessary.

2.4.2.4    Children | New info box for comments

Task #8601 | 5056.000

Comments can be made for each child in the Children table. With the new info box, the comments can be
displayed on the right side of the table. The comments can be edited directly in the info box. In addition, all
comments made for the child will, of course, be deleted if s/he is removed.

2.4.2.5    Portions of wage| Checking the Valid until date for pay rises via TimeMachine

Task #9742 | 5056.000

When a pay rise is entered via TimeMachine, a message appears that there are still entries with the old wage
rate in the portions of wage. This validation has been improved to only check entries in the portions of wage
without a ‘Valid until’ date or with a future ‘Valid until’ date.

2.4.2.6    Dossier | Document types | Translations

Task #9559 | 5056.000

Document types in the Personnel file can be translated again. There is the ‘Translation’ item in the ribbon used
to translate the text of the document type into another system language (DES/FRS/ITS/ENU). For example, if
you change the system language from ‘German (Switzerland)’ to ‘French (Switzerland)', you will find the
document type rewritten in French (if translated in the table).

2.4.2.7    Dossier | Personnel number and last/first name are displayed in the dossier

Task #9997 | 5056.000

The concerned employee’s personnel number and last/first name are now displayed in the upper left part of the
Personnel file. It helps during navigation.
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2.4.3    Payroll Process

2.4.3.1    Payroll Journal / Portions of wage | Last/first name fields are displayed immedi-ately

Task #9964 | 5056.000

Since the last Update 5055.000 of April 23, 2020, the ‘Last name’ and ‘First name’ fields are displayed
separately in the Report journal and in the Portions of wage. The advantage is that these fields can be selected
individually and now also sorted and filtered.

When the personnel number was entered, these two fields were not updated immediately. This was corrected.

2.4.3.2    Payroll Journal | Excel import | Items for employees who have resigned

Task #10001 | 5056.000

During Excel data import into the Report journal, you now have the option of determining what should be done
with data records of employees who have resigned.

In the ‘Options’ tab, you will find the new ‘Items for employees who have resigned’ field (similar to the open
data import interface) with the options below:
· Show messages
If you import a data record of an employee who has resigned, the corresponding message ‘Employee has
resigned. Make an entry anyway’ is displayed and the data record is imported.
· Ignore messages
If you import a data record of an employee who has resigned, the message ‘Employee has resigned. Make an
entry anyway’ is not displayed and the data record is imported.
· Do not import
Data record of the employee who has resigned is not imported.

2.4.3.3    Data integrity | Checking the mandatory dimension for employees that resign

Task #10011 | 5056.000

With the new data integrity check, missing data can be indicated during payroll accounting either for each
employee or automatically. If the check of the personnel dimension is set up in the payroll master data, this
check should also be carried out when an employee has resigned. Some customers remove the assignment to
the personnel dimension after the resignation, which leads to an error message if an additional payment is
made.

The data integrity check has been improved and refined.

2.4.3.4    Wage items | Target and actual time | Document date should be present in the case of
delayed billing similar to hours

Task #9985 | 5056.000

Customers who work with our time and activity recording solution EasyRapport or those who import data via an
open import interface on a daily basis, but who do not bill hours/absences from the current month but from the
previous month, receive a noticeable improvement with this update.

The target and actual time data is now taken into account in the Document date field from the referenced
month in the wage items.
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Example:
Work and absence hours from October are to be processed in the November pay process. All October time
stamps, work and absence hours as well as allowances and expenses are processed. The calculation of target
and actual time is also taken into account from October.

2.4.3.5    ISO 20022 (pain001.xml) | Processing priority

Task #10088 | 5056.000

When a ISO 20022 payment file is created, ‘Processing priority’ can now be set in addition to the value date
and debit bank. The following options can be selected:

- Normal (default)
- High

For some banks, the ‘High’ option can be used to ensure that the payment is given priority. For many banks
this option only has an impact on EUR or USD payments. Still, we recommend using the default option
‘Normal’.

2.4.3.6    DTA and EPO | References removed

Task #9863 | 5056.000

The ISO 20022 interface has been in operation for some time and has completely replaced the previous DTA
and EPO interface. With this update, the assignments to DTA and EPO have been removed.

If a customer should still have access to the DTA file, the objects are still available in the background and can
be assigned and started via ‘General reports’.

2.4.3.7    Wage posting | Test client | Warning regarding costs

Task #10096 | 5056.000

This information applies to our SwissSalary 365 customers in the SaaS cloud.

Some customers occasionally create a copy of the existing client in their productive database. This is a 1:1
copy of the productive data. If wages are posted in this TEST or DEMO client, they will always appear on the
monthly statement.

We now display information during wage posting that this posting process is paid.

TIP
Would you like to test wage posting? You have a maximum of 3 sandboxes available for each productive
database. A sandbox can be created from the productive database in the ‘Business Central admin center’. Pay
processes posted in the sandbox do not appear on the monthly bill.

2.4.4    Administration

2.4.4.1    Personnel templates | Calling up templates

Task #9428 | 5056.000

Personnel templates were introduced with an earlier update. They are used to make it easier to record new
employees with the help of a template.
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Up until now, personnel templates could only be edited via the Personnel card. Personnel templates are now
available as follows:

Web client
Settings button - Personnel templates

Role-based client (RTC client)
SwissSalary Role Center - SwissSalary Management - Personnel templates

Role-based client (RTC client) via Departments
Settings - Management - Settings - Personnel Templates

2.4.4.2    Refunding of absences | Rounding precision to 4 decimals

Task #9262 | 5056.000

A maximum of 2 decimal places could previously be set up in the Refunding of absences, tab General,
Rounding precision field. The input was extended to 4 decimals.

2.4.4.3    Payroll area | Excluding areas from ELM reporting

Task #8617 | 5056.000

Some customers create payroll areas for employees who do not receive any wages (e.g. for temporary
employees, employees employed abroad, etc.). These employees should not be taken into account during
ELM reporting. 

There is the Payroll accounting region field in the Payroll area, tab General (Show more), which is set to
‘Switzerland’ by default. If the payroll area should not be transmitted via ELM, it cab be set to ‘Other’ in the
Payroll accounting region field. This payroll area is not taken into account during ELM reporting.

It was practiced earlier that these areas were excluded for the ‘User’. It is no longer necessary.

2.4.4.4    SaaS cloud | Notification of the latest update, although it has already been in-stalled

Task #10115 | 5056.000

This information applies to SwissSalary 365 customers in the SaaS cloud.

A useful notification appears in the SwissSalary 365 Role Center whenever a new SwissSalary update or hotfix
is available. This notification was displayed for a few days, although the update or the Hotfix was installed. The
reason for this was that the version number was only updated when Organization was opened.

Starting with this update, the version in Organization is updated immediately without having to open it first.

2.4.5    ARGE - SwissSalary BAU

2.4.5.1    ARGE re-invoicing | Flexibly define the approach per wage type

Task #10173 | 5056.000
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ARGE re-invoicing has been expanded. In addition to the old setup options for various surcharges in
accordance with the ARGE contract, there is now the option of defining the rates retrieved from payroll
accounting differently for each wage type and re-invoicing group.

Example:
In ARGE re-invoicing group BP-ML, the employee’s normal hourly rate should not be delivered for WAT 1700,
but a flat rate of CHF 80.00. Individual setup is made in the Re-invoicing Rate table (located to the right of the
surcharge table).

With the next Hotfix 5056.001 it will even be possible to individually change the ARGE category (base wages,
allowances, expenses, personnel transport, accommodation and personal equipment), which is defined in the
wage type master for each wage type per ARGE re-invoicing group.

2.4.6    Reports and interfaces

2.4.6.1    Wage statement | Hiding company name and address fields

Task #9688 | 5056.000

When the wage statement is opened, the company name and the entire address were previously displayed,
that could be changed again directly on this page. We removed these fields. Changes to the address or
company name are made exclusively in the company data section.

2.4.6.2    Social Fund | Standard filter criteria extended

Task #9689 | 5056.000

Social fund year-end statement is used for various social works, e.g. for showing annual wages for Pari-fonds,
GAV far, etc. Since the demands for report flexibility have increased, the report has been expand-ed with the
standard filter criteria. This means that the report can now be filtered by any field on the Employee card.

2.4.6.3    Absence statistics | Excel export revised and additional filtering options

Task #9715 | 5056.000

The absence statistics evaluation has been revised and expanded with additional filters like the ‘active
employees only’ filter. In addition, export to Excel has been completely revised.

Tip:
Do you already know the ‘Absence statistics’ matrix?
These statistics can be used to evaluate various absences on the timeline.

2.4.6.4    Human resources | Alternative addresses | New report created for better evaluation

Task #8384 & Task #8385 | 5051.100 (SwissSalary BAU version)

The Alternative Addresses report has been updated and the sorting has been improved (search term).

2.4.6.5    Logib | Occupational competence level

Task #10118 | 5056.000

The Logib interface has been included in SwissSalary for many years and has been widely used.
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The latest Logib guidelines require that in addition to the role, ‘Occupational competence level’ should also be
used or transferred to Excel. There is a new ‘Occupational competence level’ column in the ‘Role’ table. You
can use the default options below:

1 - Most demanding and difficult work
2 - Independent and qualified work
3 - Professional and technical knowledge required
4 - Simple and/or repetitive activities

These options are currently only required by Logib and have no relevance e.g. for the FSO’s wage struc-ture
survey (LSE).

2.4.6.6    UKA | Version 8.9 import interface as XML data import now

Task #9515 | 5056.000

UKA offers two export interfaces (personnel and absence data) as well as an import interface used to import
data (daily allowance benefits) into SwissSalary. The old text interface has been revised into an XML import.

UKA processes the import data not for each client, but for several clients. For SwissSalary to know which data
is to be imported and into which client, you can enter relevant company number provided by UKA in the payroll
master data - Settings tab - field Company number interface.

2.4.6.7    swiss + work certificates | New WebService and exit date filter are available

Tasks #10009 & #10110 | 5056.000

Arbeitszeugnis swiss+ ® software helps HR professionals create job references and interim references. A
sophisticated evaluation grid forms the basis for generating individual certificates. To do this, the pro-gram uses
a database with over 60,000 text modules continuously developed for 25 years.
Source: https://iwpag.ch/arbeitszeugnis/

We have developed a page specifically for swiss+ (P 3009271) that can be used as a web service in the Plus
scope of SwissSalary.

Additionally, there is a new ‘Swiss+ resignation date filter’ field under the Settings tab in the payroll master
data. This field is used to define that, for example, information about employees who resigned more than 3
months ago will no longer be transferred to swiss+. The corresponding filter in this example is ‘-3M’.

If you need more information on using WebSerivces, please contact our support or your Dynamics 365 partner.

2.4.6.8    ISAB | New interface

Task #9523 | 5056.000

The new interface is currently included in the scope of SwissSalary BAU (Business Central, version 14). The
report can be retrieved via ‘General reports’ (enter the number 3049550 under General reports and then start via
Print).

Informationssystem Allianz Bau (ISAB) improves and modernizes the implementation of GAV in the
construction industry.
Source: https://isab-siac.ch/

In cooperation with the office of ‘Informationssystem Allianz Bau’ (ISAB SIAC), we have built an interface that
exports the required data from SwissSalary BAU directly into an Excel file, so that it can then be entered into

https://iwpag.ch/arbeitszeugnis/
https://isab-siac.ch/
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the company-specific employee list for import into the ISAB portal. In addition, ID cards stored in the
SwissSalary dossier can be exported (in a ZIP) and then uploaded to the ISAB portal.

The procedure and interface use:
1) The customer registers on the ISAB portal. S/he then has access to an employee list (Excel) that s/he can
download.
2) Store report 3049550 via General reports and start it via Print.
3) The previously downloaded list of employees is now added to the ‘Excel import file’ field under 'Options’ in
the ISAB interface.
4) The mapping below now runs in the ‘Assignment’ area:
- Document type - ID
Have you already saved your employees’ IDs in the SwissSalary personnel file?
If so, please select the correct document type.
- Wage classes A, B, C, Q and V
Please enter the corresponding wage class for each field.
5) You can set filters in the Personnel Master Data tab so that not all employees are exported. It is cer-tainly
advisable here to set filter ‘A|B|C|Q|V’ for the ‘Wage class’ filter (if you have corresponding coding in
SwissSalary).
6) Then please start the export by clicking OK. Two files will be created (Excel file and ZIP). The exported
employee data is now in the Excel file, while employees’ ID cards are in the ZIP file.
7) Now please open both Excel files (original from ISAB) and the Excel file with the employee data that has
just been created. Copy the exported employee data (CTRL+C) and add it to the original ISAB Excel
(CTRL+V). Save the template with the employee data.
8) Both Excel and ZIP file with the identification data can then be uploaded to the ISAB portal.

2.4.6.9    SAP Business ByDesign | Default values for data export

Task #10125 | 5056.000

The integrated SAP Business ByDesign financial accounting interface also has the option of splitting financial
accounting data into several dimensions. Since the dimensions in SAP Business ByDesign and in
SwissSalary are not necessarily the same, we created a mapping in the SAP settings.

There are ‘SAP interface settings’ in the menu ribbon in the payroll master data. You will find the mapping in
the new ‘Default values for data export’ tab:

- Cost center dimension
- Cost unit dimension
- Project dimension

Address your SAP Business ByDesign partner or our project manager before you adjust relevant settings.

2.4.6.10    IFS | New standard financial accounting interface

Task #9355 | 5056.000

Customers using ERP solution ‘IFS’ can benefit from the new financial accounting interface. Select value ‘IFS
Financials’ in the Interface field under Settings tab in the payroll master data. The interface is included in the
scope of SwissSalary Plus.

In addition to this new interface, SwissSalary already has 10 standard finance interfaces to the following ERP
solutions:
- Abacus
- Dynamics NAV | Standard finance interface to Dynamics NAV and Dynamics 365 Business Central
- Dynamics 365 (AX) | Standard XML interface to Dynamics 365 Finance (formerly Dynamics AX)
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- JD Edwards (Oracle)
- Sage50
- Sage200
- SAP (Excel) | Excel interface to SAP
- SAP Business ByDesign
- SAP Business One

The file is created during wage posting and displayed in the ‘Files’ info box in the posted pay process, where it
can be further exported at any time.

2.4.7    SwissSalary Direct

2.4.7.1    Registration code | Prohibited 0 (number) and O (letter)

Task #9818 | 5056.000

We regularly have support inquiries that employees cannot register for SwissSalary Direct. It was often
identified that it was due to an incorrect registration code input and that 0 (number) and O (letter) were mixed
up.

The new registration codes are recreated without 0 (number) and O (letter). In addition, the lowercase L (l) was
removed as it was often confused with uppercase.

2.4.8    SwissSalary EasyRapport

2.4.8.1    Verification of duplicated RFID

Task #9781 | 5056.000

Customers who work with EasyRapport and use the time stamping with RFID recognition are now notified if an
RFID number is mistakenly assigned twice. This can happen if the same key is mistakenly stored in the
personnel card of another employee.

2.4.9    Bug fixes

2.4.9.1    Notifications | Open the correct page

Task #9875 | 5056.000

We show you via ‘Notfications’ in the Employee card if a data record is incomplete or needs to be re-vised.
This is e.g. the case if partner information is missing or has to be supplemented for an employee who is a
withholding tax payer. When the link ‘Open the context-related record here’ was clicked, the wrong page would
open in a few cases.

2.4.9.2    Reasons for resignation | Only consider effective pay processes

Task #9854 | 5056.000

The number of resignations per reason for resignation is recorded in the Reasons for resignation table. Only the
main pay process and no down-payment or additional pay processes may be counted.
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2.4.9.3    Personnel banks | Beneficiary address validation

Task #9922 | 5056.000

The new data check for wage accounting was introduced with update 5055.000 of April 2020. Among other
things, the beneficiary’s address presence (personnel banks) was checked. Since some customers had not
entered addresses, error messages displayed during the check. Since the beneficiary’s address is not
validated in the ISO 20022 file, we have refined our check accordingly.

We also recommend to record the beneficiary’s address if it has to be recorded for the employee (debt
enforcement office, debt collection, etc.).

2.4.9.4    Wage items | Improved view in the Web Client

Task #10116 | 5055.003

The detailed view of wage items in the web client was limited.

2.4.9.5    Payroll Journal/Wage items | Locked dimension values and sums cannot be selected

Task #9729 | 5056.000

Locked dimension values could be entered in the Report journal and in the Wage items. Entries with the
assignment to ‘From- and To- Totals’ were also available. There is no adjustment in this regard in SwissSalary
solutions BAU and NSP, as this has already been implemented or a different logic is available.

2.4.9.6    Payslip | Only two decimals are displayed in the rate

Task #9859 | 5056.000

Starting from Business Central version 16 of April 2020, the decimal value of 0.008 was suddenly dis-played as
0.01 in the Rate field on the payslip. This is because Microsoft has formatted the property of the decimals in
the latest version differently. Customers with older versions were not affected.

2.4.9.7    Payslip | Problems with sorting starting from Business Central version 17

Task #10224 | 5056.000

Customers with the latest Business Central version 17 (2020 Wave 2) have reported that the payslip can no
longer be sorted in the preview, but a PDF is created later with the correct sorting.

2.4.9.8    Payslip | Error message during sorting

Task #9976 | 5056.000

If the sorting in the payslip was changed twice in a row, an error message occurred in rare cases.

2.4.9.9    Payslip | Placeholder %Employee_SalaryYTD% corrected

Task #9951 | 5056.000

Customers in the mainstream construction industry are subject to the GAV far (early retirement). Employees
aged 60 and over can retire earlier, and the far Foundation pays differential benefits up to 65.
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Employees over 60 years of age who have registered for the far pension and still want to work a few hours for
their previous employer can do so up to a specified annual income subject to AHV. So that the employee can
check his/her previous wage bill, there is a placeholder that can be entered in the employ-ee’s wage
comments. Example: AHV wage sum since the beginning of the year: CHF %Employee_SalaryYTD%.

As a result of a new development, this placeholder has not worked since update 5055.000 of April 23, 2020
and has been corrected.

2.4.9.10    Personal annual wage account | Mo more blank page if only the recap is created

Task #9999 | 5056.000

If the personal annual wage account was only printed with the Recapitulation option, but without details per
employee, the first page always appeared blank.

2.4.9.11    Personal annual wage account | Excel export | No blank rows

Task #2860 | 5050.200

The Excel export of Personal wage account A4Q has been completely redesigned, so that both reports and
PivotTable could be easily created. From now on, the following additionally appears per Excel row:

- Employee No.
- Last name
- First name
- Employment Date
- Resignation Date

2.4.9.12    ALV employer certificates and absence quotas | Corrections starting from Business Central
version 15

Task #10030 | 5056.000

There were a few options for ALV employer certificate, ALV international employer certificate and ab-sence
quotas that were displayed in English starting from Business Central version 15 onwards. In addition, for
example, the date or year of the ALV employer certificate has been extended to 4 characters.

2.4.9.13    ALV temporary employment certificate | Company address printed on several lines

Task #9007 | 5053.000

A customer has reported that the display of the gross wage subject to AHV of the assessment was incor-rect
in Paragraph 10. Holiday and vacation compensation for this customer is not calculated in ascending order, as
usual, but vice versa. This means that after the hourly wage, vacation compensation and holiday compensation
is first calculated from the cumulative basis. This order can be adjusted in the Refunding of absences.

The report has been adjusted to accept the order according to the settings in the Refunding of absences.
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2.4.9.14    Portions of wage | Personalize | Last name and first name fields added

Task #9963 | 5055.004

Customers using SwissSalary 365 in the SaaS cloud have informed us that the ‘Last name’ and ‘First name’
fields could not be added via ‘Personalize’.

2.4.9.15    FIBU posting journal | Fibu accounts with more than 10 characters

Task #9948 | 5056.000

Update 5055.000 of April 23, 2020 added a new feature to the FIBU posting journal, which led to an error when
the FIBU posting journal was launched for customers with FIBU accounts longer than 10 characters. The
function was extended to 20 characters.

2.4.9.16    Dossier | Limited view in Business Central

Task #9980 | 5055.004

The dossier was not completely displayed in the Business Central web view.

2.4.9.17    Target/actual time difference list | Consideration of the TimeMachine when changing the
level of employment

Task #9819 | 5056.000

The target/actual time difference list should always show the correct workload and thus also the correct target
time, even with retroactive changes in workload. The evaluation has been improved with the help of information
in the TimeMachine table.

2.4.9.18    ELM | AHVeasy | ResponseID with 128 characters, extended to 150 characters

Task #9950 | 5056.000

Software company AHVeasy that supplies software to many cantonal compensation offices is currently the
only provider that sends responses back during the ELM wage reporting process using a 128-character key.
Usually, these keys are max. 20-30 characters long.

We have now extended the ResponseID to 150 characters.

2.4.9.19    ELM | Status messages remain ‘in plausibility check’

Task #9940 | 5055.002

Since update 5055.000 of April 2020 we have been using the so called ‘Azure Functions’ for ELM files transfer.
At first, ELM notification was transmitted correctly, but the message remained with the ‘in plausibility check’
status.

2.4.9.20    Human resources (PIS) | Consider mutations via TimeMachine

Task #9832 | 5056.000
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Automatic comparison of the personnel card from SwissSalary and the employee card from HR (PIS) can be
activated in the Payroll master data - Settings tab. Newly registered employees in SwissSalary are
automatically created in HR. Mutations are also transferred.

However, if changes were made via TimeMachine, the changes were not always reflected in the employee card
in HR.

2.4.9.21    SAP Business ByDesign | Personal data interface | Corrections

Task #9973 | 5056.000

SAP Business ByDesign and SwissSalary 365 (SaaS Cloud) are directly connected with an integrated
personnel data, a time and a FIBU interface.

New data validation had to be performed in the personnel data interface during changes import. Business
ByDesign does not send any changes to Personnel data in chronological order, which means that the last
change does not always have to be the most current. We have made further improvements in this regard, so
that the most current data set is always read in.

In addition, the XML debugging has been completely revised and improved.

2.4.9.22    Budget | Calculation error in case of multiple transfers of pay processes

Task #9624 | 5056.000

When pay processes were transferred several times to SwissSalary Budget, one customer reported a
malfunction, which was rectified.

2.4.9.23    Direct | Wage statements | Checking who is still registered during sending

Task #9739 | 5056.000

When wage statements are sent via SwissSalary Direct, the ‘only registered employees’ option is checked.
I.e. only wage statements will be sent in SwissSalary Direct that are registered and with no resignation date,
and it is taken into account, based on the date formula, for how long access is still possible after resignation.

This means that employees with a resignation date that still have access to the solution for 90 days after
resignation will continue to receive their wage statement via SwissSalary Direct and not on paper. 90 days are
added to the resignation date and are taken into account at the time of sending.

The sending logic was slightly corrected and adapted again to the strict data protection guidelines.

2.4.9.24    IncaMail / PrivaSphere | Display the number of documents transferred

Task #10179 | 5056.000

After the documents have been sent via IncaMail or PrivaSphere, a completion message with the number of
documents transmitted should appear at the end of the transmission. This message was no longer displayed
after update 5055.000 and has been integrated again.
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2.4.10    Technical partner and customer information

2.4.10.1    System initialization | Now in the from of XML file

Task #10086 | 5056.000

System initialization for new clients is now set up using an XML file and no longer a text file.

System initialization for new customers in the SaaS cloud takes place automatically after registration for the
SwissSalary 365 app. An existing installation can be exported via Administration -> Organization and imported
into a new client (Import/Export).

2.4.10.2    SaaS cloud sandboxes | Synchronization for EasyRapport, Direct and ELM

Task #10080 | 5056.000

Up to three sandboxes can be created in the SaaS cloud with a push of a button with data from the pro-ductive
database, if required. When productive data is copied into the sandbox, all connections to any third-party
solutions (web services) and to our add-ons are also copied, of course. It is not entirely un-problematic, since,
for example, a synchronization and/or transfer to EasyRapport and/or Direct with the same login details as in
productive data can lead to data chaos. We have been beating our brains out thinking of ways to prevent this.

As soon as you start a sandbox with productive data, the connections (synchronization) to EasyRapport,
Direct and ELM are interrupted. For example, if you try to start a direct transfer, the following error mes-sage
appears:

Synchronization with SwissSalary Direct is deactivated for this sandbox. If this sandbox should synchronize
with SwissSalary Direct, you can activate ‘Sync from sandbox’ in SwissSalary Direct settings.

This ‘Sync from sandbox’ field is only displayed in sandboxes.

IMPORTANT NOTE
Please activate this function only after consulting your Dynamics 365 partner or our support.

2.4.10.3    Wage items | External Document No. | New field

Task #9889 | 5056.000

Some external solutions (e.g. HR solutions) manufacturers repeatedly requested that we have a field in wage
items similar to the FIBU postings (‘External Document No.’). We have added this new field to the tables and
dependent pages and reports below:

- Table 3009083 SwS Allocated Salary | Wage Portions
- Table 3009090 SwS Salary Entry | Wage Items
- Table 3009121 SwS Journal Line | Payroll Journal Row

As a consequence, the existing value in this new field in wage items and Report journal is recorded to wage
items during wage accounting.

2.4.10.4    Mail settings | User Name field is too short

Task #9293 | 5056.000
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In some cases, user name field in mail settings was too short. The field has been expanded similar to the
standard table 409 SMTP Mail Setup.

2.5    Update 5056.000 (29.10.2020) | Systemadmin

2.5.1    SwissSalary Website | Objects and app download

I work in SaaS cloud from Microsoft Dynamics 365 Business Central (online). Do I have to download
the objects from the website and install?

No. 
You will only find on our website the objects and apps for the installed versions (onPremise). You can update
your app directly within the SaaS solution. 

How is SwissSalary customer area accessed?

You can go to our website via https://swisssalary.ch Click Login at the top right.

Log in using your company-specific login data. Then click the Update NAV button (SwissSalary BC/NAV
customers) or the Update BAU button (SwissSalary BAU customers).

You will be offered the latest Updates and Hotfixes for download.

Which documents can you additionally download?

In addition to the latest Update, the latest Hotfixes (if any) can be downloaded and installed in SwissSala-ry.
This way, your object status will always be up to date (recommended).

The library of current manuals and further information about SwissSalary is constantly updated, expanded and
published at https://docs.swisssalary.ch.

How is a file downloaded from the Internet?

Click the corresponding icon with your mouse and the download starts (you will find the file under “Down-
loads”):

Will I be informed about improvements to SwissSalary?

We use different communication channels, e.g. Yammer (SwissSalary Partner Network), via newsletters,
website and via news in the Role Center.

Will the updates no longer be emailed?

https://swisssalary.ch
https://docs.swisssalary.ch
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As a rule, the Updates are only available on the Internet. In case of emails, there were often problems with
some providers due to the size of the files and spam/junk filters.

Do you have questions about our website or downloading?

Send us an email at support@swisssalary.ch or contact your Dynamics 365 partner or our hotline +41 (0)31 /
950 07 77. We will be pleased to advise you!

2.5.2    Importing/updating Updates and Hotfixes

These explanations only concern customers with installed versions (onPremise).

1.Download the objects as described in Chapter SwissSalary-Homepage | Download der Objekte und App.

IMPORTANT NOTES:
q The User Manual can be found at https://docs.swisssalary.ch.
q Make sure that update version B5055.000 (BAU) / N5055.000 (BC/NAV) is installed on your system. Check

this in SwissSalary under RTC client under Role Center -> Organization.

IF A VERSION EARLIER THAN B5055.000 / N5055.000 IS INSTALLED, THEN INTERRUPT THE INSTAL-
LATION AND NOTIFY YOUR PARTNER OR US!

TIP:
We recommend that you make a backup before the update. It is usually unnecessary, but makes sense for
security reasons.

2. Unzip the app/object file using WinZip.

3. Open Dynamics 365 Business Central / Microsoft Dynamics NAV and switch to the Object Designer by
pressing Shift+F12 (Extras -> Object Designer).

You can see now all objects available for you in the BC/NAV database.

4. Go to File -> Import.

5. Enter the path to your saved APP/FOB file. The system will try now to import the file.

6. You will see info now that MUST be confirmed with OK or No.

mailto:support@swisssalary.ch
https://docs.swisssalary.ch
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NOTE:
ALWAYS open the import worksheet!

7. The import worksheet will open.

IMPORTANT NOTE:
It is IMPERATIVE that you click REPLACE ALL here! Finally, click OK to continue the import process!

The following message also appears in the RTC client (starting from NAV 2015) (confirm it by selecting
“Force”):

Synchronization is automatically requested in the RTC client (starting from NAV 2015), please confirm this
message with YES:
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8. The objects are now imported into your database. After a successful installation, you will get the following
completion message:

 

IMPORTANT NOTES:

We recommend that you compile the SwissSalary objects after import (F11). Please set a filter (F7) in the
version list to SwS* and make sure that “All” is selected on the left-hand side. Please note that it is pref-erable
to restart the BC/NAV service. As a rule, only the administrator with relevant permissions can do it (please
execute during off-hours only when no users are logged in anymore).

9. Update Process

After a successful import of the objects, please switch to the SwissSalary main menu or Role Center.

Click the Personnel menu item (Personnel card). The system begins the update process automatically. A
person with administrator rights only should open the main Update menu. Otherwise, the update will fail. Once
the process is completed successfully, you will receive a completion message.

You will find an update history under Role Center -> Organization where all successfully imported update
versions are logged.

The update process must be performed after every Update/PreUpdate.

You will see in the Excel file the objects that have been newly created or modified.

Explanation of the types:

1 = Table
3 = Report
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4 = Dataport
5 = Codeunit
6 = XMLport
7 = MenuSuite
8 = Page
9 = Query

If you have any questions, please contact your partner or our support directly.

2.5.3    Access Rights and Permissions

Permission roles description:

Group ID Name Description

SWS-ALL SwissSalary - All
Users

The only user role that must be assigned to every SwissSalary user.
The “Wage Accounting Process” feature requires that the system
should obtain “indirect” information about all clients (license check,
how many employees are currently accounted for in the entire data-
base. Of course, the payroll staff member cannot see any data of the
restricted clients).

SWS-CONS /
SWS
INVOICING
(nur
SwissSalary
BAU)

SwissSalary -
Consortium
SwissSalary -
Invoicing

This role is used for working in the ARGE module. This permission role
allows full access to ARGE items and ARGE posting journals. This
role is suitable for employees that are only allowed to operate ARGE in
payroll accounting.

SWS-EE-
EDIT

SwissSalary - Edit
Employees

This role is the classical assignment for payroll staff members that
need to use all features of payroll accounting. The user can edit,
delete, enter data in SwissSalary; however, s/he cannot change pay-
roll master data.

SWS-EE
READ

SwissSalary - Read
Employees

Similar to the SWS-EE EDIT role, with the exception that data can be
viewed only, and not changed (read-only rights).

SWS-HR
EDIT

SwissSalary - HR
Edit Employee

PIS (Personal Information System) add-on module. A user with this
role can modify, delete and enter data in PIS.

SWS-HR
READ

SwissSalary - HR
Read Employee

PIS (Personal Information System) add-on module. Read-only rights.

SWS-HR
SETUP

SwissSalary - HR
Setup

PIS (Personal Information System) add-on module. A user with this
role can change settings in PIS. Classical HR wage administrator.

SWS-POST
(nur
SwissSalary
NAV)

SwissSalary -
Posting

In accordance with the SOX guidelines, payroll staff member is not
allowed to 'post wages'.
This user role can be assigned to an employee in the FIBU that is
exclusively responsible for wage posting.
IMPORTANT: Of course, this employee must be also activated in
SwissSalary under Company -> Settings -> Users or in the RTC ver-
sion under SwissSalary Administration -> Users.

SWS-SETUP SwissSalary - Setup Classical authorization role for wage administrator.

SWS-ST
EDIT

SwissSalary - Edit
Salary Type

Full access for editing wage types. A user with this role can create,
modify and delete wage types.

SWS-
BUDGET-

SwissSalary Budget
- Edit
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EDIT

SWS-
BUDGET-
READ

SwissSalary Budget
- Read

SWS-
BUDGET-
SETUP

SwissSalary Budget
- Setup

After each Update/PreUpdate the modified permission roles must be adjusted in SwissSalary (new tables
access, etc.)

IMPORTANT NOTE:

q If you made individual adjustments in the Default “SWS-*” permission roles, please bear in mind that they
are overwritten with the automatic import of the “default” roles.

q Be sure to add these new tables to the relevant permission roles before releasing the system for the users!

Current permission roles can be found in the protected area of our website under BAU Update or NAV Update.

The import process is started in the RTC client Role Center-> Organization-> Permissions. Select the SWS-*
value under Group ID or Role ID.

Select relevant path for the ZIP file in the Options tab and choose Import under Direction. Then click OK,
default user roles are adjusted in SwissSalary.

If you made changes to our default user roles or want to manually maintain user roles, you can do so below or
under Extras -> Security -> Roles. Click the relevant role and add the new tables under Role -> Access rights.
This setting can be found in the RTC client under Departments -> Administration -> IT ad-ministration ->
General -> Sets of rights. If you have any questions about these settings, contact the partner responsible for
you.

The tables below have been rebuilt and must be added to the relevant roles (if already used):

Update
Version

Table
No.

Lösung Table Name
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5056.000 300920
2

alle SwS Swissdec Setup

5056.000 304943
9

alle SwS KLE Manual Additions

5056.000 304944
4

alle SwS KLE Part Salary Raise

5056.000 304944
5

alle SwS KLE Part Person Mutated

5056.000 304955
0

BAU SwS Forward Charg. Group Setup

5056.000 304957
5

NSP SwS Lession Type

5056.000 304957
6

NSP SwS Lession Type Table

5056.000 304959
3

NSP SwS Employee Selection

SwissSalary Role Center
Each NAV module has its own role center. For this purpose, SwissSalary has developed the SwS Payroll Role
Center. We recommend that you work with this role center in the area of wages. You can also import the role
center (XML file is included with the update objects).
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3    Update 5054.000

3.1    Update 5054.000 User

3.1.1    PreUpdate 5053.100 (16.04.2019)

3.1.1.1    Introduction

Dear SwissSalary Customers,
Dear SwissSalary Partners,

We present to you the manual for SwissSalary PreUpdate 5053.100 dated April 16, 2019. It also includes
5053.001 + 5053.002 hotfix corrections. Your SwissSalary will be up to date after installing this release.

IMPORTANT NOTES

q Please make sure that a version not older than 5053.000 dated October 25, 2018 was installed be-fore this
update. If your NAV partner has made company-specific changes to your SwissSalary NAV objects, you
must contact your NAV partner prior to installing the objects.

q SwissSalary NAV customers using NAV versions 5.00, 5.00 SP1 and 2009 SP1/R2 Classic
We would also like to inform you that the update version N5054.000 of October 2019 will be the last
SwissSalary NAV version available for your NAV version. Beginning from PreUpdate N5054.100 (end of
Q1/2020) only NAV 2013 versions or above will be supported.

IMPORTANT NOTE:
The planned new swissdec version 5.0 (to be used productively starting from 2021) will be only used for NAV
versions 2013 and below.

q SwissSalary NAV customers using NAV DB versions 4.00 SP2 and 4.00 SP3
The last update for your NAV version was delivered with Update 5053.000 of October 25, 2018. The present
PreUpdate version is no longer available for your NAV version. For further information, please contact you NAV
partner.

q SwissSalary Role Center | RTC clients starting from NAV 2013
Since the introduction of the RTC Client, SwissSalary has been using a clearly arranged and intuitive Role
Center. System Administrator Manual contains important information thereto.

We hope you will enjoy the latest version of SwissSalary and thank you for the valuable improvement
suggestions we could implement for you!

Your SwissSalary Team
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3.1.1.2    Employee

3.1.1.2.1    Place of work | Filter extended to include label and FAK canton

Task #9105 | 5053.100

When entering the place of work in the Employee card (Job), the default filter was automatically set to ‘code’.
For companies with numerous workplaces, the ‘Place of work’ table had to be opened first to find the correct
workplace.

As of this version, the ‘Designation’ columns as well as the ‘FAK Canton’ column can be stored as default filter
columns. This means that if, for example, the default filter is set to the ‘FAK Canton’ column, value ‘AG’ is
entered in the Place of work field and all workplaces with FAK canton ‘AG’ are displayed in the drop-down
menu.

3.1.1.2.2    Control of Social security benefits | Personnel List Filter is Actively Adopted

Task #8798 | 5053.100

The ‘Social Services’ page can be accessed in the Employee List or Employee Card via ‘ACTIONS’. This view
is used to check whether the assignment of employees to social/private insurance is correct. The validation is
important if, for example, you have several KTG or UVGZ insurance plans for different groups of people. Other
helpful fields like Department, Workplace, etc. may be displayed in the front of the page. The page can be
copied to Excel for further inspection via CopyPaste.

Starting from this version, the Employee List date filter is adopted, so that, for example, only active employees
are displayed.

3.1.1.2.3    Suggest Raise Salary | Active Employees Only

Task #9194 | 5053.100

‘Only active employees’ option is now available in the ‘Suggest Raise Salary’ process, so that the employees
that have already resigned are not suggested for the pay rise session.

3.1.1.2.4    Human Resources (PIS)

3.1.1.2.4.1   Career | New Assessment

Task #9078 | 5053.100

From now on, there is a new assessment for the entries in Career that provides data in Excel in addition to the
view.

3.1.1.2.5    Dossier

3.1.1.2.5.1   Personnel Dossier | Display Personnel Number, Last and First Name in the Header

Task #9093 | 5053.100

If the Personnel Dossier was opened via Personnel List/Personnel Card, there was no reference to the current
employee in the page header. Starting from this version, the employee’s personnel number, last and first name
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appears in the header. This immediately makes it possible to see if you are in the dossier of the right
employee.

3.1.1.2.5.2   File Import Changed from Folder to ZIP File | WebClient Ready

Task #9219 | 5053.100

Good News: the Personal Dossier can now be fully operated in the WebClient.

For this to work, the ‘bulk’ import function in the Dossier has been changed from Directory to ‘ZIP’. This means
that if you want to import several documents for one employee at a time, zip these files and then import the
entire archive. After that, each individual document is imported automatically. Of course, you still can import
documents individually (without ZIP).

3.1.1.2.5.3   Dossier Import | Exclusion of System Files

Task #8956 | 5053.100

The so-called system files were imported in some cases during file import directly into the Dossier. These files
are usually hidden from the user in the drive folder and must be removed manually from the Dossier.

Starting from this version, the new ‘File Type Filter’ will be automatically populated with the following default
value:
.pdf|.doc|.docx|.xls|.xlsx|.ppt|.pptx

You are welcome to extend this filter. If the filter is deleted, it will be populated again with the default value at
the next launch. This way system files are prevented from being imported in the future.

3.1.1.3    Salary Types

3.1.1.3.1    Resulting Salary Types | Extension for Minimum and Maximum Number (similar to minimum and
maximum amount)

Task #9189 | 5053.100

In an earlier update, we described the possibilities of how the resulting salary types can be set up so that they
are only taken into account when a minimum or maximum amount is reached. This way, for example,
incentives for employees are automatically calculated whether they fall below the AHV limit of CHF 500.00 or
whether the AHV contributions are to be paid.

Similar to the ‘Amounts’, there is also the option in the resulting salary types to set these validations for the
‘Quantity’. That is why there are two new columns, ‘Minimum number’ and ‘Maximum number’. Please note
that all four columns (Amount/Quantity – Minimum/Maximum) must always be taken into account together
with the ‘Limit Amount Calculation’ column. Individual validations must only take place once, while others must
be added up to one month or the whole year.

Owing to these enhancements, almost all possible calculations can be carried out with the resulting salary
types.

3.1.1.4    Payroll

3.1.1.4.1    Calculation of the 13th Payday | TimeMachine Entries for Wage Rate Value and Percents by Position
Checkup

Task #9110 | 5053.100
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When calculating the 13th Payday, any possible TimeMachine entries are now taken into account in the
‘Wage Rate Value’ or ‘Percents by Position’ fields. If, for example, the 13th Payday has already been taken
into account in November 2019 and as of December 1, 2019 a pay rise is recorded in the ‘Wage Rate Value’
field via TimeMachine, it is taken into account during the December wage extrapolation.

3.1.1.4.2    Payroll Journal and Allocated Salary | Sorting Corrected | Color Display

Task #9121 & Task #9125 | 5053.100

With update 5053.000 (October 2018), the functionality and the colored representation of the resulting salary
types in the Payroll Journal and Allocated Salary have been completely revised. As a result, data sorting was
no longer possible in both journals and, depending on the screen, the colored representation of the resulting
salary types was barely readable.

The sorting was integrated again and the representation of the resulting salary types (rows) changed from gray
to blue. The adjustment has already been delivered with 5053.001 hotfix.

3.1.1.4.3    EZAG File Removed and Bank Account Master Data Revised

Task #9222 | 5053.100

The EZAG file (PostFinance) has not existed for some time and has been replaced with ISO 20022. The
corresponding report was expanded. In addition, the setup for ‘Bank Account Setup’ have been revised in
SwissSalary administration. The entire ‘EZAG’ area has been removed and the ‘DTA’ area has been renamed
to ‘Setup'. All fields were neutralized by text means.

3.1.1.5    Salary Declaration

3.1.1.5.1    ELM Beta Interface is Now Active

Task #9241 | 5053.100

We missed out a complete refactoring for the ELM interface and adjusted the code to the current guidelines.
The tests of the old interface and the new ‘BETA’ interface have been running simultaneously for many months
showing the result that the new interface processes the code more efficiently and, of course, populates the
XML with the same content just like the old interface.

As of this update, the 'BETA' interface is automatically activated in the Payroll Setup -> Ribbon -> ELM Setup.
If no negative feedback arrives until the main update 5054.000, then the ‘BETA’ will become the production
ELM interface.

3.1.1.6    Administration

3.1.1.6.1    Organization

3.1.1.6.1.1   SwissSalary Store | Performance During Import Improved and ZIP Imported Directly

Task #9205 & Task #9233 | 5053.100

Our development department did a lot of research in the first quarter of 2019 into how to make various data
imports faster and easier. A possible option is described here.

The performance during the import of

- Income tax
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- ZIP codes base
- Bank master
- Permissions

could massively be increased. Import of the complete WT rate with nearly 3 million records takes about 7
minutes (depending on the server performance).

NOTE
You do not have to unzip individual files after the download anymore, you can now import the ZIP right away.
The improvements were implemented after from NAV 2013 and newer, nothing has changed for the older
versions NAV 5.00 and NAV 2009 Classic.

3.1.1.6.1.2   SwissSalary Store | ‘Install All Store Updates’ | Feature Implemented Starting from NAV 2013

Task #9197 | 5053.100

We would like to present a great innovation!

You can see in the Organization whether or not a data master is ‘not up-to-date’ (for example, permissions,
bank master, etc.). Up until now, you had to download each update, unzip and then import it. There is a new
‘Install all Store Updates’ button in the ribbon. By clicking it, all possible updates are applied automatically.

NOTES
- The Updates/PreUpdates cannot be applied automatically.
- The .NET assemblies must then be updated using the ‘Save server add-ins’ option (this process is not yet
automated).
- The new function is available starting from NAV version 2013 and newer.

3.1.1.6.2    Work Calendar

3.1.1.6.2.1   Compensation time | View and Modify Designation

Task #9126 | 5053.100

If the Compensation time are imported in the working time calendar, an additional name per compensation time
(e.g. Easter, Easter Monday) etc. will be imported. However, this is not apparent in the infobox. As of this
update, the name is displayed directly in the infobox. The names can be changed manually by clicking
‘Add/Change Name’.

3.1.1.6.2.2   Automatic Absence Report | Adjustment During the Change of Percents by Position via TimeMachine

Task #8441 | 5053.100

With the ‘Automatic Absence Report’ function, the holidays are directly exported per employee from the
working time calendar to the report journal. This way, the holidays (hours in proportion of percents by position)
are automatically created for each employee in TapBoard/EasyRapport and do not have to be recorded
manually by the employee.

We have extended the logic so that when setting a value in TimeMachine in the ‘Percents by position’ field
(Personnel Card), the absence report value in the Report journal is also adjusted.

Automatic absence reports are changed correctly under the following rules:

- If the ‘percents by position’ are changed via TimeMachine, the holidays are posted from the effective date on
the basis of the percents by position entered.
- If the value previously entered is changed in TimeMachine, the holidays are correctly changed based on the
previously valid percents by position.
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- If the value is deleted in TimeMachine, the holidays are posted based on the last valid percents by position.
- If only the ‘valid from’ date is changed in TimeMachine, the holidays are posted correctly.
- If there are several entries in TimeMachine, the holidays are posted correctly.
- If there are several entries in TimeMachine and the last entry is deleted, the holidays are posted correctly.
- If there are several entries in TimeMachine and the ‘middle’ entry is deleted, the holidays are posted
correctly.
- If there are several entries in TimeMachine and the ‘Workgroup’ is changed for the employee, the holidays of
the new working time calendar are posted correctly.

3.1.1.6.2.3   Automatic Absence Report | Adjustment of the Workgroup via TimeMachine

Task #9149 | 5053.100

Similar to the completed task  Automatic Absence Report | Adjustment During the Change of Percents by
Position via TimeMachine the same correction was also made during workgroup adjustment via TimeMachine.
If a new workgroup (Working Time Calendar) is assigned via TimeMachine in the Workgroup, the holidays in
the report journal are then posted correctly from this point in time.

3.1.1.7    Paycheck | Salary Class Can Now be Displayed in the Same Way as Salary Step

Task #9173 | 5053.100

You will find the new ‘Suppress wage level’ selection in Payroll Setup -> tab Paycheck which is checked by
default. If you want to use the wage level in the Employee Card and want to display this value on the payslip,
you can remove the check mark.

3.1.1.8    Reports | Interfaces

3.1.1.8.1    Annual Employe Statement A4I | FTE per Employee (4)

Task #6743 | 5053.100

In A4Q Personal Wage Account, the FTE is reclassified per month and per employee, incl. an annual average
in the Total column. Up until now, the FTE was displayed on the recapitulation.

3.1.1.8.2    Hospital Statistics | Function-wise Adjustment of Annual Working Hours

Task #9008 & Task #9203 | 5053.100

In the hospital statistics, column ‘H’ (Excel) must indicate the value of the annual standard number of working
hours per function paid for at 100% of workload. Up until now, the incorrect effective value (broken down by
workload) has been written there.

There is a new ‘Value’ column in the ‘Statistics Group’ of Personnel Statistics, which can also be dis-played.
Enter the desired value per person group in this column, e.g. 2520 for Chief Physician.

3.1.1.9    SwissSalary EasyRapport

3.1.1.9.1    Data Import | Error Message Readable

Task #9048 | 5053.100
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Error messages like ‘Incorrect time’ appeared during data import from the EasyRapport import table to the
Payroll Journal. These error messages have no further indication of the employee and/or the salary type
number.

The error messages have now been made ‘readable’ and, in addition to the message, the corresponding
personnel number, the wage type number and the document date arte also displayed. This way, the in-
complete or incorrect value can be found quickly in the EasyRapport import table.

3.1.1.10    Bug fixes

3.1.1.10.1    Employee

3.1.1.10.1.1   Employee Card | Employee Change During Input

Task #9261 | 5053.100

We have received feedback that every now and then, during the registration of a new employee, another
employee’s card suddenly appears. This behavior could be experienced when e.g. no payroll area or entry date
has yet been set, and sub-tables like Children or Bank Details were already recorded. The be-havior can be
explained by the fact that if a new employee is entered via the “active” tile and the input is not done using A-Z,
the employee is no longer present in this filter (tile).

We analyzed these cases and improved the behavior. Now the employee should be recorded correctly.

3.1.1.10.1.2   Personnel Statistics | Icon was Adjusted

Task #9177 | 5053.100

The icon for Personnel Statistics (Personnel Card/Personnel List) was stored incorrectly starting from NAV
2018 update 5053.000. The error has been corrected.

3.1.1.10.1.3   Analysis | Entries in Items Not Saved

Task #9243 | 5053.100

A customer has informed us that the analysis items are not saved in particular situations. The error has been
corrected.

3.1.1.10.2    Salary Types

3.1.1.10.2.1   Resulting Salary Types | Draw Wage Types, Even if No From/Until Time is Stored

Task #9106, Task #9181 & Task #9249 | 5053.100

With update 5053.000 of October 2018, the entire resulting salary type logic as well as its view in the Report
journal/Wage items was revised. Owing to production operation, it was found with a few customers that
resulting salary types were no longer retrieved automatically, provided that there were no entries in the
‘From/until time’ columns.

This bug has already been remedied with Hotfix 5053.002, and is now included in this update. 

Please also note that there are no times past midnight. This means that if the work is done, for example, from
23:00 to 06:00, two records must be created from 23:00 to 00:00 and the next day from 00:00 to 06:00,
otherwise no resulting salary types will be retrieved.
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3.1.1.10.3    Payroll

3.1.1.10.3.1   Reporting | DrillDown Does Not Display All Fields From NAV 2018 (Search Term)

Task #9180 | 5053.100

During reporting, employees can be searched using a search term (last, first name) instead of the Employee
number, and data can be reported. To do this, the Employee list must be opened and the ‘Search term’
column ‘Set as default filter column’ must be activated.

It was noted that the search term column no longer existed in NAV versions of 2018 and later and had to be
added manually. The error has been corrected.

3.1.1.10.3.2   Reporting | Adjusting Dimensions Stored in the Project Task During Update

Task #9004 | 5053.100

Starting from NAV 2013, in addition to the storing of dimensions in the project, detailed dimensions can also
be entered in the project task.

Valid dimensions of the project task are automatically recorded during data entry in the Report Journal in
project/project task. If the project task is changed again in the Report Journal after the initial entry, the
dimensions were not updated based on the new project task. This bug has been fixed.

3.1.1.10.3.3   TapBoard | Batch Processing | Fixed Number not Visible at First Opening

Task #9244 | 5053.100

TapBoard did not display the Fixed Number field at the first opening of batch processing. The error has been
corrected.

3.1.1.10.4    Reports | Interfaces

3.1.1.10.4.1   Wage Items & Payment Order | ‘No access to payroll area’ if an Employee is Not Assigned to Anyone

Task #9147 & Task #9148 | 5053.100

An error message appeared during the opening of the ‘Wage Item’ and ‘Payment Order’ reports if a pay-roll
area had not been recorded for an employee by mistake. The error message has become more detailed.

3.1.1.10.4.2   Report Card | Last Day Not Printed

Task #9264 | 5053.100

The data for the last day of the month was not printed in the Report card. The error has been corrected.

3.1.1.10.4.3   Hourly Accumulation | Header From the 2nd Page and BAS Printed

Task #8839 | 5053.100

The ‘Hourly Accumulation’ evaluation was revised.

Evaluation with BAS (construction work key) | only included in the BAU version
One customer had reported that BAS is no longer displayed in the evaluation.
This bug has been fixed.

In addition, another customer has reported that the header from the 2nd page was displayed incorrectly.
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This bug has also been fixed.

3.1.1.10.4.4   Income Tax Canton | Report Does not Display Correct Totals

Task #9159 | 5053.100

The Income Tax Canton report did not show the correct totals after Update 5053.000. The reason for this was
an adjustment in the main update involving the writing of a new WT base for each employee (for retroactive
corrections). The report did not correctly consider this new behavior. The corrected report has already been
delivered with Hotfix 5053.001.

3.1.1.10.4.5   KTG Accounting | Character Number for Payroll Area Filter Increased After NAV 2017

Task #8973 | 5053.100

The KTG Accounting request page could be easily refreshed to make a longer filter possible to be en-tered in
the payroll area. Starting from NAV 2017, only 10 characters could be entered.
This has been corrected in all versions.

3.1.1.10.4.6   BVG Accounting | Page Numbers During Printing/Print Preview Increment-ed Correctly

Task #9003 | 5053.100

Just like in the KTG accounting the BVG Accounting was also slightly adjusted, so that a longer payroll area
filter can be recorded starting from NAV 2017. In addition, an error has been fixed that prevented page numbers
from being correctly incremented during printing/print preview (page view was OK).

3.1.1.10.5    Administration

3.1.1.10.5.1   Payroll Area | Period Start Day Error Corrected

Task #9175 | 5053.100

In rare cases, when working with EasyRapport without down-payment method and when time bookings were
offset monthly, there was a problem in January 2019 with the actual time, which was counted as over time by
100%. This error was quickly remedied with Hotfix 5053.001. 

We recommend that you always work with the down-payment method when using a time management
solution, as it always matches the two periods (wage & time) to 100%.

3.1.1.11    Notices for Our Partners

3.1.1.11.1    Salary Types | Field 148 VAT Prod. Posting Group Extended by 20 Characters

Task #9160 | 5053.100

Starting from NAV 2017, the VAT Product Posting Group field in financial accounting has been extended from
10 to 20 characters. In SwissSalary, this code is used exclusively for wage types, for assigning the correct
group to wage types. We have accordingly extended the 148 field in the SwS Salary Type | Wage Types table
by 20 characters.

3.1.1.11.2    Organization | Update Process | “Log” if the Update Process has Gone Through

Task #9161 | 5053.100
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After each SwissSalary update, the update code unit has to be gone through. Only then the post-processing
code will be executed correctly. We often encounter support situations with several versions imported at the
same time without the update code unit being started each time.

We have introduced two new fields into Organization:

- Field 40 | Data Update Date and Time
- Field 42 | Data Update User

These two fields are written or updated during each update process.

3.1.1.11.3    Organization | New Fields for Displaying Adjustments Made to SwS or Customer Objects

Task #9240 | 5053.100

There are two new fields in Organization (Boolean):

- Adjustments (SwS objects)
- Adjustments (client objects)

Unfortunately, it happens again and again that SwissSalary objects (Updates/PreUpates/Hotfixes) are
imported, even though adjustments have been made to the SwissSalary standard objects by the partner.
Unfortunately, these adjustments are then lost. For this purpose, there is a new Boolean ‘Adjustments (SwS
Objects)’. Please put a check mark if you have made adjustments to the standard for the customer.

If there are additional company-specific reports or interfaces for the customer referring to the standard
SwissSalary objects, please check the ‘Adjustments (Customers Objects)’ Boolean.

Thank you for your cooperation! Your help facilitates the work of both your and our support department.

3.1.1.11.4    Organization | SwS Tenant Web Services | New Table Created

Task #9196 | 5053.100

More and more customers have a need to provide data for external purposes via web services. The new Tenant
Web Services’ table can be accessed via Organization -> Navigate.

3.1.1.11.5    Table SwS Employee History | Field ‘Deactivated’ Removed

Task #9195 | 5053.100

The ‘Deactivated’ field in the ‘SwS Employee History’ table was removed from the page. This field was
previously used for the manual exclusion of history entries in the old wage statement and partly in reports. In
the meantime, all standard reports have been rewritten to the Table SwS Payroll Head.

The field is deleted with Update 5054.000 (October 2019).

3.1.1.11.6    Deleted Fields and Values from Tables after Update 5053.000 (2)

5053.100

This list is directly included in the manuals as a PDF file.
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3.2    Update 5054.000 Systemadmin

3.2.1    PreUpdate 5053.100

3.2.1.1    SwissSalary Homepage | Update-Download

3.2.1.1.1    Instructions

How you can enter the customer area of SwissSalary?

Link http://www.swisssalary.ch will take you to our website. Click Log In in the upper right corner: 

Log in using your company specific login data. Afterwards press the button Update NAV (SwissSalary NAV
customers) or Update BAU (SwissSalary BAU customers).

This will allow you to download the most current Updates and PreUpdates. If you click on the respective PDF
and/or ZIP icon, you will download the objects and documents.

What additional documents can be downloaded?

In addition to the latest Updates you can download and install the most current PreUpdates in SwissSalary, so
that you are always up to date (recommended).

The library of the latest manuals and other information for SwissSalary will be renewed and extended.

How a file can be downloaded from the Internet?

When you click on the corresponding icon and the download begin (the file you will find under 'Download):

Will I get notified about changes to SwissSalary?

Yes. You will receive information message each time when the latest Update is released. The PreUpdates will
be continuously available on our website with no mail notification! You will also be notified by mail about the
important PreUpdates!

Can the updates be sent via email?

As a rule, the Updates are only available online. Sending via email is often used in case of problems with some
providers related to the size of files and spam/junk filtering.

Are you familiar with our customer and partner portal?

By following https://webportal.swisssalary.ch you will enter our Customer portal. To log in you will need only
your email address and a password that you will receive from us. If you have not yet received a password from
us, please request it by sending an email at support@swisssalary.ch.

http://www.swisssalary.ch
https://webportal.swisssalary.ch
mailto:support@swisssalary.ch
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You can change the received password when you first log in to the system.

At the Customer portal you may not only submit and process new support requests (incidents), but also track
your own open or already answered mail inquiries at any time. In addition, you have access to our Tasks for
further development. You can see which customer requirements have been met and will be delivered with the
next Update or PreUpdate. You can also vote for individual tasks, so that you can actively influence the
development of SwissSalary.

Just try it!

Do you have questions about our website or downloads?

You can send us an email at support@swisssalary.ch or call our hot line +41 (0)31 / 950 07 77 or your partner.
We will be happy to advise you!

3.2.1.2    Downloading / Refreshing Updates and PreUpdates

3.2.1.2.1    Instructions

1. Download the objects and manuals according to the descriptions in chapter Instructions.

IMPORTANT NOTES:
q It is NECESSARY that you pass this User Manual on to the relevant employees!
q Make sure that the update version B5053.000 (BAU) / N5053.000 (NAV) is installed in your system. You can

check this in SwissSalary under Company -> Settings -> Organization -> Update (Version) or in RTC-Client
on Organization.

IN CASE YOU HAVE A VERSION OLDER THAN B5053.000 / N5053.000 INSTALLED, PLEASE CANCEL
THE INSTALLATION AND CONTACT US OR YOUR PARTNER!

HINT:
Please back up you data before the update. Generally, it is not required but still useful for security reasons.

2. Unzip the object file with WinZip.

3. Open Microsoft Dynamics NAV and select using Shift+F12 in Object Designer (Tools -> Object Designer).
From NAV 2009 SP1 RTC you must start the Development-Client.

mailto:support@swisssalary.ch
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Now you can see all NAV objects in the NAV DB available to you.

4. Select menu File -> Import.

5. Enter the path to the location where you saved the FOB file. The system will try to read the file.

6. You will see this info that MUST be confirmed with OK or No.

NOTE:
 For PreUpdates a different question appears. ALWAYS open the Import Worksheet!

7. The Import Worksheet will open.

IMPORTANT NOTE:
Here you SHOULD click REPLACE ALL! Click OK to continue the import process.

The RTC-Client (from NAV 2015) appear this message (confirm this with 'Force'):
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The RTC-Client (from NAV 2015) ask you to do a synchronization; confirm this message with YES:

8. The objects will be loaded into your database. After a successful completion of the import the following
message appears:
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In the Classic version:

(Example: the number of objects can vary!)

In the RTC version:

9. Done. The new update has been imported!

IMPORTANT NOTE:
This approach is similarly applied to PreUpdates! 

We recommend compiling the SwissSalary objects after importing (F11). Please put in the List a filter (F7) to
SwS* and make sure that All is selected on the right side.
We would like to point out that, especially for RTC versions (as of NAV 2009), the NAV service service, if
possible to restarted. This can usually only be done by the administrator with appropriate permissions (please
run only in margins if no users are logged in).

After a successful import of the objects, select them in SwissSalary main menu.

Click menu item Employee (Employee Card). Te system will start automatically the process of update
renewal. Only a staff member with administrator rights should open the main menu for update renewal.
Otherwise, the update will not be successful! After a successful run of the batch you will receive a message
stating that it is complete. 

Under Setup -> Setup -> Organization  or in the RTC-Client-> Organization you will find the history of updates
in which all successfully updated versions are registered. After each Update/PreUpdate you must undergo this
update/renewal process!
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In the Excel file you can see which objects will be created and modified.

Type explication:

1 = Table
2 = Form (no more available from NAV 2013)
3 = Report
4 = Dataport
5 = Codeunit
6 = XMLport
7 = MenuSuite
8 = Page (only RTC version from NAV 2009 SP1)
9 = Query (from NAV 2013)

In cases of uncertainty, please inform your partner or our support immediately.

3.2.1.3    Access Autorisations and Roles

3.2.1.3.1    Instructions

Autorisation and Roles description:

SwissSalary Budget - Edit
Groups ID Name Description
SWS-ALL SwissSalary -

All SwS-Users
The only user role that must be assigned to every SwissSalary user.
The 'Wage Accounting Process' feature requires that the system should obtain
'indirect' information about all clients (license check, how many employees are
currently accounted for in the entire database. Of course, the payroll staff
member cannot see any data of the restricted clients)The only user role that
must be assigned to every SwissSalary user.

SWS-CONS /
SWS-
INVOICING
(only
SwissSalary
BAU)

SwissSalary -
Consortium
SwissSalary -
Invoicing

This role is used for working in the ARGE module. This permission role allows
full access to ARGE items and ARGE posting journals. This role is suitable for
employees that are only allowed to operate ARGE in payroll accounting.

SWS-EE-
EDIT

SwissSalary -
Edit Employees

This role is the classical assignment for payroll staff members that need to use
all features of payroll accounting. The user can edit, delete, enter data in
SwissSalary; however s/he cannot change payroll master data.

SWS-EE
READ

SwissSalary -
Read
Employees

Similar to the SWS-EE EDIT role, with the exception that data can be viewed
only, and not changed (read-only rights).

SWS-HR
EDIT

SwissSalary -
HR Edit
Employee

PIS (Personal Information System) add-on module. A user with this role can
modify, delete and enter data in PIS. 

SWS-HR
READ

SwissSalary -
HR Read
Employee

PIS (Personal Information System) add-on module. Read-only rights.

SWS-HR
SETUP

SwissSalary -
HR Setup

PIS (Personal Information System) add-on module. A user with this role can
change settings in PIS. Classical HR wage administrator.

SWS-POST SwissSalary -
Posting

In accordance with the SOX guidelines, payroll staff member is not allowed to
'post wages'. This user role can be assigned to an employee in the FIBU that
is exclusively responsible for wage posting. IMPORTANT: Of course, this
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(only
SwissSalary
NAV)

employee must also be enabled in SwissSalary under Company -> Settings ->
Users.

SWS-SETUP SwissSalary -
Setup

Classical authorization role for wage administrator

SWS-ST
EDIT

SwissSalary -
Edit Salary
Type

Full access for editing wage types. A user with this role can create, modify
and delete wage types.

SWS-
BUDGET-
EDIT

SwissSalary
Budget - Edit

SWS-
BUDGET-
READ

SwissSalary
Budget - Read

SWS-
BUDGET-
SETUP

SwissSalary
Budget - Setup

After each update, permission roles must also be adjusted in SwissSalary (New table access, etc.)

IMPORTANT NOTICE:
q If you have customized individual permission roles in Standard "SWS-*", please remember that they will be

overwritten through the automatic import of the "default" roles.
q Before releasing the system for the user again, add the necessary appropriate permission roles to these new

tables!

Current permission roles can be found on our website in our protected area.

To begin the import in SwissSalary go to Setup -> Setup -> Organization -> button 'Service' -> Rights. In the
RTC-Client in Organization. Select SWS value under Role ID*.

Choose the appropriate path for the .txt file and select Import under Direction in the Options tab. Then click
OK and after some time the default user roles will be adjusted in SwissSalary.
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If you have written changes in our default payroll user roles or if you want to make changes to the user roles
manually, you can do this under Tools -> Security -> Roles (NAV 4.00 SP2 and newer). Click on the
appropriate role and add new tables  Role -> Permissions (NAV 4.00 SP2 and newer). In the RTC-Client go to
Departements-> Administration-> IT Administration-> General-> Permission Sets. If you have questions about
these settings, please contact your local partner.

The following tables have been re-created and must be added to the corresponding roles (if already used):

SwissSalary Role Center
Each NAV module knows its own role Center (from NAV 2009 RTC). SwissSalary has developed the Page
3009252 SwS Payroll Role Center. We encourage you to work with this Role Center for the salary. You can
import the Role Center also (XML-file you will find in the Update object).
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4    Update 5053.000

4.1    Update 5053.000 User

4.1.1    PreUpdate 5052.100 (01.05.2018)

4.1.1.1    Introduction (3)

Dear SwissSalary Customers,
Dear SwissSalary Partners,

We present to you the manual for SwissSalary PreUpdate 5052.100 dated May 1, 2018. It also includes
5052.001 + 5052.002 hotfix corrections. Your SwissSalary will be up to date after installing this release. We
can offer you some great new features.

IMPORTANT NOTES

q  Please make sure that a version not older than 5052.000 of October 26, 2017 was installed before this
update. If your NAV partner has made company-specific changes to your SwissSalary NAV objects, you
must contact your NAV partner prior to installing the objects.

q  SwissSalary NAV customers using NAV versions 2009 SP1 RTC & 2009 R2 RTC
We would like to inform you that the PreUpdate version 5052.100 of May 1, 2018 is the last SwissSala-ry
version available for RTC versions of NAV 2009 SP1 and NAV 2009 R2. Classic Client versions of NAV 2009
SP1 and NAV 2009 R2 (developed in NAV 5.00) will remain supported. The reason behind discontinuation of
these versions is disproportionately high costs for development of these RTC ver-sions of NAV 2009 SP1/R2. In
addition, these particular RTC versions lead to the highest support costs, because their design is very different
depending on the build.

q  SwissSalary NAV customers using NAV DB versions 4.00 SP2 and 4.00 SP3
We would also like to inform you that the update version 5053.000 of October 2018 will be the last SwissSalary
version available for database versions 4.00 SP2 and 4.00 SP3. Beginning from PreUpdate 5053.xxx, there will
be only updates for NAV 5.00 and later versions.

q  ISO 20022 | New Payment Format (XML instead of text)
The new payment file ISO 20022 replaces the existing DTA and EZAG files, and can be consistently used both
for bank and PostFinance transfers. All bank customers have to switch to ISO 20022 by July 1, 2018. Start the
transition today. For details, please refer to our notes at our website and the 5052.000 Update manual of
October 2017.

q  SwissSalary Role Center | RTC clients starting from NAV 2009 SP1
Since the introduction of the RTC Client, SwissSalary has been using a clearly arranged and intuitive Role
Center. However, we have discovered time and again that some of our customers had not been using it.
System Administrator Manual contains important information thereto.

We hope you will enjoy the latest version of SwissSalary and åhank you for the valuable improvement
suggestions we could implement for you!

Your SwissSalary Team
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4.1.1.2    Improvements

4.1.1.2.1    Employee Card | new table reason for resignation

Task #8823 | 5052.100

There is the Reason for Resignation table in human resources (PIS). However, HR are not used by all
customers or are not licensed to all customers. For this reason, we have created the new Reason for
Resignation table in SwissSalary ourselves. This can be configured in SwissSalary administration. The field
can be found in the Employee Card under tab Job.

You can define the reasons for resignation yourself using a code and a comment text. You can also con-figure
in the table whether or not the selected reason for resignation may be included in the calculation of personnel
turnover. In addition, the reason for resignation from the company is removed if the resignation date is deleted.

The reasons for resignation and the assignments recorded in Human Resources are transferred to the new
table during the update process.

4.1.1.2.2    Process Payroll | Automatic payroll area selection

Task #8766 | 5052.100

The required payroll area must be specified during wage calculation. It is usually not saved in RTC versions and
must be reentered with each call.

In Classic and RTC clients, payroll area appears as a new value in the Options tab. This means that it no
longer has to be added manually in the Personnel Master Data tab. The most important selection fields are
also displayed in RTC clients. All fields can be displayed via Show more fields. This way, a frequent customer
request is met and the billing process is even more efficient.

4.1.1.2.3    Pay Process | Approval Process

Task #8876 | 5052.100

Using the new approval process, the Create Payment File and Post Payroll processes can be approved by a
supervisor or other user. As soon as the approval process is activated, you can continue creating and
canceling pay processes as a user, but you cannot create a payment file or post wages until another user
approves the pay process.

Activation takes place in Payroll Setup -> tab General -> Approval process field (set to activated). You will see
the "Approval" button in the Pay Process list in the ribbon. Once you have created a pay process, any second
user (e.g. supervisor) can approve it for payment. After confirmation, the payment file (DTA/ISO 20022) can be
created and then the wage can be posted. This process is documented in the payroll journal in columns
Approved, Date of Approval and Approved by.

Note
The user that creates the pay process cannot release it oneself.

4.1.1.2.4    Work Calendar | Working Group | Flexible configuration options

Task #8801 | 5052.100
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Workgroup settings of the working time calendar have been completely revised and made more flexible. The
old options were sometimes confusing and with multiple arrangement, and could not meet the de-mands of our
customers and partners for further and more flexible automatism.

The 5 wage code tabs on the Workgroup Card have been moved to the ribbon:

After the update process, all existing settings will be moved to the settings in the ribbon. The old options are
still available, but have been expanded with new settings.

Fig.) Example of Monthly wage setup according to LMV (construction industry):

Period Week and month (before)
Day (now)

By selecting the period, over-/undertime can be
calculated based on a weekly or monthly nominal
(now also per day).

The example above covers the needs according to the
construction industry LMV (GAV). At the weekly level,
it should be checked that employees with 48h and
more per week get reimbursed. No more than 20
hours per month, or no more than 100 overtime hours
in the balance. 

Calculation Type Positive difference with target time
before: plus 1, plus 2, plus 3

Negative difference with target time
before: minus 1, minus 2, minus 3

Fixed limit value
used before, for example with weekly hours
calculation

Order With the Sequence, you determine with 1, 2, 3, etc.
the calculation of individual settings per calculation
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type. So far, they were limited to a maximum of 3
options. From now on, they can be defined without
limit.

Period limit Maximum limit per day, week or month

For examples, see above:

Week:
If the actual time of 48h per week is exceed, the
payment is made with ST 3020 owing to the specified
Fixed Limit Value calculation type. If 48h are not
reached or not exactly reached, no action is required.

Month
The employee works for 15h more in terms of target
time of the month. These 15h will be increased with
ST 1770, provided that the balance limit of 100h is not
exceeded. If the total balance is also exceeded, the
hours will be increased up to max. 100h with ST 1770
and the remaining hours will come in the sequence
under No. 2.

Balance Limit Maximal limit in the total balance.

Salary Type No. Corresponding salary type number to be retrieved
when fixed limit or difference with target time is
exceeded.

Employment % Limit The limits usually refer to a 100% workload. If the limit
values are to be adjusted or reduced based on the
percents by position, a check mark can be set for
each setting (rarely).

The Integration tab remains on the Workgroup Card. Here you adjust per wage code, whether the difference
calculation is to take place (target and actual time including compensation), whether only the target and actual
time should be calculated without hour compensation or whether no calculation should take place.

4.1.1.2.5    Employee Dossier

4.1.1.2.5.1   Employee Dossier | Access privileges to documents for person in charge

Task #8865 | 5052.100

You can authorize the head of department to view their employees’ data (Employee Card) as well as the dos-
sier entries filed for the employee. By means of restrictions per document type in the employee dossier you
can block individual types for the head of department.

The head of department must be a Dynamics NAV user. Enter the corresponding default permissions together
with your NAV administrator or your Dynamics NAV partner (SWS-*, usually grant read access rights only).

The setup continues in the Employee Card in the Department field. Assign the supervisor to the corresponding
department.

Switch to the user settings (SwissSalary administration) and select the two columns Department Permissions
and Staff No. Enter the head of department under User ID, place a check mark next to department permissions
and enter their Employee number in the Employee No. column.
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The head of department now has access to the staff card of their employees and can see the contents. S/he
also has access to his employees’ dossier. 

You can select the Person in Charge Access column in the Document type column of the employee dossier.
Place a check mark next to the document types the person in charge is allowed to view.

Example

You have defined the following document types:
- curriculum vitae
- payslip
- wage statement
- reports
- medical certificates

You want to give the head of department access to all document types, except for medical certificates,
because they contain sensitive data. Then please put a tick in the Person in Charge Access column, except
for the medical certificates type.

Please refer also to our instructions about limited access rights for heads of departements in Career.

4.1.1.2.5.2   Employee Dossier | Copying enabled client change

Task #8603 | 5052.100

The Copy Employee feature (available in the Employee Card/Personnel List) is a practical functionality for
copying all employee data from the old client to a new client. This feature is required when switching to another
client. It is debatable which documents should be copied in the dossier. Payslips and wage statements of the
previous client are hardly interesting in the new client. In contrast, other document types are needed in the new
client as well. 

In the employee dossier, you will find the Copy feature enabled column in the document type. Select once the
document types to be copied during client change.

4.1.1.2.6    Resources Module | Connection in SwissSalary

Task #8143 | 5052.100

SwissSalary and the Resources module are now interconnected. Companies working with the Resources
module can now automate the creation of a new resource when a new employee is entered in SwissSalary.

The goal is to create a new resource automatically when entering a new employee in SwissSalary and to link
the resource number in Human Resources as well. If the last/first name of the employee is changed in
SwissSalary, it will also change in the Resource.

Begin setting up in the SwissSalary Payroll Setup -> tab Setup. There, you will find the two fields Resource
Connection and Resource Data Template. Please note that the PIS connection check mark must be set
(synchronization between SwissSalary and Human Resources - PIS). 

Set a check mark in the Resource Connection field and enter the desired master data template in the Re-
source Data Template field (Table/Page 8618 Config. Template header). If you also create manual re-sources in
the Resources module, you must ensure that the two number series of SwissSalary and the Resources
module do not get in each other’s way.
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It should be noted with the master data template that the VAT product posting group is listed after the product
posting group. If the product posting group assigned a pre-VAT product posting group, the VAT product posting
group would be overwritten with the pre-VAT product posting group when the product posting group is entered
(note the order of input of individual fields). 

For the master data template, the “Base unit code” field must be set to “Skip relationship check”, other-wise
an error message will appear that the resource unit is not available.

4.1.1.3    Employee

4.1.1.3.1    TimeMachine | New fields | Departement, Function, Salary Class and Salary Step

Tasks #8464 und #8877 | 5052.100

We have expanded the TimeMachine with the Department, Role, Salary Class and Salary Step fields.

4.1.1.3.2    Salary Class/Salary Step | Description increased to 50 characters

Task #8790 | 5052.100

The description of Salary classes and wage levels have been increased from 30 to 50 characters.

4.1.1.3.3    Personnel Dimensions | Locked Dimensions are no longer displayed

Task #8834 | 5052.100

When personnel dimension(s) are selected in the Employee card/list, only the active dimensions are displayed
for selection.

4.1.1.3.4    Payroll List | Nationality can be adjusted

Task #7290 | 5052.100

In the pay process list (available in the ribbon via the Employee Card/Personnel List), some journaled data like
employment/resignation dates, partner information, ZIP Code/City, tax municipality, etc. can be changed. This
is sometimes necessary if data was not correct at the time of wage calculation. This is often done during end-
of-year processing and/or withholding tax reporting via ELM.

The employee's nationality journaled during the pay process can now also be modified in the pay process list.

4.1.1.3.5    Human Resources (PIS)

4.1.1.3.5.1   Career | New table activities and new fields

Task #8822 | 5052.100

There is a new Activities table in Career -> Activities column used to define requirements. Using it, activi-ties
like qualification discussions as well as groups like Heads of Departments, Supervisor, etc. are defined.

Moreover, the ZIP Code/City and Country Code/Region columns (will be filled automatically depending on the
ZIP code/city) have been added. Using them, local place of this position can be defined in "previous position" of
Career.
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4.1.1.3.5.2   Career | Limited access rights for heads of departments

Task #8864 | 5052.100

You can also grant the supervisor limited access rights in Career (Human Resources) similarly to access
rights for the head of departement to employee dossier To do this, the setup steps are to be applied as
described in the  employee dossier.

In Career, you can display the Person in Charge Access column in the Activities column. Similarly to the
employee dossier, you can decide which entries based on the activities of the head of department can be
viewed and which cannot.

4.1.1.3.5.3   Human Resources | Matrix uses filter from the Employee Card

Task #8892 | 5052.100

NAV versions 4.00 SP2 - NAV 2009 R2 Classic

In Human Resources (PIS), you can open three matrix windows Staffing, Confidential Assignment and
Qualification. They now use the active filter from the SwissSalary Employee Card. Only active employees are
displayed.

4.1.1.4    Salary Types

4.1.1.4.1    Following Salary Type | Number of factors with the new hours/days option

Task #8853 | 5052.100

When calculating automatic resulting wage types, the number entered is transferred to the resulting wage type
(by factor). If, for example, absence hours are recorded per day, this value is transferred by factor. If, however,
the number of days is to be transferred instead of the number of hours, the Days Option field can now be
selected in the Number field.

Example

A sick leave is recorded with 8h. In the background, the hours are automatically converted into 1 day of sick
leave. If a resulting wage type is appended to this wage type, these 8h are passed on as the initial value to the
resulting wage type. With the Days option, 1 day was passed on as reference instead of 8h.

4.1.1.4.2    Following Salary Type | Recurring error corrected

Task #8732 | 5052.100

If the same wage type was used by mistake when using resulting wage types, there was an endless loop that
in the worst case caused the client to crash. This has been corrected so that it is no longer possible to call the
same wage type repeatedly. In addition, meaningful error messages indicate this.

4.1.1.5    Pay Process

4.1.1.5.1    Payroll Journal & Allocated Salary | New fields updated by/at

Task #8835 | 5052.100

Two new columns tat cannot be mutated manually were introduced in the Report journal and in wage items:

- Updated by
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- Updated at

Owing to these two columns, it is clear who created the record and possibly changed it last.

4.1.1.5.2    Payroll Journal & Allocated Salary | Recording to project with global dimension 1 & 2

Task #8646 | 5052.100

During activity recording in the Report journal or wage items in projects, only the assigned dimension 1 (mostly
cost center) was moved automatically. If dimension 2 (mostly cost unit) is assigned to the pro-ject, it will now
also be added.

If reporting took place on a wrong project and it was replaced with the correct project, the corresponding
dimension 1 was not updated. The error has been corrected.

4.1.1.5.3    Payroll Journal & Allocated Salary | Project Tasks | Dimension 1 & 2

Task #8804 | 5052.100

If dimensions 1 & 2 are configured in project tasks (usually cost center & cost unit), the dimensions recorded
in the report tasks are retrieved during reporting in the report journal and in wage items. If there are no
dimension entries in project tasks, the dimensions stored in the project are retrieved.

4.1.1.5.4    BAU | Reporting on devices | considering locked devices

Task #8585 | 5052.100

Concerns only the customers with SwissSalary BAU and with reporting on devices.

Reporting on devices that are locked in terms of time should not be possible. Logic was implemented.

4.1.1.5.5    TapBoard | New date control (back/forward arrow)

Task #8881 | 5052.100

Versions NAV 2013 and newer

Open the TapBoard. Earlier you had two fields for selection, Month and Year. They were removed.

You always open the TapBoard in the current month and can switch from month to month with the two controls
in the ribbon (left and right arrows).

4.1.1.5.6    TapBoard | Total column now black (positive) and red (negative)

Task #8631 | 5052.100

RTC versions of NAV 2013 and newer

Previously, the number in the Total column was always highlighted in red, no matter if the sum was positive or
negative. For better clarity, a positive number is displayed in black and a negative number is displayed in red.

4.1.1.5.7    Process Payroll | Payout date (suggestion) same as current date

Task #8807 | 5052.100
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Payout date (foreign currency) is suggested during wage accounting. If you work with down-payment payroll
method and want to create a definite pay process in the following month, you will be offered a date in the past.

We have improved this by adding the current date as a suggestion to settlements in the previous month.

4.1.1.5.8    ISO 20022 | Expense regulations incorporated for payments from abroad

Task #8792 | 5052.100

For payments abroad, expense regulations can be defined in the employee's bank account.

The Expense Regulations field has the following options:
- Employer
- Employee
- Division (most cost-effective option, a prerequisite for SEPA payments)

4.1.1.5.9    Reporting when writing DTA- or ISO 20022 file with invalid directory

Task #8714 | 5052.100

In case of an invalid directory or when no permission is granted when writing the DTA or ISO 20022 file, the file
is nevertheless written to a temporary user directory. Then the file could not be located, if need be.

After creating the file, a message will be displayed indicating where the file was written to.

4.1.1.6    Salary Declaration

4.1.1.6.1    ELM | Always show UVGZ totals, even at CHF 0.00

Task #8746 | 5052.100

Usually several UVGZ codes are set up for UVGZ.

Example:

Code A0 = not insured
Code A1 = insured for up to CHF 148'200
Code A1 = insured for CHF 148'200 and above

In the case of ELM reporting, wage sums are reported per employee and per UVGZ code. A recap per code is
at the end of the message. So far, only if a value was not equal to CHF 0.00, it would be included in the recap.
However, some insurers also request that CHF 0.00 be reported in this case. From now on, the totals of the
codes with CHF 0.00 will also be reported.

4.1.1.6.2    ELM | Income tax reporting after resignation

Task #8759 | 5052.100

If an employee subject to withholding tax resigns from the company, s/he must continue to report as part of
withholding tax reporting by the end of the year (with the date of resignation). Employees only have to remove
the Subject to tax check mark in the Employee Card, the remaining settings like canton, rate, number of
children, etc. remain assigned.
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The guidelines for ELM reporting are somewhat contradictory as to how an employee should be reported
monthly after resignation. Despite automatic reporting at resignation, the employee was still reported with a
wage base of CHF 0.00. Some cantons could not do anything and have criticized this. After the resignation, no
salary basis will be reported for the resigned employee in the monthly report.

4.1.1.6.3    ELM | Income tax response | First/Last Name longer than 30 characters

Task #8760 | 5052.100

The canton of VD is the only canton to return a rate response after a ELM report on income tax. Both first and
last name of the employee subject to withholding tax are included in it. From time to time this name is longer
than 30 characters, which led to an error when importing the data. This import bug has been fixed.

4.1.1.7    Administration

4.1.1.7.1    Payroll Setup | Foreign exchange rate definition

Task #8765 | 5052.100

The rate should to be taken into account when using foreign currencies is determined in the Payroll Setup ->
tab General -> field Foreign Curr3ency Exchange. Until now, the VAT rate has been used.

Selection of the Foreign Exchange Rate field (Currency Exchange Rate table):
- VAT course (default selection)
- Valuation rate
- Rate

4.1.1.7.2    Work Calendar | Day types expanded

Task #8632 | 5052.100

RTC versions of NAV 2013 and newer

In RTC versions, you have the option of displaying info boxes (fact boxes) to get clear data record in-formation.
The working time calendar displays the holidays for you. To show information boxes of holi-days, business
closure and work-in-advance days, we have extended the tag types with the Type column.

Example

Today, the following day types are used for the Working Time Calendar:

- A = Working time
- B = Business closure
- F = Holidays
- V = Work-in-advance days 

Add relevant value to your existing entry in the Type column. We try to assign the correct value to your
existing codes during the update process. Review the assignments after the update process. After the
assignment, you will see various info boxes in the Working Time Calendar (as long as you have holidays as
well as business closure and work-in-advance days). Owing to this new assignment option, you can also use
different or multiple codes per type.
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4.1.1.8    Reports | Interfaces

4.1.1.8.1    Paycheck | Additional sorting options incorporated

Task #8449 | 5052.100

There is a variety of sorting options in the old NAV Classic versions to order the printing of payslips. This
selection in RTC versions has been reduced to the most common sorting.

Following multiple customer request, payslip printing in RTC versions can be sorted as follows:

- Pay Process No., Personnel No. (before: default setting)
- Personnel No., Pay process No. (before)
- Pay Process No., search keyword (before: by last name, first name)
- Pay Process No., workplace, search keyword (now: by workplace and then by last name, first name)
- Pay Process No., department, search keyword (now: by department and then by last name, first name)

4.1.1.8.2    Salary certificate | Remark texts (paragraph 15) for income tax canton of GE

Task #8731 | 5052.100

The following information must also be listed on the wage statement for employees subject to income tax in
the canton of GE:

- SSL number
Employer Payroll Number
(Payroll Setup -> IT Settings -> line GE -> field “IT Account No.”)
 
- Cumulated WT wage
 
- Most recently used rate code
e.g. A0N
(rate code from the most recent pay process of employees at the end of the year or at resignation)
 
- Most recently used tax rate
e.g. 12.87%
(rate code from the most recent pay process of employees at the end of the year or at resignation)
 
- fiscal period in the canton of Geneva
Only the affected periods can be displayed with billing in the withholding tax Canton of GE.

This data is only required for the Canton of GE. The above information must be entered in paragraph 15. There
will be new Standard Remarks in the Wage Statement section of the XML schema in the next version of the
CH Wage Standard (ELM) (version 5.0, approx. 2019/2020).

Please note that document Quittance Attestation no longer has to be created and sent, provided that this
information is shown on the wage statement.

4.1.1.8.3    Income tax | Deprecated reports and interfaces removed

Task #8847 | 5052.100

The following deprecated reports and interfaces were removed:

- Passerelle VD interface (Report 3009083)
- ISEL GE interface (Report 3009243)
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- Trattenuta TI report (Report 3009184)
- FR withholding tax wage statement report (Report 3009229)

These evaluations and interfaces have not been used since the introduction of the withholding tax declaration
via ELM with version 4.0 (since 2013). Notes for individual cantons:

Canton TI
Please log in to iFonte and submit the IT report monthly via ELM. You can create the original payroll forms as
well as the Trattenuta online at the end of the year.

Canton VD
Please submit the IT report monthly via ELM. Passerelle VD is still only used for manual online reporting (not
via ELM).

Canton GE
Please submit the IT report monthly via ELM. The transmitted data can be viewed in the ISEL application.
Quittance attestation is no longer required.

4.1.1.8.4    Report 3009134 SuNet interface 4.00-1083 removed

Task #8777 | 5052.100

The old Sunet interface has been removed from the system because it is outdated and no longer supported by
the provider. The current Sunet Plus version is not affected and is still active.

4.1.1.9    SwissSalary Direct

4.1.1.9.1    Report card | Sending via SwissSalary Direct

Task #8623 | 5052.100

In addition to payslip and wage statement, the report card can now also be sent via SwissSalary Direct. In
doing so, we fulfill an often mentioned request of our customers.

Please note that you must create an entry in the employee dossier. To do this, go to the Document type
column, select the Report Assignment column and assign the report card value to the corresponding code.
After this assignment, you can send the documents, as customary for payslip/wage statement.

4.1.1.9.2    No registration code for new employees without prior synchronization

Task #8680 | 5052.100

No registration code appears on the Registration Code report for new employees, unless the synchronization
has been done previously. We have improved this, there is no need for any previous synchronization.

4.1.1.9.3    Client name field filter fills automatically during client setup

Task #7574 | 5052.100

When copying existing clients or creating new clients, it must be ensured that the synchronization according
to SwissSalary Direct with the wrong client does not take place by mistake (if a copy of the client is created,
the employees are also copied 1: 1). Previously, there was an error 1002 or 1001 to point to the copied client.

The Client Name Filter field will be filled automatically with the “new” client name if a new client is created and
is therefore unique.
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4.1.1.10    Bug fixes

4.1.1.10.1    Employee

4.1.1.10.1.1   Years of services | conflict w ith the presentation of date in international data bases

Task #8700, Task #8769 & Task #8806 | 5052.100

When opening the Years of Service table, an error message appeared is different date formats were worked
with. They can be recognized by the following presentation of date fields: 2/5/2001 or 2001/5/2 instead of
02.05.2001. The problem was that e.g. the NAV server is located in England and Switzerland is working with
the Swiss language settings (Windows language).

This problem has surfaced in some international companies as well as with SwissSalary 365 customers.

4.1.1.10.2    Process Payroll

4.1.1.10.2.1   Reporting | BAS Import (as cu by mistake)

Task #8695 | 5052.100

Concerns the BAU version

The Excel import in the report journal has been adapted in the BAU version. When BAS was imported, it was
written to the Load KTR field by mistake (BASs are rarely used).

4.1.1.10.2.2   Process Payroll | Foreign currency | Calculation of FC rate for part-time

Task #8893 | 5052.100

When calculating the FC (foreign currency) rate, a calculation error has crept in with part-time employees. It
was corrected and the view in wage items is now correct.

4.1.1.10.2.3   Net/Gross calculation | Incorrect sign when offsetting for KTG/UVGZ

Task #8688 | 5052.100

During net/gross calculation of individual wage types, a calculation error has crept in the KTG/UVGZ.
Provisions for the employers were negative rather than positive.

4.1.1.10.2.4   Focus on the selectec pay process

Task #4500 | 5052.100

When FIBU posting journal, DTA or ISO 20022 file, compensation order etc. are selected, in some cases the
last pay process was filtered instaed of the actually selected pay process.

4.1.1.10.2.5   Provisional cost submission | automatic transfer after Salary posting | down-payment process

Task 7795 | 5052.100

The Report Journal enables settling previously recorded reports automatically (wage accounting and posting)
and transferring them provisionally to the cost accounting sheet or into the project recording journal. The name
of the function was adjusted from Prov. Cost Accounting Submission to Provisional Cost Submission.

In addition, if SwissSalary EasyRapport is used, there is an option for automatic data transfer to EasyRapport
after the wages have been posted. This automated process was also started during the provisional cost
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submission, which is incorrect. In addition, the submission may not take place during a down-payment
process.

4.1.1.10.2.6   Provisional cost submission | FIBU interface file not written

Task #8787 | 5052.100

During provisional cost submission, the pay process is canceled again after automated posting. If the data is
also filled into the FIBU interface file, this file was also written during provisional cost submission by mistake.

4.1.1.10.2.7   Sending Paycheck as PDF | completion nofification streamlined

Task #8824 | 5052.100

The completion notification was improved for payslips emailed in an unencrypted form via PDF. If no drive was
specified to save the PDF documents, the message saying that the documents were placed in the folder and
sent was confusing. The completion notifications are now output correctly depending on the method of delivery.

Note
We would like to point out that it is necessary to reconsider unencrypted payslip and wage statement delivery
from the point of view of data protection. We recommend that you use encrypted solutions like our own
Employee Portal SwissSalary Direct.

4.1.1.10.3    Salary Declaration

4.1.1.10.3.1   ELM | Error message in case of a child w ithout date of birth

Task #8845 | 5052.100

In case of ELM reports, there was an incomprehensible error message from time to time if a child’s birth date
was missing. This error message is now legible and indicates that the date of birth is missing.

4.1.1.10.4    Reports | Interfaces

4.1.1.10.4.1   WebClient | Fibu posting journal | Label enhanced

Task #8775 | 5052.100

This adjustment only concerns printout preview in the WebClient (especially in SwissSalary 365).

The name of the FIBU account was truncated in the FIBU Posting Journal in the WebClient if the text was
longer. There is no problem in the RTC client.

4.1.1.10.4.2   Salary and absence statistic | Assessments for printing revised

Task #8736 | 5052.100

Both assessments of wage and absence statistics were displayed correctly in the RTC versions (preview), but
when printed, numbers were cut off.

4.1.1.10.4.3   Rate fluctuation | Wrongly calculated opening balance

Task #8709 | 5052.100

Fluctuation rate assessment calculated a wrong opening balance depending on the constellation of the date
filter (To date).

https://swisssalary.ch/produkte/swisssalary-direct
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4.1.1.10.4.4   BVG Accounting | Revision

Task #8728 | 5052.100

BVG Accounting has been revised and an output bug was fixed.

4.1.1.10.4.5   KTG Accounting | Bug in the company address fixed

Task #8791 | 5052.100

In KTG Accounting, the company address was not printed in RTC reports.

4.1.1.10.4.6   Human Resources (PIS)

Task #8856 | 5052.100

The years of service were not rounded to two decimal places on the PIS sheet.

Task #8857 | 5052.100

On the PIS sheet, the Comment column was listed twice in the Staffing area and an option value displayed
incorrectly.

4.1.1.10.5    Administration

4.1.1.10.5.1   Post Payroll | Individual posting texts corrected

Task #8690 & Task #8706 | 5052.100

Posting text for the FIBU, cost accounting and projects can be individually provided in Payroll Setup -> ribbon -
> tab NAVIGATE -> Translation -> System using placeholders. The following placeholders serve this purpose:

%1 = Payroll area
%2 = Posting date
%3 = Posting month (text)
%4 = Posting year (YYYY)
%5 = Pay process
%6 = Posting month (number)

Starting from Update 5052.000, these placeholders were no longer considered by mistake. The correction has
already been delivered with 5052.001 hotfix in early January 2018. The subsequent correction for the BAU
version will be included in this PreUpdate 5052.100.

4.1.1.10.5.2   User name | Field length adjusted

Task #8831 | 5052.100

If user names were larger than 30 characters, an error message appeared when printing the wage statement.

4.1.1.10.5.3   WebClient | Exporting Work calendar into Excel

Task #8659 | 5052.100

Working time calendar could not be exported into Excel.
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4.1.1.10.6    SwissSalary Direct

4.1.1.10.6.1   SwissSalary Direct | Error 500 | Translation missing

Task #7994 | 5052.100

In the SwissSalary Direct settings, the default title texts for payslip, wage statement and report card can be
translated depending on the company. If only one language code without text is entered by mistake during the
setup in the translation table, the Error 500 message appears at the next delivery. Since this message can
mean anything or nothing, our support has been looking for the error for a long time.

We have implemented validations so that this error can no longer occur.

4.1.1.10.7    SwissSalary EasyRapport

4.1.1.10.7.1   Target time posting | Consideration of precents by position on the time axis

Task #8846 | 5052.100

This correction concerns SwissSalary EasyRapport customers who do not work with the down-payment payroll
method but work with month-shifted time posting.

The problem is that this method considers the periods of both systems differently. The pay process takes the
time period from the previous month into consideration. If the employee changes his/her level of employment,
then the target time valid for the previous period must be taken into account to determine over-/undertime or
calculate target time according to the percents by position then valid.

Example

An employee has the following levels of employment:
January = 70%
February = 90%

In this calculation option, hours from January are processed in February pay process. This means that the
employment level of 70%, and not the current employment level of 90%, must be taken into account for the
target time in February pay process.

When using time and performance recording systems, we always recommend that the down-payment payroll
method be used, as this unifies the periodicity of the systems.

4.1.1.10.7.2   NAV 2009 RTC | Target/Actual time display supressed

Task #8849 | 5052.100

Concerns exclusively the RTC Client of NAV version 2009

In the payroll area, you define which balances are to be displayed on payslip or in EasyRapport. The columns
for actual time and target time were not available in the RTC Client of NAV 2009.

4.1.1.11    Notices for our partners

4.1.1.11.1    Allocation Group-Filter | New Codeunit created

Task #8550 | 5052.100
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The payroll area filter is used by the user, provided that s/he only has access to certain payroll areas. The old
filter is outdated and had the disadvantage that it had to be installed separately for each form (Clas-sic) and for
all pages and reports.

For this purpose, the new code unit 3049205 SwS Allocation Group Mgmt has been developed. This is now
centrally responsible for correct processing of the payroll area filter.

The old functions in the Codeunit SwS Salary remain, but have been set to “local=yes”. This makes it possible
to see if there are any company-specific objects that reference them. These objects can be switched to the
new function. During hurried work, it can be temporarily changed to “local=no”.

4.1.1.11.2    Organization | Test clients | Fire all employees

Task #8825 | 5052.100

The feature is available starting from NAV 2013

For SwissSalary license verification, all active employees in all clients are added up. If a test client is created
(copied), all employees are also copied to the test client and are therefore duplicated.

Previously, the output data had to be entered manually for the employees in the test client. We have de-
veloped an automatism to set the date of resignation for employees. The function can be called up via
Organization -> Navigate -> Resignation of All Employees (the function is hidden by default and must be
activated in the Role Center).

When starting the function, the user is advised to execute this functionality only in test clients. If the mes-sage
is confirmed, the date of resignation is set to the working date for each employee. If necessary, the date of
resignation can be deleted for individual employees.

4.1.1.11.3    PDFCreator | Newer Versions support | Removal of Codeunit

Tasks #8891 & #8649 | 5052.100

NAV versions 4.00 SP2 - NAV 2009 R2 Classic

You will need PDFCreator to prepare payslips and wage statements for the subsequent mailing or for
SwissSalary Direct. Unfortunately, PDFCreator versions are very different and require different coding in
SwissSalary. We have different code units, but they can interfere with each other depending on PDFCrea-tor
version. PDFCreator is no longer required starting from NAV 2013 (only for old Classic versions).

Code unit 3009202 SwS PDF Creator for the very old version (1.7.3) will no longer be available after this
PreUpdate. 

Please note our blog post on this topic at our website.
We support PDFCreator up to version 1.7.3, from version 2.4 and newer or from version 3.2 and newer. Please
do not use versions 3.0 + 3.1 because they cause timeouts. You can find the respective code unit at our
website.

4.1.1.11.4    New Codeunit 309210 SwS Bulk Report Management

Task 8373 | 5052.100

With the new Codeunit SwS Bulk Report Management, the code for generating PDF as well as for emailing
has been combined. Previously, this code was in several reports, sometimes several times. Code combination
makes it easier to maintain and further develop the code.
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4.1.1.11.5    Dataports removed from Classic Versions

5052.100

NAV versions 4.00 SP2 - NAV 2009 R2 Classic

SwissSalary data ports are no longer used and can be removed.

4.1.1.11.6    Initialization | New fields added

Task #8702 | 5052.100

The initialization file is used to quickly predefine a new client with the most important master data (payroll
setup, salary types, payroll areas, payroll journal, etc.). The file can be exported via organization from an
existing client and imported into a new client. By doing so, a new client can be set up very quick-ly with the
master data of an existing client and then revised.

We have extended the file with additional table fields:

Table 3009158 SwS Absence Claim | Refunding of Absences
- Curtailment correction
- Accounting month claim

Table 3009073 SwS Allocation Group | Payroll Area
- Person in Charge Phone
- System journal
- Wage code
- Salary type No.
- Monthly parts

Table 3009132 SwS Rapport Types | Report Types
- hide

4.1.1.11.7    Excel-Import Buffer | Text field cut to 250 characters

Task #8643 | 5052.100

Table 3009196 SwS Excel Buffer was enhanced to cut off the following content if the number of chars exceeds
250.
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4.1.1.11.8    Codeunit 3009089 SwS Refresh Salary Declaration removed

Task #8818 | 5052.100

Code Unit 3009089 SwS Refresh Salary Declaration is no longer required and as a result removed or delivered
as a “free” object.

4.1.1.11.9    Deleted Fields and Values from Tables after Update 5052.000

5052.100

SwS Employee Table: 
- "Employment Relationship" // DELETED OptionStrings Apprentice and Trainee 
from Field 280 in 5051.100

SwS Employee History Table: 
- "Employment Relationship" // DELETED OptionStrings Apprentice and Trainee 
from Field 280 in 5052.000

Table SwS Bank Account Setup: 
- "Backup Copy (Obsolete)" // DELETED Field 60 in 5051.100
- "Backup Folder (Obsolete)" // DELETED Field 61 in 5051.100
- "Last Backup No. (Obsolete)" // DELETED Field 62 in 5051.100

Table SwS EasyRapport Setup: 
- "Auto. deactivate Resign(obsolete) " // DELETED Field 163 in 5052.000

4.1.2    Update 5053.000 (25.10.2018)

4.1.2.1    Introduction

Dear SwissSalary Customers,
Dear SwissSalary Partners,

We present to you the manual for SwissSalary Update 5053.000 of October 25, 2018. Your SwissSalary will
be up to date after installing this release. We can offer you some great new features.

IMPORTANT NOTES

q Please make sure that a version not older than 5052.000 of October 26, 2017 was installed before this
update. If your NAV partner has made company-specific changes to your SwissSalary NAV objects, you
must contact your NAV partner prior to installing the objects.

q SwissSalary NAV customers using NAV versions 2009 SP1 RTC & 2009 R2 RTC
We would like to inform you that the PreUpdate version 5052.100 of May 1, 2018 was the last SwissSalary
version available for RTC versions of NAV 2009 SP1 and NAV 2009 R2. Classic Client ver-sions of NAV 2009
SP1 and NAV 2009 R2 (developed in NAV 5.00) will remain supported. The reason behind discontinuation of
these versions is disproportionately high costs for development of these RTC versions of NAV 2009 SP1/R2. In
addition, these particular RTC versions lead to the highest sup-port costs, because their design is very different
depending on the build.

q SwissSalary NAV customers using NAV DB versions 4.00 SP2 and 4.00 SP3
We would also like to inform you that the update version 5053.000 of October 2018 will be the last SwissSalary
version available for database versions 4.00 SP2 and 4.00 SP3. Beginning from PreUpdate 5053.xxx, there will
be only updates for NAV 5.00 and later versions.
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q SwissSalary Role Center | RTC clients starting from NAV 2013
Since the introduction of the RTC Client, SwissSalary has been using a clearly arranged and intuitive Role
Center. However, we have discovered time and again that some of our customers had not been using it.
System Administrator Manual contains important information thereto.

q As of January 1, 2019, partner information is obligatory for the ELM submission
The transitional period for partner information maintenance for married employees and those in a regis-tered
partnership subject to withholding tax will expire after 6 years. Please note that you should enter this data in
the system if possible by the end of 2018 and also record it correctly for new employees. Please take note of
our article in this Manual.

We hope you will enjoy the latest version of SwissSalary and thank you for the valuable improvement
suggestions we could implement for you!

Your SwissSalary Team
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4.1.2.2    Improvements

4.1.2.2.1    Employee Templates

Task #9071 | 5053.000

This change concerns RTC versions of NAV 2013 or newer exclusively.

Employee templates for creating a new or changing an existing employee could previously be defined only via
the payroll area. However, these templates were usually not detailed enough, since most customers work with
payroll area ALL and, if need be, MW and HW. Multiple payroll areas creation, just to define templates, made
no sense.

With the new employee templates, the prefilling may be much more detailed. You can define any number of
templates and also create a new template from an existing employee.

Creating new employee template
1. Select the desired employee in the Employee Staff List and switch to the Employee Card.
2. Choose the Save As Template feature in the Ribbon -> Actions -> Templates.
3. Choose the name for the new template in the Template Name field. All default values are already in the
template. Of course, you can make changes directly in the template.
4. Click OK to finish creating a new template.

Creating new employees using an existing employee template
1. Right in the Employee List or Employee Card, select Actions -> New Employee from Template in the
Ribbon.
2. The existing templates will be displayed.
3. Select the desired template and click OK.
4. The settings will be are acquired based on the template. Record other individual data you your employee.

Assigning a new employee template to existing employees
1. Select the desired employee and switch to the Employee Card.
2. Ribbon -> Actions -> Apply Template.
3. Select the new template and confirm by clicking OK.

Editing the existing template
1. Select any employee and switch to the Employee Card.
2. Ribbon -> Actions -> Templates -> Templates.
3. Choose the desired template and edit it via Actions -> Edit.

Please note that the assignments to social security are also set up in the Ribbon.

If you have set up a new employee using an employee template, similar assignments are no longer con-
sidered in the Payroll Area. The options in the Payroll Area will be revised in a later update. If you do not want
to work with the new employee templates, you can still work with the templates in the Payroll Area, as before.
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4.1.2.2.2    Income Tax | Partner information obligatory as of January 1, 2019

Task #9081 | 5053.000

As has already been announced several times (in manuals, news, blogs), after January 1, 2019 ELM sub-
missions can only be transmitted to the IT offices provided that partner information for married employ-ees and
those in a registered partnership subject to withholding tax is recorded as of this date. Beginning from
Dynamics NAV 2017 (SwissSalary 365), if this data is missing it will be displayed in notifications.

Individual data is written into the Pay Process Header table during wage accounting and archived this way. If
you have set the ELM notification to PIV in Payroll Setup -> tab IT, it is already checked during wage
accounting whether all the required data is available. Please make sure that starting from January 2019 you do
not transmit IT via ELM if this data is missing.

It is about the following information that must be maintained after January 1, 2019 or after the import of this
update regarding employees subject to withholding tax with ‘married’ or ‘in a registered partnership’ civil status:

q  Partner's last name
q  Partner's first name
q  Partner's date of birth

additionally, if known:

q  the address of the partner (if not specified, the address of the wage recipient is acquired)
 If the partner lives at another address, the following information must be recorded:
 - ZIP code, city and canton abbreviation or EX (address abroad)

q  partner's social security number (optional)

The following information is to be entered in the second tab, provided that the ‘C-dual earners’ or ‘N-Cross-
border German Dual Earners’ IT rate is recorded:

q  income; with no indication of amounts, but:
- wage or wage replacement
- wage, wage replacement and pension
- pension

The following fields are mandatory if the Wage or Wage Replacement or Wage, Wage Replacement and
Pension value is recorded in the Income field:

q  workplace (canton); canton abbreviation or EX (employment abroad)
q  beginning of employment; partner’s employment assumption date

If you choose the Pension value for Income, no other information in required in this tab.

Optional fields in this second tab are:

q  Occupation; Main Occupation or Additional Occupation
q  End of Employment; Partner’s Employment Task Assignment Date

4.1.2.2.3    Liability to Income Tax | TimeMachine for retroactive reimbursement or subsequent charge

Task #7348 | 5053.000
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The Canton and the Rate Code fields are already changed retroactively with TimeMachine (timeline) in the
Employee Card -> IT tab. By setting the correct ‘Valid from’ date, the corrections and the sub-sequent
correction report via ELM are made automatically.

There was generally no retroactive entitlement to exemption (reimbursement) or retroactive IT calculation
(subsequent charge) via time line. The Liability to Withholding Tax field now has the Yes/No option (previously
check mark) and supplemented by TimeMachine.

Example A (retroactive annulment of withholding tax obligations)
IT was deducted for employee A up to and including September using rate A0Y. By decision of the withholding
tax office, the employer is informed that the employee received residence permit C in July and therefore is no
longer subject to withholding tax beginning from August. The deductions from August to September are to be
reimbursed to the employee in the October pay process.

Open TimeMachine in the Liability to IT field and set the Valid from value to 01.08.2018 and choose No. With
the wage accounting process, the base and amount corrections (refund) are carried out automatically.

Example B (retroactive IT obligations)
Employee B will be employed from July 1. The employer assumes that the employee already holds residence
permit C or, if necessary, the Swiss passport. Before the November pay process, the IT office informs that
payroll has not yet been run for the employee. Inquiries show that employee B holds permit B and is therefore
subject to IT.

Open TimeMachine in the Liability to IT field and set the Valid from value to 01.07.2018 and choose Yes. With
the wage accounting process, the base and amount corrections (subsequent charge) are carried out
automatically.

IMPORTANT NOTE
The correction of retroactive IT obligations can only be made after the import of update 5053.000 and only for
periods after this date. The reason for this is that a withholding tax base must be available for previous months’
retroactive obligations for. Up until now, it was only created for employees subject to IT (from now on, for all
employees from the time of installation of update 5053.000).

4.1.2.2.4    Income Tax calculation | Retroactive rate correction after residence permit receipt

Task #9080 | 5053.000

Situation:
employee is subject to IT up to and including August 2018, as s/he has been issued residence permit C in
August 2018. In September 2018, s/he receives a wage without withholding tax deduction (no longer being
subject to WT). In October 2018, the employer is informed that the employee was assigned a wrong IT rate in
July and August.

We have checked such individual cases using the new TimeMachine feature ‘IT obligations’ and in this case
retroactively corrected the rate only. The rate correction (July/August) was correct in the October payslip.

Individual calculation cases are highly complex. We look forward to your feedback if calculations could not be
done correctly in an individual case.

4.1.2.2.5    Enhancement of notification | Staff Bank and personnel Dimension (s)

Task #9061 | 5053.000

Starting from Dynamics NAV 2017 (and SwissSalary 365), there is a technical possibility to display socalled
notifications. Since the last update, we have been informing the users about the mandatory fields that must be
entered on the Employee Card to enable the calculation. As of this version, the staff bank and, in addition, the
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entry under Staff Dimension is also checked if it has been set up in the payroll master data as a mandatory
dimension.

Thanks to these notifications we can inform the users, among other things, if e.g. the assignments to the
partner are missing (compulsory from January 1.2019) in the case of a married employee subject to IT.

4.1.2.2.6    Dossier | New document | Layout completely revised

Task #9069 | 5053.000

The SwissSalary dossier has been completely revised and made clearer. Its structure will be automatically
updated after the update. It can be revised at any time to suit your wishes by means of a list edit.

Now you will find your document structure to the left and the corresponding documents to the right. The ribbon
was massively streamlined. Most features have been moved to the Personnel Dossier section.

4.1.2.2.7    Following Salary Type | Setting from/until times | Automatic calculation of night hours

Task #8965 | 5053.000

Resulting Following Salary Types were extended with the 

- Time from
- Time until

columns.

With the latest updates, we have already presented the option to automatically calculate surcharges on certain
days of the week by the Following Salary types. Now night work hours can be linked to the corresponding
resulting wage types (time bonuses and/or extra pay). They are only retrieved if a certain time period is fulfilled.
This means that in the future special entry wage types will no longer be required for Saturday, Sunday or night
hours. The surcharges can be calculated automatically by entering the Working Hours wage type and the
corresponding resulting wage types.

4.1.2.2.8    Management Rapport Journal & Allocated Salary | Following Salary Type are now displayed

Tasks #6313, #8939 & #9026 | 5053.000

The display of the resulting wage types has been completely revised in the report journal and in wage items.
The resulting wage types are now slightly indented and displayed in italics. This way, a better and more
transparent overview of entry wage types and resulting wage types is enabled.

In the course of common revision of the resulting wage types in the Report Journal and Wage Items, an older
task was executed. In Wage Items, the Valid from and Valid until columns were filled with identical values in
wage types only upon the first input. If the output wage type was adjusted later, the data was not rewritten.

Wage items can be called up from different locations. Owing to the improved display of the resulting wage
types, the entries are displayed by line number.

4.1.2.2.9    TapBoard | from-/until times can be recorded

Task #8964 | 5053.000

A task often requested by customers has been implemented. From now on, from/until times can be rec-orded
in TapBoard, as long as they are recorded as a daily report in the EasyRapport group setup in the report types.
In addition, from/until times recorded in EasyRapport are displayed in TapBoard and on the EasyRapport card.
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From/Until times recorded by mistake can be deleted with 0. It must be noted that both ‘from’ and ‘until’ entries
are recorded with 0.

4.1.2.3    Employee

4.1.2.3.1    Income Tax | Removal of assignments if the employee is no longer subject to it

Task #8446 | 5053.000

When withholding tax is reported via ELM, there is an error message if all assignments are deleted for an
employee no longer subject to IT. We have recommended earlier that you only remove the check mark for
subject to withholding tax. Employees must be reported in the recapitulation by the end of the year.

This procedure was not intuitive and led to many support requests with subsequent corrections.

We have improved the validation so that you can remove the assignments on the Employee Card if the
employee is no longer subject to IT. Manual rewriting of the data via the pay process list is no longer
necessary.

4.1.2.3.2    IBAN Number | Extension to 50 characters

Task #9058 | 5053.000

When a foreign IBAN number (with spaces) was entered, an error message appeared stating that 37 char-
acters were exceeded. We have extended the field to 50 characters so that these numbers with spaces can
also be entered. If without spaces, an IBAN number must not exceed 32 characters.

4.1.2.3.3    Bank List | SWIFT/BIC display

Task #8918 | 5053.000

When the staff banks are called up, first appears the list that can be expanded with additional columns.
Following requests, we added the SWIFT/BIC column so that it can be selected.

4.1.2.3.4    Copying Employee | Dimensions are copied if identical

Task #1583 | 5053.000

The 'Copy Employee' function was enhanced. The dimensions and dimension values assigned in the old client
are also copied if they exist in the target client. If the dimensions and/or dimension values in the target client
are different, a message appears after copying that the dimensions or dimension values could not be copied.

4.1.2.3.5    Dossier | Mailing List Template | Using the employee's language

Task #9070 | 5053.000

Documents for employees can be created directly from the Dossier (certificates of employment, contracts,
letters based on Word templates, etc.). When the document was initiated, the company language was used
instead of the language stored for the employee. Now the correct template language is re-trieved.
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4.1.2.4    Salary Types

4.1.2.4.1    Following Salary Type | Limit amounts validation (per event or per month/year)

Task #8715 | 5053.000

With the last update (5052.000), we presented new validations of the following wage types. Resulting wage
types can be calculated based on minimum and maximum limit amounts.

In this update, we extended this validation with the Limit Amount Calculation field and the following options

- current record
- current month
- current year

Some benefits are taxable per event, but accumulated annually for AHV (incentives for employees).

With the new validation options, you can set the wage types according to legal and social insurance specifics.

4.1.2.5    Pay Process

4.1.2.5.1    Management Rapport Journal | New Infobox: Salary Entry

Task #8987 | 5053.000

The new Wages infobox can be displayed in the report journal. For the selected wage type, it displays the
wage items used by the employee in question for the last few months. You can easily show/hide the infobox.

4.1.2.5.2    Payroll Process | TimeMachine input after resignation

Task #9079 | 5053.000

Up until now, a back payment was only settled for a resigned employee in the subsequent months if a wage
type with the number or amount was entered in the Report Journal. This logic has now been extended with
TimeMachine. This means that if e.g. a higher wage is to be paid retroactively to an employee that resigned
(before the date of resignation), this can be recorded in TimeMachine. The system creates a recalculation,
even without additional entries in the Report Journal. The same happens with a WT rate change (retroactively).
Please note that a minus payday can occur.

4.1.2.5.3    Payroll Process | Automatic transition from additional income to pensioner

Task #9076 | 5053.000

Low wage AHV code 3 as well as low wage ALV code 2 are manually adjustable codes. That means that this
code can be set manually for employees with a low wage <CHF 2'300/year. CHF 2'300/year are calculated
automatically. The code may be changed to ‘liable’ at the earliest by 01.01 of the next year.

Upon reaching retirement age, this code must be automatically converted to AHV pensioner or subject to ALV.
This has been corrected in this update.

4.1.2.5.4    Payroll Process | ISO 20022 | Validation in the address field

Task #9025 | 5053.000
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The Employee Address field must be filled for the ISO 20022 payment file. It will now be validated during wage
accounting. If it is empty, the pay process cannot be settled.

4.1.2.5.5    Post Payroll | Missing Payment file note

Task #8925 | 5053.000

Both Cancel pay process and Post wage are close to each other. In the past, we were occasionally reported
that a pay process was posted instead of being canceled. Now, we have built in a validation.

The following message appears: No payment file has been created yet. Do you still want to start posting? If
this message is confirmed with Yes, the pay process is posted. Also see the task below Task.

4.1.2.6    Administration

4.1.2.6.1    Payroll Setup | Age limit for KTG and UVGZ

Task #9063 | 5053.000

In response to many requests, the age limit can be defined for deduction in the KTG and UVGZ social and
private insurance. For example, if a contract according to VVG is concluded with the KTG, the age limit is
usually 70 years. With today’s solution, KTG deductions will be calculated after this date.

Display the Age limit column for each insurance (KTG/UVGZ) and enter, for example, the value of 70 (years).
After the age of 70 is reached, no deductions will be processed.
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4.1.2.6.2    Workgroup | new field locked

Task #9075 | 5053.000

The new “Locked” field has been inserted into Workgroup (working time calendar). Therefore, workgroups that
are no longer needed can be locked. They are no longer offered for selection in the Staff Card.

4.1.2.6.3    Report types | Activating target time lower and upper limit on group title

Task #9035 | 5053.000

The entries regarding the target time lower limit and upper limit per report type can be validated in the report
types (TapBoard/EasyRapport).

Example:
An employee should not be able to record sick hours per day exceeding the target time scheduled for that day.
If s/he records more hours, the entry is automatically corrected to the target time.

The validations can already be activated on the group title. Therefore, all report types in this group are
validated.

4.1.2.7    Reports | Interfaces

4.1.2.7.1    Attestation of Employer ALV | Employment periods of the last two years

Tasks #4637, #6579, #6747, #7880 & #8802 | 5053.000

In the ALV Employer Certificate report, the income of the last two years subject to AHV is declared on the
second page. We have declared more than two years so far. In addition, the data was not chronologically
declared in individual cases (Paragraph 16) and the date of resignation was not set correctly. We made
adjustments. Furthermore, minor layout problems have been resolved for Paragraphs 10 + 13.

4.1.2.7.2    Intermediate certificate of profit ALV | Paragraph 10 adjusted based on the refunding of absences

Task #9007 | 5053.000

A customer has reported that the display of the gross wage subject to AHV of the assessment was incor-rect
in Paragraph 10. Holiday and vacation compensation for this customer is not calculated in ascending order, as
usual, but vice versa. This means that after the hourly wage, vacation compensation and holiday compensation
is first calculated from the cumulative basis. This order can be adjusted in the Refunding of absences.

The report has been adjusted to accept the order according to the settings in the Refunding of absences.
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4.1.2.7.3    Rate Fluctation | Selection field added

Task #8345 | 5053.000

The turnover rate assessment was extended with an additional selection field (any Employee Card field, e.g.
Percents by position, etc.). The selection field can only be selected if the check mark is set for Detail. The
selection field appears on the assessment immediately after the employee's name.

4.1.2.7.4    Difference list | Percents by position and recruitment/resignation date added

Task #8923 | 5053.000

The difference list was expanded with the Percents by position and Recruitment/Resignation Date values (if
occurred during the selected month). This upgrades the assessment and serves as an important control
instrument for the pay process.

4.1.2.7.5    FIBU Interface with Abacus | Version 2012.00

Task #8394 | 5053.000

SwissSalary will receive a standard Fibu interface to Abacus (version 2012.00). The interface can be acti-vated
in Payroll Setup -> tab Setup -> field Interface.

Since Abacus works differently than Dynamics NAV, the following parameters must be transferred into the
“Company Number Interface” field (separated with the dollar sign):

MMMM$DD$FFFF

Legend:
MMMM = client number (does not necessarily have to consist of 4 characters)
DD = division number (does not necessarily have to consist of 2 characters)
FFFF = Fibu account number for the Abacus offset entry (does not necessarily have to consist of 4 characters)

Example:
client 1234, division 11, Fibu account number 2111
1234$11$2111

4.1.2.7.6    DTA Payment order | Display on a single page

Task #6224 | 5053.000

The DTA Payment Order report has been completely revised and only outputs detailed data on a single page
(previously on 2 pages).

4.1.2.7.7    BESTA Employment statistics | Reference period consideration

Task #9089 | 5053.000

The collection is carried out by random sampling of companies retrieved from the Company and Busi-ness
Register (BUR). The collection takes place every 3 months (quarter). Up until now, all employees were counted
who were still active as of the reference date (for example, September 30) and in the quarter received a wage
subject to AHV. Employees not subject to AHV were not counted.

According to the latest regulations of the FSO (Federal Statistical Office), the reference period is always the
last month of the quarter. That means that only employees active in this reference month and that have earned
a wage subject to AHV need to be considered. Active employees with a wage subject to AHV payments in the
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previous month are not considered unless they have a wage subject to AHV in the reference month.
Pensioners with income below tax exemption limit of CHF 1,400/month are also not considered.

4.1.2.7.8    Sunet plus Interface | Setting Payroll area filter for the user

Task #7191 | 5053.000

Payroll area filter deposited for the user influences the data export of the Sunet plus interface. 

Example:
In addition to the MW and HW payroll areas, you know the TEMP payroll area for temporary employees. These
temporary employees should not be transferred to Sunet plus. Enter the <>TEMP payroll area filter for the
user. Only employees from the MW and HW areas will be transferred to Sunet plus.

4.1.2.8    SwissSalary Direct

4.1.2.8.1    Send documents | Data upload via Webclient became possible

Task #9077 | 5053.000

A .NET error message appeared in the web client if documents (not payslips or wage statements) were to be
sent to SwissSalary Direct. This now works like in the RTC client.

4.1.2.8.2    Subdomain incorrectly entered | Error message readable

Task #8183 | 5053.000

An illegible error message appeared in the RTC clients (NAV 2013 or newer) if an incorrect subdomain was
recorded in SwissSalary Direct settings (usually at system start). This error message is now readable. The
subdomain is entered in the Ribbon -> tab Actions under SwisSalary Direct in the General tab.

4.1.2.9    SwissSalary EasyRapport

4.1.2.9.1    Double entry of Logins in several clients

Task #8936 | 5053.000

If the same login for EasyRapport is used in several clients, there has been an error message since the last
update during recording in a new client. The error message has been replaced by a note and the stor-age of
the same login is possible again.

4.1.2.9.2    SwissSalary EasyRapport | HTTP transfer mode removed

Task #8942 | 5053.000

The fields in the SwissSalary EasyRapport table for HTTP transmission are hidden in this update and
completely deleted in PreUpdate 5053.100. Standard transmission takes place via WebService, HTTP was
considered as an option for another type of transmission, but it was not followed up.
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4.1.2.10    Bug fixes

4.1.2.10.1    Employee

4.1.2.10.1.1   Role Center | Persons without recruitment date | Display in recruitment

Task 8933 | 5053.000

This change concerns RTC versions of NAV 2013 or newer exclusively.

Some customers already record persons in SwissSalary with the “Applicant” status, i.e. without the
recruitment date. These persons will be deleted if they are not employed. Up until now, these persons were
displayed both in tile “In Recruitment” and under “Active” and counted. These persons are now only displayed
under “In Recruitment”.

4.1.2.10.1.2   NAV 2017 | Employee Card cannot be mutated

Task #9009 | 5053.000

We have received feedback from some customers that data in the Staff Card cannot be mutated by some
employees. The following error message appeared:

An attempt was made to change an old version of the ‘Personnel Master’ record.

After intensive analysis, an error with the new image format for employee photos (image synchronization event)
could be detected and resolved starting from NAV 2017 and newer.

4.1.2.10.1.3   PIS | Payroll area filter for qualification matrix

Task #9021 | 5053.000

In the Microsoft Human Resources module (PIS), SwissSalary payroll area filter has been integrated so that
employees with restricted payroll filter can only see the qualifications of authorized employees.

4.1.2.10.2    Pay Process

4.1.2.10.2.1   Income Tax calculation | Salary after resignation | Adjustments

Task #8945 | 5053.000

Income Tax calculation with retroactive corrections via rates, canton changes and consideration in case of
back payments after resignation are highly complex. Individual cases have been reported to us over the past
months that withholding tax was calculated incorrectly in the month of resignation for wage payments after
resignation from the company. These cases have been extensively tested and the calculation was improved.

4.1.2.10.2.2   Management Rapport Journal | Error message in case of locked dimension value

Task #9031 | 5053.000

The error message with blocked dimension value in the Report Journal was improved.

4.1.2.10.2.3   Management Rapport Journal | Child allowance correction | assignment field cannot be opened

Task #8960 | 5053.000

This error correction only concerns customers with NAV Classic 4.00 SP2 – NAV 5.00 SP1.
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After PreUpdate 5052.100, it has been impossible to open the “Assignment” field for child allowance cor-
rections. Manual filing of the child’s name worked. The error has been corrected.

4.1.2.10.2.4   Management Rapport Journal | "Cost Center" Infobox for cross-client cc selection

Task #7396 | 5053.000

This change only concerns SwissSalary BAU customers with cross-client cost center reporting.

Cross-client cost centers were not displayed in the Report journal in the Cost Center infobox. The error has
been corrected.

4.1.2.10.2.5   Down-Payment process for haurly wage | Calculating surcharges for resulting Following Salary Type

Task #8600 | 5053.000

In a particular individual case, surcharges were also calculated (Saturday/Sunday) using the Calculate Down-
payment Process feature, provided that the hourly wage type was assigned to the resulting wage types. There
was a miscalculation if the last day of the month was Saturday or Sunday. The error has been corrected.

4.1.2.10.2.6   Payroll Process | Prevent zero division or output w ith message

Task #8704 | 5053.000

In some cases, a zero-division error message appears during wage accounting, provided, for example, that
posting keys were worked with. If, for example, no hours (divider) are recorded for an employee, this message
may appear. An eloquent or understandable error message is shows now with personnel number, etc.

4.1.2.10.2.7   Post Payroll | FIBU Posting | Placeholder w ithout date values

Task #8946 | 5053.000

This change concerns only SwissSalary BAU customers.

Placeholders can be specified in the payroll master data for FIBU posting. This makes it possible to up-date
the FIBU posting, for example, with the payroll area or date in more detailed text.

There was an error in SwissSalary BAU solution with date values after the last adjustment. It was corrected.

4.1.2.10.3    Reports | Interfaces

4.1.2.10.3.1   Attestation of Employer ALV | Display error in paragraph 19

Task #9037 | 5053.000

This change concerns RTC versions of NAV 2013 or newer exclusively.

If an amount was entered under item 20 Holiday Compensation in the Other payments section, this amount
was also transferred to Paragraph 19. The error has been corrected.

4.1.2.10.3.2   A4H/A4Q Employee list statistics | only one person in displayed

Task #8966 | 5053.000

This change concerns RTC versions of NAV 2013 or newer exclusively.
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Only one person appeared on A4H/A4Q staff list statistics after the last update. This bug has been fixed.

4.1.2.10.3.3   PIS sheet | Show comments about relatives

Task #8941 | 5053.000

This change concerns RTC versions of NAV 2013 or newer exclusively.

Details about relatives were no longer displayed on the PIS sheet (in contrast to the previous Classic version).

The error has been corrected.

4.1.2.10.3.4   Paycheck | Fields extended and view improved

Task #8902 | 5053.000

Depending on the language setting and text length (for example, the social security number) points ap-peared
below the text in the payslip. This is because the field was a bit too short. Several fields on the payroll have
been extended.

4.1.2.10.3.5   Salary certificate | Setting free transportation to work during ELM submission

Task #8913 | 5053.000

If private share of company cars is settled for the employee and if the corresponding wage type is as-signed
number 2.2, the “F” check mark appears automatically on the wage statement. This means that the Free
Transportation to Work check mark in the Staff Card did not have to be additionally set.

A tax office has determined that the check mark was present on the paper document but was missing in the
ELM submission of the wage statement. Most tax offices validate this automatically and put the check mark
ex officio.

The error has been corrected.

4.1.2.10.4    Administration

4.1.2.10.4.1   User name | Field length adjusted

Task #8831 | 5053.000

User Name field had already been extended with PreUpdate 5052.100, but was subsequently improved. Also
see the following Description.

4.1.2.11    Notices for our partners

4.1.2.11.1    System tables converted to existing SwissSalary tables (ZIP Code and banks)

Task #8255 & #9066 | 5053.000

In the past, there were always problems with Dynamics NAV system tables shared by SwissSalary (for
example, Banks and ZIP Code tables).

the Banks table (table 11500) was especially problematic in the W1 version and in foreign partners’ branch
solutions, since table 11500 only exists in the CH version. For this reason, we have developed the SwS Bank
Directory Internat. table years ago. It is always used when the customer uses a non-CH version. The same
applies to the zip code table (Table 225).
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As of this update, we have permanently rewritten all functions, reports, etc. in this table. In terms of Dynamics
365 Business Central, this is the only viable solution to ensure functionality.

The standard ZIP code table (Table 225) is also updated for the ZIP code during data update. For banks, the
import takes place exclusively in the SwissSalary own table.

4.1.2.11.2    ELM Management (Beta) | Refactoring and relocation of the XML functions

Task #7447 | 5053.000

The new ELM Beta field is displayed in the ELM Settings field (payroll setup). The existing ELM Code Unit has
been completely revised and improved according to current knowledge. According to our tests, the old code
unit (active) and the new code unit (beta) work identically. 

We will conduct further tests with selected customers during 2018/2019 reporting period until we define the
new beta interface as the default (with PreUpdate 5053.100 at the earliest).

4.1.2.11.3    Username > 30 characters | Problems with Excel Export

Task #8943 | 5053.000

There was a problem with a user name with more than 30 characters during the Excel export of assessment.
The problem has been solved.

4.1.2.11.4    Excel-Import-/Export | Excel Buffer Table with temporary records (no logging)

Task #9011 | 5053.000

The Excel buffer table was previously used for reports with Excel export and import functionality. The table
serves purely as an auxiliary table. First, this table is deleted completely with each import. This led to many
entries in the change log for customers who turned on logging.

The table is now filled only temporarily. Thus, no data remains and the logging is no longer affected.

4.1.2.11.5    NSP | 'DTA created' field removed

Task #9085 | 5053.000

There was a special validation in the NSP solution during wage posting. It was checked if the DTA file had
been created before. This special validation for NSP is no longer necessary as it has been adopted in
SwissSalary-Standard.

4.2    Update 5053.000 Systemadmin

4.2.1    SwissSalary Homepage | Update-Download

4.2.1.1    Instructions (4)

How you can enter the customer area of SwissSalary?

Link http://www.swisssalary.ch will take you to our website. Click Log In in the upper right corner: 

http://www.swisssalary.ch
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Log in using your company specific login data. Afterwards press the button Update NAV (SwissSalary NAV
customers) or Update BAU (SwissSalary BAU customers).

This will allow you to download the most current Updates and PreUpdates. If you click on the respective PDF
and/or ZIP icon, you will download the objects and documents.

What additional documents can be downloaded?

In addition to the latest Updates you can download and install the most current PreUpdates in SwissSalary, so
that you are always up to date (recommended).

The library of the latest manuals and other information for SwissSalary will be renewed and extended.

How a file can be downloaded from the Internet?

When you click on the corresponding icon and the download begin (the file you will find under 'Download):

Will I get notified about changes to SwissSalary?

Yes. You will receive information message each time when the latest Update is released. The PreUpdates will
be continuously available on our website with no mail notification! You will also be notified by mail about the
important PreUpdates!

Can the updates be sent via email?

As a rule, the Updates are only available online. Sending via email is often used in case of problems with some
providers related to the size of files and spam/junk filtering.

Are you familiar with our customer and partner portal?

By following https://webportal.swisssalary.ch you will enter our Customer portal. To log in you will need only
your email address and a password that you will receive from us. If you have not yet received a password from
us, please request it by sending an email at support@swisssalary.ch.

You can change the received password when you first log in to the system.

https://webportal.swisssalary.ch
mailto:support@swisssalary.ch
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At the Customer portal you may not only submit and process new support requests (incidents), but also track
your own open or already answered mail inquiries at any time. In addition, you have access to our Tasks for
further development. You can see which customer requirements have been met and will be delivered with the
next Update or PreUpdate. You can also vote for individual tasks, so that you can actively influence the
development of SwissSalary.

Just try it!

Do you have questions about our website or downloads?

You can send us an email at support@swisssalary.ch or call our hot line +41 (0)31 / 950 07 77 or your partner.
We will be happy to advise you!

4.2.2    Downloading / Refreshing Updates and PreUpdates

4.2.2.1    Instructions (4)

1. Download the objects and manuals according to the descriptions in chapter Instructions.

IMPORTANT NOTES:
q It is NECESSARY that you pass this User Manual on to the relevant employees!
q Make sure that the update version B5052.000 (BAU) / N5052.000 (NAV) is installed in your system. You can

check this in SwissSalary under Company -> Settings -> Organization -> Update (Version) or in RTC-Client
on Organization.

IN CASE YOU HAVE A VERSION OLDER THAN B5052.000 / N5052.000 INSTALLED, PLEASE CANCEL
THE INSTALLATION AND CONTACT US OR YOUR PARTNER!

HINT:
Please back up you data before the update. Generally, it is not required but still useful for security reasons.

2. Unzip the object file with WinZip.

3. Open Microsoft Dynamics NAV and select using Shift+F12 in Object Designer (Tools -> Object Designer).
From NAV 2013 RTC you must start the Development-Client.

mailto:support@swisssalary.ch
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Now you can see all NAV objects in the NAV DB available to you.

4. Select menu File -> Import.

5. Enter the path to the location where you saved the FOB file. The system will try to read the file.

6. You will see this info that MUST be confirmed with OK or No.

NOTE:
 For PreUpdates a different question appears. ALWAYS open the Import Worksheet!

7. The Import Worksheet will open.

IMPORTANT NOTE:
Here you SHOULD click REPLACE ALL! Click OK to continue the import process.

The RTC-Client (from NAV 2015) appear this message (confirm this with 'Force'):
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The RTC-Client (from NAV 2015) ask you to do a synchronization; confirm this message with YES:

8. The objects will be loaded into your database. After a successful completion of the import the following
message appears:
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In the Classic version:

(Example: the number of objects can vary!)

In the RTC version:

9. Done. The new update has been imported!

IMPORTANT NOTE:
This approach is similarly applied to PreUpdates! 

We recommend compiling the SwissSalary objects after importing (F11). Please put in the List a filter (F7) to
SwS* and make sure that All is selected on the right side.
We would like to point out that, especially for RTC versions (as of NAV 2013), the NAV service service, if
possible to restarted. This can usually only be done by the administrator with appropriate permissions (please
run only in margins if no users are logged in).

After a successful import of the objects, select them in SwissSalary main menu.

Click menu item Employee (Employee Card). Te system will start automatically the process of update
renewal. Only a staff member with administrator rights should open the main menu for update renewal.
Otherwise, the update will not be successful! After a successful run of the batch you will receive a message
stating that it is complete. 

Under Setup -> Setup -> Organization  or in the RTC-Client-> Organization you will find the history of updates
in which all successfully updated versions are registered. After each Update/PreUpdate you must undergo this
update/renewal process!
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In the Excel file you can see which objects will be created and modified.

Type explication:

1 = Table
2 = Form (no more available from NAV 2013)
3 = Report
4 = Dataport
5 = Codeunit
6 = XMLport
7 = MenuSuite
8 = Page (only RTC version from NAV 2013)
9 = Query (from NAV 2013)

Important note on MenuSuite:

SwissSalary NAV:
The old menu is no longer available in NAV Version 4.00 SP2 or newer. MenuSuite is included in regular
update.

In cases of uncertainty, please inform your partner or our support immediately.

4.2.3    Access Autorisations and Roles

4.2.3.1    Instructions (4)

Autorisation and Roles description:

SwissSalary Budget - Edit
Groups ID Name Description
SWS-ALL SwissSalary -

All SwS-Users
The only user role that must be assigned to every SwissSalary user.
The 'Wage Accounting Process' feature requires that the system should obtain
'indirect' information about all clients (license check, how many employees are
currently accounted for in the entire database. Of course, the payroll staff
member cannot see any data of the restricted clients)The only user role that
must be assigned to every SwissSalary user.

SWS-CONS /
SWS-
INVOICING
(only
SwissSalary
BAU)

SwissSalary -
Consortium
SwissSalary -
Invoicing

This role is used for working in the ARGE module. This permission role allows
full access to ARGE items and ARGE posting journals. This role is suitable for
employees that are only allowed to operate ARGE in payroll accounting.

SWS-EE-
EDIT

SwissSalary -
Edit Employees

This role is the classical assignment for payroll staff members that need to use
all features of payroll accounting. The user can edit, delete, enter data in
SwissSalary; however s/he cannot change payroll master data.

SWS-EE
READ

SwissSalary -
Read
Employees

Similar to the SWS-EE EDIT role, with the exception that data can be viewed
only, and not changed (read-only rights).

SWS-HR
EDIT

SwissSalary -
HR Edit
Employee

PIS (Personal Information System) add-on module. A user with this role can
modify, delete and enter data in PIS. 

SWS-HR
READ

SwissSalary -
HR Read

PIS (Personal Information System) add-on module. Read-only rights.
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Employee
SWS-HR
SETUP

SwissSalary -
HR Setup

PIS (Personal Information System) add-on module. A user with this role can
change settings in PIS. Classical HR wage administrator.

SWS-POST
(only
SwissSalary
NAV)

SwissSalary -
Posting

In accordance with the SOX guidelines, payroll staff member is not allowed to
'post wages'. This user role can be assigned to an employee in the FIBU that
is exclusively responsible for wage posting. IMPORTANT: Of course, this
employee must also be enabled in SwissSalary under Company -> Settings ->
Users.

SWS-SETUP SwissSalary -
Setup

Classical authorization role for wage administrator

SWS-ST
EDIT

SwissSalary -
Edit Salary
Type

Full access for editing wage types. A user with this role can create, modify
and delete wage types.

SWS-
BUDGET-
EDIT

SwissSalary
Budget - Edit

SWS-
BUDGET-
READ

SwissSalary
Budget - Read

SWS-
BUDGET-
SETUP

SwissSalary
Budget - Setup

After each update, permission roles must also be adjusted in SwissSalary (New table access, etc.)

IMPORTANT NOTICE:
q If you have customized individual permission roles in Standard "SWS-*", please remember that they will be

overwritten through the automatic import of the "default" roles.
q Before releasing the system for the user again, add the necessary appropriate permission roles to these new

tables!

Current permission roles can be found on our website in our protected area.

To begin the import in SwissSalary go to Setup -> Setup -> Organization -> button 'Service' -> Rights. In the
RTC-Client in Organization. Select SWS value under Role ID*.
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Choose the appropriate path for the .txt file and select Import under Direction in the Options tab. Then click
OK and after some time the default user roles will be adjusted in SwissSalary.

If you have written changes in our default payroll user roles or if you want to make changes to the user roles
manually, you can do this under Tools -> Security -> Roles (NAV 4.00 SP2 and newer). Click on the
appropriate role and add new tables  Role -> Permissions (NAV 4.00 SP2 and newer). In the RTC-Client go to
Departements-> Administration-> IT Administration-> General-> Permission Sets. If you have questions about
these settings, please contact your local partner.

The following tables have been re-created and must be added to the corresponding roles (if already used):

Table SwissSalary BAU/NAV Name Object Name

3009200 (only SwissSalary 365) SwS Payroll Log Overview Payroll Overview

3009310 SwS Working Group Time
Balance

Working Group Time Balance

3049160 SwS Activities Activities

3049161 SwS Resignation Reason Resignation Reason

3049400 SwS Document Service Document Service

3065014 SwS Bdg Forecast Entry Payroll Budget Forecast Entry

3049170 SwS Config. Template Header Config. Template Header

3049171 SwS Config. Template Line Config. Template Line

3049175 SwS Employee Data Template Employee Data Template

3049176 SwS EE SocSecIns Data
Template

Employee Social Securitiy
Insurance Data Template

SwissSalary Role Center
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Each NAV module knows its own role Center (from NAV 2013). SwissSalary has developed the Page 3009252
SwS Payroll Role Center. We encourage you to work with this Role Center for the salary. You can import the
Role Center also (XML-file you will find in the Update object).
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5    Update 5052.000

5.1    Update 5052.000 User

5.1.1    PreUpdate 5051.100 (10.05.2017)

5.1.1.1    INTRODUCTION (3)

Please note the introduction to the update 5052.000 from 26.10.2017.

5.1.1.2    NEW FEATURES

5.1.1.2.1    SwissSalary Budget | New Module

5051.100

We are pleased to announce that starting from Microsoft Dynamics NAV-Version NAV 2013 to NAV 2017
(including SwissSalary 365) we will be delivering a new wage budget module with job index. The corresponding
objects are delivered and installed with this PreUpdate.

The module is already being successfully used by three customers. We will shortly deliver further information
on the module via our newsletter and our home page (range of functions, price list, etc.). Additional licensing is
required for the operation of SwissSalary Budget.

You can certainly look forward to it!

5.1.1.2.2    ISO 20022 | New Interface for Wage Payments Using Banks

Task #6751, Task #8067 & Task #8253 | Update 5051.100

Europe runs the standardized payment service called SEPA. This standard is called in Switzerland ISO 20022.
Switzerland is implementing the project under “Harmonization of Payment Transactions in Switzerland”.

By the end of 2017, all ERP vendors have to transfer the existing “EZAG  and “DTA” interfaces (creditors,
wage, etc.) into the new standardized XML format. The interface is now named pain.001 or ISO 20022. There is
no distinction anymore between PostFinance (EZAG) and Banks (DTA).

By the beginning of 2018, all ERP systems and thus also all customers concerned will have to be transferred
to the new interface. As of January 2018, PostFinance will no longer accept EZAG files. The introduction
schedule for the Banks is still unclear.

We have developed the new ISO 20022 interface in the Area of Wages and it has already been in productive
use by some pilot customers since the beginning of 2017.

Settings
You can find the settings under Bank Account Master Data (SwissSalary Administration). There is a new “XML
ISO 20022” option now in the Delivery method field. A number series is also required for the creation of the
XML interface. You can determine the numbering yourself. For bank information, please continue using bank
data in the DTA tab. I.e., those customers who want to migrate from DTA to ISO 20022 only have to change
the transmission type and also create the number series.

Description of important fields under bank account master data
Tab General
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- Delivery method | XML ISO 20022
- Transmission of number series | Create new number series, e.g. ISO20022

Tab DTA (the data remains unchanged as in the previous DTA, unless you have new bank details)
- DTA file folder | Disk drive
- DTA Sender clearing | Principal bank clearing number
- DTA IBAN | Principal bank IBAN number
- DTA sender name | Company name

The field names (DTA) will be changed in the course of 2018 after ISO 20022 is introduced completely.

Writing ISO 20022 file
Similar to writing of the existing DTA/EZAG text files, you now will find the “ISO 20022 file” button in the pay
process menu bar. The procedure is the same as with the existinf DTA/EZAG files. After writing the XML file,
Windows Explorer will reopen with the created XML file. The file will appear now in the new “Files” infobox on
the right, where you can also export the file. This process also applies to the writing of the existing DTA/EZAG
files.

In the old Classic client, you can find the file by clicking the Files button in the Pay process Journal.

File handling in the web-client
The payment files can also be created in the web client (browser). After the file is created, the following
message will appear:

The file was created. Please confirm the download in the web browser.

Click OK. You can also confirm the following message by clicking “OK”. A download dialog of your Internet
browser (e.g. Internet Explorer) will appear. It can be directly confirmed by clicking “Save” or “Save as”. “Open
folder” opens the folder where the file was saved (if you have confirmed the previous message with “Save”, the
file will be saved in your local personal download folder). From this directory, you can upload the exported file
to your Internet banking.

5.1.1.2.3    Printing Payslips | From – Till

Task #122 | Update 5051.100

The options (filters) for printing payslips have been completely revised and optimized. The filter criteria are now
retrieved directly via the Pay Process Header table. For example, it allows to print certain employees’ payslip
covering a certain period.

Up until now, only payslips per pay process could be printed. When, for example, an employee had to receive
all payslips for the past year, one had to launch the Payslip 12 - 13x report. From now on, you can freely use
the following filter criteria:

- Payroll No.
- Employee No.
- Allocation Group
- Payday Date
etc.

Example A:
You want to print all payslips for employee 101 he has ever received.

Solution A:
Employee No = 101
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The rest of the filters remain empty
All employee 101's payslips are printed in chronological order.

Example B:
You want to print all payslips for employee 101 covering the following period: January 1, 2017 – June 30, 2017

Solution B:
Employee No = 101
Payday date = January 1, 2017..June 30, 2017
All employee 101's payslips from January 2017 till June 2017 will be printed in chronological order.

Example C:
You want to print all payslips from pay process 252 + 279 for employees 101 and 113.

Solution C:
Employee No = 101|113 (AltGr+7)
Payroll No. = 252|279 (AltGr+7)
All employee 101’s and 113’s payslips from pay processes 252 + 279 will be printed in chronological order.

Tip:
You can select multiple pay processes, and then click “Payslip”. The filter will be accepted automatically

5.1.1.2.4    Calculation of Daily Allowance Estimate (UVG)

Task #8140 | Update 5051.100

From now on, the rate in the salary type can also be set up for the calculation of daily allowance amount
(accident daily allowance). The accident daily allowance is calculated on the basis of salary types and wage
items according to the settings in Salary types -> tab Absence -> Damage insured salary. You can use the
following options:

- retroactively
The past 12 months average, retroactively only by last contract amendment (monthly wage to hourly wage and
vice versa)
e.g. hourly wage, loyalty bonus, achievement bonus, etc.

- presumably
Extrapolation of the current wage to 12 months
e.g. 13th monthly wage. Wage payment, family allowance etc.

All salary types under Liabiliy tab with ‘a subject to UVG’ check mark are taken into account. By assigning the
“retroactively” or “presumably” option in the Insured wage claim field, SwissSalary recognizes the way posted
or future items are to be calculated.

On the accident day salary type, set the “Wage rate approach” value to the new “Daily allowance amount”
option. This salary type is recorded in the Report journal with the number of calendar days (365 days). The
Daily allowance amount is calculated and recognized automatically.

This reporting can be used in the case of pure payment of daily allowance amount, if wage continuation has
expired and the daily allowance is not definite yet. Please note that this calculation is only available in the first
phase for the accident daily allowance. Later, we will also provide the function for daily allowance calculation.
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5.1.1.2.5    Request to Parifonds for Benefit Payment Starting From April 1, 2017

Task #8320 | Update 5051.100 (SwissSalary BAU-Version NAV 2015)

On March 23, 2017, Parifonds Bau (Parity Fund of the Swiss Construction Industry) published a new,
simplified application form for courses starting from April 1, 2017. The new form has only one page and is only
published in German and French.

The form previously used has been removed. Please use the new form only.

5.1.1.2.6    FIBU Registration Journal Import | Default Import Interface for Dynamics NAV

Task #8096 | Update 5051.100

Some customers run payroll accounting (SwissSalary) and the remaining Dynamics NAV modules in different
NAV databases. This procedure is selected, for example, when the existing ERP solution runs in an old NAV
version no longer supported by SwissSalary. Payroll accounting is then operated in a newer NAV version
and/or via SwissSalary 365 cloud solution.

The FIBU standard interface (export) can be set up in SwissSalary -> Payroll Setup -> tab Setup. In case of
wage posting, the compressed payroll data, on the one hand, is posted in financial accounting of the source
database and, on the other hand, a text file is created in a selected folder. For this file to be imported into the
"old" NAV database, we have created a standardized FIBU import interface. This report with number 3009271
SwS G/L Journal Import can be integrated and launched in the Financial Accounting menu. Enter the
registration journal template name, the registration journal name, and the file name. Payroll data is then
imported directly into the selected FIBU posting journal.

5.1.1.2.7    SOMED Interface

Task #8093 | Update 5051.100

Version 2.5 of the SOMED interface A (SCA1) is now included in the scope of SwissSalary NAV Plus (year of
operation 2017, Data submission operations -> Canton until March 31, 2018).

The interface can be added via General Reports with ID 3009319 and started via printing. The following
information

- Type of education
- Occupational status
- Remuneration account
- Origin of the diploma

can be obtained from us. The data can be imported via personnel statistics import and then assigned to
employees. A test file can also be created with a push of a button. The file format has *.dat extension.

5.1.1.2.8    Hospital Statistics

Task #7974 & Task #8080 | Update 5051.100

Version 3.0.4 of Hospital Statistics is now included in the scope of SwissSalary NAV Plus.

The statistics can be added via General Reports with ID 3009320 and started via printing. The following
information
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- Position
- Main service location
- Main location
- Origin of the diploma

can be obtained from us. The data can be imported via personnel statistics import and then assigned to
employees. A test file can also be created with a push of a button. The file format has *.dat extension

5.1.1.3    EMPLOYEE

5.1.1.3.1    New Infobox Employee Comment

Task #4578 & Task #8044 | Update 5051.100

From now on, the Employee Comment infobox as well as the Comment column on the Employee List can be
added in RTC versions (starting from NAV 2009 SP1 RTC). The per-employee comments are displayed in the
infobox. You will be informed with yes/no in the new column in the Staff List if any remarks are available.

In addition to the Employee List/Card, the infobox can be activated in the Report journal.

5.1.1.3.2    Image | New Area in Dynamics NAV 2017

Task #8210 | Update 5051.100

With the launch of Dynamics NAV 2017 (October 2016), Microsoft has introduced the new “Media” data type.
It is useful for displaying images and other media. Using the appropriate tools, the existing image of the
employee is automatically migrated during an upgrade from an older NAV version. However, if this migration is
performed incorrectly during the upgrade, the image will be available in the new NAV 2017 database, though
not visible.

For this purpose, we created the “Migrate pictures” function that can be found directly in the Employee photo
infobox in the Employee List/Employee Card. If you click this function, the following message will appear: 

This function copies the image from the old field ‘Image’ to the new field ‘Image’. The existing images will be
replaced. Would you like to continue?

Answer this question by chosing Yes. The images will then be displayed.

Important note: This feature must be executed once per client.

Another advantage is that the images can be directly imported/exported in the infobox.

5.1.1.3.3    Search Term | Update via SmartPort

Task #8242 | Update 5051.100

If the last or first name of an employee was updated via SmartPort, the search term on the Employee Card will
not be updated.

If the search term is still empty (new employee) or if this search term has never been adjusted manually, it is
revalidated and updated. If, however, the search term was changed manually beforehand, it will no longer be
updated, and manual adjustments would otherwise be overwritten.
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5.1.1.3.4    Personnel Dimension | Display Last/First Name

Task #8122 | Update 5051.100

In Personnel Dimension, you can also select the column with the employee's "Last/First Name” and Employee
Number. Advantage: When you remove the filter, will see dimensions (shares) assigned to employees.

5.1.1.3.5    Department | Responsible Staff Members and Deputies

Task #7963 | Update 5051.100

From now on, you can enter the responsible department Employee members and deputies. You can insert the
two new columns Person Responsible and Responsible Deputy.

5.1.1.3.6    TimeMachine | Display Changes Only

Task #8354 | Update 5051.100

You can change the data in selected fields (Wage, WTR, Address, etc.) using time axes. In the TimeMachine
History area, all entries are displayed per pay process.

There is a new filter in the menu bar you can use to filter the following entries:

- complete history (default, all entries are displayed per pay process)
- changed history (only changes are displayed)

5.1.1.3.7    Children | Show Comments

Task #8260 | Update 5051.100

Comments on individual children can be recorded in the Children table. It is not evident at first sight whether
comments are recorded. A new “Comments” field has been incorporated to display “Yes/No” if there are any
remarks. The comments can be opened in the menu bar.

5.1.1.3.8    Income Tax | New Validation When Setting ‘Subject to Income Tax’ Check Mark

Task #8025 | Update 5051.100

If the ‘Subject to Income Tax’ check mark is activated for a person with residence abroad (except for
Liechtenstein), the system asks whether the ZIP code and the location of the tax municipality should be
adjusted based on the workplace. This is intended to prevent wrong identification of a foreign ZIP code as a
Swiss tax municipality.

Please note that for people with the place of residence abroad you should always input a Swiss ZIP code for
the tax municipality In the case of cross-border commuters with an overnight stay, this is always the place of
work of the employer. For employees with a week stay with a CH address, it is the postcode of the ZIP code).

5.1.1.3.9    Allocated Salary | Allocation for Family Allowance Correction (Current Year)

Task #8258 | Update 5051.100

If family allowance corrections are registered in the current year, the child must be entered in the Allocation
field. This feature worked exclusively in the Report journal. From now on, these corrections can also be
recorded in wage items.
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TIPS:
It is variable data to be entered into the Report journal. The Allocated Salary are intended for recording of
benefits recurring monthly. Please also note that family allowance corrections relating to previous years are
entered using another correction salary type.

5.1.1.3.10    Pay Process List | Columns Recruitment and Resignation Displayed

Task #8188 | Update 5051.100

Columns Recruitment and Resignation in the Pay Process List are now permanently displayed, since they are
often used. They can, of course, be hidden per user.

5.1.1.3.11    Pay Process List | Column Comments and Comments 2 Editable

Task #8026 | Update 5051.100

The columns Comments and Comments 2 (wage statement) can now be edited in the Pay Process List. The
wage statement refers to its information since the last update using the journaled entries. The entries are
relevant to the last pay process for the corresponding year. If this information has not yet been entered into the
Staff Card at the time of the wage calculation, it can be recorded retrospectively.

5.1.1.4    SALARY TYPES

5.1.1.4.1    Following Salary Type | ShortCut Changed to CTRL+O

Task #8020 | 5051.100

Following salary types can be called in the salary type card and list with a ShortCut. However, this ShortCut
was already used for a default Microsoft (Go to) feature. From now on, the resulting wage types can be called
using the CTRL+O ShortCut.

5.1.1.4.2    Following Salary Types | Application for Automated Calculations As Well

Task #6996 | Update 5051.100

The range of functions of the Following Salary Types has been extended. For example, when the working time
calendar is used, a surcharge can automatically be posted to a separate Fibu account, if the 48h weekly
premium was calculated automatically. Or a follow-up salary type should be passed on to overtime hours,
which are calculated automatically. Thus, there are hardly any limitations in this area.

5.1.1.4.3    Project Posting | Line Type Can be Set on Salary Type

Task #8141 | 5051.100 (SwissSalary NAV-versionen and project)

The per-project posting line type (project item) is now on the salary type. It controls the offsetting of the
corresponding services (hours). The following options are available in the new “Job Line Type" field (tab
Absences):

- 'blank' (column Line Type is posted 'empty’ in the project items)
- Schedule (column Line Type is posted in the project items with the 'plan’ value)
- Contract (column Line Type is posted in the project items with the 'contract’ value)
- Both Schedule and Contract (column Line Type is posted in the project items with the 'plan and contract’
value)
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5.1.1.5    PAYROLL SETUP

5.1.1.5.1    BVG Calculation | BVG Deduction until Pension Month (AHV)

Task #8252 | 5051.100

In the case of automatic BVG calculation according to the fictitious or effective wage sum, the BVG resignation
date had to be set at the employee's pension start date, provided that the BVG deduction should no longer be
calculated one month after pension start. From now on, the retired are checked automatically.

Open different settings per code in the Payroll Setup -> BVG Settings -> Column Rate Table. For men, please
set the percentage from age 65 | to 0% and for women from age 64 | to 0%. 

For example, for a woman with the date of birth on February 5, 1953 and the retirement on February 28, 2017,
BVG deduction will be calculated from March 2017 at 0%. If the BVG deduction is to be deducted even after
the regular retirement age (up to a maximum of 70 years – article 33b BVG - gainful employment after ordinary
retirement age), this is possible without any problems; the age limit must be increased and the correct date
must be set accordingly for the BVG resignation date in Employee Card -> tab Job.

5.1.1.5.2    Provisions | Minus Hours Do Not Reset for FIBU

Task #8019 | 5051.100

According to various CECs, minus hours at an employee's resignation cannot be offset against the wage
deposits in each case. I.e., minus hours are usually attributed to the employer's expenses. To ensure that
these minus hours are not taken into account for automated FIBU provisions for overtime, plus/minus balance
with a separate salary type can be set up in provision settings (like in the case of automatic balance
compensation at resignation).

Customers already working with the automated provisions do not need to do anything. The stored salary type
will be updated in both columns during update.

5.1.1.5.3    First-day Amount (CC) on Project Items | New Option for Calculation

Task #8083 | Update 5051.100 (SwissSalary version NAV and use of projects)

The first-day amount (CC = client currency) was not always written correctly in the project items in the project
items. The internal re-invoicing rate was always considered instead of quantity x price.

There is a new option Project acquired cost in Payroll Setup -> Setup. You must check the Project acquired
price option in the payroll setup after update installation. The default value "SwissSalary/Resource" will be set
during the update process. If, however, the resource module is decisive for the purchase price determination,
this new option must be set manually to "Resource/SwissSalary".

If the Project acquired cost option is set in the payroll master data to "Resource/SwissSalary” and posted to
the project against variable expense amount reported in the report journal, each corresponding expense salary
type must be assigned to a work type. Work type field can be found in the salary type card. In the resource
acquired pricing, an entry with the amount of 0.00 must be entered for this resource or resource group and this
work type. This way, the expense reported in SwissSalary are posted to the project.

5.1.1.5.4    Work Group | Copy Function

Task #8168 & Task #8229 | Update 5051.100
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Similarly to the “Copy salary types” function, this function is also available for the work group (working time
calendar). I.e., if you need to create multiple work groups not significantly different in content, you can copy an
existing work group to a new one.

5.1.1.6    PAYROLL LOG

5.1.1.6.1    PAYROLL

5.1.1.6.1.1   Error Message During Data Import | Hours-Days Conversion

Task #8308 | Update 5051.100

When data is imported into the Payroll journal (from EasyRapport, Excel import, open data import interface,
company-specific interface), the absences data is usually converted from hours to days so that the reports can
be evaluated in hours and days.

If this conversion failed to take place (absence hours recorded on one day without set time), a huge (illegible)
error message appeared. This error message has now been replaced by an eloquent error message. If a data
record cannot be read, the following message appears:

The hour/day conversion of time cannot be computed. Employee 1000 Date Jan 1, 2017 Wage type 2150
(example)

The faulty row can now be quickly detected and corrected.

5.1.1.6.1.2   Import From Excel | Empty Cells Not Imported

Task #8203 | Update 5051.100

SwissSalary is also capable of importing complex Excels using the standard Excel import in the Report journal
and in the portions of wages. However, the “Rolling” function had a disadvantage: empty values   were also
imported. They were filtered after the import and deleted manually.

The import has been improved so that empty cells are detected and no longer imported.

5.1.1.6.1.3   Import From Excel | Importing Projects and Project Tasks

Task #8230 | Update 5051.100

In addition to the existing import options, projects and project tasks can also be imported via Excel import.

5.1.1.6.1.4   Employee Details Infobox | Display Language Code

Task #8228 | Update 5051.100

The employees' language code can now be displayed in the Report journal in the Employee details infobox.
The language code can be added from the available fields via actions and Alt+F10 ShortCut.

This improvement has the advantage that the employee in the report sees in which language s/he has to enter
the text in the report.
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5.1.1.6.2    TAPBOARD

5.1.1.6.2.1   Opening TapBoard in the Web Client Directly

Task #8342 | Update 5051.100

In the web client, TapBoard could only be called using the search function. The icon can also be found in the
Role Center menu bar.

5.1.1.6.3    PROCESS PAYROLL

5.1.1.6.3.1   Nationality Code | Validation During Wage Accounting

Task #8161 | Update 5051.100

The nationality code (table Contry/Region) must be entered in double digits (swissdec default) according to the
standard ISO 3166-2. A few customers have still recorded 1-digit or 3-digit country codes in the system and
assigned them to employees. This causes problems (validation) during ELM submission. 

During wage accounting, the system checks if the country code has 2 digits. This does not yet ensure that
this country code actually exists, but there is no validation error during the ELM submission.

A list of current country codes according to ISO 3166-2 can be found under the following Link.

5.1.1.6.3.2   Pay Process | Additional Information about Payment

Task #8186 & Task #8187 | Update 5051.100 (only RTC-Clients)

In the Pay Process details infobox, the payment details can now be displayed per pay process.

There is a new “Payment” section in the Infobox with the following details:

- Number of payment bank
- Number of payment cash
- Payment amount

Click one of these entries to open the page “Payroll Detail”. In addition to the bank details per employee and
the corresponding payment amounts, you can also see information on the employee and his/her contract wage
in the information box.

5.1.1.6.4    POST PAYROLL

5.1.1.6.4.1   Cost Accounting | Wage Posting Completely Revised

Task #7962 | 5051.100

The booking routine for payroll data transfer to cost accounting has been completely revised. In addition to cost
centers, cost units are also updated. The handoff is also prepared for the possibility to record both quantities
and amounts in the future. The adjustment applies exclusively to the SwissSalary NAV versions.

https://de.wikipedia.org/wiki/ISO_3166-2
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5.1.1.7    SALARY DECLARATION

5.1.1.7.1    ELM | Test Certificate | Check Before Submission

Task #8097 | 5051.100

You can choose in the ELM settings whether ELM submission is executed using LIVE certificate (default) -
submission to the LIVE distributor or using TEST certificate - submission to the TEST distributor. The TEST
setup is intended exclusively for internal tests as well as for partner presentations (no productive customer
data).

We received few reports from swissdec earlier that productive customer data was also transmitted to the TEST
environment. This is sensitive for data protection reasons, and the data must be deleted by swissdec within a
very short time.

We have now set up a test that only data with the company name (company data) “CRONUS” can be
transmitted using TEST certificate.

Note for our SwissSalary NAV partners
Please do not submit any DEMO data with LIVE certificate. For presentation purposes, please install TEST
certificate and set the company name to "CRONUS" (case sensitive).

5.1.1.7.2    Salary certificate | Number of Shift Days

Task #8000 | 5051.100

The number of shift days on a voluntary basis can be indicated on the Tax Declaration comment (No. 15). If a
separate salary type exists for this purpose, and the shift days as the number are posted on the payroll each
month, they can be printed on the wage statement.

On the salary type, please place a check mark for “Tax Declaration comment (No. 15). Additionally, you must
set the following placeholders in the translation of the salary type:

Examples:
DES | Anzahl Schichttage %2
FRS | Nombre de jours couche %2
ITS | Numero di giorni strato %2

Placeholder %2 stands for number totaling and shows the number of shift days. Placeholder %1 = Amount can
also be used for other purposes.

5.1.1.7.3    Liechtenstein Salary certificate | Swiss Income Tax - Suppressing Texts

Task #8286 | 5051.100

Default texts in section 15 of the salary certificate are automatically printed if the employee is subject to
source tax. The same document is also used for companies in Liechtenstein familiar with a different form of
income tax.

The default texts will be suppressed if Payroll accounting = Liechtenstein is selected in the payroll setup.
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5.1.1.7.4    BVG ELM Submission per Month

Task #7462 | Update 5051.100

swissdec version 4.0 guidelines have been extended to make it possible for a BVG ELM submission to be
transmitted to the BVG insurer not only annually but also monthly. There is the Accounting period field in BVG
contract in the payroll setup that can be changed for this purpose to monthly.

At the moment, only AXA Winterthur BVG insurer is linked to this process. In addition, this insurer can only
receive messages from swissdec version 3.0, which we have not supported for a long time. One of our
customers is also testing the interface with their insurer. It is yet to be seen how this interface will evolve in the
future.

5.1.1.8    BUG FIXES

5.1.1.8.1    GENERAL

5.1.1.8.1.1   SwissSalary Direct | PDF Files Cannot Open After Uploading

Task #8256 | 5051.100 (customer with SwissSalary Direct)

Some of our customers have reported that their own PDF documents cannot be opened after upload. The error

message that the file was corrupted would appear. The error has been corrected.

5.1.1.8.1.2   SwissSalary Direct | Synchronization at Slow Document Sending

Task #8175 | 5051.100 (customer with SwissSalary Direct)

Data synchronization took a long time for all employees during document delivery. After intensive analysis the
error was corrected.

5.1.1.8.1.3   Translations Into IT | Figli Instead of Bambini

Task #8299 | 5051.100

We were informed by our Italian speaking customers and partners that the use of the word Bambini in relation
to child allowances is incorrect, and that the word ‘figli’ should be used. Following full revision, word Bambini
was replaced with word Figli.

5.1.1.8.2    EMPLOYEE

5.1.1.8.2.1   Employee Banks | Column Salary Type Filter Can Be Selected

Task #8131 | 5051.100

The new “Salary type filter” column could not be displayed in the staff banks overview. This has been fixed.

5.1.1.8.2.2   Statistics | Column Naming (Hours/Days)

Task #8173 | 5051.100

The balance of holidays, overtime, etc. are displayed in the Employee Card -> tab Statistics. By mistake,
columns “Hours” and “Days” were overwritten with “Holiday hours” and “Holiday days” in an earlier update.
This has also been corrected.
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5.1.1.8.3    PAYROLL SETUP

5.1.1.8.3.1   Years of service | Year-of-service Period Type Can Be Changed | After Change to Pro Rata

Task #8305 | 5051.100

The pro-rata calculation type was introduced as a new option during an earlier update. It allows flexible
calculation of years of service and sums up individual and part-months. When switching to pro rata, the
remaining 3 features in the payroll master data were deactivated.

This is incorrect for period type selection. The calculation and presentation of the years of service continue to
refer to the options

- accounting period (Jan 1 - Dec 31
- Entry date period (date of recruitment – last day before the date of recruitment)

For the existing customers who switched to pro rata, the calculation was made correctly because the period
type was retained. For new customers this value was wrong. The period type field can be changed again.

Further information can be found in the dedicated manual.

5.1.1.8.4    PROCESS PAYROLL

5.1.1.8.4.1   Report Journal / TapBoard | Link in the Staff Card

Task #8281 | 5051.100

You can navigate to the Employee Card, wage items, etc. directly from the menu bar of the Report journal and
TapBoard. Up until now, the employee name was used that was replaced with the Employee Card.

5.1.1.8.4.2   Color Rendering Optimized In RTC

Task #8383 | Update 5051.100

Color representation of weekends can be defined during work group setup. This setting had no effect in the
RTC client. This was corrected.

5.1.1.8.4.3   Web Client | Create DTA

Task #8227 | Update 5051.100

The capabilities in the web client should be the same as in the Windows client. DTA files can also be created
directly in the web client.

5.1.1.8.4.4   Write DTA File | NAV 2013 R2 | Troubleshooting

Task #8262 | 5051.100

The DTA file could not be created in some builds of Microsoft Dynamics NAV 2013 R2. This bug has been
fixed.

5.1.1.8.4.5   Correction of Immediate Curtailment | Error Message Upn Exit Fixed

Task #8146 | 5051.100
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If the curtailment correction is set to “immediate” in the Refunding of absences and the employee resigns, the
error message “Please limit the period” appeared. As soon as the unit fixed value was filled in the work group,
the error message no longer appeared. This error message no longer appears without a fixed value.

5.1.1.8.4.6   Automatic BVG Calculation | Adjustment of Percents by Position and Wage Rate Value via TimeMachine

Task #8211 | Update 5051.100

If percents by position and wage rate value were changed simultaneously during automatic BVG calculation in
TimeMachine, only one of the two characteristics was taken into account for the calculation. It is now ensured
that both properties influence the calculation.

5.1.1.8.4.7   Calculation of Holiday Correction | Age/Years of Service Accumulation

Task #7015 | 5051.100

In the Refunding of absences, the holidays can be parametrized according to age and/or years of service. If
these two features depend on one another, the combination of limits is meant here. I.e., holiday entitlements
and vacation corrections upon resignation are calculated not only according to the age level, but also taking
into account the number of years of service at the same time (rarely used).

However, this type of calculation (combination of limits) had a calculation error in the case of automatic output
shortening, which has now been corrected.

5.1.1.8.4.8   Provisional Cost Accounting Submission | SWS TEMP Items are Deleted Correctly

Task #8353 | 5051.100 (SwissSalary BAU version)

Temporary items (SWS-TEMP) from the provisional cost accounting submission in the BAU version were not
deleted during the definite pay process run. This bug has been fixed.

5.1.1.8.5    SALARY DECLARATION

5.1.1.8.5.1   Error Message When Writing 2D Bar Code | Incorrect Country Code In Workplace

Task #7946 | 5051.100

The 2D bar code for the wage statement can only be written if the country code is blank (empty) or CH. Other
entries are now ignored during XML writing.

5.1.1.8.5.2   ELM | 2-digit Insurance Code Validation

Task #8077 | 5051.100

Insurance code in the payroll master data in the KTG and UVGZ must always have two digits. This code is
usually A1, A2, 11, 12, etc. (depending on the insurer) and includes the distinction between the group of
persons (first digit) and the division within the group of persons (second digit). Previously, it was possible to
record only one digit. From now on, a validation is made already when you enter the insurance code. No error
appears during ELM submission.

Note
Please always ask for the ELM insurance profile from your insurer.

5.1.1.8.5.3   ELM | Faulty XML For Multiple Retroactive Corrections

Task #7773 | 5051.100
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When multiple corrections have been applied to the withholding tax at the same time, e.g. change of canton
with simultaneous birth of a child and resignation date, etc., there were in some cases problems with XML file
submission via ELM. Individual mutations were not processed in the correct order. This error has been fixed.

5.1.1.8.5.4   ELM | Canton of VD Withholding Tax Rate Notices

Task #8156 & Task #8178 | 5051.100

The withholding tax canton of VD is the first canton to provide rate notices (confirmations). These notices are
listed in the ELM process under View reply.

Some customers have reported that when this rate notice is fetched, an error message appears because the
confirmation exceeds 250 characters (default value of the swissdec certification authority). We have now split
the notices during the import into several lines. Thereby, even very long messages can now be read without
problems.

5.1.1.8.5.5   Wage Reporting | Optimizations (RTC Client Only)

Task #8213 | 5051.100

In the case of wage reporting (ELM), also BVG insurers with no assignments to the ELM have appeared in the
RTC clients. This has been fixed.

5.1.1.8.6    ADMINISTRATION

5.1.1.8.6.1   Payroll Area | Balance Display in EasyRapport

Task #8257 | 5051.100 (Customers using SwissSalary EasyRapport)

There were problems with balances in SwissSalary EasyRapport dashboard (holidays, overtime, etc.). These
settings played a key role in the Payroll Area. This bug has been fixed.

5.1.1.8.6.2   Open interface | Logic Improved When Prefix/Suffix is Deleted

Task #8377 | 5051.100 (SwissSalary BAU- und SwissSalary NAV Plus-Version)

There is an option in the open interface settings to delete the so-called prefix or suffix (example for prefix =
super-, e.g. supermarket | example for suffix = -er, e.g. worker). For example, some time-management
manufacturers provide in the interface a comma before or after a value that must be deleted.

Columns in the Open Interface:
- Delete prefixed character (suffix)
- Delete character at the end (prefix)

If a manufacturer provided a value with suffix AND a prefix, there were problems. We have corrected this.

5.1.1.8.7    REPORTS | INTERFACES

5.1.1.8.7.1   Employee List | Number of Employees Totalizing Error

Task #8298 | 5051.100

There was an error in the totalization of the number of employees in the employee list due to the date filter
choice. This bug has been fixed.
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5.1.1.8.7.2   Child Allowances/Education Benefits Procedure | Layout Revision

Task #8066 | 5051.100

The layout of evaluation for child allowances/education benefits has been revised and improved.

5.1.1.8.7.3   Raise Salary List | Wrong Output Based On the Role In Excel

Task #7902 | 5051.100

The Raise Salary List can be exported to Excel based on various criteria. The export function based on the role
lead to switching the employees in Excel (paper report was OK). This Excel export bug has been fixed.

5.1.1.8.7.4   Annual Employee Statement A4I | Performance Greatly Improved (2)

Task #8192 | 5051.100

Some of our customers have reported that Annual Employee Statement A4I preparation with many employees
took very long time. We were able to greatly increase the performance.

5.1.1.8.7.5   Annual Employee Statement A4I and Salary Entry | Translation to EN Adjusted

Task #8319 | 5051.100

The layouts of the two reports ‘Annual Employee Statement A4I’ and 'Salary Entry' were slightly revised in the
English translation.

5.1.1.8.7.6   Annual Employee Statement A4I | Layout Revision

Task #8061 | 5051.100

The layout of the Annual Employee Statement A4I report has been improved. Specifically, the Last/First Name
field has been extended.

5.1.1.8.7.7   Salary certificate | Text Overflow for Long User Names

Task #8201 | 5051.100

The salary certificate could not be created in a few cases if the SwissSalary user name had too many
characters (50). This has been fixed.

5.1.1.8.7.8   Salary certificate | Field Service Calculation at Federal Level >100%

Task #8101 | 5051.100

During automatic field service calculation, depending on the constellation at the at federal level more than
100% were displayed in error. This was corrected.

5.1.1.8.7.9   Employee History | Layout Revision

Task #8091 | 5051.100

The Employee History evaluation layout was modernized.
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5.1.1.8.7.10   Attestation of Employer ALV and Intermediate certificate of profit ALV | Texts & Layout Revised

Task #7988, Task #8069, Task #8152 & Task #8249 | 5051.100

Attestation of Employer (ALV), Attestation of Employer ALV (int) and Intermediate certificate of profit ALV have
been slightly reworked in terms of text and layout. The revision of these forms is a constant process since the
evaluations are continually revised and re-delivered by SECO.

5.1.1.8.7.11   Vacation Control & Vacation List | Sorting by Department

Task #6764 | 5051.100

Both evaluations Vacation Control and Vacation List were reworked in the RTC versions with regard to the
sorting by department. The sorting now works like in the old Classic Client.

5.1.1.8.7.12   Human Resources | Alternative Addresses | Sorting

Task #8384 & Task #8385 | 5051.100 (SwissSalary BAU version)

The Alternative Addresses report has been updated and the sorting has been improved (search term).

5.1.1.8.7.13   Report Journal | Layout Revision

Task #8003 | 5051.100

The Report Journal report has been revised and improved in the RTC versions.

5.1.1.8.7.14   EasyRapport Card | Optimizations In Other Languages

Task #8232 | 5051.100

EasyRapport card in other languages has been optimized.

5.1.1.8.7.15   Payroll Journal | Layout Revision

Task #8189 | 5051.100

Payroll journal evaluation layout was slightly revised.

5.1.1.8.7.16   BVG-DTA List | Layout Revision

Task #7975 | 5051.100

The BVG DTA list layout has been slightly revised since individual column headers could not be completely
displayed.

5.1.1.8.7.17   Hour Statement | Multiple Row Titles Revised

Task #7976 | 5051.100

Multiple row titles in the Hour Statement report were not displayed correctly. The layout has been revised.

5.1.1.8.7.18   Payroll Setup | Header Missing In Preview

Task #8195 | 5051.100
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The Payroll Setup evaluation had an error in the header area when the report was displayed in the preview.
Print preview and PDF were OK. This was corrected.

5.1.1.8.7.19   ARGE Re-invoicing | Report Does Not Display Overheads In Percents

Task #8135 | 5051.100 (SwissSalary BAU-Version)

In the ARGE report, overheads in percents were not displayed. Although, for example, “Base wage + 20%”
was entered for allowances. This bug has been fixed.

5.1.1.8.7.20   ARGE Re-invoicing | Administrative and Cost of Funds Overhead Not Calculated

Task #8309 | 5051.100 (SwissSalary BAU version)

Administrative and cost of funds overhead entered into the ARGE overheads was not taken into account in the
ARGE report. This bug has been fixed.

5.1.1.8.8    NOTICES FOR OUR PARTNERS

5.1.1.8.8.1   Organization | Update Outdated Data

5051.100

With every Update/PreUpdate, the data in the organization with the status "expired" must be updated. For
example, .NET Assemblies have to be re-registered in this PreUpdate, since there is an important
adjustment/improvement in the application.

.NET assemblies are installed on the server (middle tier) with a push of the button, and the client is installed to
allow the objects to be compiled from the client.

5.1.1.8.8.2   ELM Transmitter | Log File Created Instead of ErrorMessage [1024]

Task #8293 | 5051.100

The DLL from ELM transmitter was extended with the ErrorLogFilePath property. An error message no longer
appears. The data content is now written into a log file and displayed in NotePad.

The latest SwissSalary Essentials version 5.1.0 must be installed for Classic clients up to and including NAV
2009 R2. For NAV 2013 or later, the latest .NET Assemblies must be installed. They are displayed as
“expired” in Organization.

5.1.1.8.8.3   .NET Assemblies | Usage Check During Deletion

Task #8092 | 5051.100

.NET assemblies are periodically improved and delivered. The existing DLL are deleted and replaced with the
new DLL. A new error message appears now during deletion if a DLL is still in use.

Note
The Middle Tier Service must be stopped and restarted for this manipulation to be executed.

5.1.1.8.8.4   SwissSalary Store | Accepting Proxy Settings

Task #8266 | 5051.100

From now on, SwissSalary Store also accepts proxy settings that can be stored in ELM Transmitter.
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5.1.1.8.8.5   Deleted Table Fields

The following fields have been deleted after Update 5051.000 and, therefore, are no longer available in the
scope of the following updates:

Table 3009080 'SwS Employee' 
- "UVG Cost Centre (Obsolete)" // DELETED Field No. 131 
- "Salutation (Obsolete)" // DELETED Field No. 212 

Table 3009081 'SwS Employee History' 
- "UVG Cost Centre (Obsolete)" // DELETED Field No. 131 
- "Salutation (Obsolete)" // DELETED Field No. 212 

Table 3009083 'SwS Allocated Salary' 
- "Fixed/Variable (Obsolete)" // DELETED Field No. 9 

Table 3009099 'SwS Salary Type' 
- "Subject to PKV (Obsolete)" // DELETED Field No. 26 
- "Following Salary Type (Obsolete)" // DELETED Field No. 80 
- "Following ST - Amount (Obsolete)" // DELETED Field No. 81 
- "Following ST - Rate (Obsolete)" // DELETED Field No. 82 
- "Following ST - Quant (Obsolete)" // DELETED Field No. 83 
- "Following ST - Trans (Obsolete)" // DELETED Field No. 84 
- "Following ST - Sugge (Obsolete)" // DELETED Field No. 85 

Table 3009100 'SwS Payroll Setup' 
- "Employee History (Obsolete)" // DELETED Field No. 11 
- "Franking (Obsolete)" // DELETED Field No. 88 
- "BVG Calculation Mode (Obsolete)" // DELETED Field No. 647 
- "ELM Directory (Obsolete)" // DELETED Field No. 1772 
- "ELM Program Dir. (Obsolete)" // DELETED Field No. 1773 

Table 3009103 'SwS Pension Setup' 
- "Upper Limit Employme (Obsolete)" // DELETED Field No. 50

5.1.1.8.8.6   ADMINISTRATION

Task #8142 | 5051.100

.NET Assemblies, digital certificates, ZIP code and bank master data, etc. are downloaded from the store via
Organization -> SwissSalary Store (menu bar) with a push of a button and then installed. So far, there was no
way to retry this download once the installation was complete (status = current). 

From now on, there is the “Reset Status” function in the menu bar (Organization). Please select the desired
row (for example, .NET Assemblies), click Reset update, and the status will change to “outdated”. Only the
status is updated, while the installed version will not be affected. The download process can be repeated now.

Task #7660 | 5051.100

PDFCreator is used in the old Classic NAV versions (up to NAV 2009 R2 Classic) to create and send wage
documents in PDF format via mail, via IncaMail or via SwissSalary Direct. Prior to PDFCreator 1.7.3, this
software was free both for workstations and for terminal server (Citrix, etc.). Starting from version 2.0.0 (the
current version is 2.5.0), the terminal server version is paid (around € 952/year).



Seite 175

We also recommend that our customers continue to use version 1.7.3, since the newer versions are not
backwards compatible. Please also note that the same PDFCreator version is ALWAYS installed for the
terminal server and for the employee’s client. The manufacturer has deactivated the download link and only
offers the latest version. We have a download link on our website (Magazine – Blog). Of course, we can also
provide you with the software.

PDFCreator is no longer required for NAV versions 2013, 2013 R2, 2015, 2016 and 2017. The PDFs are
created using the PDF tool contained in NAV.

Task #8095 | 5051.100

The specifications are stored in the Payroll Area (social insurance, wage code, etc.) that are set in the
Employee Card for each new employee automatically. These specifications were supplemented with monthly
parts (average monthly hours).

Task #8094 | 5051.100

You can redefine individual data contents in the Open Data Import interface during the import process.

Example
The import file contains entries with salary type 101 you do not want to import. Up until now, these entries had
to be imported, then filtered and deleted manually from the Payroll journal.

Open the Replace view values   in the corresponding column (here salary type) in the Open Interface row tab.
Set salary type 101 in the File Value column, leave the import value blank. Place a check mark in the new
column next to ‘Skip line’. That’s it. During the import process, all rows with salary type 101 are not imported.

5.1.1.9    REPORTS | INTERFACES

5.1.1.9.1    Attestation of Employer ALV | Company Address from Payroll Area

Task #8129 | 5051.100

Company Address for the following documents

- Attestation of Employer ALV
- Employer's Certificate ALV (int)
- Intermediate certificate of profit ALV

is retrieved based on the company data.

There is an option in the Payroll Area to enter a different address. This assigned company address is now
retrieved if one is recorded in the Payroll Area.

Exception:
This is impossible in SwissSalary NSP, since an employee can have several appointment that can be
assigned to different payroll areas.

5.1.1.9.2    Employer's Certificate ALV (int) | Adjustment of Paragraph 16 + 17 Calculation

Task #5884 | 5051.100
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Calculations in paragraphs 16 and 17 have been revised and improved.

5.1.1.9.3    Allocated Salary | Excel Export Optimized

Task #8245 | 5051.100

The Allocated Salary report was optimized for Excel export to make it possible to create also filters and totals.

5.1.1.9.4    Salary Type List | Search Term and UserText Displayed in Bold

Task #8045 | 5051.100

The Search term and UserText columns are now shown in bold in the salay type list, if the salary type is
marked with the Header type. It was done for better overview in the salay type list.

5.1.1.9.5    Payroll Journal | Now Includes Excel Export

Task #8217 | 5051.100

The Payroll journal in the Report Journal can also be exported to Excel.

5.1.1.9.6    Difference List | Gross Wage

Task #8296 & Task #8322 | 5051.100

The difference list is used in the wage calculation process to make differences between two pay processes
visible. However, gross wage could not be compared. It was added.

5.1.1.9.7    FAK Banks | New XML Interface Definition

Task #8068 | 5051.100

The following error message appeared in the case of data inconsistency during FAK Banks interface creation
(in the menu under Cantonal Assessments):

This message is intended for C/AL-programmers: Failed to call 'System.IO.StreamWriter.Dispose': A closed
file could not be accessed.

This error message appeared only if the data of a child was not fully entered (missing child's social security
number or family status, etc.). The XML interface was updated according to the latest guidelines. In addition,
the error messages are now displayed correctly. The above error message no longer appears.

5.1.1.9.8    Sending Salary Certificate | Via Mail, IncaMail or PrivaSphere

Task #8162 | 5051.100

In the employee portal, our SwissSalary Direct customers can provide employees with the payslips, wage
statements and other documents. Customers sending wage documents via mail (not recommended) or via
IncaMail or PrivaSphere in an unencrypted form, could not submit wage statements. This capability has been
remade.
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For this to get done, go to the menu bar in Process Payroll -> Actions and open the “Salary Certificate PDF"
menu item (RTC client). Navigate in the old Classic Client to Payroll Log -> button Salary journal -> Salary
certificate PDF.

In addition to the common selection options (date, language, etc.), the following four fields are available:

Directory
Directory to store the PDF files. Only mandatory in the old Classic client. In the roll-based client (RTC), the
field can be left blank when files are sent via email.

File Name
PDF file name (for example, Wage Statement 2017). If not present, the PDF extension is automatically added.
If the field is left blank, name “Salary Certificate” will be used.

Email
When sending emails, the corresponding email configuration must be selected here. If the field is left ‘empty’,
the files are only stored as PDF and are not sent.

Attach document
Optionally, another document may be added as an attachment to the email (e.g., year-end info).

5.1.1.9.9    Sending Payslip | Via Mail, IncaMail or PrivaSphere

Task #8225 | 5051.100

To get additional information on this topic, please follow this Link.

The interface had to be revised so that the payslip could also be sent via mail and a web client.

For this to get done, go to the menu bar in Pay process -> Actions and open the “PDF Document" menu item
(RTC client). Navigate in the old Classic Client to Pay Process Journal -> button Payroll journal -> PDF
Document.

Directory
Can be left blank if PDF files are to be sent. If a directory is selected, the PDF files in this directory are stored
in a folder named with the current date/time. For technical reasons, this does not work for the web client.

File Name
Can be left empty (default name: “Lohnlauf 1 Personal 1000”). If the file name is specified, placeholder %1 (pay
process No.) and %2 (employee No.) must be included in the name (for example, “Pay process %1 Employeef
%2”). If not specified, the PDF extension will be added automatically.

Email
Must be specified if files are to be sent via email. The document is sent to the email address selected in the
“Electronic delivery” field in the Staff Card. If no address is selected, document will not be sent.

Attach document
Optionally, another document may be added as an attachment to the email

5.1.1.9.10    Account Reconciliation | Excel Export Optimized

Task #8246 | 5051.100

The Account Reconciliation report was optimized for Excel export also to make it possible to do calculations.
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5.1.1.9.11    Income Tax Wage Statement for the Canton of FR | Report Removed

Task #8205 | 5051.100

Prior to the introduction of ELM, the canton of FR has requested a cantonal wage statement per employee.
This specific report is no longer necessary after clarifications received from the income tax office of the canton
FR, provided that the income tax statements are submitted using ELM.

The report has already been removed from the menu and will be deleted in PreUpdate 5051.200 and/or
5052.000. If you still submit the income tax statement for the canton of FR in paper form, we urge you to move
to ELM.

5.1.1.9.12    Sunet Interfaces | Accident Details and Insured Wage Claim

Task #8134 | 5051.100

Sunet interfaces have been revised so that the categories are assigned in the new field “Damage details” in
salary type -> tab Absences. This means that you can now decide more flexibly which amounts should be
transferred to which area in Sunet. The following options are available:

A - Main salary
B - Family allowances
C - Vacation and Holiday Allowance
D - Other Salay allowances
E - Bonus and 13th Payment

In the new “Damage insured salary” field, you can also decide whether the value of this salary type should be
considered 

- retroactively (average of the last 12 months) or
- presumably (12 months)

. Thanks to this assignment, data quality in Sunet is much more accurate than before.

Enter the assignments in the wage types before the next file export.

5.1.1.9.13    Sunet Interface 4.00-1081 | Removed

Task #8133 | 5051.100

The old Sunet interface 4.00-1081 has been removed since it is no longer being used.

5.1.1.9.14    UKA Interfaces | Accident Details and Insured Wage Claim

Task #8138 | 5051.100

UKA interfaces were also revised like Sunet interfaces. The two new fields "Damage Deteail" and "Damage
insuredn salary" perform the same function as in the Sunet-interface.

5.1.1.9.15    UKA Import Interface | Document Date Based On File Value

Task #8147 | 5051.100
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Using the UKA import interface, daily allowances calculated by UKA are placed directly into the Report journal.
Up until now, a date for daily allowances had to be recorded at the start of the import. This date is now
imported directly from data content.

5.1.2    PreUpdate 5051.200 (31.08.2017)

5.1.2.1    INTRODUCTION

Please note the introduction to the update 5052.000 from 26.10.2017.

5.1.2.2    NEW FEATURES

5.1.2.2.1    Daily Allowance Calculation | Now Also for Daily Sickness Benefits

Task #8527 | 5051.200

In PreUpdate 5051.100, we introduced the new calculation option for accident daily allowance. From now on,
you can also automatically calculate the daily allowance estimate for the daily sickness benefits. The new
options can be found in the Wage Type setup -> tab General -> field Wage rate estimate.

Select the «KTG Daily Allowance Amount» option for the corresponding daily allowance wage type. The
estimate is calculated automatically on the basis of the individual wage type obligations as well as the
«Insured Wage Claim» field in the Absences tab. See also the notes in chapter Calculation of Daily Allowance
Estimate (UVG).

5.1.2.2.2    Personnel Dossier | Automatic Import of Link Documents into Database

Task #8538 | 5051.200

Customers managing documents in the Personnel Dossier (SwissSalary NAV Plus is a precondition) have had
the opportunity to link the documents to a drive (link) or to upload the documents directly to the NAV
database. We recommend integrating the documents directly into the database, since the “link” function has
many disadvantages. If, for example, the drive concept is restructured in the company, the documents in files
lose the link and can no longer be opened.

In a later update, we will remove the «link» option in the “Payroll master data -> tab General -> Dossier save
mode”. Afterwards, new documents can only be imported into the NAV database.

We have developed an automatic import feature for customers who want to switch from “link” to “database”
import. Change the value from “Link” to “Database” in the Payroll master data. The following query will appear:

All documents are now imported into the NAV database. Do you want to continue?

By clicking Yes, all documents in the Dossier will be automatically transferred to the NAV database.
Documents with a missing link (document no longer exists in the drive path) will not be skipped. If the
documents are not found, because they are all in a different drive, the value can be reset to Link again and
switched back to Database. The import process will restart.

5.1.2.2.3    Fibu Interface | Import Feature for External NAV Database

Task #7308 | 5051.200

Some customers work with SwissSalary NAV in an up-to-date NAV version, e.g. NAV 2015 or NAV 2017. The
rest of the modules, including the one for financial accounting, are stored in another, usually older NAV DB
version, e.g. NAV 5.0. SwissSalary NAV is familiar with the default FIBU interface for Microsoft Dynamics
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NAV. That means that, if desired (if set up in the Payroll master data), the payroll data for the Fibu is also
exported via the text interface using the Wage posting process.

On the side of the “external” NAV database (Fibu module), the data should then be imported into the Fibu
registration journal. 

The «3009271 SwS G/L Journal Import» report is delivered again in the standard scope of SwissSalary NAV. If
the NAV license with the SwissSalary NAV modules is missing from the “external” NAV database, the report
can be copied into a company-specific report by the NAV partner. This report can be made available in the
FIBU recording journal and/or in the corresponding Role Center.

The following information must be recorded when the report is started:
- Registration journal template name | mostly GENERAL
- Registration journal name | e.g. $L-ML$
Filename | The path of the previously created text file

After clicking OK, the payroll data is ready for revision/posting in the desired FIBU registration journal.

5.1.2.2.4    Dynamics 365 for Finance and Operations | New FIBU/Wage Interface

Task #7996 | 5051.200

There is now the standardized FIBU interface for ERP solution “Dynamics 365 for Finance and
Operations” (formerly Microsoft Dynamics AX) that can be selected in “Payroll master data -> tab Settings ->
field Interface” (Dynamics 365 (AX)).

The interface has basically been designed and tested for the following versions:
Dynamics 365 for Finance and Operations, Enterprise Edition
Platform version: Update 9 (7.0.4612.35162).

The delimiter for Fibu accounts and dimensions is |. The delimiter can be defined in Dynamics 365 for Finance
and Operations in settings.

For example, the financial accounting account and the dimension values (CC, CU, etc.) are exported as
follows:
5000|Dimension value 1 (e.g. CC)|Dimension value 2 (e.g. CU)|Dimension value 3 (e.g. Area)

Example:
5000|CC1|CU25|Area5

The export order of dimension values is determined by the order of the global dimension codes 1 and 2 and the
1 - 8 dimension codes shortcut in financial accounting settings. In Dynamics 365 for Finance and Operations,
the order of import can be parameterized via settings.

For the sales tax group (VAT business posting category in Dynamics NAV), «All-tax» is always exported. The
value for the Fibu posting journal is GenJrn.

5.1.2.2.5    Office 365 Integration | SharePoint Connection Settings

Task #7168 & Task #7187 | 5051.200

RTC NAV versions starting from NAV 2016 offer the option to integrate document storage in Office 365
(SharePoint). In Dynamics NAV, the service ID and the folder where the data is to be stored are specified in
the menu item SharePoint Connection Setup.
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If an Excel or Word file is created from any module via Dynamics NAV 2016 or NAV 2017, it is automatically
placed in the folder defined in SharePoint (Office 365) instead of the local folder.

For further information on this integration, please contact your Dynamics NAV partner.

5.1.2.3    EMPLOYEE

5.1.2.3.1    ID | Field Will Be Checked if Already Available

Task #8474 | 5051.200

The ID field is re-validated as to whether the abbreviation is already used for another employee.

5.1.2.3.2    Employment Relationship | Apprentice and Trainee | Field Content Relocated

Task #8457 | 5051.200

The “Employment Relationship” field in the Statistics tab has been revised. The “Apprentice” and “Trainee”
options have been removed because they must be maintained in the “Employment contract” field. There are
options “Apprenticeship contract» and “Internship contract” of the wage structure survey official fields.

Update is used to check whether a value has already been selected in the Employment contract field. If not,
the old Apprentice value is linked to “Apprenticeship” and the Trainee value is linked to “Internship contract”.
The “Temporary” value remains in the “Employment relationship” field.

5.1.2.3.3    Infobox Personnel Dimension | Display Current Dimensions Only

Task #8537 | 5051.200 (nur RTC-Versionen)

The Personnel Dimension infobox has been provided with the Valid from/to filter. Only valid dimensions are
displayed based on the working date.

5.1.2.3.4    Base Wage Matrix | Revised Completely in RTC Versions

Task #8315 | 5051.200 (RTC versions)

The basic wage matrix has been completely revised in RTC versions.

The matrix displays minimum wages per wage class/wage level and per time axis on the X/Y axis. Some
customers have a lot of wage classes/wage levels, so the previous application had difficulties. An infinite
number of columns can now be managed. The “Previous and next set” buttons now work correctly.

5.1.2.4    PAYROLL LOG

5.1.2.4.1    TAPBOARD

5.1.2.4.1.1   TapBoard | Simplified Cost Center Selection and Acquisition

Task #8434 | 5051.200 (SwissSalary BAU)

In the SwissSalary BAU industry solution, cost center selection in TapBoard in the RTC client is more
complex than in the earlier Classic client. We have made an adjustment to simplify this process. Proceed as
follows:

1) Select the row in TapBoard, where the cost centers should be entered
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2) Ctrl+D (for dimensions)
3) Enter cost center number
4) Click Ctrl+Enter or OK (acquire cost center number in the row)

5.1.2.4.1.2   TapBoard | Entering Comments for Employees

Task #8435 | 5051.200

Comments for the employee (internal/external for payroll) can be recorded In the Staff card and Report journal.
These comments could not be viewed or revised in the TapBoard. The Comment button is now in the menu bar.

5.1.2.4.2    PROCESS PAYROLL

5.1.2.4.2.1   Export Payment Files | Windows Explorer Not Opened Anymore

Task #8402 & Task #8403 | 5051.200

Payment files handling was changed along with the introduction of the ISO 20022 file with PreUpdate
5051.100. After writing of the file, Windows Explorer was automatically opened (payment file path). This
automation has confused several customers. From this version onwards, after the payment file is created, an
information message with the execution progress and the indication of the path appears.

5.1.2.4.3    POST PAYROLL

5.1.2.4.3.1   Wage Posting Routine Revised for the Whole Area

Task #8514 | 5051.200

The code in the Wage Posting process has been completely revised. With this refactoring, we have optimized
the code that is still derived for the new RTC clients from earlier NAV versions.

5.1.2.5    SALARY DECLARATION

5.1.2.5.1    ELM | Comments are Provided | New Report Button

Task #8104 & Task #8361 | 5051.200 (RTC versions)

Using wage reporting via ELM, you have the possibility to sending the receiver of the message a short note,
e.g. “contains all employees without BM”, etc. This notification can be transmitted per recipient and/or to all
recipients if you send it to multiple recipients at the same time. These capabilities have been improved.

In the course of this improvement, the options in the RTC versions were newly prioritized. Only the fields
required or usually used for ELM transmission are now visible. The other options can be displayed using “Show
more fields”. With this, the operation is easier than before.

The reporting itself no longer takes place by clicking “OK”, it takes place by clicking the «Report» button in the
ribbon.

5.1.2.5.2    ELM | WT Reporting | CHF 0 Reporting When an Employee Has Not Worked

Task #8427 | 5051.200

We have received feedback from customers that some WT offices have problems when an employee is not
reported in case s/he has not been paid wages in one month. According to the valid ELM guidelines, this
situation is correct, but partly not plausible for WT offices.
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If an active employee subject to withholding tax had no salary in one month and, therefore, there is no WT
deduction (unpaid leave, hourly wage without employment), this employee is now reported with CHF 0.00 WT
base.

5.1.2.5.3    ELM | Child Allowance From/To Date Improved

Task #8439 | 5051.200

For some insurers, in addition to reporting of children, the from/to date of child allowances must also be
reported. From now on, the end date of the education benefits is taken into account in the “to date” based on
the entry in Personnel Master Data -> Children -> Education Benefit until. Thanks to this adjustment,
employers should have fewer questions.

5.1.2.6    ADMINISTRATION

5.1.2.6.1    Payroll Area | Credit Balance Inhibited In EasyRapport

Task #8314 | 5051.200 (concerns the customers using SwissSalary EasyRapport)

From now on, credit balance can be inhibited via Payroll Area -> tab EasyRapport Display. This means that a
possible credit balance is no longer displayed for the employee in EasyRapport (similar to payslip).

5.1.2.7    REPORTS | INTERFACES

5.1.2.7.1    Cover Letter, Short Letter & Fax | Consideration of TimeMachine When Changing Address

Task #8507 | 5051.200

Address changes made in TimeMachine were not taken into account in the three assessments, Cover Letter,
Short Letter and Fax, that can be launched via Personnel card/Personnel list. It was added.

5.1.2.7.2    Intermediate certificate of profit ALV | Other Wage Components| Now CHF or %

Task #8511 | 5051.200

A percentage or amount can now be recorded in item 10 of the ALV Temporary Employment Certificate
document (other wage components).

5.1.2.7.3    Wage Allocation (Allocation Salary) | Excel Export Improved

Task #8376 | 5051.200 (5051.100)

Excel export of the Wage Allocation (Allocation Salary) assessment has been completely revised and
improved. Wage items can now be revised in Excel.

5.1.2.7.4    Salary certificate | Private & Confidential In Front of the Address

Task #6326 | 5051.200

You can define in Payroll Setup -> tab Paycheck whether the “Confidential” notice is to be displayed on the
paycheck. The same now also applies to the wage statement. If you want a different expression, e.g. “Private”,
you can accordingly define it in translations.
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5.1.2.7.5    FIBU Posting Journal | Time Balance Provisions

Task #8551 | 5051.200

It is now possible to report in the FIBU Posting Journal report time balance provisions (holidays, overtime, etc.)
that affect the expenses. The “Time Balance Provisions” option field appears only if the setting exists in Payroll
master data -> Provisions ribbon, and the customer has also licensed SwissSalary NAV Plus (a basis for
calculation).

5.1.2.7.6    BAU | BauBit Pro Interface | Settings

Task #8557 | 5051.200 (SwissSalary BAU only)

To be able to import the work and absence hours recorded in BauBit Pro correctly into the Report journal, the
following settings are required:

EasyRapport group -> Card
The Report journal (Journal) to enter the data to must be specified in the EasyRapport group card.

Employee card -> tab EasyRapport -> EasyRapport group
The correct EasyRapport group must be defined for the employee. This is the only way that employees can be
assigned to the correct journal during import.

Payroll journal -> Origin type filter (Import)
Depending on the BauBit version, the value ‘Baubit’ or ‘Baubit Pro’ must be stored in this filter.

The data from BauBit can be easily imported only if these three settings/assignments are made correctly.

5.1.2.8    SWISSSALARY DIRECT

5.1.2.8.1    Document Delivery Generally from the Dossier | Continue After Abort

Task #8559 | 5051.200

All payslips and wage statements are now sent via Personnel dossier. I.e., each PDF is stored first in the
Personnel dossier for the corresponding employee. If this PDF creation fails for any reason, all dossier entries
will be rolled back. The delivery (via payroll/wage statement) can simply be restarted then.

The SwissSalary Direct delivery is only started when all documents are stored in the dossier. If the delivery is
interrupted due to a network error, etc., you will find the button “Send dossier documents” in the menu bar in
the SwissSalary Direct settings. Click this button to send the documents.

With this new process, we want to prevent any network disruption and ensure in every situation that a transfer
is made completely.

5.1.2.8.2    Share Documents from Dossier | Partial Automation

Task #7480 | 5051.200

In the employee dossier, employees’ PDF documents can be directly submitted to SwissSalary Direct.
Previously, a checkmark in the “Direct” columns and a date in the “Visible from” field had to be set if the
submission did not take place immediately. The submission to SwissSalary Direct was not executed until the
next synchronization.

This process has been “partially automated”. You will find the “Send with Direct” button in the menu bar. You
no longer have to consider the two fields “Direct” and “Visible from”. When you click “Send with Direct”, you will
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be prompted again for the “Visible from” date. After clicking OK, the documents will be sent. The date of
sending is displayed in the new “Direct Upload on” column in the document row of the Dossier.

5.1.2.8.3    Set Up Task Queue for Scheduled Synchronization (Auto-Sync)

Task #7856 | 5051.200 (NAV 2013 and above)

Beginning from NAV 2013, there is the “Task Queue” feature using which scheduled processes can be defined.
We use this standardized feature, for example, for automated EasyRapport transfer and now also for
SwissSalary Direct automated synchronization (Auto-Sync).

You will find the “Auto-Sync Activated” field in the SwissSalary Direct settings. Put a check mark here. The
following query will appear:

SwissSalary Direct Auto-Sync was set up. Would you like to open the Auto Synchronization Settings
window?

If you confirm this by clicking “Yes”, the “Task Queue Map” will appear. If you click “No”, the Auto-Sync will be
still active, but the window will not open. If the check mark is removed, the queue will be also deactivated in the
background (but not deleted, no special settings will be lost).

You can specify the days and frequency of the synchronization in the Series tab of the “Task Queue Map”. All
the required settings are made via automated setup.

In NAV 2013 + 2013 R2, the command queuing optimization must still be started manually ([client name]
\Departments\Administration\Application Setup\Task Queue\Task Queues) -> Start Task Queue. Starting from
NAV 2015, this step is no longer required.

5.1.2.8.4    Newly Registered Employees No Longer Receive Paper Payroll

Task #8554 | 5051.200

Previously, the employee that had registered for SwissSalary Direct during the month would receive a paper
payroll (additional delivery via SwissSalary Direct) at the next payroll processing. Beginning from this version,
the document is only offered in SwissSalary Direct and no longer in paper form.

5.1.2.8.5    Reset Synchronization | Feature Hidden In the Menu Bar

Task #8346 | 5051.200

We have added the “Reset Synchronization” feature with Update 5051.000. This feature entirely resets
SwissSalary Direct settings. It is to be used only when, for example, a synchronization has been carried out
by mistake from a copied test client.

Unfortunately, this feature was misunderstood and used in a wrong way by some customers. We have
removed this feature from the ribbon.

This feature can be displayed in the “Actions -> General” area by clicking the right mouse button -> Customize
menu bar. Please contact your NAV partner or our Support before using this feature.
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5.1.2.9    BUG FIXES

5.1.2.9.1    EMPLOYEE

5.1.2.9.1.1   TimeMachine | Address Changes after the Working Date Displayed In Personnel Card/List

Task #8525 | 5051.200

If address changes are scheduled in the TimeMachine during the month, they are displayed in the Personnel
Card and in the Personnel List only after wage posting.

It was corrected based on the working date. This also applies to the short letter, cover letter, etc.

5.1.2.9.1.2   Personnel Dimensions | ShortCut Changed

Task #8501 | 5051.200 (only RTC versions of NAV 2013 and above)

The shortcut for calling personnel dimensions has been changed from Ctrl+Shift+J to Ctrl+Shift+D.

5.1.2.9.1.3   Copy Personnel Feature | Personnel Statistics | Copying Employee Groups Correctly

Task #8526 | 5051.200

The Copy Personnel (copy Personnel Card to another client) feature had a minor error if personnel statistics
were different in the source and target client. The statistics groups are now retrieved by the target client and no
longer by the source one.

5.1.2.9.2    PAYROLL LOG

5.1.2.9.2.1   ISO 20022 | International NAV DB | Table 11500 was not found

Task #8534 | 5051.200

If the customer does not work with a CH NAV database, an error message “The metadata object table 11500
was not found” appeared when setting up the ISO 20022 bank. This error was corrected.

5.1.2.9.2.2   Report Journal | Document Date Earlier Than 01/01/1800 Cannot be Recorded

Task #8397 | 5051.200

In a few individual cases, data from external systems was transferred to the Report journal with the date
01/01/0000. From now on, it is verified during data import and during manual entry that the document date is
not earlier than 01/01/1800.

5.1.2.9.2.3   BAU | Retrospective Pay Change with TimeMachine | Load Fibu Cost Type

Task #8397 | 5051.200 (SwissSalary BAU)

If a wage was corrected retrospectively using TimeMachine, cost type was not filled in the Cost Type column,
which resulted in an error during wage posting. This bug has been fixed..

5.1.2.9.3    SALARY DECLARATION

5.1.2.9.3.1   ELM | Company Data | Name 2 Causes XML Validation Error

Task #8502 | 5051.200
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In rare cases, the Name 2 field is filled with data along with the Name field. This caused a validation error
during ELM submission, which has been corrected.

5.1.2.9.3.2   ELM | Spaces in WT Payroll Number (SSL Number)

Task #8469 | 5051.200

If an empty space is recorded by mistake for the WT payroll number instead of a valid payroll number in the
Payroll Master Data, an error message would appear during ELM submission. This error was corrected.

5.1.2.9.3.3   ELM | NAV 5.0 | Feedback From Distributor (Error) is Now Displayed Correctly

Task #8531 | 5051.200 (NAV 4.00 SP2 - NAV 5.00 SP1 only)

Starting from PreUpdate 5051.100, feedback (error) from the distributor, e.g. because the sent XML is valid but
not plausible, is displayed as a text file via Notepad.exe. It has worked in the newer versions, in NAV 4.00 SP2
- NAV 5.00 SP1 only an empty text file was created. This error was corrected.

5.1.2.9.3.4   ELM | Retroactive Canton Change With Complete WT Repayment In the Same Year

Task #8541 | 5051.200

We corrected an error that could only appear during WT reporting in very rare cases. If all WT contributions for
an employee were corrected to CHF 0 as a result of a retroactive change of canton in the current reporting
year, and s/he still was the only employee in this canton, a validation error appeared during reporting. The error
in this rare configuration has been corrected.

5.1.2.9.4    ADMINISTRATION

5.1.2.9.4.1   Time Types | Translations In All Clients Deleted If Time Type is Deleted

Task #8408 | 5051.200

The Time Types table is a cross-client table. That means that when you create or rename a new time type, the
change is displayed in all the clients.

A partner has pointed out that the corresponding translations are not deleted in all clients when a time type is
deleted. The translation was only deleted in the client, in which the time type was removed. This was
corrected.

5.1.2.9.5    REPORTS | INTERFACES

5.1.2.9.5.1   Personnel File | Header Row is Displayed Correctly (RTC)

Task #6582 | 5051.200 (RTC versions)

The header row on the personnel file was not displayed correctly in RTC versions. This bug has been fixed.

5.1.2.9.5.2   Personnel File | Years of Service and Apprenticeship Date Corrected

Task #8547 | 5051.200

The number of years with many decimal places appeared in the personnel file. Furthermore, the date did not
display correctly for apprenticeship. The corrections were made in the report.
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5.1.2.9.5.3   Personnel Year of Service Details | Display Error Corrected

Task #8496 | 5051.200

Value “119987” was displayed in individual cases in the Month column of the Personnel Year of Service Details
report instead of correct values. This bug has been fixed.

5.1.2.9.5.4   Payroll Setup | Date Format Corrected In Two Fields

Task #6589 | 5051.200 (RTC versions)

The date format including time in the BVG Resignation Date and the BVG Change fields was displayed in the
Payroll Master Data report. This bug has been fixed.

5.1.2.9.5.5   ISO 20022 | Payment Order | Debit Bank Not Printed

Task #8515 | 5051.200

When an ISO 20022 payment file was created, the debit report was no longer displayed in the Payment Order
report. This bug has been fixed.

5.1.2.9.5.6   Open Data Import Interface | WebClient | Data Import via Excel

Task #8453 | 5051.200

The Excel import of the Open Data Import Interface was not designed for the Web Client. The Excel import now
also works via the Web Client.

5.1.2.9.5.7   Payslip as PDF Export | Placeholder %3 ID Activated Again

Task #8521 | 5051.200

Some customers export Payslips as a PDF, then import it back into a foreign system (for example, for
archiving purposes). The following placeholders can be used for filenames:

%1 | Pay process No.
%2 | Employee No.

Unfortunately, placeholder %3 for employee ID was lost due to a refactoring of all PDF export functions in
PreUpdate 5051.100. %3 appeared in the document path instead of the employee’s ID. This was corrected.

5.1.2.9.5.8   Payslip PDF via Email/SwissSalary Direct | PDFCreator Time-Out | Empty Payslips

Task #8480 | 5051.200 (concerns only Classic versions of NAV 2013 and above)

Beginning from PreUpdate 5051.100, there was a problem in older NAV versions when payrolls were emailed
via PDFCreator. The transfer was interrupted in the case of unencrypted PDF mail and/or via SwissSalary
Direct provided that there were “empty” Payslips.

This error has already been corrected as a hotfix for 5051.100 and corrected now in this release.

5.1.2.10    NOTICES FOR OUR PARTNERS

5.1.2.10.1    Organization | SwissSalary Store Also Fully Functional In the WebClient

Task #8438 | 5051.200
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Master data in the organization, e.g. ZIP code and bank master, WT tariffs, etc., can be downloaded from the
SwissSalary Store and installed with a push of a button. There had been various restrictions in the WebClient
that were corrected.

5.1.2.10.2    Migration Report for NAV 2009 in NAV 5 Removed

5051.200

Up until now, there was Migration Report 3009239 SwS Migration NAV 2009SP1_R2 in the object scope of
NAV versions 4.00 SP2 – 5.00 SP1. This report was used if the customer was migrated from Microsoft
Standard Salary to SwissSalary NAV using NAV 4.00 SP2 - 5.00 SP1, but the old payroll objects had already
been installed from NAV 2009.

It was impossible for us to deliver a 100% compileable report in the old NAV database that takes into account
the NAV 4/5 environment object properties as well as the NAV 2009 program objects. The report has been
deactivated.

If you have a migration customer in this configuration, you can always export the same report (R3009239) from
a NAV 2009 database as text and import it into the 4/5 environment. A few field changes are to be adjusted
manually. Please never upload a NAV 2009 report as fob in version 4/5.

5.1.3    Update 5052.000 (26.10.2017)

5.1.3.1    INTRODUCTION

Dear SwissSalary Customers,
Dear SwissSalary Partners,

We present to you the manual for SwissSalary Update 5052.000 of October 26, 2017. It also includes the
updates and corrections of PreUpdates 5051.100 of May 10, 2017 and PreUpdate 5051.200 of August 31,
2017. Your SwissSalary will be up to date after installing this release. We can offer you some great new
features.

IMPORTANT NOTES

q Please make sure that a version not older than 5051.000 of October 18, 2016 was installed before this
update. If your NAV partner has made company-specific changes to your SwissSalary NAV objects, you
must contact your NAV partner prior to installing the objects.

q SwissSalary NAV customers using NAV DB versions 4.00 SP2 and 4.00 SP3
We would like to inform you that the update version 5053.000 of October 2018 will be the last
SwissSalary version available for database versions 4.00 SP2 and 4.00 SP3. Beginning from
PreUpdate 5053.xxx, there will be only updates for NAV 5.00 and later versions.

q SwissSalary NAV customers with NAV DB versions 3.70, 4.00 + 4.00 SP1
SwissSalary Update N5051.000 (October 18, 2016) was the last full version for these NAV DB versions.
There will be only Updates, PreUpdates and Hotfixes for versions NAV DB 4.00 SP2 or later! For further
information, please contact you NAV partners.

q SwissSalary BAU customers with NAV 5.0
SwissSalary Update B5050.000 (autumn 2015) was the last version for BAU 5.0. NO further improvements
are made to the BAU version 5 since autumn 2015.
We kindly request you to migrate from NAV 2015 to the new NEVARIS solution as soon as possible. If you
have additional questions about this topic please contact the NEVARIS support.
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q SwissSalary Role Center | RTC clients starting from NAV 2009 SP1
Since the introduction of the RTC Client, SwissSalary has been using a clearly arranged and intuitive Role
Center. However, we have discovered time and again that some of our customers had not been using it.
System Administrator Manual contains important information thereto.

We hope you will enjoy the latest version of SwissSalary and åhank you for the valuable improvement
suggestions we could implement for you!

Your SwissSalary Team

5.1.3.2    SALARY TYPES

5.1.3.2.1    Following Salary Type Now With Limit Amounts (Minimum/Maximum)

Task #8609 | 5052.000

In the Following Salary Type, the two columns “Maximum amount” and “Minimum amount” can now be
selected. This way, for example, the calculation of incentives for employees (> CHF 500) or further training
costs can be automated.

Example of the incentive for employees:
The following example shows you how to automate the process of accounting for natural incentives over CHF
500 subject to social security deductions.

1. Select salary type 1440 “Natural incentive exceeding CHF 500”.
2. Please copy salary type 1440 as a new salary type 1441. Please change the text of the new salary type to

“Natural incentive less than CHF 500”.
3. Set the new salary type to “Employer Part”. Please set the FIBU account assignment using the same

account/offset account number (no FIBU posting should follow). This wage type has no obligations.
4. Please click “Following Salary Type” in the salary type 1441 and enter salary type 1440. Please set the

1.00 value for “Following Salary – Factor Amount”. Please enter the value CHF 500.05 into the “Minimum
amount” field.

Please test the new salary types in the Report journal. Please always record salary type 1441 with the value of
the incentive first. No resulting wage types will be retrieved in case of amounts below CHF 500.00. Amounts
below CHF 500.00 are not entered in the accounts and also do not appear on the payslip. If, for example, you
register CHF 700.00, resulting salary types 1440 + 8440 are retrieved automatically.

5.1.3.3    PAYROLL LOG

5.1.3.3.1    REPORTING

5.1.3.3.1.1   Payroll Journal | Periode of time column

Task #8571 | 5052.000

The “Periode of time” column can now be selected in the Payroll Journal. It reinterprets the amount of time in
the “Amount” field into text. This way, 8.5h in the “Periode of time column” field is displayed now as “8 hours
30 minutes”. Of course, you can also record text “8 hours 30 minutes" in this column, then 8.5 will be filled for
the amount.
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5.1.3.4    SALARY DECLARATION

5.1.3.4.1    ELM | Long Feedback From Data Recipients Generates an Error Message

Task #8619 | 5052.000

Withholding tax office of the Canton of VD is the only canton occasionally submitting long ELM data
transmission notices/error messages. These notices are usually very detailed. We faced problems displaying
such feedback correctly, especially in the old Classic clients, in terms of text length.

This has been fixed, feedback can be displayed now.

5.1.3.5    SWISSSALARY DIRECT

5.1.3.5.1    Preparing Payslips for “Unregistered Employees” for Printing After Delivery

Task #8621 | 5052.000

Some improvements have been implemented with Update 5051.000 in terms of document delivery. However,
there was some confusion in PreUpdate versions, since payslips for “Unregistered employees” were suddenly
no longer created automatically after delivery. Payslips for printing were only created if the Send documents to
“Registered employees only” option was selected in the SwissSalary Direct settings.

We have revised this process. It now works again like before. I.e. after payslips are delivered automatically,
they are automatically offered for printing to those who have not registered for the service.

For data protection reasons, we recommend setting the “Send Documents to” option to “Registered employees
only”. There is some disagreement as to whether the documents of employees should be published on the
portal before they register for it.

5.1.3.5.2    Send Documents to | Setting the Default Value to Registered Employees Only

Task #8620 | 5052.000

For data protection reasons, we now changed the default value in the “Send Documents to” field in the
SwissSalary Direct settings to “Registered employees only”. We recommend applying this default value.

5.1.3.5.3    Test Mode | Upload via Dossier

Task #8622 | 5052.000

“Test mode” can be activated in the SwissSalary Direct settings. If it is active, PDF documents (e.g. payslip)
are prepared and sent during a SwissSalary Direct delivery, though marked with the “test mode” flag.
Employees cannot see these documents in SwissSalary Direct. 

Moreover, the adjustment brought in PreUpdate 5051.200 allows creating the documents as a PDF first and
then filing them in the Dossier before delivery. Then, the “Test Mode” has not worked correctly anymore.

The “Test Mode” now works again. The documents are created, stored in the Dossier and submitted in a test
form. After the delivery, the “test documents” will be removed again from the Dossier.

5.1.3.5.4    SmartPort | Changed Bank Details Transferred to the Staff Card Correctly

Task #8512 | 5052.000
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With SwissSalary Direct Plus, an employee has an option in SwissSalary Direct to inform about the change of
the bank address in addition to the change of their residential address. With the help of SmartPort, a payroll
staff member can check the data and accept it with a push of a button.

In some cases, there was a problem accepting the changed bank details, unless the address was changed as
well. This has been fixed.

5.1.3.6    REPORTS | INTERFACES

5.1.3.6.1    Personnel File | Personnel Dimensions Output

Task #8528 | 5052.000

The “Personnel Dimension” option is now available in the personnel file. This way, personnel dimensions stored
for employees are displayed in the personnel file.

5.1.3.6.2    ALV Temporary Employment Certificate | Digit 11 Corrected

Task #8511 | 5052.000

There was another small error in digit 11, if the 13th wage was not paid along with the wage at resignation.
Relevant correction has been made.

5.1.3.6.3    Salary Certificate | Language Selection In Workplace

Task #5787 | 5052.000

The language of the workplace can now be entered in the “Language code” column in the workplace. As a
consequence, additional automatic texts on the Salary Certificate are automatically printed in the language of
the workplace. This way, companies aware of workplaces all over Switzerland can create the Salary Certificate
more easily than before.

5.1.3.6.4    BESTA Statistics | Preview Similar to Print Preview In RTC Versions

Task #8614 | 5052.000

This adjustment concerns all RTC versions of NAV 2013 or newer. Cannot be technically implemented in NAV
2009!

If the BESTA statistics or business census are prepared first as a preview, individual fields are not correctly
displayed (shifted). The document is structured correctly only by clicking print preview. Printing, however, has
always been correct.

The preview is now started directly in the print preview and this way correctly displayed.

5.1.3.6.5    Account Reconciliation | Excel Export With Account Layout

Task #8598 | 5052.000

An error in the “Account” layout of the account reconciliation report occurred during Excel export. The
cumulative values in the preview and in Excel were not identical.

This bug has been fixed.
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5.2    Update 5052.000 Systemadmin

5.2.1    SwissSalary Homepage | Update-Download

5.2.1.1    Instructions (3)

How you can enter the customer area of SwissSalary?

Link http://www.swisssalary.ch will take you to our website. Click Log In in the upper right corner: 

Log in using your company specific login data. Afterwards press the button Update NAV (SwissSalary NAV
customers) or Update BAU (SwissSalary BAU customers).

This will allow you to download the most current Updates and PreUpdates. If you click on the respective PDF
and/or ZIP icon, you will download the objects and documents.

What additional documents can be downloaded?

In addition to the latest Updates you can download and install the most current PreUpdates in SwissSalary, so
that you are always up to date (recommended).

The library of the latest manuals and other information for SwissSalary will be renewed and extended.

How a file can be downloaded from the Internet?

When you click on the corresponding icon and the download begin (the file you will find under 'Download):

Will I get notified about changes to SwissSalary?

Yes. You will receive information message each time when the latest Update is released. The PreUpdates will
be continuously available on our website with no mail notification! You will also be notified by mail about the
important PreUpdates!

Can the updates be sent via email?

As a rule, the Updates are only available online. Sending via email is often used in case of problems with some
providers related to the size of files and spam/junk filtering.

Are you familiar with our customer and partner portal?

By following https://webportal.swisssalary.ch you will enter our Customer portal. To log in you will need only
your email address and a password that you will receive from us. If you have not yet received a password from
us, please request it by sending an email at support@swisssalary.ch.

You can change the received password when you first log in to the system.

http://www.swisssalary.ch
https://webportal.swisssalary.ch
mailto:support@swisssalary.ch
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At the Customer portal you may not only submit and process new support requests (incidents), but also track
your own open or already answered mail inquiries at any time. In addition, you have access to our Tasks for
further development. You can see which customer requirements have been met and will be delivered with the
next Update or PreUpdate. You can also vote for individual tasks, so that you can actively influence the
development of SwissSalary.

Just try it!

Do you have questions about our website or downloads?

You can send us an email at support@swisssalary.ch or call our hot line +41 (0)31 / 950 07 77 or your partner.
We will be happy to advise you!

5.2.2    Downloading / Refreshing Updates and PreUpdates

5.2.2.1    Instructions (3)

1. Download the objects and manuals according to the descriptions in chapter Instructions.

IMPORTANT NOTES:
q It is NECESSARY that you pass this User Manual on to the relevant employees!
q Make sure that the update version B5051.000 (BAU) / N5051.000 (NAV) is installed in your system. You can

check this in SwissSalary under Company -> Settings -> Organization -> Update (Version) or in RTC-Client
on Organization.

IN CASE YOU HAVE A VERSION OLDER THAN B5051.000 / N5051.000 INSTALLED, PLEASE CANCEL
THE INSTALLATION AND CONTACT US OR YOUR PARTNER!

HINT:
Please back up you data before the update. Generally, it is not required but still useful for security reasons.

2. Unzip the object file with WinZip.

3. Open Microsoft Dynamics NAV and select using Shift+F12 in Object Designer (Tools -> Object Designer).
From NAV 2009 SP1 RTC you must start the Development-Client.

mailto:support@swisssalary.ch


Seite 195

Now you can see all NAV objects in the NAV DB available to you.

4. Select menu File -> Import.

5. Enter the path to the location where you saved the FOB file. The system will try to read the file.

6. You will see this info that MUST be confirmed with OK or No.

NOTE:
 For PreUpdates a different question appears. ALWAYS open the Import Worksheet!

7. The Import Worksheet will open.

IMPORTANT NOTE:
Here you SHOULD click REPLACE ALL! Click OK to continue the import process.

The RTC-Client (from NAV 2015) appear this message (confirm this with 'Force'):
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The RTC-Client (from NAV 2015) ask you to do a synchronization; confirm this message with YES:

8. The objects will be loaded into your database. After a successful completion of the import the following
message appears:
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In the Classic version:

(Example: the number of objects can vary!)

In the RTC version:

9. Done. The new update has been imported!

IMPORTANT NOTE:
This approach is similarly applied to PreUpdates! 

We recommend compiling the SwissSalary objects after importing (F11). Please put in the List a filter (F7) to
SwS* and make sure that All is selected on the right side.
We would like to point out that, especially for RTC versions (as of NAV 2009), the NAV service service, if
possible to restarted. This can usually only be done by the administrator with appropriate permissions (please
run only in margins if no users are logged in).

After a successful import of the objects, select them in SwissSalary main menu.

Click menu item Employee (Employee Card). Te system will start automatically the process of update
renewal. Only a staff member with administrator rights should open the main menu for update renewal.
Otherwise, the update will not be successful! After a successful run of the batch you will receive a message
stating that it is complete. 

Under Setup -> Setup -> Organization  or in the RTC-Client-> Organization you will find the history of updates
in which all successfully updated versions are registered. After each Update/PreUpdate you must undergo this
update/renewal process!
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In the Excel file you can see which objects will be created and modified.

Type explication:

1 = Table
2 = Form (no more available from NAV 2013)
3 = Report
4 = Dataport
5 = Codeunit
6 = XMLport
7 = MenuSuite
8 = Page (only RTC version from NAV 2009 SP1)
9 = Query (from NAV 2013)

Important note on MenuSuite:

SwissSalary NAV:
The old menu is no longer available in NAV Version 4.00 SP2 or newer. MenuSuite is included in regular
update.

In cases of uncertainty, please inform your partner or our support immediately.

5.2.3    Access Autorisations and Roles

5.2.3.1    Instructions (3)

Autorisation and Roles description:

SwissSalary Budget - Edit
Groups ID Name Description
SWS-ALL SwissSalary -

All SwS-Users
The only user role that must be assigned to every SwissSalary user.
The 'Wage Accounting Process' feature requires that the system should obtain
'indirect' information about all clients (license check, how many employees are
currently accounted for in the entire database. Of course, the payroll staff
member cannot see any data of the restricted clients)The only user role that
must be assigned to every SwissSalary user.

SWS-CONS /
SWS-
INVOICING
(only
SwissSalary
BAU)

SwissSalary -
Consortium
SwissSalary -
Invoicing

This role is used for working in the ARGE module. This permission role allows
full access to ARGE items and ARGE posting journals. This role is suitable for
employees that are only allowed to operate ARGE in payroll accounting.

SWS-EE-
EDIT

SwissSalary -
Edit Employees

This role is the classical assignment for payroll staff members that need to use
all features of payroll accounting. The user can edit, delete, enter data in
SwissSalary; however s/he cannot change payroll master data.

SWS-EE
READ

SwissSalary -
Read
Employees

Similar to the SWS-EE EDIT role, with the exception that data can be viewed
only, and not changed (read-only rights).

SWS-HR
EDIT

SwissSalary -
HR Edit
Employee

PIS (Personal Information System) add-on module. A user with this role can
modify, delete and enter data in PIS. 

SWS-HR
READ

SwissSalary -
HR Read

PIS (Personal Information System) add-on module. Read-only rights.
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Employee
SWS-HR
SETUP

SwissSalary -
HR Setup

PIS (Personal Information System) add-on module. A user with this role can
change settings in PIS. Classical HR wage administrator.

SWS-POST
(only
SwissSalary
NAV)

SwissSalary -
Posting

In accordance with the SOX guidelines, payroll staff member is not allowed to
'post wages'. This user role can be assigned to an employee in the FIBU that
is exclusively responsible for wage posting. IMPORTANT: Of course, this
employee must also be enabled in SwissSalary under Company -> Settings ->
Users.

SWS-SETUP SwissSalary -
Setup

Classical authorization role for wage administrator

SWS-ST
EDIT

SwissSalary -
Edit Salary
Type

Full access for editing wage types. A user with this role can create, modify
and delete wage types.

SWS-
BUDGET-
EDIT

SwissSalary
Budget - Edit

SWS-
BUDGET-
READ

SwissSalary
Budget - Read

SWS-
BUDGET-
SETUP

SwissSalary
Budget - Setup

After each update, permission roles must also be adjusted in SwissSalary (New table access, etc.)

IMPORTANT NOTICE:
q If you have customized individual permission roles in Standard "SWS-*", please remember that they will be

overwritten through the automatic import of the "default" roles.
q Before releasing the system for the user again, add the necessary appropriate permission roles to these new

tables!

Current permission roles can be found on our website in our protected area.

To begin the import in SwissSalary go to Setup -> Setup -> Organization -> button 'Service' -> Rights. In the
RTC-Client in Organization. Select SWS value under Role ID*.
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Choose the appropriate path for the .txt file and select Import under Direction in the Options tab. Then click
OK and after some time the default user roles will be adjusted in SwissSalary.

If you have written changes in our default payroll user roles or if you want to make changes to the user roles
manually, you can do this under Tools -> Security -> Roles (NAV 4.00 SP2 and newer). Click on the
appropriate role and add new tables  Role -> Permissions (NAV 4.00 SP2 and newer). In the RTC-Client go to
Departements-> Administration-> IT Administration-> General-> Permission Sets. If you have questions about
these settings, please contact your local partner.

The following tables have been re-created and must be added to the corresponding roles (if already used):

Table SwissSalary BAU/NAV Name Object Name

3009189 SwS Payroll Base Working
Table

Payroll Base Working Table

3009196 SwS Excel Buffer Excel Buffer

3009197 (only for SwissSalary 365) SwS SAP Interface Setup SAP Interface Setup

3009198 (only for SwissSalary 365) SwS SAP Interface Relations SAP Interface Relations

SwissSalary Role Center
Each NAV module knows its own role Center (from NAV 2009 RTC). SwissSalary has developed the Page
3009252 SwS Payroll Role Center. We encourage you to work with this Role Center for the salary. You can
import the Role Center also (XML-file you will find in the Update object).
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6    Update 5051.000

6.1    Update 5051.000 User

6.1.1    PreUpdate 5050.100

6.1.1.1    Introduction

Dear SwissSalary Customers, dear SwissSalary Partners,

We are pleased to present to you the manual for SwissSalary PreUpdate 5050.100. Your SwissSalary will be
up to date after installing this release. And again, we can offer you some great new features.

With this PreUpdate, we introduce a new versioning approach. Up until now, PreUpdates have been defined
using codes .001, .002. From now on, you can recognize the versions as follows:

q Update (cumulative update) | 5050.000, 5051.000, 5052.000, etc.
q PreUpdate | 5050.100, 5050.200, 5050.300, etc.
q Hotfix for an Update | 5050.001, 5050.002, 5050.003, etc.
q Hotfix for a PreUpdate | 5050.101, 5050.102, 5050.103, etc.

Owing to this improvement, you and your NAV partner in Support can always see the current version of your
SwissSalary.

Personal interest notice
With the new cloud solution SwissSalary 365, we have succeeded in reaching another important milestone.
So now, smaller companies and companies working with other ERP solutions can process your wages easily
and without any installation work using SwissSalary. Please click here for more information.

IMPORTANT NOTES

q Please make sure that a version not older than 5050.000 dated November 10, 2015 was installed before this
update. If your NAV partner has made company-specific changes to your SwissSalary NAV objects, you
must contact your NAV partner BEFORE installation.

q SwissSalary BAU customers with NAV 5.0
SwissSalary Update B5050.000 was the last version for BAU 5.0. NO further developments are planned in
BAU version 5.
We kindly request you to migrate from NAV 2015 to the new NEVARIS solution as soon as possible. Many
existing BAU customers already took this step last year, and have since worked with the NAV 2015
platform. If you have additional questions about this topic please contact the NEVARIS support.

q SwissSalary NAV customers with NAV DB versions 3.70, 4.00 + 4.00 SP1
SwissSalary Update N5050.000 is the last full version for these NAV DB versions. By September 2016, we
will release more PreUpdates (5050.xxx) for these NAV versions. Starting from October 2016, there will be
updates for versions after NAV DB 4.00 SP2 only!

q SwissSalary Role Center | RTC clients starting from NAV 2009 SP1
Since the introduction of the RTC Client, SwissSalary has been using a clearly arranged and intuitive Role
Center. However, we have repeatedly discovered that some of our customers had not been using it.
System Administrator Manual contains important information thereto.

We hope you will enjoy the latest version of SwissSalary!

http://www.swisssalary.ch/en/products
mailto:support@bausoftware.de
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Your SwissSalary Team

6.1.1.2    Improvements

6.1.1.2.1    Salary certificate (Form. 11) | Activity external work (3)

Task #7470 | 5050.100

Since the implementation of FABI (Financing and Development of Railway Infrastructure) on January 1, 2016,
the field service percentage must be recorded for field employees in paragraph 15 (Comments) of the Salary
certificate (for direct federal taxes and for cantonal taxes in individual cantons).

The starting point for percentage calculation can be immediately set up as the salary type. To do this, you
need a new salary type with the “Employer Part” type and the allocation to paragraph "15. Activity external
work" of the Salary certificate position. FIBU allocations are neutral, they are not posted in the FIBU.

With this salary type, a "1" is recorded in the "Amount" field (TapBoard or via reporting) for every day of a
person’s involvement in field service. For half a day, e.g. "0.5" can be recorded. SwissSalary interprets these
days accordingly and shows the percentage in paragraph 15 of the Salary certificate using the "Field Service"
note.

Examples:
q At the beginning of work, an employee e.g. goes directly to one or more customers and then returns home: 

Using this salary type, you can enter "1" in the "Amount" field.
q At the beginning of work, an employee e.g. goes directly to a customer, then to the contractually defined

workplace and in the evening returns home from the workplace: 
Using this salary type, you can enter "0.5" in the "Amount" field.

q At the beginning of work, an employee e.g. goes directly to the contractually defined workplace, then to a
customer and in the evening returns home from the customer: 
Using this salary type, you can enter "0.5" in the "Amount" field.
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q At the beginning of work, an employee e.g. goes directly to a customer, then to the contractually defined
workplace, to another customer again and returns home in the evening: 
Using this salary type, you can enter "1" in the "Amount" field.

q At the beginning of work, an employee goes to the contractually defined workplace and returns home in the
evening without visiting any customers. 
You may not record this salary type.

6.1.1.2.2    Absence Claim | Automatic Holiday and Work-in-Advance Days Entitlement (3)

Task #492 / #7438 | 5050.100

You can select per refunding of absences to have holiday and/or work-in-advance days entitlement reported
automatically. You can choose the month for the entitlement (usually January). If it is set, the entitlement in
the corresponding month will be calculated automatically without the need to run the "Cary Forward the Time
Types" report in the Management Rapport Journal.

The calculation month is defined in the card data view "Refunding of absences":

If you are using work-in-advance days balances (rarely), you must assign the appropriate salary types for time
types and in Refunding of absences.

An example of compensation time setup:

1. Create salary types (if not yet present)

2. Set up time types

3. Assign salary types in Refunding of absences and define the number per year
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6.1.1.2.3    PP Franking | Payslip (3)

Task #833 / #4553 | 5050.100

Available for versions NAV 2013, NAV 2013 R2, NAV 2015 and NAV 2016

In response to many requests and based on the specifications of the Swiss Post, we have implemented PP
franking into the payslip.

There are 4 new fields in the Payroll Setup -> tab 'Paycheck'. Enter normal or "A Priority" franking  in "Shipping
method". Enter the ZIP code and location, as well as the invoice reference number received from the Swiss
Post.

For more information about franking please contact your post office or search the Interne

6.1.1.2.4    SwissSalary Direct | Independent Creation of New Access (3)

Task #6505 | 5050.100

Are you already familiar with our SwissSalary Direct employee portal? Starting from CHF 0.50/month, you can
provide payslips, salary certificate, personalized and general documents for registered employees in a secure
cloud. The employee is informed via mail and can operate 24/7 him/herself via web access.

Previously, the initial service registration could only be obtained from our Support. Now you can register for the
service yourself. To do this, go to Ribbon under SwissSalary Direct in SwissSalary Role Center (Classic client:
Setup-> Setup -> SwissSalary Direct). The screen below will appear. Enter the desired subdomain for your
company, for example, cronus for https://cronus.swisssalarydirect.ch and a main mail address like
personal@cronus.com (the email address must exist) and a secure password. Then click "Create access" and
enter further information.
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After successful registration, you can log in with the newly created URL, your user name and password. Do
you need support to do this? Please send an email to support@swisssalary.ch or contact your NAV partner.
We can provide further help with the registration!

When did you start using SwissSalary Direct? When can you start saving money every month?
Did you know that you pay CHF 4.40/month per employee for the creation and delivery of payroll (paper,
printing, postage, envelope, packaging, post, etc.)? You can now do it starting at CHF 0.50 instead of CHF
4.40.

6.1.1.2.5    SwissSalary Store | Direct File Download (3)

Task #6955 | 5050.100

The data can be directly downloaded in SwissSalary Store, if you confirm the message below with Yes. This
means that you do not need to download the file from our website first, the file is downloaded immediately. You
will only need to unzip it and then import.
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6.1.1.2.6    RTC-Versions | Graphs and Charts (3)

Exclusively concerns the customers using RTC versions of NAV 2013 or newer!

Task #7291 | 5050.100

Each user can build an unlimited number of graphs and charts, and view them in the Role Center. This became
possible after version NAV 2013 (.NET components are required).
Various graphs are already available by default after the update process. You can also define them on your
own. By clicking "Edit", you can customize an existing graph or create a new one by clicking "New".

Name Name of graph/chart

Description Description of graph/chart

Start date The date as of which you want to start using the graph for evaluation

Calculated start
date

A calculated start date may also be selected instead of the start date. If, for example,
you want to analyze the dates over the past 5 years, enter -5J.

Period Length You can specify a day, a week, a month, a quarter or a year as the period.

No. of periods The number of periods (e.g. months) you want to display in the view (e.g. 6 for 6
months)

Indicator - Name Name your indicator, e.g. Recruitments, Resignations

Chart Type Different types of graphs are available for you, e.g. point, intersection, area, etc.

Value type Select whether the movement or the balance is to display

Unit Select the units for the number, amount, days or hours

Table No. Tables "Personnel Master Data", "Salary Type" and "Time Types" are available for you

Field No.. After you select the table, choose the value field for each line that you want to evaluate

Field name Field name display (cannot be changed)

Filter You can select any filter for the value, e.g. Employee No. from/to, Value from/to, etc.

Reverse sign of
amount.

If a value is to be displayed with - instead of +, select the appropriate field

NOTE
Please follow the instructions in the System Administration Guide. New tables to be considered in the
permission roles were created for graphs. If you work with our default roles, the tables are integrated and you
just need to import the new permission roles. The new tables are below:
q 3049190
q 3049191
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6.1.1.2.7    RTC-Versions | Salary Types and Payroll Setup are Started as View (3)

Task #7203 | 5050.100

In response to numerous customers' requests, the salary types list is now started as a "view" (no revision).

To start editing, select "Edit", then you can directly revise the salary types in the card data view via "Edit List"
in the list view.

6.1.1.2.8    Creating New Company Using the Setup Wizard (3)

Task #7323 | 5050.100

It has never been so simple to create new payroll clients in SwissSalary. The first time you start your new
client, our wizard will launch automatically and guide you through the payroll setup step-by-step. This way, you
will be able to capture your company data, DTA/EZAG Setup as well as your insurance solutions quickly and
easily.

Of course, after closing the wizard, you can check and complete your entries!

6.1.1.2.9    New Support for PDFCreator Version 2.x (3)

Task #6975 | 5050.100

Free PDFCreator is used to create PDFs (payslips, salary certificate for SwissSalary Direct, IncaMail, etc.) in
the old NAV Classic Clients. This software is no longer necessary for all NAV RTC versions starting from NAV
2013 because PDFs are directly created in the NAV client. Major adjustments have been made to PDFCreator
between versions 1.x and 2.x. Up until now, the export from SwissSalary only worked with PDFCreator older
than v1.7.3. 

Starting from this version, PDFCreator 1.x or 2.x installation on your system is checked automatically. Thus,

PDFCreator 2.x (latest version 2.3) can be used now. To download the latest version, go to:

http://de.pdfforge.org/pdfcreator/download

http://de.pdfforge.org/pdfcreator/download
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6.1.1.2.10    One-time Installation of .NET Assemblies for 2 D-Barcodes on Wage Statement (3)

Task #7009 / #7112 | 5050.100

Concerns all the customers using NAV versions NAV 2013, NAV 2013 R2, NAV 2015 + NAV 2016!

Starting from PreUpdate N5050.100, you need to perform a one-time installation of so-called .NET assemblies.
For this reason, the generation of 2D bar codes for salary certificate is now started on the middle-tier server.
Thus, salary certificate can be created in the future much faster than before (execution speed is improved
significantly).

To do this, please proceed as follows:

1) Go to "Role Center -> Ribbon" and open "Organization". The view will contain the line ".NET Assemblies"
and the status "expired".

2) You can now download .NET assemblies automatically. To do this, click the three dots button under the
name .NET Assemblies.

The following query will open. Please select "Yes".

3) The ZIP file is automatically downloaded and stored in a temporary directory. Now copy the ZIP file to a
selected location (without unzipping the file).
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4) Select ".NET Assemblies" in "Ribbon -> Organization" in the Role Center. Then select "Import Zip file" and
the path where you saved the ZIP file in step 3). Select "Open" in Windows file explorer.

The following message will appear:

5) The available .NET assemblies can be viewed below.

6) Select "Save server add-ins". After that, .NET assemblies will be directly stored on the middle-tier server.
The process is now completed. You can once again select "Update" in Organization. The status should then
be "up-to-date".

If a permission error appears when calling up "Save server add-ins", you must manually extract (with admin
rights) the zip file into the add-ins directory on the middle-tier server; 
e.g .: 'C:\Program Files\Microsoft Dynamics NAV\70\Service\Add-ins\SwissSalary\' (for a NAV 2013
installation). Optionally, you can also store the files via "Save client add-ins". This is to ensure the compilation
of objects in the DEV client.

You cannot install .NET assemblies and require further assistance? Please call your internal IT supervisor,
your NAV partner or contact our support at support@swisssalary.ch.

mailto:support@swisssalary.ch
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6.1.1.3    Personnel

6.1.1.3.1    TimeMachine | Asterisk Like in the Classic-Client (3)

Task #7118 | 5050.100

In the "old" Classic versions, blank lines are marked with an asterisk at the beginning. This character does not
exist in the RTC versions anymore. We have reintroduced this character in the TimeMachine, so that you could
see if a record is blank. However, each time when the TimeMachine is opened, a value with a star is displayed
if a record is empty.

6.1.1.3.2    TimeMachine-Entries | New Factbox in the RTC-Client (3)

Task #7279 | 5050.100

You can select the new "Employee TimeMachine" factbox in the Employee card or Employee list of RTC
clients via "Customize -> Fact boxes". It shows all the entries in the employee's TimeMachine. The factbox is
additionally built into Management Rapport Journal.

6.1.1.3.3    Holiday Payment and Holiday Remuneration Order (3)

Task #7386 | 5050.100

When holiday payment remuneration is taken into account during hourly wage calculation, some customers
also consider holiday remuneration percentage. Normally, the base for holiday remuneration is calculated on
the base wage (hourly wage), similarly to recess remuneration. In GAV, however, it is regulated somewhat
differently for temporary employment agencies. Namely, holiday remuneration is taken into account on the
basis of base wage. Then, there is a sub-total and after that holiday remuneration is calculated.

You can now rearrange the order of the calculation in Refunding of absences of the Personnel card. The new
selection field "Surcharge order" the calculation can be defined as follows:

q Holiday Payment/Holiday (default)
q Holiday/Holiday Payment

For the majority of our customers it does not change anything, and the default value is set automatically. The
selection can change the situation for temporary employment agencies and other customers with similar
starting point. You can see two examples of calculation below.
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6.1.1.3.4    Personnel Dimension | Totalizing (3)

Task #7246 | 5050.100

Personnel dimension(s) are separately stored for each employee in Personnel Master Data. The entries with a
"Valid from/to" date can now be limited in time. When an employee was assigned to multiple dimensions (e.g.
different cost centers), the total of all dimensions was summed regardless of their validity.

This has been fixed, the total corresponds to the total of time-valid dimensions based on the working date.

6.1.1.3.5    Social Services Control | More Columns Similar to Classic-Clients (3)

Task #7272 | 5050.100

You can launch the Social Services Control view in the Employee Card/Employee list of RTC clients via Ribbon
-> tab ACTIONS It shows you at a glance what social security the employees are assigned and subject to. In
addition to the personnel number and last/first name, this popular control evaluation could be selected in
Classic clients with extra columns. It is now possible also in RTC clients.

6.1.1.3.6    General Reports | Assigning Reports to Individual Users (3)

Task #7407 | 5050.100

A company-specific report can be assigned to a single or multiple users in "General Reports".

6.1.1.4    Salary Types

6.1.1.4.1    New Field | Posted Salary Types (Payroll Setup Analysis)

Task #7324 | 5050.100

Do you want to revise your existing salary types and recognize, for example, unused ones (without Salary
Entries)?

For this purpose, we have developed a new field for you. The "Posted Salary Entries" column can be displayed
in the Salary type list by selecting "Yes/No" to show whether the salary type has already been used (Salary
Entries exist). Thereby, salary type masters can be analyzed quickly.
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6.1.1.5    Payroll Setup

6.1.1.5.1    Tab 'BVG'

6.1.1.5.1.1   BVG fictitious monthly rouding of Contributions (3)

Task #7384 | 5050.100

You can find a new selection field "Fictitious BVG Monthly Rounding" in the Payroll master data. Owing to this
new field, fictitious annual BVG wage may be rounded, so that the monthly BVG deduction is calculated the
same each month.

Example with monthly wage | CHF 5'000.00
Monthly wage of CHF 5'000.00 results in a BVG annual wage of CHF 65'000.00 (incl. 13th Payday). The
calculated monthly BVG wage amounts to CHF 5'416.66666/month (unrounded). Without the new rounding
function the amount was always calculated over the whole year. This means that the BVG wage amount of
CHF 5'416.65 was calculated both in January and in February. In March, however, it was balanced every year
at CHF 5'416.70, etc.

With the new "Fictitious BVG Monthly Rounding" feature, you can prevent this from happening. The annual
BVG wage is calculated depending on the selection as follows:
q 'blank' | Calculation as before | CHF 65'000.00 = CHF 5'416.66666
q Nearest | CHF 64'999.80 = CHF 5'416.65
q Up | CHF 65'000.40 = CHF 5'416.70
q Down | CHF 64'999.80 = CHF 5'416.65

The monthly amount thus remains the same every month, but, as you can see in the example, there is a slight
deviation to CHF 65'000.00.

NOTE
Please note that this setting in the "BVG fictitious monthly rounding" field in the BVG tab should be provided
only as of January 1 of the New Year. The fictitious annual BVG wage is activated or written as usual via the
'Activate Raise Salary' report. As described in the example, the wage amount of 65'000.00 CHF is adjusted to
CHF 64'999.80, even if no pay rise has taken place.

6.1.1.5.1.2   Pay Rise as of January 1 | Annual BVG Wage Fictitiously Calculated Even at Zero Rounding (3)

Task #7430 | 5050.100

If there is a wage adjustment without annual BVG wage adjustment in the current year, it will be included in the
future at a pay raise as of January 1 of the following year (also in case of zero rounding). It is in this way
guaranteed the defined pay rise in the following year from proper consideration during the year.
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6.1.1.5.1.3   BVG Calculation on the Hourly Wage Base (3)

Task #7253 | 5050.100

In rare cases, BVG limit amounts (lower/upper limit, minimum wage and coordination) are not to be calculated
based on monthly limits, but on an hourly basis for hourly wage. For this purpose, the BVG settings have been
expanded and revised as follows:

q New field "Hourly Calculation / Hours per Year" | Input field for hours per year
q Panning of the "BVG Calculation Mode" field on the line | Parameterization per insurance solution made

possible (not overall)

The calculation type is only provided for the "effective" calculation (fictitious annual salary calculation is not
taken into account). The value for an employee in the BVG tab of the Personnel card must be set to "actual".
Thus, the accounted salary types with check marks set in the "Subject to BVG" and time types assigned are
taken into account. This way, we additionally recognize the hourly wage types that are to be considered.

Salary type = Subject to BVG + Available time type | Wage type is taken into account for the calculation of
BVG limits 

Example with 2'193.33 hours a year
Upper limit | CHF 84'600 / 2,193.33 = Hourly basis upper limit | CHF 38.57
Lower limit | CHF 84'600 / 2,193.33 = Hourly basis lower limit | CHF 9.64
etc.

This means that an employee with an hourly wage < CHF 9.64 is not considered in the BVG.

With this calculation type no compensation could be partly contributed over the year. For this reason, the
existing field "BVG Calculation Mode" has now been transferred to the line and can be flexibly re-defined for
each calculation.

6.1.1.5.1.4   BVG Maximum Percent by Position | Turned into Selection Field (3)

Task 7379 | 5050.100

The old field "Maximum Percent by Position" is now a selection box. You can use the following options:

q 'blank' | As before, the upper limit is not reduced based on percent by position
q Upper Limit Base | As before, the upper limit is reduced based on percent by position
q Coordinated Base | New = The upper limit is taken into account based on the coordination limit. Thus, the

maximum BVG upper limit is always the same in relation to the coordination even for employees with
percent by position (when the maximum wage is exceeded) 
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6.1.1.6    Payroll Log

6.1.1.6.1    Reporting

6.1.1.6.1.1   Wage Rate Taken into Account Based on the Change in the TimeMachine (3)

Task #7110 / #7257 | 5050.100

If the wage rate of an employee is changed in tab 'Salary' of the Employee card via TimeMachine during the
month, it now also affects the entries in Report journal/TapBoard.

Example
The wage rate is increased via TimeMachine from CHF 33.40 to CHF 36.70 as of 'Valid from' date May 10,
2016. If an hourly salary type is recorded in the Report journal or TapBoard with document date May 9, 2016,
then the previous wage rate of CHF 33.40 will be retrieved. If the document date is May 10, 2016 or later, the
new wage rate of CHF 36.70 will be applied automatically.

If the document date is empty, the working date is used to take the correct wage rate into account. The same

also applies to the wage items. There, the 'Valid until' date is crucial and/or also corresponds, on the other

hand, to the working date if no date is set.

6.1.1.6.1.2   TapBoard | Launching the Correct Report Journal (3)

Task #7261 | 5050.100

The Management Rapport Journal can be directly accessed from the TapBoard via the Ribbon. The Report
journal assigned to the employee in the EasyRapport Group will open automatically. Therefore, the correct
Report journal is always opened.

6.1.1.6.1.3   Plausibility Check | Daily our Monthly Check (3)

Task #7437 | 5050.100

You can now select for the "Plausibility check" report in the Management Rapport Journal to check the limits
for each salary type daily or monthly. To do this, use a new field 'Plausibility period' in Salary type -> tab
'Plausibility' with the following options:

q Day
q Month

6.1.1.6.2    Post Payroll

6.1.1.6.2.1   Accounting Details | Additional Information in Factbox (3)

Task #7306 | 5050.100

In addition to the number of employees invoiced, extra accounting details per pay process appear in the
Factbox:

q Number of recruitment's
q Number of resignations
q Number of back payments



Seite 215

6.1.1.6.2.2   Project Items | Document Date and Detailed Text (3)

Task #7043 | 5050.100

When the wage is posted to the project items, each record is now transferred individually with "Document
date" and, additionally, with the corresponding wage item text. Up until now, the text was delivered with
"Collective Wage Posting".

NOTE:
The text will be transferred only during definitive wage posting, and not during the provisional project items
transfer. The reason is that when provisional project items are deleted, each of them is additionally filtered by
the text "Collective Wage Posting" (for security reasons).

The corresponding settings can be found in Payroll master data, tab 'Settings', field 'Transfer in project'.

6.1.1.7    Salary Declaration

6.1.1.7.1    Income Tax Statements (3)

Task #7197 | 5050.001

At the request of some customers, income tax evaluations are now included into the Ribbon in the 'Wage
Reporting' report (formerly 'Year-end Reports'). Therefore, all evaluations that can be submitted via ELM, are
available in 'Salary Declaration'.

6.1.1.8    Reports

6.1.1.8.1    Attestation of Employer ALV | Also without Date of Resignation (4)

Task #7405 | 5050.100

Both 'Attestation of Employer ALV' and 'International ALV Employer Certificate' can also be executed without
the date of resignation.

6.1.1.8.2    Short message and Accompanying Letter | Full Name (3)

Task #6223 | 5050.100
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Up until now, the name of the staff member was displayed on the short message and accompanying lettter
along with the company name and employee abbreviation. From now on, the full name (first/last name) is
retrieved from the SwissSalary user table.

6.1.1.8.3    Payslip with SwissSalary Direct | Placeholder %8 for URL (3)

Task #6943 | 5050.100

In addition to the existing placeholder "%7" for individual SwissSalary Direct registration codes, there is a new
placeholder "%8" for URLs, e.g. https://musterfirma.swisssalarydirect.ch. Therefore, you can use the following
placeholders in the text block for registration:

Sample Text
Your registration code is %7. You can register at %8 using this code.

6.1.1.8.4    Employee Salary Statement A4L | Can be Accessed in Pay Process (3)

Task #7103 | 5050.100

'Employee Salary Statement A4L' can be accessed now in RTC versions from the ribbon via Pay process ->
Reports.

6.1.1.8.5    Salary Type List A4P and A4L Expanded with Quantity (3)

Task #7369 | 5050.100

Salary types used for reporting of e.g. number or kilometers or number of lunch allowances, could not be
evaluated with quantity. Now, the "Quantity" selection provides the expected result.

6.1.1.8.6    Salary Summery Holding | New 'Canton' Column (3)

Task #6871 | 5050.100

The "Salary Summery Holding" report (wage sum by tax municipality) contains abbreviations of cantons in
recapitulation as an additional column after tax municipality.

6.1.1.9    Administration SwissSalary

6.1.1.9.1    DTA/EZAG Setup | Now Under Administration (3)

Task #7197 | 5050.001

DTA/EZAG master data is now located in the "Administration" section (previously in the Ribbon of the Role
Center home page).

6.1.1.9.2    Allocation Group | Tab Labels Revised (3)

Task #7264 | 5050.100

Two tabs under "Payroll Area" were unlabeled

q Print -> new: Printing of payslip
q EasyRapport -> new: EasyRapport Display
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6.1.1.9.3    RTC-Versions | SmartPort can be Opened Now via Departments (3)

Task #7248 | 5050.100

Previously, SmartPort could be started only via our SwissSalary Role Center. From now on, those not using
the default Role Center can also open it via "Departments".

6.1.1.9.4    Automatic Execution of EasyRapport Transfer After Post Payroll (3)

Task #7263 | N5050.100

Once a pay process is posted, the actually billed data must be transferred to EasyRapport to synchronize
SwissSalary and EasyRapport. Up until now, EasyRapport transfer had to be launched manually.

From now on, automatic EasyRapport transfer can be activated in 'EasyRapport/TapBoard' settings as soon as
the wage was posted.

6.1.1.9.5    EasyRapport/TapBoard | Rapport Types | Extended Option "hide" (3)

Task #7117 / #7320 | 5050.100

The "hide" column was extended with the "TapBoard" option. This means that you can specify in report types
whether certain rows in EasyRapport or now also in TapBoard are to be hidden.

Example:
You want to have several types of sick pay (80%, 90% and 100%) in TapBoard. However, the employee is only
to see a single line "Illness" in EasyRapport, which, for example, has 80% configured in the row. Using the
"hide" option, you can now suppress individual rows in TapBoard that are, for example, to be displayed in
EasyRapport only.

In addition, the same wage type numbers like in another line under "salary type" are entered in the "Conversion
salary types 1 and 2".

6.1.1.10    SmartPort

6.1.1.10.1    SmartPort | Display Fields Last Name/First Name

Task #7160 | 5050.100

Fields "First name" and "Last Name" are displayed now in addition to the Employee No. in SmartPort, so you
can see at a glance the employees the change was made for.
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6.1.1.10.2    SmartPort | More Fields can be imported (3)

Task #7161 | 5050.100

SwissHRM users can now synchronize other fields with SwissSalary:

q Social security No. unknown
q Work Permit
q Permit valid from
q Permit valid to
q SIMIC No.
q ZAR No.
q Place of origin
q Employment (LSE)
q Education (LSE)
q Occupational status (LSE)
q Employment contract (LSE)

So now, practically all fields in SwissHRM and SwissSalary can be synchronized.

6.1.1.11    Bug fixes

6.1.1.11.1    Various Reports Revised (3)

Minor adjustments not mentioned in detail have been made to each report. Here is a list of tasks implemented
with their brief description:

Task #7403 | 5050.100
Underemployment-/ Bad weather | Number of employees in all RTC versions corrected

Task #7313 | 5050.100
Lists for Cash Payments | Header in RTC versions were not equal with respect to Classic versions, unless a
cash wages was available.

Task #7352 | 5050.100
Typo in item 12 of the ALV Employer Certificate was corrected.

Task #6845 | 5050.100
Workgroups can be printed now and the calendar is printed on a single page (without page breaks) during
Excel export of the working time calendar.

Task #7353 | 5050.100
The account sheet could not be executed if a wage translation was longer than 40 characters.

Task #7285 | 5050.100
Fields "Time from" and "Time until" could not be recognized during Excel import into Report journal.

Task #7286 | 5050.100
Report "Social Fund Accounting" was revised. All columns are now displayed correctly and fully.

Task #7268 | 5050.100
In RTC versions, the 'Employment period from/to' column in the "CC UVG Accounting" report has been
adjusted. The columns were too narrow, that is why the date was not printed correctly.

Task #5757 | 5050.100
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The 'Test billing' can be launched from the Personnel card or Personnel list by pressing Ctrl+T. It sometimes
caused errors in RTC versions.

Task #6745 | 5050.100
The from/to date included wrong delimiters during plausibility report.

Task #7303 | 5050.100
The 'AHV-exempt wages' report sometimes showed persons with no movement in the current year. It has been
corrected and improved. 

Task #7233 | 5050.100
The 'salary type list assignment' did not consider the salary type filter.

Task #6573 | 5050.100
Evaluations 'Internal Re-invoicing' and 'Hourly Accumulation' have been revised and improved.

Task #7377 | 5050.100
Absence Quotas | If an employee was sick for several weeks, the weekends were interpreted as interruption of
the sick period. From now on, a sick period is no longer interrupted by weekends.

Task #7242 | 5050.100
The 'Reporting via Excel' function had an error message "The value "01.01.16 00:00:00" cannot be evaluated in
the Date type". This import error appeared because of the "00:00:00" value and is now corrected. If there is the
value "00:00:00" during import, it is deleted and validated afterwards.

6.1.1.11.2    Personnel History with Error Message in Case of Multiple Changes (3)

Task 7252 | 5050.100

If multiple changes were made within seconds in the Personnel card using batch processing, the following error
message would appear: "Personnel Master Data history already exists".

6.1.1.11.3    Salary declaration ELM | Improvements (4)

Task #7317 | 5050.100

In case of IT Declaration via ELM the replies from income tax offices are sent back in English and displayed to
the user in English. The responses now appear in the user's language.

Task #7318 | 5050.100

This led to the situation when the same text (office reference texts) was presented several times (several
responses were received for repeated "Get status" requests, each with the same text).

6.1.1.11.4    Salary Certificate without Gross Wage, but with Flatrate Expenses (3)

Task #7217 / #7270 | 5050.100

If an employee is paid no gross wage during a calendar year, only flatrate expenses instead, the following error
message would appear when the wage statement was printed: "File xxx does not exist". This is due to the fact
that 2D barcode cannot be created without gross wage.

From now on, the correct wage statement is created and can be submitted via ELM. Even empty wage
statements may be issued provided that there is an approved expense regulation.
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6.1.1.11.5    TimeMachine | Change of Percents by Position During the Month (3)

Task #7122 / #7123 | 5050.100

If there was a change of percents by position via TimeMachine during the month, for example, from 90% to
100% on May 15, 2016, the reduction would be calculated until May 15 instead of May 14. Therefore, one day
was overcharged. 

6.1.1.11.6    TimeMachine | Text in Multiple Languages (3)

Task #7155 | 5050.100

The text of corrections in the payslip during wage adjustments via TimeMachine was always printed in
German. From now on, the text is translated into the language of the employee indicated in the Personnel card
(language code). As usual, the translation is made in the wage type directly.

6.1.1.11.7    Payroll Journal | Notice When an Employee Had Resigned (3)

Task #6942 | 5050.100

Previously, if an employee that had already resigned was recorded in the Report journal data, the following
notice appeared next to each row: "Employee resigned. Register anyway?" that should be confirmed with Yes
or No. This message appears only once per employee.

6.1.1.11.8    Payroll Journal | Too Long Salary Type Translation (3)

Task #7328 | 5050.100

If the custom text of salary type was longer than 50 characters, one line could be recorded in the Report
journal. However, an error message would appear during deletion.

6.1.1.11.9    Working Time Calendar | Settings | Days/Hours Column Designations (3)

Task #7129 | 5050.100

When a user wanted to add the 'Days or hours' column in the working time calendar in RTC versions, the
following error message would appear: "The "Date" table is write-protected."

6.1.1.11.10    FIBU CC Matrix | Now Always Active (3)

Task #7239 | 5050.100

Up until now, the FIBU cost center matrix was only taken into account if the FIBU integration was activated in
the payroll master data. Without this integration, the accounts defined in the salary type depending on posting
category were not retrieved.

6.1.1.11.11    BAU | Personnel Dimension | CC Cannot be Recorded (3)

Task #7176 | 5050.100

No personnel dimension could be recorded in the SwissSalary BAU version (only NAV 2015), although CC
dimension could be selected. The error message "CC burden must have a value in 'Personnel Dimension'..."
appeared immediately upon clicking of the dimension value.
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6.1.1.12    Notes for our SwissSalary NAV partners

6.1.1.12.1    System Initialization | Extension of Net Wage Compensation (3)

Task #7292 | 5050.100

The following fields have been supplemented in the system initialization file:
q Salary Type Master | Net Pay Correction (Boolean)
q Payroll Setup | Net Pay Correction ST

6.1.1.12.2    BAU | UVG Cost Centers (BUV) Eliminated (3)

Task #7292 | 5050.100

After a detailed clarification with the SUVA, there are no UVG cost centers with increased UVG BUV premium
anymore effective 2016. The UVG cost centers were often required in underground construction since the
employer BUV deduction was higher due to increased risk of accidents compared to normal SUVA UVG
agreement. Employees working in such UVG cost center were thus subjected to a higher BUV employer
deduction.

The fields required for this were removed and adjusted. Only the values of wage items remain. The following
objects have been adjusted:

q Table SwS Employee | Field content deleted
q Table SwS Employee History | Field content deleted
q Form/Page SwS Employee Card | Field removed
q Form/Page SwS Employee History | Field removed
q Form/Page Wage Declaration | Field removed (selection field)
q ELM Submission | Logic removed (starting from PreUpdate 5050.100, no ELM UVG cost centers can be

reported anymore)
q Report Employee | History field removed
q Report Wage Accounting | Logic removed
q Report UVG Accounting | Logic removed
q Report UVG Cost Center | deleted
q All reports for Sunetplus logic and fields were removed

6.1.1.12.3    SwissSalary Module S | Integrated into License Verification (3)

Task #7188 | 5050.100

The new SwissSalary "S" module (Basic or Plus) for 1 - 15 active wage earners is now verified correctly in the
license. I.e., if 16 employees are to be accounted for after N5050.100, an error message appears.

Solution: Upgrade to SwissSalary 1 - 30

6.1.1.12.4    SwissSalary User with GetUserName (3)

Task 7025 | 5050.100

A new field "Custom User Name" was added to table "SwS User SwissSalary" (Table 3009102). By default,
the field is set to visible = 'False'. The "GivenName" is returned instead of User Login.
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6.1.1.12.5    Revision of Fields | Deleted and Obsolete Fields (3)

Deleted Fields: 
(The following fields have been deleted from PreUpdate 5050.101 or marked as “Obsolete”:)

Table 'SwS Payroll Setup' (NAV5 only) 
"Rapport Archive" // DELETED Field 65 
"Paycheck Archive" // DELETED Field 66 
"Salary Certificate Archive" // DELETED Field 67 
"Archive" // DELETED Field 68 

Table 'SwS County' 
"IT Return Account" // DELETED Field 1000 

Table 'SwS Income Tax County' 
"WT Entitlement Provision" // DELETED Field 11 

Table 'SwS Salary Type' 
"One-liner for additional text" // DELETED Field 60 
"Additional Text on Statement" // DELETED Field 61 

Table 'SwS DMS Setup' 
"Archive" // DELETED Field 5 

Table 'SwS Organization' 
"Ordered Key (Obsolete)" // DELETED Field 10 
"Test Key (Obsolete)" // DELETED Field 11 

Fields marked as "obsolete": 
(can only be definitively deleted after Update 5051.000 | October 2016!) 

Table 'SwS Payroll Setup' 
"BVG Calculation Mode" // Marked as OBSOLETE Field 647 
“BVG Franking" // Marked as OBSOLETE Field 88 

Table 'SwS Pension Setup' 
"Upper Limit Employment % OLD" // Marked as OBSOLETE Field 50 

Table 'SwS Allocated Salary' 
"Fixed/Variable" // Marked as OBSOLETE Field 9 

Table 'SwS Employee' 
"UVG Cost Centre" // Marked as OBSOLETE Field 131 
"Salutation" // Marked as OBSOLETE Field 212 

Table 'SwS Employee History' 
"UVG Cost Centre" // Marked as OBSOLETE Field 131 
"Salutation" // Marked as OBSOLETE Field 212 

6.1.2    PreUpdate 5050.200
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6.1.2.1    Introduction

Dear SwissSalary Customers,
Dear SwissSalary Partners,

We are pleased to present to you the manual for SwissSalary PreUpdate 5050.200. Your SwissSalary will be
up to date after installing this release. And again, we can offer you some great new features.

Personal interest notice
With the new SwissSalary 365 cloud solution, we have succeeded in reaching another important milestone.
So now, smaller companies and companies working with other ERP solutions can process your wages easily
and without any installation work using SwissSalary. Please click here for more information.

IMPORTANT NOTES

q Please make sure that a version not older than 5050.000 dated November 10, 2015 was installed before this
update. If your NAV partner has made company-specific changes to your SwissSalary NAV objects, you
must contact your NAV partner BEFORE installation.

q SwissSalary BAU customers with NAV 5.0
SwissSalary Update B5050.000 was the last version for BAU 5.0. NO further developments are planned in BAU
version 5.
We kindly request you to migrate from NAV 2015 to the new NEVARIS solution as soon as possible. Many
existing BAU customers already took this step last and this year, and have since worked with the NAV 2015
platform. If you have additional questions about this topic, please contact the  NEVARIS-Support.

q SwissSalary NAV customers with NAV DB versions 3.70, 4.00 + 4.00 SP1
SwissSalary Update N5050.000 is the last full version for these NAV DB versions. By September 2016, we
will release more PreUpdates (5050.xxx) for these NAV versions. Starting from October 2016, there will be
updates for versions after NAV DB 4.00 SP2 only!

q SwissSalary Role Center | RTC clients starting from NAV 2009 SP1
Since the introduction of the RTC Client, SwissSalary has been using a clearly arranged and intuitive Role
Center. However, we have discovered time and again that some of our customers had not been using it.
System Administrator Manual contains important information thereto.

We hope you will enjoy the latest version of SwissSalary!

Your SwissSalary Team

6.1.2.2    Improvements

6.1.2.2.1    ELM Transmitter | Communication and Submission Now Made in the NAV Client Directly (3)

Task #4189 | 5050.200

In the recent months, our SwisSalary developers have done much research, programming and testing. We are
very proud that we have managed to massively simplify the entire setup and installation of the ELM
Transmitter, and additionally, all the communication and ELM data transmission is offered in the NAV client
directly.

What will change for you?

http://www.swisssalary.ch/en/products
mailto:support@bausoftware.de
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ü You do not need to install any external ELM transmitters anymore. The installed ELM Transmitter can be
uninstalled.

ü No external drive path is needed anymore. The XML files are stored directly in the NAV DB.
ü Fewer problems with missing permissions for the installation of software and digital certificates.
ü No external installation on Remote Desktop Server, Citrix etc. anymore and therefore, no more recurring

expenses on external resources.
ü Some obsolete fields were removed (Payroll Setup -> tab General).

What remains the same?

ü The entire ELM-reporting process remains exactly the same as before!
The "Online" check box can be found now in the ELM Settings only, not during ELM submission.

TIP
We recommend completing open ELM submissions prior to updating to N5050.200. The new ELM process
works exclusively within the NAV Client; the already written XML files in directories will not be considered
anymore.

There are new ELM settings in the Payroll Master Data.

RTC Client View (starting from NAV 2009 SP1 RTC)

Restore default
Values

Automatically configures the settings that you can load from the swissdec LIVE server

Check Connectivity
(Ping)

Connectivity test (testing the amount of time required for connection between the client
and the server - the time difference should not be too big)

Check
Interoperability 

The interoperability test checks whether the umlauts (language settings) and decimal
settings are correct.

Proxy settings Definition for setting up a special proxy host

Certificates Used to manage digital certificates.
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Classic Client View (NAV 4.00 SP2 up to NAV 2009 R2 Classic)

If the integrated ELM Transmitter is not properly installed, a message will appear stating that it must be first
installed via the "Organization".

6.1.2.2.1.1   ELM Transmitter Installation | RTC Versions | NAV 2009 SP1 RTC up to NAV 2016 (3)

Task #4189 & Task #7617 | 5050.200

ELM Transmitter Installation for Versions NAV 2013, NAV 2013 R2, NAV 2015 + NAV 2016

1. Open Organization, download .NET assemblies:

2. Open .NET assemblies, import ZIP file (downloaded ZIP file), then "Save server add-ins":
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If the “Save server add-ins” causes privilege errors, the NAV Middle Tier Server service may need to be
restarted, and the Server add-ins saved again.

3. Install certificates

Up until now, digital ELM certificates were installed during the installation of ELM Transmitter. Due to the
elimination of physical ELM transmitters with PreUpdate 5050.200, we had to find a new way to register digital
certificates.

They became available in SwissSalary Store under “Organization”. You will see the “Certificates” entry and
status “outdated”. Click Certificates, and ELM certificates will be downloaded and installed automatically. If
you are not sure if the certificates are up to date, please select “Process -> Update Certificates” in the ribbon.
The existing certificates will then be removed and re-installed.

When you return to the organization view, the status should then be “up to date”.
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6.1.2.2.1.2   ELM Transmitter Installation | Classic Versions | NAV 4.00 SP2 - NAV 2009 R2 Classic (3)

Task #4189 & Task #7748 | 5050.200

ELM Transmitter Installation for NAV 4.00 SP2, NAV 4.00 SP3, NAV 5.00, NAV 5.00 SP1, NAV 2009 SP1
Classic + NAV 2009 R2 Classic

1. Open Organization, download and install SwissSalary Essentials (Setup). To do this, the necessary NAV
client permissions are required!
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After the download, the following ZIP file will appear in the Temp folder:

2. You need to extract the contents of this zip-file and then launch Setup.exe (requires local admin rights)

After the download, the store item status will automatically display as “up to date”, since we have no control
over the setup and see whether it was actually executed or not. This means also that you or your partner
should actually run this setup. It can be managed in the Control Panel.

As for NAV 2009 RTC Client, this Setup must also be performed on the NAV Server!

3. After installation, you will see the “SwissSalary Essentials 5.0” entry under “Programs and Features”:

The following files will be installed in the program folder:
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ELM Transmitter Software libraries (DLLs) for ELM submission

Barcode Software libraries (DLLs) for 2D barcodes from wage statement

Zip Software libraries (DLLs) for automatic unzipping

NATHash Software libraries (DLLs) for SwissSalary EasyRapport

MSXML6 Software libraries (DLLs) for generating XML documents (usually available via
Windows installation)

4. Restart NAV Client.

6.1.2.2.1.3   Proxy Server Support for Outbound Connections (3)

Task #7705 | 5050.200

Some clients allow outbound connections only via a proxy server. Beginning from PreUpdate N5050.200, a
proxy server can be set up for ELM submission and SwissSalary Direct. We have already tested this setup live
at a customer's site.

The settings can be found in the Payroll Setup -> ribbon “Process” -> proxy settings for ELM Transmitter.
Similar settings can also be found under SwissSalary Direct settings.

6.1.2.2.2    SmartPort | Completely Revised and Enhanced (3)

Task #6713 & Task #7675 | 5050.200

SmartPort has been completely revised and flexibly enhanced since its launch in PreUpdate 5049.003.

For example, SmartPort serves as a data interface between a leading HR system and SwissSalary. The same
interface is used for data exchange between our employee portal SwissSalary Direct and SwissSalary. Based
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on our XSD schema, the external system provides an XML file for SwissSalary that indicates mutations of
personnel data, new employees, employees laid-off, etc.

In this case, data supplier e.g. can independently choose data to be confirmed by payroll officer or data to be
adjusted automatically in payroll accounting (source code). Data can be provided using a ‘Valid from’ date. If
TimeMachine is provided for this field in SwissSalary, this value will be provided with the correct ‘Valid from’
date in TimeMachine. Data fields without timeline will be retained in SmartPort until changed over time.

You can display SmartPort in SwissSalary Role Center via “Customize -> Customize this page”. SmartPort
can be launched in the Classic Client under “Periodic activities -> SmartPort journal”. The settings are located
under “Setup -> Setup -> SmartPort”.

Description of fields and functions:

Import XML file import (visible only if an import directory is defined under "Settings")

Direct Sync Execute SwissSalary Direct synchronization (visible only if SwissSalary Direct is configured)

Open Open change details and accept/reject the change

Reject Reject the change directly  

Show All Also show future changes (if available). Another click activates the filter again.

Journal The Journal shows all pending changes incl. changes preview in the factbox.

Protocol Change log view (persons that accepted/rejected and time) for tracking purposes

Setup Opens SmartPort settings

Find Default Dynamics NAV search feature

Select a row and open it. This view will open (the figure shows a new employee view – not yet recorded in
SwissSalary):
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You can “Accept”, “Reject”, “Update” the existing values or “Reset” the ignored values in the ribbon.

Field Data field name in SwissSalary

Current value Existing data record in SwissSalary

New value Change delivered from external system

Action Action allows choosing between “Update”, “Ignore” and “Delete”. This value cannot be
changed manually.

Valid from The transfer of value from which the change is valid (transfer to TimeMachine)

Ignore You can ignore individual values that you do not want. These rows disappear; they can be
retrieved again via “Reset”.

New value edited You can manually override the value provided. Thereby, the edited value will be provided
instead of the returned.

New value
original

So that you can keep track (at any time) in the log which values remain in the original state
and which of them are edited, 
both values are placed in the log.

All changes can be analyzed in a preview in “Journal”. The “Log” shows any change with all the details.

You will see the following in the “Setup”:



Seite 232

Client import directory Directory used to import XML files stored in the NAV client

Server import directory Directory used to import XML files stored in the NAV Server (option available in
RTC
versions only)

Auto import source code
filter

Source code that can be used as an individual record feature. These data
records 
Automatically updated without manual release.

Last import The date of the last import

For other SmartPort adjustments, see the sections below.

6.1.2.2.2.1   New Fields | XML Schema (XSD) Extended (3)

Task #7635, Task #7638 & Task #7639 | 5050.200

XML Schema (XSD) from SmartPort has been enhanced as follows:

- Employee photo
- Department
- Position
- Description (of the change, e.g. 'Moved after marriage')

Task #7106 | 5050.100

These fields can be imported additionally:

- Title Code
- Gender Code
- Language Code
- Nationality
- Date of employment
- Payroll entry date
- Date of resignation
- Canton

The XSD schema with all fields can be obtained from our Support at support@swisssalary.ch.
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6.1.2.2.2.2   Preview of Mutations in Factbox (3)

Task #7651 | 5050.200

If you click “Journal”, you will see entries in SmartPort. You can select the “Changes” factbox in role tailored
clients (RTC) that will display the mutations.

6.1.2.2.2.3   Editing and Ignoring Fields (3)

Task #7674 | 5050.200

The new SmartPort opens up many new practical capabilities. 

Ignore
You can set a flag in the “Ignore” column if you do not want to accept records sent by an external system.

New edited value
Records directly sent by an external system can be renamed in the “New edited value” column. The “Accept”
action will upload this “edited” value to SwissSalary. The original record (unchanged) can be viewed at any
time via the “New original value”.

6.1.2.2.2.4   Mutation Confirmation Order Controlled (3)

Task #7158 & Task #7640 | 5050.200

SwissSalary automatically checks the sequence of mutation inputs. I.e., it ensures that a record already
previously adjusted in another submission is not updated by mistake.

6.1.2.2.2.5   Records Accepted Without Manual Confirmation (3)

Task #7646 | 5050.200

Some customers have reported that certain mutations did not require manual confirmation. I.e., if you are
confident about data entry in the external system and, for example, do not want to confirm department change,
you can now set a “Source code” in SmartPort settings. This code will be provided by the external system as
a flag for this data field. From now on, if the department for an employee is changed in the external system,
this mutation will no longer appear in the SmartPort, it will be confirmed automatically.

Task #6978 | 5050.100

Changes originating from external systems and making no differences in terms of data available in SwissSalary
are automatically archived and appear in the log with status “ignored”.

6.1.2.2.2.6   Original Value is Saved and Displayed in the Log (3)

Task #7676 | 5050.200

The original value can always be viewed in the log in the “Current value” field. This way traceability is ensured.

6.1.2.2.2.7   Deleting Employees via SmartPort (3)

Task #7687 | 5050.200

A “DELETE” command can be transferred to SmartPort via external system. This “Delete” command will
appear in the “Action” column of the SmartPort-view. Of course, an employee can only be deleted if no wage
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items were previously settled. After the “Accept” action, the employee will be definitely deleted from
SwissSalary.

6.1.2.2.2.8   Mutation Description (3)

Task 7644 | 5050.200

From now on, a “ChangeDescription” node can be provided in the XML file. I.e., payroll officer will not only see
"who" made a change and "when" on the confirmation page, but also for what reason (for example, change of
address due to a move).

6.1.2.2.3    Following Salary Type | Enhancement

Task #4075, Task #7667, Task #7668, Task #7669, Task #7671, Task #7672 & Task #7723 | 5050.200

The resulting salary types can no longer be found in the wage card “Function” tab. Instead, they are now
directly located in the ribbon (RTC Client) or can be opened via the “Salary Type” button in Classic clients. This
has the advantage that you can define several resulting wage types with a variety of options for each wage
type. You can now define premiums and weekdays of their calculation. The resulting wage types can be
opened with the help of “Ctrl+G” key combination.

Example:
A premium of 25% is due on Saturday and of 50% is due on Sunday. Until now, 2 more salary types with
appropriate premiums needed to be created besides working hours report ST (Saturdays and Sundays). From
now on, you only need ST 1700 MW Reporting (working hours) and salary types for surcharges (per weekday)
in “Following Salary Types”.

In the “Following Types” table additional following wage types with different surcharges per weekday can be
defined:

The following columns are displayed (by default):

Following Salary Type Recording of the resulting wage type number
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Following Salary Type –
Factor Quantity

Recording of the factor for the resulting wage type in the “Number” field
Example: Payout of 100 overtime hours plus the resulting wage type premium of
25%. The resulting wage type already contains
0.25 as the Factor. Thereby, 100 hours will be transferred from the output wage
type to the resulting wage type at 1:1.

Following Salary Type -
Factor Amount

Recording of the factor for the resulting wage type in the “Amount” field
Example: Daily allowance adjustment WT should catch up the daily allowance
WT. After the recording of daily allowance amount,
the same amount will be transferred at 1:1 to the “Amount” field of the resulting
wage type.

Weekdays (Monday –
Sunday)

Based on the document date (TapBoard/Report Journal), it is checked which
resulting salary type is pulled for premium calculation. The calculation can only be
made if, for example, working hours can be accurately detected to the day.

Settlement Children
Allowances by direct
payment

In the cantons of GE and VS, family allowances are directly paid to employees in
part. For amount offsetting for a WT wage bill, family allowance must also be
calculated,
though set off with a compensation wage type right away. In case of the resulting
wage type (settlement), a check mark must be set here.

Following Salary Type –
Transfer Dimension

By setting the check mark, the recorded dimension (CC/CB) on the output wage
type is automatically 
transferred to the resulting wage type.

The following columns can be displayed additionally:

Following Salary Type –
Factor Rate

Recording of the factor for the resulting wage type in the “Rate” field
(rarely used; recording of the output value is usually done under “Number” or
“Amount”)

Following Salary Type –
Suggestion Line

If more than one resulting salary type are rowed together, then the calculation is
done to the last wage. A break in the calculation process can be made by setting
a check mark. E.g., the calculation will stop at the second resulting wage type
and you can enter a different number or a different amount. After that the
calculation will continue.

Day Types If employees work on holidays, usually premiums also apply like on Saturdays or
Sundays. You can add the “Day type” for holidays to the row with the premium.
Based on the transaction, the system will then automatically detect that the same
premium must also be paid for a holiday. The day types
can only be used in SwissSalary Plus, provided that working time calendar is use.

The old resulting wage types are incorporated into the new structure automatically via the automatic “Update
process”. If the wage type masters are linked across clients, the resulting wage types are also incorporated
accordingly.

Using the “Function” selection option, the “Wage Type List” report also shows the resulting wage type unless
it has several of them. Then, the following message appears: “There are x resulting wage types”.

6.1.2.2.4    SwissSalary Direct

6.1.2.2.4.1   No Email Notification Sending (3)

Task #6754 | 5050.100

From now on, it can be globally set per client whether notifications are to be emailed to the employee:
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As long as the option is on, no notification emails will be sent when documents are uploaded.

If the option is on, a message also appears while sending messages (to prevent the option from being on by
mistake):

6.1.2.2.4.2   Employee Documents Synchronization (3)

Task #7175 | 5050.100

Since PreUpdate 5050.100, personal employee documents like employment contract, medical certificates
(only PDF files), etc. can also be transferred to SwissSalary Direct in addition to paycheck and Salary
Certificate. Documents uploaded for synchronization to SwissSalary Direct via column “Direct” can be stored
in the employee's “Dossier”. Mail delivery to the employee can be delayed via “Visible from” (similar to
payslip/wage statements).

Of course, you can delete these documents for an employee. Simply remove the check mark next to “Direct”
and launch synchronization.
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6.1.2.2.4.3   Dossier Batch Import (via Folder) (3)

Task #7173 | 5050.100

Up until now, only individual files could be imported via the employee's Dossier and/or via document import.
This was impractical if, for example, all employees’ hourly tickets needed to be imported in PDF format.

This feature became available beginning from PreUpdate 5050.100. It is required that the PDF documents per
employee be created in a folder as follows:

The documents in the folder must correspond to the format “%EMPLNO%_*.*” (%EMPLNO% = Personnel
Number).
e.g. 1005_Stundenrapport_Jan2015.pdf

The files are stored in the relevant dossier by import per employee and finally uploaded through
synchronization.

1. The function can be launched via “Departments” or via the “Dossier folder import” search window (Ctrl+F3):

2. The following view will appear:
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Folder Path selection/recording for the folder whose content is to be imported

Description Optional description of the document. If the field is left blank, the file name will be
used as description.

Document type Used to specify document type (types can be freely defined and currently have no
additional influence in SwissSalary Direct)

Direct Defines whether the imported document should be visible in SwissSalary Direct.

IMPORTANT
After the import, SwissSalary Direct synchronization must be started. Otherwise, the
documents will be hidden in 
SwissSalary Direct.

Visible from Define date the documents are to become visible (and also when the employee
should be informed 
about the new document via email).

6.1.2.2.4.4   Automatic Synchronization via Job Queue (3)

Task #6612 | 5050.000

With the introduction of SmartPort with PreUpdate 5049.003, the change of address and bank details “returns”
from the web into SwissSalary. It was supposed that the changes in the Role Center could be directly visible
after a few minutes, and did not have to be synchronized manually.

It can be relatively easy to configure via the so-called “Job Queue” (NAV standard function) beginning from
Dynamics NAV 2013. The advantage is that this Job Queue runs on the NAS (NAV Server), hence on the
Middle Tier. Consequently, no user should be actively logged to start the synchronization.

The setup is made as follows (in each client to be synchronized):):
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Important notes:

q Please do not set too low value for "No. of Minutes between Runs", because otherwise our server can
quickly go down.

q It is also recommended not to set it to the full hour, e.g. 110 min. (as we reduce the risk that all customers
sync at the same time).

In addition, Microsoft recommends creating individual NAS service for “Job Queue”.

6.1.2.2.4.5   Documents are Dispatched and Logged Immediately (even in the case of partial delivery) (3)

Task #6831 | 5050.000

If the payslip delivery stops at 50% (e.g., due to Internet connection fault), 50% of wage statements were
effectively sent. However, it was not visible under “Documents”. According to this view, no payslips were sent.

From now on, an entry for each document sent is immediately created and stored in the Documents table
(COMMIT). Thereby, they are still visible even in the case of interruption.

6.1.2.2.4.6   Company Name Filter | Preventing Incorrect Test Client Synchronizations (3)

Task #6827 | 5050.000
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Since the major update 5050.000, there is the “Company Name Filter” field in SwissSalary Direct settings.
You can enter the name of the client in the field. If this client is copied regularly for test purposes, e.g. “TEST
xxxx” is taken from the copied client. Since in any case this new TEST client has a name other than the LIVE
client, SwissSalary automatically detects that synchronization should not be made in this client.

Earlier, we had repeated support requests from customers who had performed synchronization in test clients
(copy of the live client) by mistake. False synchronization is no longer possible in live clients after the
introduction of the “Company Name Filter”.

6.1.2.2.4.7   Synchronization Rollback (3)

Task #6826 & Task #7624 | 5050.200

You can now completely reset the configuration using the SwissSalary Direct settings. This is necessary if, for
example, a test client was copied from the live client and synchronization was performed in the test client after
that by mistake.

Please note the following when starting this function:

If you are not sure if you are allowed to perform this function, please contact our support team at
support@swisssalary.ch.

6.1.2.3    Employee

6.1.2.3.1    Employee Address | TimeMachine (3)

Task #7126 | 5050.200

We have expanded the fields for the TimeMachine. From now on, data fields Address, Address 2, as well as
fields ZIP Code/City and ZIP Code/City of Tax Municipality can be edited on the timeline. We will also
establish additional validation for major update 5051.000 of October 2016 (automatic change of WT canton
based on the TimeMachine entry in fields ZIP Code/City of Tax Municipality).

6.1.2.3.2    Pay Process List | Changing Additional Fields for WT ELM Submission (3)

5050.200

We had many support requests in the past regarding missing life partner information and/or wrong ZIP
code/Tax municipality during WT ELM submission. Up until now, this missing or incorrectly recorded data
could be recorded or corrected only by the partner or our support.

You can now edit this data in the Pay Process List yourself. We allow making changes to this information,
since it does not rely on sensitive/important information and there are many special cases that cannot be
correctly detected in advance.

In addition to the already changeable fields 
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- Recruitment
- Resignation
- BVG change
- BVG insurance report code
- BVG insurance report type
- BVG report additional text,

the following fields are changeable, beginning from PreUpdate 5050.200, after wage posting:

- Tax municipality ZIP code (must always be a CH ZIP code)
- Tax municipality (must always be a CH municipality similar to the ZIP code)
- Life partner earnings
- Life partner occupation
- Life partner's workplace
- Beginning of life partner's employment
- End of life partner's employment
- Residence permit

Please note that in each case correct data for the whole year is in place for a valid WT ELM submission.
Besides the current month, WT ELM submission also includes the whole year in a form of a recapitulation.

6.1.2.3.3    Personnel List and Personnel Card | New ‘Payroll Journal Row’ Factbox (3)

Task #7572 | 5050.200

This improvement concerns the customers with the RTC Client beginning from NAV 2009 SP1 exclusively!

You can select the new “Payroll Journal Row” factbox in the Personnel card or Personnel list via “Customize -
> Select Infoboxes”. In addition to the existing “Wage Items” factbox, you can recognize variable data already
collected per employee from Report journal.

Consequently, the following factboxes are already available in this area beginning from N5050.200:

- Employee photo
- Employee dimensions
- Employee dossier
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- Employee statistics
- Employee TimeMachine
- Children
- Wage items
- Payroll journal row (new)
- Notes (NAV Standard)
- Links (NAV Standard)

6.1.2.3.4    Income Tax Calculation | TimeMachine Also Balanced with Year + Year Calculation Type (3)

Task #6842 | 5050.200

Income tax calculations with TimeMachine in case of tariff or canton mutations has already been implemented
in the “Month” calculation type. Almost all special cases are covered today. In case of the “Year” (cantons
GE, VD, FR and VS) and “Year balanced” (canton TI) calculation type, it was always necessary for retroactive
and monthly tariff changes to work with the “IT Calculation Date” field. 

Since PreUpdate 5050.100 of the end of April 2016, retroactive mutations in “Year” and “Year balanced” can
be made directly via TimeMachine. The “IT Calculation Date” is updated automatically. If a mutation occurs in
the same month and no TimeMachine entry is created, the “IT Calculation Date” field must be updated
manually.

We have also re-examined in detail the calculation of back payments after resignation (previous year also) and
can implement it in PreUpdate 5050.100 release.

Consequently, TimeMachine can be fully deployed for all calculation types. Retroactive cancellation via
TimeMachine when the WT is calculated by mistake is still pending. The same applies to retrospective
subsequent charge, provided that no IT bases were previously considered. We seek a simple and intuitive
solution.

6.1.2.3.5    Wage Items | Creating Test Billing (3)

Task #7662 | 5050.200

Test billing may be created in the Report journal and in TapBoard, as well as in the Personnel Card/List. This
feature has been newly incorporated into Wage Items. Test billing can be launched using the “Ctrl+T” key
combination.

6.1.2.4    Payroll Setup

6.1.2.4.1    Family Allowances | Calculation/Rounding in Case of Employment During the Month (3)

Task #7493 | 5050.200

A customer from a western Swiss canton informed us that in case of employment during the month the
calculation of family allowance always had to be rounded up “to CHF 0.05 per day” and had not been totalized
at the end of the calculation.

This calculation type (requirement) is defined in the Family Allowances Guidelines: Para. 511 of FamZWL.
Family allowances compensation funds do not necessarily need to adhere to this requirement.

Example WITHOUT day-specific rounding:
Monthly family allowance | CHF 230.00
Term of employment | July 1–15, 2016
Calculation | CHF 230 / 30 days x 15 = CHF 115.00
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Example WITH day-specific rounding:
Monthly family allowance | CHF 230.00
Term of employment | July 1–15, 2016,
CHF 230.00 / 30 days = CHF 7.667 -> with day-specific rounding results in CHF 7.70/day
= 15 days at CHF 7.70 = CHF 115.50

We now offer both types of calculation.

The definition can be set up per FAK canton in the payroll master data. The assignment is made in the “Type
of child allowance rounding” column:

- monthly (default) = rounding done per month and not per day
- daily (new) = rounding done precisely per day

If, in case of employment forms during the month, you have not noticed any difference in the FAK fund
calculation, you do not need to do anything.

6.1.2.5    Salary Declaration

6.1.2.5.1    Year-end Statements Filtered Using the Recorded Values (3)

Task #4487 | 5050.200

The following evaluations are now filtered using the recorded values (previously filtered by current values):

- AHV Summary | (SwS AHV Summary)
- AHV Free Summary | (SwS AHV Free Summary)
- UVG Summary | (SwS UVG Summary) 
- UVG Additional Summary | (SwS UVG Add. Summary)
- BVG Summary | (SwS BVG Summary)
- HI Summary | (SwS HI Summary)
- FAK Summary | (FAK Summary)
- Social Unit Summary | (SwS Social Unit Summary)

Example:
Mrs. M. was at the workplace in Zurich on December 31, 2015, and at the workplace in Luzern beginning from
January 2016. If the assessment of social security was filtered for 2015 in February 2016 using the “Lucerne”
workplace filter, Mrs. M. would appear on the list, even though she was still employed in Zurich on December
31, 2015. The filter now applies to the recorded values valid at the time of wage payment.

6.1.2.5.2    Salary Certificate | Field Service Share | Distinguishing Between Federal and Cantona (3)

Task #7608 | 5050.200

In PreUpdate 5050.100, we have outlined the first portion of information on Salary Certificate in the “FABI
Implementation” area. We have incorporated the latest findings in PreUpdate 5050.200 (also see information on
our website http://www.swisssalary.ch under “News” and “Blog”).

If you entered the number of field service days (half-days) using a special salary type (the wage type must be
necessarily assigned to the wage statement item 15. Comments), these days will be automatically recorded
as a percentage and displayed in Paragraph 15 of the wage statement as follows:

Example: cantonal and federal authorities consider a different number of working days per year:
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Example: cantonal and federal authorities consider the same number of working days per year:
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6.1.2.5.3    Salary Certificate | Field Service Share | Acquiring Days in the Amount Field (3)

Task #7604 | 5050.200

When field service days are entered in the “Amount” field using the “Field Service” salary type (cf. PreUpdate
5050.100 manual), they will also appear on all other evaluations (e.g., Empoyee Salary Statement A4P), for
which the amounts are assessed.

To avoid this, we have made a relevant improvement, so that the Number field can also be used for the “Field
Service” print proofs. You can change the entry from “Number” to “Amount” during the year as well. The two
fields are cumulated for “Field Service” share calculation.

6.1.2.5.4    Salary Certificate | Employee's Individual Comments (3)

Task #7571 | 5050.200

Additional comments (paragraph 15) for the Salary Certificate (column “Comment Text” and “Comment Text
2”) can be recorded in the employee’s Employee Card (Wage Tax Declaration). These comments were written
at the moment of creation of the Salary Certificate. If they were changed later, the wage statement could not
be created in state “Original”.

The comments are now written into the “Payroll head” table with each pay process. It is ensured this way that
the Salary Certificate is always created with comments valid at the moment. Please note that the comments of
the last pay process will be considered in December

6.1.2.5.5    Social Unit | Headers Missing On Subsequent Pages (3)

Task #7250 | 5050.100

A header with the details on insurance was missing from the following pages in the annual evaluation for social
funds (FAR, Parifonds, MDK/MEK, etc.).

The report has been corrected.

6.1.2.5.6    ELM | Marriage Date 0001-01-01 During IT ELM Submission (3)

Task #7375 | 5050.100

In older NAV 2013 R2 builds, an empty marriage date with the value “0001-01-01” was written in the XML file
and then submitted during  ELM submission instead of being ignored. For some IT offices, these reports led to
error messages.

We have already published a hotfix for NAV 2013 R2 for version N5050.000, and beginning from PreUpdate
5050.100 this problem is solved.

6.1.2.5.7    ELM | XML File Misspelled When a IT Canton Exclusively Receives Corrections (3)

Task #7736 | 5050.200

There was a problem in the correction month while sending the XML file in case of retroactive IT corrections
(change of canton). The challenge was that while the new canton with positive corrections was written to the
file, the existing respective canton with negative corrections could not be correctly determined.
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This error has been corrected, the XML file is created correctly.

6.1.2.5.8    ELM | IT ELM Error Message in Case of Clean Additional Pay Processes (3)

Task #7294 | 5050.100

If an employee has only one additional pay process in a month and no major pay process, the month is not
correctly reported during IT ELM submission. This could lead to weird errors, especially if the employee only
had additional pay processes in all months of the reporting year (invalid XML file) or even all employees only
had additional pay processes.

From now on, to determine the reporting period (months to be reported) not only major but also additional pay
processes are counted (not down-payment and/or closure pay.

6.1.2.5.9    ELM | Validation Error When TimeMachine Entries Created in Version 5050.000 (3)

Task #7163 | 5050.100

ELM Transmitter stopped working during IT ELM submission with a “red” error message. Our analysis has
shown that TimeMachine entries created using version 5050.000 could not be written and submitted correctly.

A hotfix has been created then for version 5050.000 shortly after its release. This error was removed in
PreUpdate 5050.100.

6.1.2.6    Reports

6.1.2.6.1    History | TimeMachine Entries Considered (3)

Task #7623 | 5050.200

Various data fields can be changed on the timeline via TimeMachine (e.g., wages, IT fields, etc.). These entries
are not incorporated in the History table and, therefore, have no log entries generated.

The entries are now included in the History table.

6.1.2.6.2    Attestation of Employeur ALV | Para 20: Pension Fund Name (3)

Task #5880 | 5050.200

From now on, the name from the BVG contract contact address is indicated in Paragraph 20 (BVG fund) of the
Attestation of Employeur ALV (Swiss, not international certificates) provided that the Marketing and Sales
module - Contacts is licensed. Up until now, the description, and not the “BVG Fund Address”, had been
transferred from the “Insurance Contract”.

6.1.2.6.3    Intermediate certificate of profit ALV | Holiday Pay for Monthly Wages Produces False Wages  (3)

Task #7499 | 5050.200 

In addition to holidays in days/hours, a holiday pay percentage (rarely used) can be registered for an employee
per month wage in the Refunding of Absences. If this was the case, a wrong hourly wage rate and, therefore,
an incorrect gross wage was calculated by mistake and included in the Temporary Employment Certificate.
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This miscalculation has been corrected.

6.1.2.6.4    Plausibility Check | Report Revised Completely (3)

Task #7538 | 5050.200

The Plausibility Check assessment in the Report journal has been completely revised. Sorting was particularly
random in RTC versions. The entries are now sorted correctly by employee, wage type and day.

6.1.2.6.5    Paycheck | Second On-account Payment Not Displayed On Payslip

Task #7653 | 5050.200

This correction concerns the customers with the RTC Client beginning from NAV 2009 SP1 exclusively!

If an additional on-account payment is made within the same accounting period, only one detailed on-account
payment appears on the paycheck. The payment amount was always calculated correctly; it was only a
problem of display on the paycheck. Both on-account payments were displayed in wage items.

The paycheck has been revised and now shows multiple on-account payments within the same accounting
period.

6.1.2.6.6    Paycheck | In Case of 2 ESR Banks Only 1 ESR Payment is Taken into Account (3)

Task #7434 | 5050.200

This correction concerns the customers with the RTC Client beginning from NAV 2009 SP1 exclusively!

If two ESR banks with the same reference number were stored in Personnel Bank (different maximum
amounts), only the first ESR bank was taken in the payslip into account.

The problem has been solved.

6.1.2.6.7    Paycheck | Classic Client | Displaying the Number of Employees per Pay Process (3)

Task #6914 | 5050.100

Valuable information on pay process is displayed in factboxes in modern RTC clients (number of employees
settled, etc.).

This information can also be found now in the old Classic Client. When you launch the payslip, you can use
the lookup field “Payroll No.” to open the pay process list. The “Employee No.” column shows the
corresponding employees settled in each pay process.

6.1.2.6.8    General Ledger Log | Excel Export with Period Specified (3)

Task #7722 | 5050.200

Excel export of General Ledger Log has been slightly adjusted. The posting period is now also placed in the
first column.
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6.1.2.6.9    HI / UVG / UVG Additional Summary | Insurer Name Displayed (3)

Task #7535 | 5050.200

The name of the insurer was incorrectly (top right) printed on the KTG/UVG and UVGZ Accounting, if it was a
little longer than usual.

The report output has been corrected.

6.1.2.6.10    Employee Salary Statement A4L Personal Wage Account Adjusted (3)

Task #2860 | 5050.200

The Excel export of Personal wage account A4Q has been completely redesigned, so that both reports and
PivotTable could be easily created. From now on, the following additionally appears per Excel row:

- Employee No.
- Last name
- First name
- Employment Date
- Resignation Date

6.1.2.6.11    Payroll Setup | Field ‘AHV Administrative Costs' (3)

Task #6467 | 5050.200

This correction concerns the customers with the RTC Client beginning from NAV 2009 SP1 exclusively!

“AHV Administrative Costs” did not appear in the 'Payroll master data' report (SwS Payroll Setup). This has
been corrected in all RTC versions.

6.1.2.6.12    Rate Fluctuation | Report Revised (3)

Task #7351 | 5050.200

Totalizing has been revised in the Rate Fluctuation report.

Example:
An employee gets hired by a company on January 1, 2016. The report is filtered via date filter by January 1,
2016 – January 31, 2016. The employee was already in the “Opening Balance” and was also defined as
“Entry” at the same time.

The report has been corrected in a way that these employees are neither summed as an entry, nor summed in
the opening balance. In addition, the size of the columns has been optimized.
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6.1.2.7    Administration SwissSalary

6.1.2.7.1    Payroll Setup | Personnel Master Data History Always Written (3)

Task #7620 | 5050.200

An activation option for the History personnel Payroll Setup was present in the Payroll Setup -> tab Setup
means. Since this History is enabled by all customers and we recommend this as well, the activation option
(check mark) has been removed from the settings. For customers that have previously waived the journaling
option, the entries are now being written.

6.1.2.7.2    Allocation Group | Social Benefits Presets Expanded with the Wage Type Field (3)

Task #7609 | 5050.200

The “Social Benefits Presets” automatically fill many default fields when setting up the Payroll Area in the
Employee Card. In addition to the “Salary code” field, “Salary Type No.” can be predefined now (usually ST
1100). The wage type needs to be registered in the Employee card only for the monthly wage. In case of hourly
wage, the “Salary type” field remains empty.

6.1.2.7.3    Allocation Group | Display for Balances | Payroll and EasyRapport are Separate (3)

Task #6533 | 5050.000

From now on, the payroll area settings for printing balances in Paycheck and EasyRapport are separate.
Thereby, you can choose balances to be displayed on the Paycheck or in the Employee Info in EasyRapport.

6.1.2.8    Bug Fixes

6.1.2.8.1    Copy Employee | Error in Case of Client Names with “(” (3)

Task #7721 | 5050.200

The “Copy Employee” function returned an error message if a client name (target client) contained brackets,
e.g. “CRONUS (Switzerland) AG”.

This error was corrected. 

6.1.2.8.2    Years of Service Calculation | Evaluation and Calculation (Leap Year) Validated and Corrected (3)

Task #7316, Task #7690 & Task #7729 | 5050.200

At the beginning of 2016, the inquiries regarding the calculation of years of service “pro rata” and the
designation in the Jubilee List have been quite regular. We have found in the analysis that both calculation and
presentation in the assessment sometimes shifted in the leap year. There were some jubilants shown in the
assessment one day earlier or later. Date calculation in the year of service table has also been validated. Most
of the cases with the customer we have analyzed were not due to this irregularity. They resulted from incorrect
entries or manual inputs of previous years of service.

We have dedicated a lot of time in the past few weeks and months to the calculation of years of service and
many cases and assessed many cases and special cases. We are confident that most of the cases have
been covered properly. If you still notice deviations after applying PreUpdate 5050.200, please let us know so
that we could analyze them well and correct for the future.
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6.1.2.8.3    Payroll Journal | Cursor Jump within Resulting Salary Types (3)

Task #7031 | 5050.200

This correction concerns the customers with the RTC Client beginning from NAV 2009 SP1 exclusively!

We have received reports from some customers about the cursor not navigating to the next free line
automatically, but remaining with the resulting salary type when working with resulting wage types. We have
applied various adjustments, but discovered different NAV version dependent behaviour.

The intended feature has been temporarily removed again.

6.1.2.8.4    Plausibility Report | Character Number Error (3)

Task #7277 | 5050.200

When the SwS Plausibility Report was executed within reporting, error message “Length of the string” would
appear if the report text comprised more than 40 characters.

This error message does not appear anymore if this report is executed.

6.1.2.8.5    ‘Fetch EasyRapport Items’ Function With a New Notice (3)

Task #7583 | 5050.200

Previously, when the ‘Fetch EasyRapport items’ action was executed, an error message together with import
cancellation would appear if no EasyRapport group was assigned to an employee but an import line was
available for the employee concerned. No error appears anymore. Instead, a notice appears at the end of the
process saying that a number of “xxx items” are available for employees with no EasyRapport group assigned.

6.1.2.8.6    Paycheck | IT Deduction, Even If No Time Reported for Hourly Wage Recipients (3)

Task #4539 & Task 5847 | 5050.200

I no cash work or absence hours were accounted for an employee subject to withholding tax in case of hourly
wages, a payslip would still be generated (IT deduction and already deducted IT). This always resulted in CHF
0 which annoyed payroll staff members, because a payslip with CHF 0 would be created.

The same also applies to employees subject to withholding tax in case of monthly wages, if due to time
corrections several pay processes (not relevant to the amount) are accounted for.

This error has been fixed, and no payslip is created anymore.

6.1.2.8.7    Paycheck | Additional Pay Process with CHF 0 Triggers IT Calculation (3)

Task #7230 | 5050.100

Some customers have reported that a new withholding tax calculation was triggered in case of employees
subject to withholding tax with clean additional pay process of CHF 0. I.e., there was a recalculation and
balancing with the same amount occurred. This situation caused no mathematical problems, but was
disturbing, since payslips were generated for nothing.

This error was corrected.
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6.1.2.8.8    Paycheck | Wrong First/Last Name On the Next Page (3)

Task #7356 | 5050.200

Sometimes, a false first/last name appeared on the next page of the payslip if an employee changed their
name in the past.

This problem has been solved.

6.1.2.8.9    Paycheck | NAV 2009 | Error If Address Is Set "To the Left” (3)

Task #7137 | 5050.100

Update 5050.000 caused a display problem on the payslip in the NAV 2009 RTC version if the address was set
"to the left”.

This error was corrected in a form of a hotfix.

6.1.2.8.10    Paycheck Email Delivery Without SwissSalary Direct (3)

Task #7605 | 5050.200

Paycheck can also be created as single PDF files without SwissSalary Direct and/or IncaMail and sent without
encryption via email (not recommended). After the last update, an error message would appear by mistake
indicating the launch of SwissSalary Direct, and the export would stop afterwards.

This error was corrected; the error message does not appear anymore.

6.1.2.8.11    DTA File | Completion Notification Shows Wrong Currency Code (3)

Task #7774 | 5050.200

If the DTA bank was set to EUR in the DTA/EZAG settings, the amount after DTA writing would appear in
completion notification with currency code CHF instead of EUR. This was incorrect and has been rectified. The
DTA file itself was always created correctly, only the completion notification was misleading.

6.1.2.8.12    Post Payroll | Error in Case of Recruitment/Resignation During the Same Month, But Not in the Same
Year (3)

Task #7378 | 5050.200

An error message appeared during Post Payroll in case of a resignation or recruitment during the same month,
but not in the same year.

Example:
Employees begins their employment at the company on February 27, 2015 and resigns on February 14, 2016.
The following message would appear during wage posting: 
Date up (14.02.16) can't be earlier than the date of (27.02.16)!

In addition, this error occurred only in cases if the date of resignation was “numerically greater” than the date
of recruitment: February 27 > February 14 (leap year issue).

This wage posting error has been solved.



Seite 252

6.1.2.8.13    Social Unit | Additional Income Limit Taken into Account (3)

Task #2861 | 5050.200

A deduction for an employee would be created during social fund calculation with the “AHV with free Amount”
base, even though the employee was recorded in Social Benefits as an “Additional Income” (CHF 2,300) and
the annual limit of CHF 2,300 was not yet exceeded.

This specific case is now accounted for correctly.

6.1.2.8.14    IT Calculation Error | Salary Types Without Rate Determination with Extrapolation (3)

Task #7663 | 5050.200

A customer of ours reported a withholding tax calculation error. If a salary type is set to be subject to
withholding tax, but the amount is not entered into rate determination, the same salary type cannot be entered
into the Payroll Master Data as a lump sum. This configuration cannot be allowed.

From now on, SwissSalary already verifies during the wage type entry, if an entry is present in the
extrapolation table. The same validation in the other direction is made during the wage type entry into the
extrapolation table.

6.1.2.8.15    A4Q Personnel List Statistics | Excel Export with Error Message (3)

Task #7446 | 5050.200

An error message appeared in the Classic Client version when exporting to Excel from within the ‘A4Q
Personnel List Statistics’ report.

This error was corrected.

6.1.2.8.16    Salary Certificate | Windows Access Control with 2D Barcode (3)

Task #4182 | 5050.200

When opening wage statement using a 2D barcode, AD (active directory) WindowsUser verification could take
a long time and in some cases resulted in the NAV Client crash.

This has been fixed with an option to store the user's name directly (column Custom User Name) via
Administration SwissSalary -> User (SwissSalary User table).
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6.1.2.8.17    SmartPort | Records Not Reported Were Deleted (3)

Task #7649 | 5050.200 (Hotfix 5050.101)

A customer of ours has reported that sometimes data like phone numbers registered in SwissSalary would be
missing after SmartPort synchronization. Our failure analysis has revealed that records not reported by the
external system deleted records in SwissSalary by mistake (synchronization error).

For this reason, a hotfix for version 5050.100 (5050.101) was immediately released.

6.1.2.9    Notes for our SwissSalary NAV partners

6.1.2.9.1    TimeMachine History | Subpage Deleted by User (3)

Task #6896 | 5050.000

“TimeMachine History” subpage can be deleted by an employee using the default “List – delete” feature.
However, after that the employee will not be able to add the subpage themself.

Solution: To make this subpage visible again, customization made by the corresponding user and the
corresponding page must be deleted.

6.1.2.9.2    Error Message During ZIP Code Loading (missing LI entry) (3)

Task #7627 | 5050.200

The “LI” entry for the Principality of Liechtenstein is missing in the Dynamics NAV countries table. When
importing our ZIP code file, the error appears reporting that the LI state does not exist. The ZIP code file can be
imported without any error after the acquisition of this state in the country table.

We have extended now the ZIP code import, so that it checks first whether the LI state exists. If not, it is
created automatically during ZIP code file import.

6.1.2.9.3    SwissSalary Store | Lock Updates When SwissSalary Version is Outdated (3)

Task #7254 | 5050.100

All available updates for ZIP, bank master data, etc. of each SwissSalary version are available in SwissSalary
Store. However, a withholding tax tariff file cannot be imported sometimes via SwissSalary Store, if the actual
SwissSalary version is “outdated”. The customer will see a message that they need to update SwissSalary
first.

This message is an indication and a guarantee that data having possible dependencies to a version will not be
installed. In this example it might be that we need to deliver a new WT tariff file containing fields available only
with a certain SwissSalary version. If you are not sure whether you can import an update or not, please contact
our Support.

We recommend to keep using SwissSalary Standard, if possible, and keep its version updated. This applies in
particular to the version of SwissSalary.

6.1.2.9.4    swissdec Code Unit | Converted from COM to .NET Components (3)

Task #7009 & Task #7395 | 5050.100
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swissdec Code unit requires many COM components that beginning from NAV-2013 do not work on the server
side anymore. So, for example, no ELM submissions can be carried out via the Web Client or SwissSalary
365. In addition, there massive performance problems appear, especially within environments like SwissSalary
365, when COM components are executed on the client side.

XML files are created and XML responses are now completely parsed in all RTC versions on the server side. In
addition, .NET components are exclusively used beginning from NAV 2013.

Important
Since the XML is created now on the server side, the 2-D barcode image is also created on the server side
when the wage statement is printed. This brings about a massive increase in performance. This means,
however, that Barcode.dll is also installed on the NAV Server (Middle Tier). It is especially relevant for the NAV
2009 RTC version, since the DLLs cannot be deployed there as comfortably. This does NOT apply to the old
Classic Client installations, because DLLs may still be installed on the Client.

If company-specific Reports (Sunet and UKA interfaces) requiring COM components are created for the
customer, they must be updated if need be.

In addition, if the 64bit version of the NAV 2016 client is launched, there is no error message after 5050.100
update when creating a 2D barcode in the wage statement.

6.1.2.9.5    SwissSalary Direct | Error Code 1001 Displayed Incorrectly (3)

Task #7549 | 5050.200

If a client is copied, SwissSalary Direct configuration is copied as well. The “1002” error will appear during the
next synchronization indicating that a duplicate “CompanyKey” was recognized. The configuration in the new
client must be deleted and re-entered.

After this action, synchronization will repeat and the “1001” error code because of a duplicate “EmployeeKey"
will not appear by mistake. These errors messages must necessarily appear not to synchronize the same
employees in Test Clients by mistake.

The error has been corrected, the error messages appear as intended.

6.1.2.9.6    SmartPort | Placing BLOB Field (3)

The new SmartPort can also be populated with a “BLOB” field. For this purpose, the following procedure (tip) is
recommended:

1. Create variable ‘TempBlob’, e.g.:

2. Populate variable ‘TempBlob’ BLOB with XML, e.g:

pTempBlob.Blob.CREATEOUTSTREAM(OutStream);
SmartPortDoc.Save(OutStream);
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3. Place variable ‘TempBlob’ as a parameter for the ‘ImportChanges’ function, e.g.:

SmartPortMgt.ImportChanges(TempBlob);

6.1.3    Update 5051.000

6.1.3.1    Introduction

Dear SwissSalary Customers, dear SwissSalary Partners,

We are pleased to present to you the manual for SwissSalary Update 5051.000. Your SwissSalary will be up
to date after installing this release. And again, we can offer you some great new features.

Personal interest notice
With the new cloud solution SwissSalary 365, we have succeeded in reaching another important milestone.
So now, smaller companies and companies working with other ERP solutions can process your wages easily
and without any installation work using SwissSalary. Please click here for more information.

IMPORTANT NOTES

q Please make sure that a version not older than 5050.000 dated November 10, 2015 was installed before this
update. If your NAV partner has made company-specific changes to your SwissSalary NAV objects, you
must contact your NAV partner BEFORE installation.

q SwissSalary BAU customers with NAV 5.0
SwissSalary Update B5050.000 was the last version for BAU 5.0. NO further developments are planned in
BAU version 5.
We kindly request you to migrate from NAV 2015 to the new NEVARIS solution as soon as possible. Many
existing BAU customers already took this step last year, and have since worked with the NAV 2015
platform. If you have additional questions about this topic please contact the NEVARIS support.

q SwissSalary NAV customers with NAV DB versions 3.70, 4.00 + 4.00 SP1
SwissSalary Update N5051.000 is the last full version for these NAV DB versions. We will release updates
for versions after NAV DB 4.00 SP2 only!

q SwissSalary Role Center | RTC clients starting from NAV 2009 SP1
Since the introduction of the RTC Client, SwissSalary has been using a clearly arranged and intuitive Role
Center. However, we have repeatedly discovered that some of our customers had not been using it.
System Administrator Manual contains important information thereto.

We hope you will enjoy the latest version of SwissSalary!

Your SwissSalary Team

6.1.3.2    Improvements

6.1.3.2.1    Salary certificate (Form. 11) | Activity external work

Task #7470 | 5050.100

Since the implementation of FABI (Financing and Development of Railway Infrastructure) on January 1, 2016,
the field service percentage must be recorded for field employees in paragraph 15 (Comments) of the Salary
certificate (for direct federal taxes and for cantonal taxes in individual cantons).

http://www.swisssalary.ch/en/products
mailto:support@bausoftware.de
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The starting point for percentage calculation can be immediately set up as the salary type. To do this, you
need a new salary type with the “Employer Part” type and the allocation to paragraph "15. Activity external
work" of the Salary certificate position. FIBU allocations are neutral, they are not posted in the FIBU.

With this salary type, a "1" is recorded in the "Amount" field (TapBoard or via reporting) for every day of a
person’s involvement in field service. For half a day, e.g. "0.5" can be recorded. SwissSalary interprets these
days accordingly and shows the percentage in paragraph 15 of the Salary certificate using the "Field Service"
note.

Examples:
q At the beginning of work, an employee e.g. goes directly to one or more customers and then returns home: 

Using this salary type, you can enter "1" in the "Amount" field.
q At the beginning of work, an employee e.g. goes directly to a customer, then to the contractually defined

workplace and in the evening returns home from the workplace: 
Using this salary type, you can enter "0.5" in the "Amount" field.

q At the beginning of work, an employee e.g. goes directly to the contractually defined workplace, then to a
customer and in the evening returns home from the customer: 
Using this salary type, you can enter "0.5" in the "Amount" field.

q At the beginning of work, an employee e.g. goes directly to a customer, then to the contractually defined
workplace, to another customer again and returns home in the evening: 
Using this salary type, you can enter "1" in the "Amount" field.

q At the beginning of work, an employee goes to the contractually defined workplace and returns home in the
evening without visiting any customers. 
You may not record this salary type.

6.1.3.2.2    Following Salary Type | Enhancement

Task #4075, Task #7667, Task #7668, Task #7669, Task #7671, Task #7672 & Task #7723 | 5050.200

The resulting salary types can no longer be found in the wage card “Function” tab. Instead, they are now
directly located in the ribbon (RTC Client) or can be opened via the “Salary Type” button in Classic clients. This
has the advantage that you can define several resulting salary types with a variety of options for each wage
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type. You can now define premiums and weekdays of their calculation. The resulting wage types can be
opened with the help of “Ctrl+G” key combination.

Example:
A premium of 25% is due on Saturday and of 50% is due on Sunday. Until now, 2 more salary types with
appropriate premiums needed to be created besides working hours report ST (Saturdays and Sundays). From
now on, you only need ST 1700 MW Reporting (working hours) and salary types for surcharges (per weekday)
in “Following Salary Types”.

In the “Following Types” table additional following wage types with different surcharges per weekday can be
defined:

The following columns are displayed (by default):

Following Salary Type Recording of the resulting wage type number

Following Salary Type –
Factor Quantity

Recording of the factor for the resulting wage type in the “Number” field
Example: Payout of 100 overtime hours plus the resulting wage type premium of
25%. The resulting wage type already contains
0.25 as the Factor. Thereby, 100 hours will be transferred from the output wage
type to the resulting wage type at 1:1.

Following Salary Type -
Factor Amount

Recording of the factor for the resulting wage type in the “Amount” field
Example: Daily allowance adjustment WT should catch up the daily allowance
WT. After the recording of daily allowance amount,
the same amount will be transferred at 1:1 to the “Amount” field of the resulting
wage type.

Weekdays (Monday –
Sunday)

Based on the document date (TapBoard/Report Journal), it is checked which
resulting salary type is pulled for premium calculation. The calculation can only be
made if, for example, working hours can be accurately detected to the day.

Settlement Children
Allowances by direct
payment

In the cantons of GE and VS, family allowances are directly paid to employees in
part. For amount offsetting for a WT wage bill, family allowance must also be
calculated,
though set off with a compensation wage type right away. In case of the resulting
wage type (settlement), a check mark must be set here.
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Following Salary Type –
Transfer Dimension

By setting the check mark, the recorded dimension (CC/CB) on the output wage
type is automatically 
transferred to the resulting wage type.

The following columns can be displayed additionally:

Following Salary Type –
Factor Rate

Recording of the factor for the resulting wage type in the “Rate” field
(rarely used; recording of the output value is usually done under “Number” or
“Amount”)

Following Salary Type –
Suggestion Line

If more than one resulting salary type are rowed together, then the calculation is
done to the last wage. A break in the calculation process can be made by setting
a check mark. E.g., the calculation will stop at the second resulting wage type
and you can enter a different number or a different amount. After that the
calculation will continue.

Day Types If employees work on holidays, usually premiums also apply like on Saturdays or
Sundays. You can add the “Day type” for holidays to the row with the premium.
Based on the transaction, the system will then automatically detect that the same
premium must also be paid for a holiday. The day types
can only be used in SwissSalary Plus, provided that working time calendar is use.

The old resulting wage types are incorporated into the new structure automatically via the automatic “Update
process”. If the wage type masters are linked across clients, the resulting wage types are also incorporated
accordingly.

Using the “Function” selection option, the “Wage Type List” report also shows the resulting wage type unless
it has several of them. Then, the following message appears: “There are x resulting wage types”.

6.1.3.2.3    Absence Claim | Automatic Holiday and Work-in-Advance Days Entitlement

Task #492 / #7438 | 5050.100

You can select per refunding of absences to have holiday and/or work-in-advance days entitlement reported
automatically. You can choose the month for the entitlement (usually January). If it is set, the entitlement in
the corresponding month will be calculated automatically without the need to run the "Cary Forward the Time
Types" report in the Management Rapport Journal.

The calculation month is defined in the card data view "Refunding of absences":

If you are using work-in-advance days balances (rarely), you must assign the appropriate salary types for time
types and in Refunding of absences.

An example of compensation time setup:

1. Create salary types (if not yet present)
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2. Set up time types

3. Assign salary types in Refunding of absences and define the number per year

6.1.3.2.4    PP Franking | Paycheck

Task #833 / #4553 | 5050.100

Available for versions NAV 2013, NAV 2013 R2, NAV 2015 and NAV 2016

In response to many requests and based on the specifications of the Swiss Post, we have implemented PP
franking into the payslip.

There are 4 new fields in the Payroll Setup -> tab 'Paycheck'. Enter normal or "A Priority" franking  in "Shipping
method". Enter the ZIP code and location, as well as the invoice reference number received from the Swiss
Post.
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For more information about franking please contact your post office or search the Interne

6.1.3.2.5    SwissSalary Store | Direct File Download

Task #6955 | 5050.100

The data can be directly downloaded in SwissSalary Store, if you confirm the message below with Yes. This
means that you do not need to download the file from our website first, the file is downloaded immediately. You
will only need to unzip it and then import.
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6.1.3.2.6    RTC-Versions | Graphs and Charts

Exclusively concerns the customers using RTC versions of NAV 2013 or newer!

Task #7291 | 5050.100

Each user can build an unlimited number of graphs and charts, and view them in the Role Center. This became
possible after version NAV 2013 (.NET components are required).
Various graphs are already available by default after the update process. You can also define them on your
own. By clicking "Edit", you can customize an existing graph or create a new one by clicking "New".

Name Name of graph/chart

Description Description of graph/chart

Start date The date as of which you want to start using the graph for evaluation

Calculated start
date

A calculated start date may also be selected instead of the start date. If, for example,
you want to analyze the dates over the past 5 years, enter -5J.

Period Length You can specify a day, a week, a month, a quarter or a year as the period.

No. of periods The number of periods (e.g. months) you want to display in the view (e.g. 6 for 6
months)

Indicator - Name Name your indicator, e.g. Recruitments, Resignations

Chart Type Different types of graphs are available for you, e.g. point, intersection, area, etc.

Value type Select whether the movement or the balance is to display

Unit Select the units for the number, amount, days or hours

Table No. Tables "Personnel Master Data", "Salary Type" and "Time Types" are available for you

Field No.. After you select the table, choose the value field for each line that you want to evaluate

Field name Field name display (cannot be changed)

Filter You can select any filter for the value, e.g. Employee No. from/to, Value from/to, etc.

Reverse sign of
amount.

If a value is to be displayed with - instead of +, select the appropriate field

NOTE
Please follow the instructions in the System Administration Guide. New tables to be considered in the
permission roles were created for graphs. If you work with our default roles, the tables are integrated and you
just need to import the new permission roles. The new tables are below:
q 3049190
q 3049191
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6.1.3.2.7    RTC-Versions | Salary Types and Payroll Setup are Started as View

Task #7203 | 5050.100

In response to numerous customers' requests, the salary types list is now started as a "view" (no revision).

To start editing, select "Edit", then you can directly revise the salary types in the card data view via "Edit List"
in the list view.

6.1.3.2.8    BAU Version | Links in the Role Center

Task #7901 | 5051.000

In the SwissSalary BAU version, you can display the “Links” fact box on the right side in the Role Center. This
fact box is used to directly access frequently used external Internet websites.

6.1.3.2.9    Creating New Company Using the Setup Wizard

Task #7323 | 5050.100

It has never been so simple to create new payroll clients in SwissSalary. The first time you start your new
client, our wizard will launch automatically and guide you through the payroll setup step-by-step. This way, you
will be able to capture your company data, DTA/EZAG Setup as well as your insurance solutions quickly and
easily.

Of course, after closing the wizard, you can check and complete your entries!

6.1.3.2.10    New Support for PDFCreator Version 2.x

Task #6975 | 5050.100

Free PDFCreator is used to create PDFs (payslips, salary certificate for SwissSalary Direct, IncaMail, etc.) in
the old NAV Classic Clients. This software is no longer necessary for all NAV RTC versions starting from NAV
2013 because PDFs are directly created in the NAV client. Major adjustments have been made to PDFCreator
between versions 1.x and 2.x. Up until now, the export from SwissSalary only worked with PDFCreator older
than v1.7.3. 
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Starting from this version, PDFCreator 1.x or 2.x installation on your system is checked automatically. Thus,
PDFCreator 2.x (latest version 2.3) can be used now. To download the latest version, go to:
http://de.pdfforge.org/pdfcreator/download

6.1.3.2.11    Expense Receipts | Export/Import Feature

Task #7833 | 5051.000

From now on, expense receipts can be imported/exported and displayed during reporting.

Example:
When expenses are recorded in the Report journal, an expense receipt (PDF, JPG, etc.) of the corresponding
report row can be attached using the “Import expenses” feature:

After the expense receipt has been imported, it can be displayed or exported to an external system or folder
storage. A Receipt may be removed at any time.

The BLOB table (or rather fields) can be displayed and/or modified in the following views:

- Page 3009086 | Wage Portions | Display and modification became possible
- Page 3009153 | Journal Report Files | Display and modification became possible
- Page 3009176 | EasyRapport Import | Display and modification became possible
- Page 3009095 | Wage Items | Display only, NO modification
- Page 3009238 | Wage Items Subform | Display only, NO modification

6.1.3.2.12    Work Calendar | Work Group | Limits per Percent by Position to be Considered

Task #7884 | 5051.000

The Timber Construction GAV in Article 17e defines Maximum number of flexi time hours per month:
In case of part-time employees, the permissible flexi time hour balances of 20 or 10 hours per month are
calculated on the basis of employment rate pro rata.

For this purpose, we have developed the new “Limits per Percents by Position” field. If this field is activated,
the balances are taken into account based on percent by position.

http://de.pdfforge.org/pdfcreator/download
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6.1.3.2.13    ELM Transmitter | Communication and Submission Now Made in the NAV Client Directly

Task #4189 | 5050.200

In the recent months, our SwisSalary developers have done much research, programming and testing. We are
very proud that we have managed to massively simplify the entire setup and installation of the ELM
Transmitter, and additionally, all the communication and ELM data transmission is offered in the NAV client
directly.

What will change for you?

ü You do not need to install any external ELM transmitters anymore. The installed ELM Transmitter can be
uninstalled.

ü No external drive path is needed anymore. The XML files are stored directly in the NAV DB.
ü Fewer problems with missing permissions for the installation of software and digital certificates.
ü No external installation on Remote Desktop Server, Citrix etc. anymore and therefore, no more recurring

expenses on external resources.
ü Some obsolete fields were removed (Payroll Setup -> tab General).

What remains the same?

ü The entire ELM-reporting process remains exactly the same as before!
The "Online" check box can be found now in the ELM Settings only, not during ELM submission.

TIP
We recommend completing open ELM submissions prior to updating to N5050.200. The new ELM process
works exclusively within the NAV Client; the already written XML files in directories will not be considered
anymore.

There are new ELM settings in the Payroll Master Data.

RTC Client View (starting from NAV 2009 SP1 RTC)
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Restore default
Values

Automatically configures the settings that you can load from the swissdec LIVE server

Check Connectivity
(Ping)

Connectivity test (testing the amount of time required for connection between the client
and the server - the time difference should not be too big)

Check
Interoperability 

The interoperability test checks whether the umlauts (language settings) and decimal
settings are correct.

Proxy settings Definition for setting up a special proxy host

Certificates Used to manage digital certificates.

Classic Client View (NAV 4.00 SP2 up to NAV 2009 R2 Classic)

If the integrated ELM Transmitter is not properly installed, a message will appear stating that it must be first
installed via the "Organization".

6.1.3.2.13.1   One-time Installation of .NET Assemblies for 2 D-Barcodes on Wage Statement

Task #7009 / #7112 | 5050.100

Concerns all the customers using NAV versions NAV 2013, NAV 2013 R2, NAV 2015 + NAV 2016!
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Starting from PreUpdate N5050.100, you need to perform a one-time installation of so-called .NET assemblies.
For this reason, the generation of 2D bar codes for salary certificate is now started on the middle-tier server.
Thus, salary certificate can be created in the future much faster than before (execution speed is improved
significantly).

To do this, please proceed as follows:

1) Go to "Role Center -> Ribbon" and open "Organization". The view will contain the line ".NET Assemblies"
and the status "expired".

2) You can now download .NET assemblies automatically. To do this, click the three dots button under the
name .NET Assemblies.

The following query will open. Please select "Yes".

3) The ZIP file is automatically downloaded and stored in a temporary directory. Now copy the ZIP file to a
selected location (without unzipping the file).
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4) Select ".NET Assemblies" in "Ribbon -> Organization" in the Role Center. Then select "Import Zip file" and
the path where you saved the ZIP file in step 3). Select "Open" in Windows file explorer.

The following message will appear:

5) The available .NET assemblies can be viewed below.

6) Select "Save server add-ins". After that, .NET assemblies will be directly stored on the middle-tier server.
The process is now completed. You can once again select "Update" in Organization. The status should then
be "up-to-date".

If a permission error appears when calling up "Save server add-ins", you must manually extract (with admin
rights) the zip file into the add-ins directory on the middle-tier server; 
e.g .: 'C:\Program Files\Microsoft Dynamics NAV\70\Service\Add-ins\SwissSalary\' (for a NAV 2013
installation). Optionally, you can also store the files via "Save client add-ins". This is to ensure the compilation
of objects in the DEV client.

You cannot install .NET assemblies and require further assistance? Please call your internal IT supervisor,
your NAV partner or contact our support at support@swisssalary.ch.

mailto:support@swisssalary.ch
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6.1.3.2.13.2   ELM Transmitter Installation | RTC Versions | NAV 2009 SP1 RTC up to NAV 2016

Task #4189 & Task #7617 | 5050.200

ELM Transmitter Installation for Versions NAV 2013, NAV 2013 R2, NAV 2015 + NAV 2016

1. Open Organization, download .NET assemblies:

2. Open .NET assemblies, import ZIP file (downloaded ZIP file), then "Save server add-ins":

If the “Save server add-ins” causes privilege errors, the NAV Middle Tier Server service may need to be
restarted, and the Server add-ins saved again.
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3. Install certificates

Up until now, digital ELM certificates were installed during the installation of ELM Transmitter. Due to the
elimination of physical ELM transmitters with PreUpdate 5050.200, we had to find a new way to register digital
certificates.

They became available in SwissSalary Store under “Organization”. You will see the “Certificates” entry and
status “outdated”. Click Certificates, and ELM certificates will be downloaded and installed automatically. If
you are not sure if the certificates are up to date, please select “Process -> Update Certificates” in the ribbon.
The existing certificates will then be removed and re-installed.

When you return to the organization view, the status should then be “up to date”.

6.1.3.2.13.3   ELM Transmitter Installation | Classic Versions | NAV 4.00 SP2 - NAV 2009 R2 Classic

Task #4189 & Task #7748 | 5050.200

ELM Transmitter Installation for NAV 4.00 SP2, NAV 4.00 SP3, NAV 5.00, NAV 5.00 SP1, NAV 2009 SP1
Classic + NAV 2009 R2 Classic

1. Open Organization, download and install SwissSalary Essentials (Setup). To do this, the necessary NAV
client permissions are required!
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After the download, the following ZIP file will appear in the Temp folder:

2. You need to extract the contents of this zip-file and then launch Setup.exe (requires local admin rights)

After the download, the store item status will automatically display as “up to date”, since we have no control
over the setup and see whether it was actually executed or not. This means also that you or your partner
should actually run this setup. It can be managed in the Control Panel.

As for NAV 2009 RTC Client, this Setup must also be performed on the NAV Server!

3. After installation, you will see the “SwissSalary Essentials 5.0” entry under “Programs and Features”:
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The following files will be installed in the program folder:

ELM Transmitter Software libraries (DLLs) for ELM submission

Barcode Software libraries (DLLs) for 2D barcodes from wage statement

Zip Software libraries (DLLs) for automatic unzipping

NATHash Software libraries (DLLs) for SwissSalary EasyRapport

MSXML6 Software libraries (DLLs) for generating XML documents (usually available via
Windows installation)

4. Restart NAV Client.

6.1.3.2.13.4   Proxy Server Support for Outbound Connections

Task #7705 | 5050.200

Some clients allow outbound connections only via a proxy server. Beginning from PreUpdate N5050.200, a
proxy server can be set up for ELM submission and SwissSalary Direct. We have already tested this setup live
at a customer's site.

The settings can be found in the Payroll Setup -> ribbon “Process” -> proxy settings for ELM Transmitter.
Similar settings can also be found under SwissSalary Direct settings.
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6.1.3.2.14    SwissSalary Direct

6.1.3.2.14.1   SwissSalary Direct | Independent Creation of New Access

Task #6505 | 5050.100

Are you already familiar with our SwissSalary Direct employee portal? Starting from CHF 0.50/month, you can
provide payslips, salary certificate, personalized and general documents for registered employees in a secure
cloud. The employee is informed via mail and can operate 24/7 him/herself via web access.

Previously, the initial service registration could only be obtained from our Support. Now you can register for the
service yourself. To do this, go to Ribbon under SwissSalary Direct in SwissSalary Role Center (Classic client:
Setup-> Setup -> SwissSalary Direct). The screen below will appear. Enter the desired subdomain for your
company, for example, cronus for https://cronus.swisssalarydirect.ch and a main mail address like
personal@cronus.com (the email address must exist) and a secure password. Then click "Create access" and
enter further information.
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After successful registration, you can log in with the newly created URL, your user name and password. Do
you need support to do this? Please send an email to support@swisssalary.ch or contact your NAV partner.
We can provide further help with the registration!

When did you start using SwissSalary Direct? When can you start saving money every month?
Did you know that you pay CHF 4.40/month per employee for the creation and delivery of payroll (paper,
printing, postage, envelope, packaging, post, etc.)? You can now do it starting at CHF 0.50 instead of CHF
4.40.

6.1.3.2.14.2   No Email Notification Sending

Task #6754 | 5050.100

From now on, it can be globally set per client whether notifications are to be emailed to the employee:

As long as the option is on, no notification emails will be sent when documents are uploaded. The following
message appears (to prevent the option from being on by mistake):
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6.1.3.2.14.3   Employee Documents Synchronization

Task #7175 | 5050.100

Since PreUpdate 5050.100, personal employee documents like employment contract, medical certificates
(only PDF files), etc. can also be transferred to SwissSalary Direct in addition to paycheck and Salary
Certificate. Documents uploaded for synchronization to SwissSalary Direct via column “Direct” can be stored
in the employee's “Dossier”. Mail delivery to the employee can be delayed via “Visible from” (similar to
payslip/wage statements).

Of course, you can delete these documents for an employee. Simply remove the check mark next to “Direct”
and launch synchronization.

6.1.3.2.14.4   Dossier Batch Import (via Folder)

Task #7173 | 5050.100

Up until now, only individual files could be imported via the employee's Dossier and/or via document import.
This was impractical if, for example, all employees’ hourly tickets needed to be imported in PDF format.

This feature became available beginning from PreUpdate 5050.100. It is required that the PDF documents per
employee be created in a folder as follows:

The documents in the folder must correspond to the format “%EMPLNO%_*.*” (%EMPLNO% = Personnel
Number).
e.g. 1005_Stundenrapport_Jan2015.pdf

The files are stored in the relevant dossier by import per employee and finally uploaded through
synchronization.

1. The function can be launched via “Departments” or via the “Dossier folder import” search window (Ctrl+F3):
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2. The following view will appear:

Folder Path selection/recording for the folder whose content is to be imported

Description Optional description of the document. If the field is left blank, the file name will be
used as description.

Document type Used to specify document type (types can be freely defined and currently have no
additional influence in SwissSalary Direct)

Direct Defines whether the imported document should be visible in SwissSalary Direct.

IMPORTANT
After the import, SwissSalary Direct synchronization must be started. Otherwise, the
documents will be hidden in 
SwissSalary Direct.

Visible from Define date the documents are to become visible (and also when the employee
should be informed 
about the new document via email).
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6.1.3.2.14.5   Automatic Synchronization via Job Queue

Task #6612 | 5050.000

With the introduction of SmartPort with PreUpdate 5049.003, the change of address and bank details “returns”
from the web into SwissSalary. It was supposed that the changes in the Role Center could be directly visible
after a few minutes, and did not have to be synchronized manually.

It can be relatively easy to configure via the so-called “Job Queue” (NAV standard function) beginning from
Dynamics NAV 2013. The advantage is that this Job Queue runs on the NAS (NAV Server), hence on the
Middle Tier. Consequently, no user should be actively logged to start the synchronization.

The setup is made as follows (in each client to be synchronized):):

Important notes:

q Please do not set too low value for "No. of Minutes between Runs", because otherwise our server can
quickly go down.

q It is also recommended not to set it to the full hour, e.g. 110 min. (as we reduce the risk that all customers
sync at the same time).

In addition, Microsoft recommends creating individual NAS service for “Job Queue”.
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6.1.3.2.14.6   Documents are Dispatched and Logged Immediately (even in the case of partial delivery)

Task #6831 | 5050.000

If the payslip delivery stops at 50% (e.g., due to Internet connection fault), 50% of wage statements were
effectively sent. However, it was not visible under “Documents”. According to this view, no payslips were sent.

From now on, an entry for each document sent is immediately created and stored in the Documents table
(COMMIT). Thereby, they are still visible even in the case of interruption.

6.1.3.2.14.7   Company Name Filter | Preventing Incorrect Test Client Synchronizations

Task #6827 | 5050.000

Since the major update 5050.000, there is the “Company Name Filter” field in SwissSalary Direct settings.
You can enter the name of the client in the field. If this client is copied regularly for test purposes, e.g. “TEST
xxxx” is taken from the copied client. Since in any case this new TEST client has a name other than the LIVE
client, SwissSalary automatically detects that synchronization should not be made in this client.

Earlier, we had repeated support requests from customers who had performed synchronization in test clients
(copy of the live client) by mistake. False synchronization is no longer possible in live clients after the
introduction of the “Company Name Filter”.

6.1.3.2.14.8   Synchronization Rollback

Task #6826 & Task #7624 | 5050.200

You can now completely reset the configuration using the SwissSalary Direct settings. This is necessary if, for
example, a test client was copied from the live client and synchronization was performed in the test client after
that by mistake.

Please note the following when starting this function:

If you are not sure if you are allowed to perform this function, please contact our support team at
support@swisssalary.ch.
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6.1.3.2.15    SmartPort | Completely Revised and Enhanced

Task #6713 & Task #7675 | 5050.200

SmartPort has been completely revised and flexibly enhanced since its launch in PreUpdate 5049.003.

For example, SmartPort serves as a data interface between a leading HR system and SwissSalary. The same
interface is used for data exchange between our employee portal SwissSalary Direct and SwissSalary. Based
on our XSD schema, the external system provides an XML file for SwissSalary that indicates mutations of
personnel data, new employees, employees laid-off, etc.

In this case, data supplier e.g. can independently choose data to be confirmed by payroll officer or data to be
adjusted automatically in payroll accounting (source code). Data can be provided using a ‘Valid from’ date. If
TimeMachine is provided for this field in SwissSalary, this value will be provided with the correct ‘Valid from’
date in TimeMachine. Data fields without timeline will be retained in SmartPort until changed over time.

You can display SmartPort in SwissSalary Role Center via “Customize -> Customize this page”. SmartPort
can be launched in the Classic Client under “Periodic activities -> SmartPort journal”. The settings are located
under “Setup -> Setup -> SmartPort”.

Description of fields and functions:

Import XML file import (visible only if an import directory is defined under "Settings")

Direct Sync Execute SwissSalary Direct synchronization (visible only if SwissSalary Direct is configured)

Open Open change details and accept/reject the change

Reject Reject the change directly  

Show All Also show future changes (if available). Another click activates the filter again.

Journal The Journal shows all pending changes incl. changes preview in the factbox.

Protocol Change log view (persons that accepted/rejected and time) for tracking purposes

Setup Opens SmartPort settings

Find Default Dynamics NAV search feature

Select a row and open it. This view will open (the figure shows a new employee view – not yet recorded in
SwissSalary):
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You can “Accept”, “Reject”, “Update” the existing values or “Reset” the ignored values in the ribbon.

Field Data field name in SwissSalary

Current value Existing data record in SwissSalary

New value Change delivered from external system

Action Action allows choosing between “Update”, “Ignore” and “Delete”. This value cannot be
changed manually.

Valid from The transfer of value from which the change is valid (transfer to TimeMachine)

Ignore You can ignore individual values that you do not want. These rows disappear; they can be
retrieved again via “Reset”.

New value edited You can manually override the value provided. Thereby, the edited value will be provided
instead of the returned.

New value
original

So that you can keep track (at any time) in the log which values remain in the original state
and which of them are edited, 
both values are placed in the log.

All changes can be analyzed in a preview in “Journal”. The “Log” shows any change with all the details.

You will see the following in the “Setup”:
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Client import directory Directory used to import XML files stored in the NAV client

Server import directory Directory used to import XML files stored in the NAV Server (option available in
RTC
versions only)

Auto import source code
filter

Source code that can be used as an individual record feature. These data
records 
Automatically updated without manual release.

Last import The date of the last import

For other SmartPort adjustments, see the sections below.

6.1.3.2.15.1   SmartPort | Display Fields Last Name/First Name

Task #7160 | 5050.100

Fields "First name" and "Last Name" are displayed now in addition to the Employee No. in SmartPort, so you
can see at a glance the employees the change was made for.
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6.1.3.2.15.2   New Fields | XML Schema (XSD) Extended

Task #7635, Task #7638 & Task #7639 | 5050.200

XML Schema (XSD) from SmartPort has been enhanced as follows:

- Employee photo
- Department
- Position
- Description (of the change, e.g. 'Moved after marriage')

Task #7106 | 5050.100

These fields can be imported additionally:

- Title Code
- Gender Code
- Language Code
- Nationality
- Date of employment
- Payroll entry date
- Date of resignation
- Canton

The XSD schema with all fields can be obtained from our Support at support@swisssalary.ch.

6.1.3.2.15.3   Preview of Mutations in Factbox

Task #7651 | 5050.200

If you click “Journal”, you will see entries in SmartPort. You can select the “Changes” factbox in role tailored
clients (RTC) that will display the mutations.

6.1.3.2.15.4   SmartPort | More Fields can be imported

Task #7161 | 5050.100

SwissHRM users can now synchronize other fields with SwissSalary:

q Social security No. unknown
q Work Permit
q Permit valid from
q Permit valid to
q SIMIC No.
q ZAR No.
q Place of origin
q Employment (LSE)
q Education (LSE)
q Occupational status (LSE)
q Employment contract (LSE)

So now, practically all fields in SwissHRM and SwissSalary can be synchronized.
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6.1.3.2.15.5   Editing and Ignoring Fields

Task #7674 | 5050.200

The new SmartPort opens up many new practical capabilities. 

Ignore
You can set a flag in the “Ignore” column if you do not want to accept records sent by an external system.

New edited value
Records directly sent by an external system can be renamed in the “New edited value” column. The “Accept”
action will upload this “edited” value to SwissSalary. The original record (unchanged) can be viewed at any
time via the “New original value”.

6.1.3.2.15.6   Mutation Confirmation Order Controlled

Task #7158 & Task #7640 | 5050.200

SwissSalary automatically checks the sequence of mutation inputs. I.e., it ensures that a record already
previously adjusted in another submission is not updated by mistake.

6.1.3.2.15.7   Records Accepted Without Manual Confirmation

Task #7646 | 5050.200

Some customers have reported that certain mutations did not require manual confirmation. I.e., if you are
confident about data entry in the external system and, for example, do not want to confirm department change,
you can now set a “Source code” in SmartPort settings. This code will be provided by the external system as
a flag for this data field. From now on, if the department for an employee is changed in the external system,
this mutation will no longer appear in the SmartPort, it will be confirmed automatically.

Task #6978 | 5050.100

Changes originating from external systems and making no differences in terms of data available in SwissSalary
are automatically archived and appear in the log with status “ignored”.

6.1.3.2.15.8   Original Value is Saved and Displayed in the Log

Task #7676 | 5050.200

The original value can always be viewed in the log in the “Current value” field. This way traceability is ensured.

6.1.3.2.15.9   Deleting Employees via SmartPort

Task #7687 | 5050.200

A “DELETE” command can be transferred to SmartPort via external system. This “Delete” command will
appear in the “Action” column of the SmartPort-view. Of course, an employee can only be deleted if no wage
items were previously settled. After the “Accept” action, the employee will be definitely deleted from
SwissSalary.
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6.1.3.2.15.10   Mutation Description

Task 7644 | 5050.200

From now on, a “ChangeDescription” node can be provided in the XML file. I.e., payroll officer will not only see
"who" made a change and "when" on the confirmation page, but also for what reason (for example, change of
address due to a move).

6.1.3.3    Personnel

6.1.3.3.1    Employee List and Employee Card | New ‘Payroll Journal Row’ Factbox

Task #7572 | 5050.200

This improvement concerns the customers with the RTC Client beginning from NAV 2009 SP1 exclusively!

You can select the new “Payroll Journal Row” factbox in the Employee card or Employee list via “Customize -
> Select Infoboxes”. In addition to the existing “Wage Items” factbox, you can recognize variable data already
collected per employee from Report journal.

Consequently, the following factboxes are already available in this area beginning from N5050.200:

- Employee photo
- Employee dimensions
- Employee dossier
- Employee statistics
- Employee TimeMachine
- Children
- Wage items
- Payroll journal row (new)
- Notes (NAV Standard)
- Links (NAV Standard)

6.1.3.3.2    Employee Address | TimeMachine

Task #7126 | 5050.200
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We have expanded the fields for the TimeMachine. From now on, data fields Address, Address 2, as well as
fields ZIP Code/City and ZIP Code/City of Tax Municipality can be edited on the timeline. We will also
establish additional validation for major update 5051.000 of October 2016 (automatic change of WT canton
based on the TimeMachine entry in fields ZIP Code/City of Tax Municipality).

6.1.3.3.3    TimeMachine | Asterisk Like in the Classic-Client

Task #7118 | 5050.100

In the "old" Classic versions, blank lines are marked with an asterisk at the beginning. This character does not
exist in the RTC versions anymore. We have reintroduced this character in the TimeMachine, so that you could
see if a record is blank. However, each time when the TimeMachine is opened, a value with a star is displayed
if a record is empty.

6.1.3.3.4    TimeMachine-Entries | New Factbox in the RTC-Client

Task #7279 | 5050.100

You can select the new "Employee TimeMachine" factbox in the Employee card or Employee list of RTC
clients via "Customize -> Fact boxes". It shows all the entries in the employee's TimeMachine. The factbox is
additionally built into Management Rapport Journal.

6.1.3.3.5    TimeMachine | Warning in Case of Missing Monthly Parts

Task #7926 | 5051.000

If when entering a new employee, the wage rate value is recorded first, and then a TimeMachine entry with
future adjustments of the monthly wage, a new warning message appears. This indicates to the editor that no
monthly parts have yet been recorded.

If no monthly parts are recorded before a TimeMachine entry, the TimeMachine automatically writes a Null for
the wage rate. This is no longer validated for belated input of monthly parts and remains as Null. This is
problematic, for example, if the daily sickness allowance is to be used, for the purpose of calculation, as a
basis of the wage rate.

6.1.3.3.6    Income Tax Calculation | TimeMachine Also Balanced with Year + Year Calculation Type

Task #6842 | 5050.200

Income tax calculations with TimeMachine in case of tariff or canton mutations has already been implemented
in the “Month” calculation type. Almost all special cases are covered today. In case of the “Year” (cantons
GE, VD, FR and VS) and “Year balanced” (canton TI) calculation type, it was always necessary for retroactive
and monthly tariff changes to work with the “IT Calculation Date” field. 
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Since PreUpdate 5050.100 of the end of April 2016, retroactive mutations in “Year” and “Year balanced” can
be made directly via TimeMachine. The “IT Calculation Date” is updated automatically. If a mutation occurs in
the same month and no TimeMachine entry is created, the “IT Calculation Date” field must be updated
manually.

We have also re-examined in detail the calculation of back payments after resignation (previous year also) and
can implement it in PreUpdate 5050.100 release.

Consequently, TimeMachine can be fully deployed for all calculation types. Retroactive cancellation via
TimeMachine when the WT is calculated by mistake is still pending. The same applies to retrospective
subsequent charge, provided that no IT bases were previously considered. We seek a simple and intuitive
solution.

6.1.3.3.7    Wage Items | Creating Test Billing

Task #7662 | 5050.200

Test billing may be created in the Report journal and in TapBoard, as well as in the Personnel Card/List. This
feature has been newly incorporated into Wage Items. Test billing can be launched using the “Ctrl+T” key
combination.

6.1.3.3.8    Holiday Payment and Holiday Remuneration Order

Task #7386 | 5050.100

When holiday payment remuneration is taken into account during hourly wage calculation, some customers
also consider holiday remuneration percentage. Normally, the base for holiday remuneration is calculated on
the base wage (hourly wage), similarly to recess remuneration. In GAV, however, it is regulated somewhat
differently for temporary employment agencies. Namely, holiday remuneration is taken into account on the
basis of base wage. Then, there is a sub-total and after that holiday remuneration is calculated.

You can now rearrange the order of the calculation in Refunding of absences of the Personnel card. The new
selection field "Surcharge order" the calculation can be defined as follows:

q Holiday Payment/Holiday (default)
q Holiday/Holiday Payment

For the majority of our customers it does not change anything, and the default value is set automatically. The
selection can change the situation for temporary employment agencies and other customers with similar
starting point. You can see two examples of calculation below.
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6.1.3.3.9    Pay Process List | Changing Additional Fields for WT ELM Submission

5050.200

We had many support requests in the past regarding missing life partner information and/or wrong ZIP
code/Tax municipality during WT ELM submission. Up until now, this missing or incorrectly recorded data
could be recorded or corrected only by the partner or our support.

You can now edit this data in the Pay Process List yourself. We allow making changes to this information,
since it does not rely on sensitive/important information and there are many special cases that cannot be
correctly detected in advance.

In addition to the already changeable fields 

- Recruitment
- Resignation
- BVG change
- BVG insurance report code
- BVG insurance report type
- BVG report additional text,

the following fields are changeable, beginning from PreUpdate 5050.200, after wage posting:

- Tax municipality ZIP code (must always be a CH ZIP code)
- Tax municipality (must always be a CH municipality similar to the ZIP code)
- Life partner earnings
- Life partner occupation
- Life partner's workplace
- Beginning of life partner's employment
- End of life partner's employment
- Residence permit

Please note that in each case correct data for the whole year is in place for a valid WT ELM submission.
Besides the current month, WT ELM submission also includes the whole year in a form of a recapitulation.

6.1.3.3.10    Personnel Dimension | Totalizing

Task #7246 | 5050.100

Personnel dimension(s) are separately stored for each employee in Personnel Master Data. The entries with a
"Valid from/to" date can now be limited in time. When an employee was assigned to multiple dimensions (e.g.
different cost centers), the total of all dimensions was summed regardless of their validity.

This has been fixed, the total corresponds to the total of time-valid dimensions based on the working date.

6.1.3.3.11    Social Services Control | More Columns Similar to Classic-Clients

Task #7272 | 5050.100

You can launch the Social Services Control view in the Employee Card/Employee list of RTC clients via Ribbon
-> tab ACTIONS It shows you at a glance what social security the employees are assigned and subject to. In
addition to the personnel number and last/first name, this popular control evaluation could be selected in
Classic clients with extra columns. It is now possible also in RTC clients.
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6.1.3.3.12    PIS | Tab ‘Pass’ in the RTC

Task #7678 | 5051.000

Adjustment fields have been returned to RTC versions in the Employee card/list -> ribbon ‘Human
resources’ (PIS) -> Card (like in the Classic version).

6.1.3.3.13    General Reports | Assigning Reports to Individual Users

Task #7407 | 5050.100

A company-specific report can be assigned to a single or multiple users in "General Reports".

6.1.3.4    Salary Types

6.1.3.4.1    Resulting Following Salary Types | More Decimals After Comma

Task #7865 | 5051.000

Up until now, maximum two decimals could be entered for resulting salary types.

From now on, the fields

- Resulting Following Salary Types – Number of factors
- Resulting Following Salary Types – Factor rate
- Resulting Following Salary Types – Amount of factors

can have up to 5 decimals.

6.1.3.4.2    Copy Salary Type | Resulting Wage Type is Not Copied as Well

Task #7900 | 5051.000

When a salary type was copied, the resulting salary type would not copy as well (starting from 5050.200).
Resulting salary types are now copied as well, also in case of client-specific salary types.
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6.1.3.5    Payroll Setup

6.1.3.5.1    Family Allowances | Calculation/Rounding in Case of Employment During the Month

Task #7493 | 5050.200

A customer from a western Swiss canton informed us that in case of employment during the month the
calculation of family allowance always had to be rounded up “to CHF 0.05 per day” and had not been totalized
at the end of the calculation.

This calculation type (requirement) is defined in the Family Allowances Guidelines: Para. 511 of FamZWL.
Family allowances compensation funds do not necessarily need to adhere to this requirement.

Example WITHOUT day-specific rounding:
Monthly family allowance | CHF 230.00
Term of employment | July 1–15, 2016
Calculation | CHF 230 / 30 days x 15 = CHF 115.00

Example WITH day-specific rounding:
Monthly family allowance | CHF 230.00
Term of employment | July 1–15, 2016,
CHF 230.00 / 30 days = CHF 7.667 -> with day-specific rounding results in CHF 7.70/day
= 15 days at CHF 7.70 = CHF 115.50

We now offer both types of calculation.

The definition can be set up per FAK canton in the payroll master data. The assignment is made in the “Type
of child allowance rounding” column:

- monthly (default) = rounding done per month and not per day
- daily (new) = rounding done precisely per day

If, in case of employment forms during the month, you have not noticed any difference in the FAK fund
calculation, you do not need to do anything.

6.1.3.5.2    Payroll Setup | Personnel Master Data History Always Written

Task #7620 | 5050.200

An activation option for the History personnel Payroll Setup was present in the Payroll Setup -> tab Setup
means. Since this History is enabled by all customers and we recommend this as well, the activation option
(check mark) has been removed from the settings. For customers that have previously waived the journaling
option, the entries are now being written.

6.1.3.5.3    General | DTA Relevant Fields Relocated

Task #7780 | 5051.000

The three fields in the payroll setup -> tab ‘General’

- Calculation Payment date
- Payment Days
- Block with DTA file

were moved up.
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6.1.3.5.4    Paycheck | Subtotals Can Be Hidden in the RTC Payslip

Task #7762 | 5051.000

Hiding of subtotals in paycheck now works in all NAV versions.

6.1.3.5.5    Tab 'BVG'

6.1.3.5.5.1   BVG fictitious monthly rouding of Contributions

Task #7384 | 5050.100

You can find a new selection field "Fictitious BVG Monthly Rounding" in the Payroll master data. Owing to this
new field, fictitious annual BVG wage may be rounded, so that the monthly BVG deduction is calculated the
same each month.

Example with monthly wage | CHF 5'000.00
Monthly wage of CHF 5'000.00 results in a BVG annual wage of CHF 65'000.00 (incl. 13th Payday). The
calculated monthly BVG wage amounts to CHF 5'416.66666/month (unrounded). Without the new rounding
function the amount was always calculated over the whole year. This means that the BVG wage amount of
CHF 5'416.65 was calculated both in January and in February. In March, however, it was balanced every year
at CHF 5'416.70, etc.

With the new "Fictitious BVG Monthly Rounding" feature, you can prevent this from happening. The annual
BVG wage is calculated depending on the selection as follows:
q 'blank' | Calculation as before | CHF 65'000.00 = CHF 5'416.66666
q Nearest | CHF 64'999.80 = CHF 5'416.65
q Up | CHF 65'000.40 = CHF 5'416.70
q Down | CHF 64'999.80 = CHF 5'416.65

The monthly amount thus remains the same every month, but, as you can see in the example, there is a slight
deviation to CHF 65'000.00.

NOTE
Please note that this setting in the "BVG fictitious monthly rounding" field in the BVG tab should be provided
only as of January 1 of the New Year. The fictitious annual BVG wage is activated or written as usual via the
'Activate Raise Salary' report. As described in the example, the wage amount of 65'000.00 CHF is adjusted to
CHF 64'999.80, even if no pay rise has taken place.

6.1.3.5.5.2   Pay Rise as of January 1 | Annual BVG Wage Fictitiously Calculated Even at Zero Rounding

Task #7430 | 5050.100

If there is a wage adjustment without annual BVG wage adjustment in the current year, it will be included in the
future at a pay raise as of January 1 of the following year (also in case of zero rounding). It is in this way
guaranteed the defined pay rise in the following year from proper consideration during the year.
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6.1.3.5.5.3   BVG Calculation on the Hourly Wage Base

Task #7253 | 5050.100

In rare cases, BVG limit amounts (lower/upper limit, minimum wage and coordination) are not to be calculated
based on monthly limits, but on an hourly basis for hourly wage. For this purpose, the BVG settings have been
expanded and revised as follows:

q New field "Hourly Calculation / Hours per Year" | Input field for hours per year
q Panning of the "BVG Calculation Mode" field on the line | Parameterization per insurance solution made

possible (not overall)

The calculation type is only provided for the "effective" calculation (fictitious annual salary calculation is not
taken into account). The value for an employee in the BVG tab of the Personnel card must be set to "actual".
Thus, the accounted salary types with check marks set in the "Subject to BVG" and time types assigned are
taken into account. This way, we additionally recognize the hourly wage types that are to be considered.

Salary type = Subject to BVG + Available time type | Wage type is taken into account for the calculation of
BVG limits 

Example with 2'193.33 hours a year
Upper limit | CHF 84'600 / 2,193.33 = Hourly basis upper limit | CHF 38.57
Lower limit | CHF 84'600 / 2,193.33 = Hourly basis lower limit | CHF 9.64
etc.

This means that an employee with an hourly wage < CHF 9.64 is not considered in the BVG.

With this calculation type no compensation could be partly contributed over the year. For this reason, the
existing field "BVG Calculation Mode" has now been transferred to the line and can be flexibly re-defined for
each calculation.

6.1.3.5.5.4   BVG Maximum Percent by Position | Turned into Selection Field

Task 7379 | 5050.100

The old field "Maximum Percent by Position" is now a selection box. You can use the following options:

q 'blank' | As before, the upper limit is not reduced based on percent by position
q Upper Limit Base | As before, the upper limit is reduced based on percent by position
q Coordinated Base | New = The upper limit is taken into account based on the coordination limit. Thus, the

maximum BVG upper limit is always the same in relation to the coordination even for employees with
percent by position (when the maximum wage is exceeded) 
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6.1.3.6    Payroll Log

6.1.3.6.1    Reporting

6.1.3.6.1.1   Wage Rate Taken into Account Based on the Change in the TimeMachine

Task #7110 / #7257 | 5050.100

If the wage rate of an employee is changed in tab 'Salary' of the Employee card via TimeMachine during the
month, it now also affects the entries in Report journal/TapBoard.

Example
The wage rate is increased via TimeMachine from CHF 33.40 to CHF 36.70 as of 'Valid from' date May 10,
2016. If an hourly salary type is recorded in the Report journal or TapBoard with document date May 9, 2016,
then the previous wage rate of CHF 33.40 will be retrieved. If the document date is May 10, 2016 or later, the
new wage rate of CHF 36.70 will be applied automatically.

If the document date is empty, the working date is used to take the correct wage rate into account. The same

also applies to the wage items. There, the 'Valid until' date is crucial and/or also corresponds, on the other

hand, to the working date if no date is set.

6.1.3.6.1.2   TapBoard | Launching the Correct Report Journal

Task #7261 | 5050.100

The Management Rapport Journal can be directly accessed from the TapBoard via the Ribbon. The Report
journal assigned to the employee in the EasyRapport Group will open automatically. Therefore, the correct
Report journal is always opened.

6.1.3.6.1.3   Plausibility Check | Daily our Monthly Check

Task #7437 | 5050.100

You can now select for the "Plausibility check" report in the Management Rapport Journal to check the limits
for each salary type daily or monthly. To do this, use a new field 'Plausibility period' in Salary type -> tab
'Plausibility' with the following options:

q Day
q Month

6.1.3.6.2    Post Payroll

6.1.3.6.2.1   Accounting Details | Additional Information in Factbox

Task #7306 | 5050.100

In addition to the number of employees invoiced, extra accounting details per pay process appear in the
Factbox:

q Number of recruitment's
q Number of resignations
q Number of back payments



Seite 292

6.1.3.6.2.2   Project Items | Document Date and Detailed Text

Task #7043 | 5050.100

When the wage is posted to the project items, each record is now transferred individually with "Document
date" and, additionally, with the corresponding wage item text. Up until now, the text was delivered with
"Collective Wage Posting".

NOTE:
The text will be transferred only during definitive wage posting, and not during the provisional project items
transfer. The reason is that when provisional project items are deleted, each of them is additionally filtered by
the text "Collective Wage Posting" (for security reasons).

The corresponding settings can be found in Payroll master data, tab 'Settings', field 'Transfer in project'.

6.1.3.7    Salary Declaration

6.1.3.7.1    Year-end Statements Filtered Using the Recorded Values

Task #4487 | 5050.200

The following evaluations are now filtered using the recorded values (previously filtered by current values):

- AHV Summary | (SwS AHV Summary)
- AHV Free Summary | (SwS AHV Free Summary)
- UVG Summary | (SwS UVG Summary) 
- UVG Additional Summary | (SwS UVG Add. Summary)
- BVG Summary | (SwS BVG Summary)
- HI Summary | (SwS HI Summary)
- FAK Summary | (FAK Summary)
- Social Unit Summary | (SwS Social Unit Summary)

Example:
Mrs. M. was at the workplace in Zurich on December 31, 2015, and at the workplace in Luzern beginning from
January 2016. If the assessment of social security was filtered for 2015 in February 2016 using the “Lucerne”
workplace filter, Mrs. M. would appear on the list, even though she was still employed in Zurich on December
31, 2015. The filter now applies to the recorded values valid at the time of wage payment.

6.1.3.7.2    Salary Certificate | Field Service Share | Distinguishing Between Federal and Cantona

Task #7608 | 5050.200

In PreUpdate 5050.100, we have outlined the first portion of information on Salary Certificate in the “FABI
Implementation” area. We have incorporated the latest findings in PreUpdate 5050.200 (also see information on
our website http://www.swisssalary.ch under “News” and “Blog”).
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If you entered the number of field service days (half-days) using a special salary type (the wage type must be
necessarily assigned to the wage statement item 15. Comments), these days will be automatically recorded
as a percentage and displayed in Paragraph 15 of the wage statement as follows:

Example: cantonal and federal authorities consider a different number of working days per year:

Example: cantonal and federal authorities consider the same number of working days per year:
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6.1.3.7.3    Salary Certificate | Field Service Share | Acquiring Days in the Amount Field

Task #7604 | 5050.200

When field service days are entered in the “Amount” field using the “Field Service” salary type (cf. PreUpdate
5050.100 manual), they will also appear on all other evaluations (e.g., Empoyee Salary Statement A4P), for
which the amounts are assessed.

To avoid this, we have made a relevant improvement, so that the Number field can also be used for the “Field
Service” print proofs. You can change the entry from “Number” to “Amount” during the year as well. The two
fields are cumulated for “Field Service” share calculation.

6.1.3.7.4    Salary Certificate | Employee's Individual Comments

Task #7571 | 5050.200

Additional comments (paragraph 15) for the Salary Certificate (column “Comment Text” and “Comment Text
2”) can be recorded in the employee’s Employee Card (Wage Tax Declaration). These comments were written
at the moment of creation of the Salary Certificate. If they were changed later, the wage statement could not
be created in state “Original”.

The comments are now written into the “Payroll head” table with each pay process. It is ensured this way that
the Salary Certificate is always created with comments valid at the moment. Please note that the comments of
the last pay process will be considered in December

6.1.3.7.5    Income Tax Statements

Task #7197 | 5050.001

At the request of some customers, income tax evaluations are now included into the Ribbon in the 'Wage
Reporting' report (formerly 'Year-end Reports'). Therefore, all evaluations that can be submitted via ELM, are
available in 'Salary Declaration'.

6.1.3.7.6    Social Unit | Headers Missing On Subsequent Pages

Task #7250 | 5050.100

A header with the details on insurance was missing from the following pages in the annual evaluation for social
funds (FAR, Parifonds, MDK/MEK, etc.).

The report has been corrected.

6.1.3.7.7    ELM | Marriage Date 0001-01-01 During IT ELM Submission

Task #7375 | 5050.100
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In older NAV 2013 R2 builds, an empty marriage date with the value “0001-01-01” was written in the XML file
and then submitted during  ELM submission instead of being ignored. For some IT offices, these reports led to
error messages.

We have already published a hotfix for NAV 2013 R2 for version N5050.000, and beginning from PreUpdate
5050.100 this problem is solved.

6.1.3.7.8    ELM | XML File Misspelled When a IT Canton Exclusively Receives Corrections

Task #7736 | 5050.200

There was a problem in the correction month while sending the XML file in case of retroactive IT corrections
(change of canton). The challenge was that while the new canton with positive corrections was written to the
file, the existing respective canton with negative corrections could not be correctly determined.

This error has been corrected, the XML file is created correctly.

6.1.3.7.9    ELM | IT ELM Error Message in Case of Clean Additional Pay Processes

Task #7294 | 5050.100

If an employee has only one additional pay process in a month and no major pay process, the month is not
correctly reported during IT ELM submission. This could lead to weird errors, especially if the employee only
had additional pay processes in all months of the reporting year (invalid XML file) or even all employees only
had additional pay processes.

From now on, to determine the reporting period (months to be reported) not only major but also additional pay
processes are counted (not down-payment and/or closure pay.

6.1.3.7.10    ELM | Validation Error When TimeMachine Entries Created in Version 5050.000

Task #7163 | 5050.100

ELM Transmitter stopped working during IT ELM submission with a “red” error message. Our analysis has
shown that TimeMachine entries created using version 5050.000 could not be written and submitted correctly.

A hotfix has been created then for version 5050.000 shortly after its release. This error was removed in
PreUpdate 5050.100.

6.1.3.7.11    ELM | Text Overflow During IT Rate Reporting for the Canton of VD

Task #7942 | 5051.000

Since September 2016, many of our customers have been receiving a "text overflow" error message when
fetching IT results of the Canton of VD. The Canton of VD is now the first canton to provide also a time zone
(e.g., “2016-09+01:00”) in a time period (e.g. “2016-09”), which has not been previously supported by the
SwissSalary WT import.

Clarifications from swissdec support showed that, according to XML schema definition, time zone inclusion is
legitimate, although uncommon. From now on, responses from the cantons including time zones are imported
correctly.
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For more information on rate reporting (Canton of VD), please visit the following link: http://bit.ly/2e102bs

6.1.3.8    Administration SwissSalary

6.1.3.8.1    Allocation Group | Social Benefits Presets Expanded with the Wage Type Field

Task #7609 | 5050.200

The “Social Benefits Presets” automatically fill many default fields when setting up the Payroll Area in the
Employee Card. In addition to the “Salary code” field, “Salary Type No.” can be predefined now (usually ST
1100). The wage type needs to be registered in the Employee card only for the monthly wage. In case of hourly
wage, the “Salary type” field remains empty.

6.1.3.8.2    Allocation Group | Display for Balances | Payroll and EasyRapport are Separate

Task #6533 | 5050.000

From now on, the payroll area settings for printing balances in Paycheck and EasyRapport are separate.
Thereby, you can choose balances to be displayed on the Paycheck or in the Employee Info in EasyRapport.

6.1.3.8.3    Allocation Group | Tab Labels Revised

Task #7264 | 5050.100

Two tabs under "Payroll Area" were unlabeled

q Print -> new: Printing of payslip
q EasyRapport -> new: EasyRapport Display

6.1.3.8.4    DTA/EZAG Setup | Now Under Administration

Task #7197 | 5050.001

DTA/EZAG master data is now located in the "Administration" section (previously in the Ribbon of the Role
Center home page).

6.1.3.8.5    RTC-Versions | SmartPort can be Opened Now via Departments

Task #7248 | 5050.100

Previously, SmartPort could be started only via our SwissSalary Role Center. From now on, those not using
the default Role Center can also open it via "Departments".

http://bit.ly/2e102bs
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6.1.3.8.6    Automatic Execution of EasyRapport Transfer After Post Payroll

Task #7263 | N5050.100

Once a pay process is posted, the actually billed data must be transferred to EasyRapport to synchronize
SwissSalary and EasyRapport. Up until now, EasyRapport transfer had to be launched manually.

From now on, automatic EasyRapport transfer can be activated in 'EasyRapport/TapBoard' settings as soon as
the wage was posted.

6.1.3.8.7    EasyRapport/TapBoard | Rapport Types | Extended Option "hide"

Task #7117 / #7320 | 5050.100

The "hide" column was extended with the "TapBoard" option. This means that you can specify in report types
whether certain rows in EasyRapport or now also in TapBoard are to be hidden.

Example:
You want to have several types of sick pay (80%, 90% and 100%) in TapBoard. However, the employee is only
to see a single line "Illness" in EasyRapport, which, for example, has 80% configured in the row. Using the
"hide" option, you can now suppress individual rows in TapBoard that are, for example, to be displayed in
EasyRapport only.

In addition, the same wage type numbers like in another line under "salary type" are entered in the "Conversion
salary types 1 and 2".

6.1.3.8.8    EasyRapport/TapBoard | Report Types | Salary Type Check and ‘hide’ Taken into Account

Task #7789 | 5051.000

Salary type assignment to report types is currently used to check if the salary type has already been used in
another row. This check also works when a conversion salary type is entered second. If, however, the
conversion salary type is entered first and then the salary type is used again in another row, no message will
be displayed. In addition, no message will be displayed even if the same conversion salary type is entered
twice.

The check is carried out again to verify if the same salary type has already been used. This check is very
important since only one instance of the same wage type is allowed in EasyRapport/TapBoard.

Task #7790 | 5051.000
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There is a check in report types to verify if the salary type has already been used in a report type.

The check was extended to additionally use the ‘hide’ box for the wage type check. This makes the
EasyRapport view and the TapBoard view even more sophisticated. The same salary type, Conversion
Salary Type 1 or Conversion Salary Type 2 should be assigned if the corresponding report types differ in
the ‘hide’ field.

This also means that the check only takes place when you leave the report row or close the page.

6.1.3.9    Reports

6.1.3.9.1    Paycheck

6.1.3.9.1.1   Paycheck with SwissSalary Direct | Placeholder %8 for URL

Task #6943 | 5050.100

In addition to the existing placeholder "%7" for individual SwissSalary Direct registration codes, there is a new
placeholder "%8" for URLs, e.g. https://musterfirma.swisssalarydirect.ch. Therefore, you can use the following
placeholders in the text block for registration:

Sample Text
Your registration code is %7. You can register at %8 using this code.

6.1.3.9.1.2   Paycheck | Second On-account Payment Not Displayed On Paycheck

Task #7653 | 5050.200 & Task #7771 | 5051.000

This correction concerns the customers with the RTC Client beginning from NAV 2009 SP1 exclusively!

If an additional on-account payment is made within the same accounting period (rarely), only one detailed on-
account payment appears on the payslip. The payment amount was always calculated correctly; it was only a
problem of display on the paycheck. Both on-account payments were displayed in wage items at any time.

The payslip has been revised and now correctly shows multiple on-account payments within the same
accounting period.

6.1.3.9.1.3   Paycheck | In Case of 2 ESR Banks Only 1 ESR Payment is Taken into Account

Task #7434 | 5050.200

This correction concerns the customers with the RTC Client beginning from NAV 2009 SP1 exclusively!

If two ESR banks with the same reference number were stored in Personnel Bank (different maximum
amounts), only the first ESR bank was taken in the payslip into account.

The problem has been solved.

6.1.3.9.1.4   Paycheck | Classic Client | Displaying the Number of Employees per Pay Process

Task #6914 | 5050.100

Valuable information on pay process is displayed in factboxes in modern RTC clients (number of employees
settled, etc.).
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This information can also be found now in the old Classic Client. When you launch the payslip, you can use
the lookup field “Payroll No.” to open the pay process list. The “Employee No.” column shows the
corresponding employees settled in each pay process.

6.1.3.9.2    Attestation of Employer ALV | Also without Date of Resignation (2)

Task #7405 | 5050.100

Both 'Attestation of Employer ALV' and 'International ALV Employer Certificate' can also be executed without
the date of resignation.

6.1.3.9.3    Attestation of Employeur ALV | Para 20: Pension Fund Name

Task #5880 | 5050.200

From now on, the name from the BVG contract contact address is indicated in Paragraph 20 (BVG fund) of the
Attestation of Employeur ALV (Swiss, not international certificates) provided that the Marketing and Sales
module - Contacts is licensed. Up until now, the description, and not the “BVG Fund Address”, had been
transferred from the “Insurance Contract”.

6.1.3.9.4    Intermediate certificate of profit ALV | Holiday Pay for Monthly Wages Produces False Wages

Task #7499 | 5050.200 

In addition to holidays in days/hours, a holiday pay percentage (rarely used) can be registered for an employee
per month wage in the Refunding of Absences. If this was the case, a wrong hourly wage rate and, therefore,
an incorrect gross wage was calculated by mistake and included in the Temporary Employment Certificate.

This miscalculation has been corrected.

6.1.3.9.5    SBV Earnings Survey | Report is Now in BAU (NAV 2015)

Task #7589 | 5051.000

The SBV Earnings Survey report was previously included in the Classic version of SwissSalary BAU. The
report is now also available in SwissSalary BAU (NAV 2015). It can be directly called in SwissSalary Role
Center -> Report -> tab ‘Statistics’.

In addition, the ISO country code mapping has been revised, since the Swiss Contractors' Association (SBV)
unfortunately uses its own obsolete country codes.

6.1.3.9.6    History | TimeMachine Entries Considered

Task #7623 | 5050.200

Various data fields can be changed on the timeline via TimeMachine (e.g., wages, IT fields, etc.). These entries
are not incorporated in the History table and, therefore, have no log entries generated.

The entries are now included in the History table.

6.1.3.9.7    Short message and Accompanying Letter | Full Name

Task #6223 | 5050.100
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Up until now, the name of the staff member was displayed on the short message and accompanying lettter
along with the company name and employee abbreviation. From now on, the full name (first/last name) is
retrieved from the SwissSalary user table.

6.1.3.9.8    General Ledger Log | Excel Export with Period Specified

Task #7722 | 5050.200

Excel export of General Ledger Log has been slightly adjusted. The posting period is now also placed in the
first column.

6.1.3.9.9    Employment Statistics | New Profiling File per Employee

Task #7930 | 5051.000

The Federal Statistical Office (BfS) has revised the file for Profiling. Until today, the file had been issued per
workplace. From now on, each employee is listed individually.

IMPORTANT INFORMATION
The profiling is to be used by larger customers with at least 10 different workplaces. The rest of the customers
should continue to use the report and manual input on the Internet.

6.1.3.9.10    Employee Salary Statement A4L Personal Wage Account Adjusted

Task #2860 | 5050.200

The Excel export of Personal wage account A4Q has been completely redesigned, so that both reports and
PivotTable could be easily created. From now on, the following additionally appears per Excel row:

- Employee No.
- Last name
- First name
- Employment Date
- Resignation Date

6.1.3.9.11    Employee Salary Statement A4L | Can be Accessed in Pay Process

Task #7103 | 5050.100

'Employee Salary Statement A4L' can be accessed now in RTC versions from the ribbon via Pay process ->
Reports.

6.1.3.9.12    HI / UVG / UVG Additional Summary | Insurer Name Displayed

Task #7535 | 5050.200

The name of the insurer was incorrectly (top right) printed on the KTG/UVG and UVGZ Accounting, if it was a
little longer than usual.
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The report output has been corrected.

6.1.3.9.13    Salary Type List A4P and A4L Expanded with Quantity

Task #7369 | 5050.100

Salary types used for reporting of e.g. number or kilometers or number of lunch allowances, could not be
evaluated with quantity. Now, the "Quantity" selection provides the expected result.

6.1.3.9.14    Payroll Setup | Field ‘AHV Administrative Costs'

Task #6467 | 5050.200

This correction concerns the customers with the RTC Client beginning from NAV 2009 SP1 exclusively!

“AHV Administrative Costs” did not appear in the 'Payroll master data' report (SwS Payroll Setup). This has
been corrected in all RTC versions.

6.1.3.9.15    Rate Fluctuation | Report Revised

Task #7351 | 5050.200

Totalizing has been revised in the Rate Fluctuation report.

Example:
An employee gets hired by a company on January 1, 2016. The report is filtered via date filter by January 1,
2016 – January 31, 2016. The employee was already in the “Opening Balance” and was also defined as
“Entry” at the same time.

The report has been corrected in a way that these employees are neither summed as an entry, nor summed in
the opening balance. In addition, the size of the columns has been optimized.

6.1.3.9.16    Salary Summery Holding | New 'Canton' Column

Task #6871 | 5050.100

The "Salary Summery Holding" report (wage sum by tax municipality) contains abbreviations of cantons in
recapitulation as an additional column after tax municipality.

6.1.3.9.17    GastroSocial Interface Extended

Task #7813 | 5051.000

In addition to the existing quarterly report (monthly items), an annual report can also be created. This
means that one item a year is created per employee, unless the employee had a break. You can define in the
Options whether you want to create quarterly reports (default) or annual reports (with wage amount
adjustment).

6.1.3.9.18    Plausibility Check | Report Revised Completely

Task #7538 | 5050.200

The Plausibility Check assessment in the Report journal has been completely revised. Sorting was particularly
random in RTC versions. The entries are now sorted correctly by employee, wage type and day.
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6.1.3.9.19    LOGIB Version 3.0

Task #7928 | 5051.000

Logib V3.0 is now available. The export is built into reports statistics or also in the role center.

6.1.3.10    Bug fixes

6.1.3.10.1    Various Reports Revised

Minor adjustments not mentioned in detail have been made to each report. Here is a list of tasks implemented
with their brief description:

Task #7403 | 5050.100
Underemployment-/ Bad weather | Number of employees in all RTC versions corrected

Task #7313 | 5050.100
Lists for Cash Payments | Header in RTC versions were not equal with respect to Classic versions, unless a
cash wages was available.

Task #7352 | 5050.100
Typo in item 12 of the ALV Employer Certificate was corrected.

Task #6845 | 5050.100
Workgroups can be printed now and the calendar is printed on a single page (without page breaks) during
Excel export of the working time calendar.

Task #7353 | 5050.100
The account sheet could not be executed if a wage translation was longer than 40 characters.

Task #7285 | 5050.100
Fields "Time from" and "Time until" could not be recognized during Excel import into Report journal.

Task #7286 | 5050.100
Report "Social Fund Accounting" was revised. All columns are now displayed correctly and fully.

Task #7268 | 5050.100
In RTC versions, the 'Employment period from/to' column in the "CC UVG Accounting" report has been
adjusted. The columns were too narrow, that is why the date was not printed correctly.

Task #5757 | 5050.100
The 'Test billing' can be launched from the Personnel card or Personnel list by pressing Ctrl+T. It sometimes
caused errors in RTC versions.

Task #6745 | 5050.100
The from/to date included wrong delimiters during plausibility report.

Task #7303 | 5050.100
The 'AHV-exempt wages' report sometimes showed persons with no movement in the current year. It has been
corrected and improved. 

Task #7233 | 5050.100
The 'salary type list assignment' did not consider the salary type filter.

Task #6573 | 5050.100
Evaluations 'Internal Re-invoicing' and 'Hourly Accumulation' have been revised and improved.
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Task #7377 | 5050.100
Absence Quotas | If an employee was sick for several weeks, the weekends were interpreted as interruption of
the sick period. From now on, a sick period is no longer interrupted by weekends.

Task #7242 | 5050.100
The 'Reporting via Excel' function had an error message "The value "01.01.16 00:00:00" cannot be evaluated in
the Date type". This import error appeared because of the "00:00:00" value and is now corrected. If there is the
value "00:00:00" during import, it is deleted and validated afterwards.

Task #7890 | 5051.000
Depending on the item in the ‘Staff List’ report, the amount in the ‘Wage Rate Value’ field either did not print at
all or the separators were missing. This has been corrected in Update 5051.000. In addition, the display was
optimized to now display everything “fixed and with right alignment”.

Task #7772 | 5051.000
The ‘Last/First Name’ column in the ‘Social Fund Accounting’ report was too short. It is longer now

Task #7691 | 5051.000
Another balancing error was discovered in ‘Bank Statement’. The balance of the previous person was always
transferred to the next person.
The balancing is now displayed per person correctly, and there is no overlapping anymore.

Task #7872 | 5051.000
Some fields from the ‘ER’ tab (EasyRapport) were missing in the RTC report in the ‘Personnel Wage
File’ (report 3009075). They have been complemented.

6.1.3.10.2    Copy Employee | Error in Case of Client Names with “(”

Task #7721 | 5050.200

The “Copy Employee” function returned an error message if a client name (target client) contained brackets,
e.g. “CRONUS (Switzerland) AG”.

This error was corrected. 

6.1.3.10.3    Personnel History with Error Message in Case of Multiple Changes

Task 7252 | 5050.100

If multiple changes were made within seconds in the Personnel card using batch processing, the following error
message would appear: "Personnel Master Data history already exists".

6.1.3.10.4    Alternative Address | Error Message

Task #7875 | 5051.000

When an alternative address abroad was entered, an error message would appear by mistake, because the
country code could not be assigned.

6.1.3.10.5    Years of Service Calculation | Evaluation and Calculation (Leap Year) Validated and Corrected

Task #7316, Task #7690 & Task #7729 | 5050.200
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At the beginning of 2016, the inquiries regarding the calculation of years of service “pro rata” and the
designation in the Jubilee List have been quite regular. We have found in the analysis that both calculation and
presentation in the assessment sometimes shifted in the leap year. There were some jubilants shown in the
assessment one day earlier or later. Date calculation in the year of service table has also been validated. Most
of the cases with the customer we have analyzed were not due to this irregularity. They resulted from incorrect
entries or manual inputs of previous years of service.

We have dedicated a lot of time in the past few weeks and months to the calculation of years of service and
many cases and assessed many cases and special cases. We are confident that most of the cases have
been covered properly. If you still notice deviations after applying PreUpdate 5050.200, please let us know so
that we could analyze them well and correct for the future.

6.1.3.10.6    Zero Division of the Income Tax Calculation in Case of Recruitment On Day 31 of the Month

Task #7817 | 5051.000

In case of recruitment on day 31 of the month, the income tax could not be calculated (zero division). After a
telephone consultation with the withholding tax office of the Canton of Lucerne, one day is to be calculated if a
wage has been paid out for this month.

6.1.3.10.7    Salary declaration ELM | Improvements (2)

Task #7317 | 5050.100

In case of IT Declaration via ELM the replies from income tax offices are sent back in English and displayed to
the user in English. The responses now appear in the user's language.

Task #7318 | 5050.100

This led to the situation when the same text (office reference texts) was presented several times (several
responses were received for repeated "Get status" requests, each with the same text).

6.1.3.10.8    Salary Certificate without Gross Wage, but with Flatrate Expenses

Task #7217 / #7270 | 5050.100

If an employee is paid no gross wage during a calendar year, only flatrate expenses instead, the following error
message would appear when the wage statement was printed: "File xxx does not exist". This is due to the fact
that 2D barcode cannot be created without gross wage.

From now on, the correct wage statement is created and can be submitted via ELM. Even empty wage
statements may be issued provided that there is an approved expense regulation.

6.1.3.10.9    Salary Certificate | Windows Access Control with 2D Barcode

Task #4182 | 5050.200

When opening wage statement using a 2D barcode, AD (active directory) WindowsUser verification could take
a long time and in some cases resulted in the NAV Client crash.

This has been fixed with an option to store the user's name directly (column Custom User Name) via
Administration SwissSalary -> User (SwissSalary User table).
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6.1.3.10.10    TimeMachine | Change of Percents by Position During the Month

Task #7122 / #7123 | 5050.100

If there was a change of percents by position via TimeMachine during the month, for example, from 90% to
100% on May 15, 2016, the reduction would be calculated until May 15 instead of May 14. Therefore, one day
was overcharged. 

6.1.3.10.11    TimeMachine | Text in Multiple Languages

Task #7155 | 5050.100

The text of corrections in the payslip during wage adjustments via TimeMachine was always printed in
German. From now on, the text is translated into the language of the employee indicated in the Personnel card
(language code). As usual, the translation is made in the wage type directly.

6.1.3.10.12    Balances in Personnel File Do Not Show

Task #7932 | 5051.000

If the personnel file was opened via Employee Card | Reports | Personnel File, the balances of holidays and
overtime were not displayed.

This has been fixed. The balances were always displayed on the PIS sheet in Human Resources.

6.1.3.10.13    Payroll Journal | Notice When an Employee Had Resigned

Task #6942 | 5050.100

Previously, if an employee that had already resigned was recorded in the Report journal data, the following
notice appeared next to each row: "Employee resigned. Register anyway?" that should be confirmed with Yes
or No. This message appears only once per employee.

6.1.3.10.14    Payroll Journal | Too Long Salary Type Translation

Task #7328 | 5050.100

If the custom text of salary type was longer than 50 characters, one line could be recorded in the Report
journal. However, an error message would appear during deletion.
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6.1.3.10.15    Payroll Journal | Cursor Jump within Resulting Salary Types

Task #7031 | 5050.200

This correction concerns the customers with the RTC Client beginning from NAV 2009 SP1 exclusively!

We have received reports from some customers about the cursor not navigating to the next free line
automatically, but remaining with the resulting salary type when working with resulting wage types. We have
applied various adjustments, but discovered different NAV version dependent behaviour.

The intended feature has been temporarily removed again.

6.1.3.10.16    Function Keys in TapBoard

Task #7935 | 5051.000

Both Employee card and Employee list in the TapBoard (RTC versions only) had the same keyboard shortcut
(Shift+F5) by mistake.

The shortcut in the staff card remains the same (Shift+F5), while the staff list can be opened now via Shift+F6.

6.1.3.10.17    ‘Fetch EasyRapport Items’ Function With a New Notice

Task #7583 | 5050.200

Previously, when the ‘Fetch EasyRapport items’ action was executed, an error message together with import
cancellation would appear if no EasyRapport group was assigned to an employee but an import line was
available for the employee concerned. No error appears anymore. Instead, a notice appears at the end of the
process saying that a number of “xxx items” are available for employees with no EasyRapport group assigned.

6.1.3.10.18    Paycheck | IT Deduction, Even If No Time Reported for Hourly Wage Recipients

Task #4539 & Task 5847 | 5050.200

I no cash work or absence hours were accounted for an employee subject to withholding tax in case of hourly
wages, a payslip would still be generated (IT deduction and already deducted IT). This always resulted in CHF
0 which annoyed payroll staff members, because a payslip with CHF 0 would be created.

The same also applies to employees subject to withholding tax in case of monthly wages, if due to time
corrections several pay processes (not relevant to the amount) are accounted for.

This error has been fixed, and no payslip is created anymore.

6.1.3.10.19    Paycheck | Additional Pay Process with CHF 0 Triggers IT Calculation

Task #7230 | 5050.100

Some customers have reported that a new withholding tax calculation was triggered in case of employees
subject to withholding tax with clean additional pay process of CHF 0. I.e., there was a recalculation and
balancing with the same amount occurred. This situation caused no mathematical problems, but was
disturbing, since payslips were generated for nothing.

This error was corrected.



Seite 307

6.1.3.10.20    Paycheck | Wrong First/Last Name On the Next Page

Task #7356 | 5050.200

Sometimes, a false first/last name appeared on the next page of the payslip if an employee changed their
name in the past.

This problem has been solved.

6.1.3.10.21    Paycheck | NAV 2009 | Error If Address Is Set "To the Left”

Task #7137 | 5050.100

Update 5050.000 caused a display problem on the payslip in the NAV 2009 RTC version if the address was set
"to the left”.

This error was corrected in a form of a hotfix.

6.1.3.10.22    Paycheck Email Delivery Without SwissSalary Direct

Task #7605 | 5050.200

Paycheck can also be created as single PDF files without SwissSalary Direct and/or IncaMail and sent without
encryption via email (not recommended). After the last update, an error message would appear by mistake
indicating the launch of SwissSalary Direct, and the export would stop afterwards.

This error was corrected; the error message does not appear anymore.

6.1.3.10.23    SwissSalary Direct Delivery | Error 500 When Sending Certain PDF Files

Task #7859 | 5051.000

When individual documents were sent using SwissSalary Direct, the Error 500 message appeared during the
upload of certain PDF files.

The situation was caused by PDF files that could not be opened (via Acrobat Reader), even if they were not
confidential. The opening failed with certain newer PDF versions (Acrobat Reader). However, this is not a
problem, because the confidential files are only generated by Dynamics NAV, and they can always be opened.

From now on, all files are accepted, regardless of whether they are confidential or not.

6.1.3.10.24    DTA File | Completion Notification Shows Wrong Currency Code

Task #7774 | 5050.200

If the DTA bank was set to EUR in the DTA/EZAG settings, the amount after DTA writing would appear in
completion notification with currency code CHF instead of EUR. This was incorrect and has been rectified. The
DTA file itself was always created correctly, only the completion notification was misleading.

6.1.3.10.25    Post Payroll | Error in Case of Recruitment/Resignation During the Same Month, But Not in the Same
Year

Task #7378 | 5050.200
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An error message appeared during Post Payroll in case of a resignation or recruitment during the same month,
but not in the same year.

Example:
Employees begins their employment at the company on February 27, 2015 and resigns on February 14, 2016.
The following message would appear during wage posting: 
Date up (14.02.16) can't be earlier than the date of (27.02.16)!

In addition, this error occurred only in cases if the date of resignation was “numerically greater” than the date
of recruitment: February 27 > February 14 (leap year issue).

This wage posting error has been solved.

6.1.3.10.26    IT Calculation Error | Salary Types Without Rate Determination with Extrapolation

Task #7663 | 5050.200

A customer of ours reported a withholding tax calculation error. If a salary type is set to be subject to
withholding tax, but the amount is not entered into rate determination, the same salary type cannot be entered
into the Payroll Master Data as a lump sum. This configuration cannot be allowed.

From now on, SwissSalary already verifies during the wage type entry, if an entry is present in the
extrapolation table. The same validation in the other direction is made during the wage type entry into the
extrapolation table.

6.1.3.10.27    Social Unit | Additional Income Limit Taken into Account

Task #2861 | 5050.200

A deduction for an employee would be created during social fund calculation with the “AHV with free Amount”
base, even though the employee was recorded in Social Benefits as an “Additional Income” (CHF 2,300) and
the annual limit of CHF 2,300 was not yet exceeded.

This specific case is now accounted for correctly.

6.1.3.10.28    A4Q Personnel List Statistics | Excel Export with Error Message

Task #7446 | 5050.200

An error message appeared in the Classic Client version when exporting to Excel from within the ‘A4Q
Personnel List Statistics’ report.

This error was corrected.

6.1.3.10.29    Working Time Calendar | Settings | Days/Hours Column Designations

Task #7129 | 5050.100

When a user wanted to add the 'Days or hours' column in the working time calendar in RTC versions, the
following error message would appear: "The "Date" table is write-protected."

6.1.3.10.30    FIBU CC Matrix | Now Always Active

Task #7239 | 5050.100
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Up until now, the FIBU cost center matrix was only taken into account if the FIBU integration was activated in
the payroll master data. Without this integration, the accounts defined in the salary type depending on posting
category were not retrieved.

6.1.3.10.31    SmartPort | Records Not Reported Were Deleted

Task #7649 | 5050.200 (Hotfix 5050.101)

A customer of ours has reported that sometimes data like phone numbers registered in SwissSalary would be
missing after SmartPort synchronization. Our failure analysis has revealed that records not reported by the
external system deleted records in SwissSalary by mistake (synchronization error).

For this reason, a hotfix for version 5050.100 (5050.101) was immediately released.

6.1.3.10.32    BAU | Personnel Dimension | CC Cannot be Recorded

Task #7176 | 5050.100

No personnel dimension could be recorded in the SwissSalary BAU version (only NAV 2015), although CC
dimension could be selected. The error message "CC burden must have a value in 'Personnel Dimension'..."
appeared immediately upon clicking of the dimension value.

6.1.3.10.33    Plausibility Report | Character Number Error

Task #7277 | 5050.200

When the SwS Plausibility Report was executed within reporting, error message “Length of the string” would
appear if the report text comprised more than 40 characters.

This error message does not appear anymore if this report is executed.

6.1.3.10.34    Reporting On Project Items | Sale Price Written to Items

Task #7916 | 5051.000

If expenses are recorded and posted in SwissSalary NAV and/or SwissSalary EasyRapport, the sale price is
not additionally written to the project items automatically.

From now on, the sale price is stored and written to the project items, if there is no other price in Resources ->
Pricing.

6.1.3.10.35    Pay Process | Payroll Number Taken into Filter Correctly

Task #7811 | 5051.000

This correction concerns the customers with the RTC exclusively!

When several reports were called, the last processed pay process would be taken instead of the selected pay
process.

This problem has been completely solved, the report calling has been revised.



Seite 310

6.1.3.11    Notes for our SwissSalary NAV partners

6.1.3.11.1    System Initialization | Extension of Net Wage Compensation

Task #7292 | 5050.100

The following fields have been supplemented in the system initialization file:
q Salary Type Master | Net Pay Correction (Boolean)
q Payroll Setup | Net Pay Correction ST

6.1.3.11.2    BAU | UVG Cost Centers (BUV) Eliminated

Task #7292 | 5050.100

After a detailed clarification with the SUVA, there are no UVG cost centers with increased UVG BUV premium
anymore effective 2016. The UVG cost centers were often required in underground construction since the
employer BUV deduction was higher due to increased risk of accidents compared to normal SUVA UVG
agreement. Employees working in such UVG cost center were thus subjected to a higher BUV employer
deduction.

The fields required for this were removed and adjusted. Only the values of wage items remain. The following
objects have been adjusted:

q Table SwS Employee | Field content deleted
q Table SwS Employee History | Field content deleted
q Form/Page SwS Employee Card | Field removed
q Form/Page SwS Employee History | Field removed
q Form/Page Wage Declaration | Field removed (selection field)
q ELM Submission | Logic removed (starting from PreUpdate 5050.100, no ELM UVG cost centers can be

reported anymore)
q Report Employee | History field removed
q Report Wage Accounting | Logic removed
q Report UVG Accounting | Logic removed
q Report UVG Cost Center | deleted
q All reports for Sunetplus logic and fields were removed

6.1.3.11.3    TimeMachine History | Subpage Deleted by User

Task #6896 | 5050.000

“TimeMachine History” subpage can be deleted by an employee using the default “List – delete” feature.
However, after that the employee will not be able to add the subpage themself.

Solution: To make this subpage visible again, customization made by the corresponding user and the
corresponding page must be deleted.

6.1.3.11.4    SwissSalary Direct | Error Code 1001 Displayed Incorrectly

Task #7549 | 5050.200

If a client is copied, SwissSalary Direct configuration is copied as well. The “1002” error will appear during the
next synchronization indicating that a duplicate “CompanyKey” was recognized. The configuration in the new
client must be deleted and re-entered.
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After this action, synchronization will repeat and the “1001” error code because of a duplicate “EmployeeKey"
will not appear by mistake. These errors messages must necessarily appear not to synchronize the same
employees in Test Clients by mistake.

The error has been corrected, the error messages appear as intended.

6.1.3.11.5    SwissSalary Module S | Integrated into License Verification

Task #7188 | 5050.100

The new SwissSalary "S" module (Basic or Plus) for 1 - 15 active wage earners is now verified correctly in the
license. I.e., if 16 employees are to be accounted for after N5050.100, an error message appears.

Solution: Upgrade to SwissSalary 1 - 30

6.1.3.11.6    SwissSalary User with GetUserName

Task 7025 | 5050.100

A new field "Custom User Name" was added to table "SwS User SwissSalary" (Table 3009102). By default,
the field is set to visible = 'False'. The "GivenName" is returned instead of User Login.

6.1.3.11.7    swissdec Code Unit | Converted from COM to .NET Components

Task #7009 & Task #7395 | 5050.100

swissdec Code unit requires many COM components that beginning from NAV-2013 do not work on the server
side anymore. So, for example, no ELM submissions can be carried out via the Web Client or SwissSalary
365. In addition, there massive performance problems appear, especially within environments like SwissSalary
365, when COM components are executed on the client side.

XML files are created and XML responses are now completely parsed in all RTC versions on the server side. In
addition, .NET components are exclusively used beginning from NAV 2013.

Important
Since the XML is created now on the server side, the 2-D barcode image is also created on the server side
when the wage statement is printed. This brings about a massive increase in performance. This means,
however, that Barcode.dll is also installed on the NAV Server (Middle Tier). It is especially relevant for the NAV
2009 RTC version, since the DLLs cannot be deployed there as comfortably. This does NOT apply to the old
Classic Client installations, because DLLs may still be installed on the Client.

If company-specific Reports (Sunet and UKA interfaces) requiring COM components are created for the
customer, they must be updated if need be.

In addition, if the 64bit version of the NAV 2016 client is launched, there is no error message after 5050.100
update when creating a 2D barcode in the wage statement.

6.1.3.11.8    SwissSalary Store | Lock Updates When SwissSalary Version is Outdated

Task #7254 | 5050.100

All available updates for ZIP, bank master data, etc. of each SwissSalary version are available in SwissSalary
Store. However, a withholding tax tariff file cannot be imported sometimes via SwissSalary Store, if the actual
SwissSalary version is “outdated”. The customer will see a message that they need to update SwissSalary
first.
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This message is an indication and a guarantee that data having possible dependencies to a version will not be
installed. In this example it might be that we need to deliver a new WT tariff file containing fields available only
with a certain SwissSalary version. If you are not sure whether you can import an update or not, please contact
our Support.

We recommend to keep using SwissSalary Standard, if possible, and keep its version updated. This applies in
particular to the version of SwissSalary.

6.1.3.11.9    SmartPort | Placing BLOB Field

The new SmartPort can also be populated with a “BLOB” field. For this purpose, the following procedure (tip) is
recommended:

1. Create variable ‘TempBlob’, e.g.:

2. Populate variable ‘TempBlob’ BLOB with XML, e.g:

pTempBlob.Blob.CREATEOUTSTREAM(OutStream);
SmartPortDoc.Save(OutStream);

3. Place variable ‘TempBlob’ as a parameter for the ‘ImportChanges’ function, e.g.:

SmartPortMgt.ImportChanges(TempBlob);

6.1.3.11.10    Error Message During ZIP Code Loading (missing LI entry)

Task #7627 | 5050.200

The “LI” entry for the Principality of Liechtenstein is missing in the Dynamics NAV countries table. When
importing our ZIP code file, the error appears reporting that the LI state does not exist. The ZIP code file can be
imported without any error after the acquisition of this state in the country table.

We have extended now the ZIP code import, so that it checks first whether the LI state exists. If not, it is
created automatically during ZIP code file import.

6.1.3.11.11    Revision of Fields | Deleted and Obsolete Fields

Deleted Fields: 
(The following fields have been deleted from PreUpdate 5050.101 or marked as “Obsolete”:)

Table 'SwS Payroll Setup' (NAV5 only) 
"Rapport Archive" // DELETED Field 65 
"Paycheck Archive" // DELETED Field 66 
"Salary Certificate Archive" // DELETED Field 67 
"Archive" // DELETED Field 68 
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Table 'SwS County' 
"IT Return Account" // DELETED Field 1000 

Table 'SwS Income Tax County' 
"WT Entitlement Provision" // DELETED Field 11 

Table 'SwS Salary Type' 
"One-liner for additional text" // DELETED Field 60 
"Additional Text on Statement" // DELETED Field 61 

Table 'SwS DMS Setup' 
"Archive" // DELETED Field 5 

Table 'SwS Organization' 
"Ordered Key (Obsolete)" // DELETED Field 10 
"Test Key (Obsolete)" // DELETED Field 11 

Fields marked as "obsolete": 
(can only be definitively deleted after Update 5051.000 | October 2016!) 

Table 'SwS Payroll Setup' 
"BVG Calculation Mode" // Marked as OBSOLETE Field 647 
“BVG Franking" // Marked as OBSOLETE Field 88 

Table 'SwS Pension Setup' 
"Upper Limit Employment % OLD" // Marked as OBSOLETE Field 50 

Table 'SwS Allocated Salary' 
"Fixed/Variable" // Marked as OBSOLETE Field 9 

Table 'SwS Employee' 
"UVG Cost Centre" // Marked as OBSOLETE Field 131 
"Salutation" // Marked as OBSOLETE Field 212 

Table 'SwS Employee History' 
"UVG Cost Centre" // Marked as OBSOLETE Field 131 
"Salutation" // Marked as OBSOLETE Field 212 

6.2    Update 5051.000 Systemadmin

6.2.1    SwissSalary Homepage | Update-Download

6.2.1.1    Instructions (2)

How you can enter the customer area of SwissSalary?

Link http://www.swisssalary.ch will take you to our website. Click Log In in the upper right corner: 

Log in using your company specific login data. Afterwards press the button Update NAV (SwissSalary NAV
customers) or Update BAU (SwissSalary BAU customers).

http://www.swisssalary.ch
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This will allow you to download the most current Updates and PreUpdates. If you click on the respective PDF
and/or ZIP icon, you will download the objects and documents.

What additional documents can be downloaded?

In addition to the latest Updates you can download and install the most current PreUpdates in SwissSalary, so
that you are always up to date (recommended).

The library of the latest manuals and other information for SwissSalary will be renewed and extended.

How a file can be downloaded from the Internet?

When you click on the corresponding icon and the download begin (the file you will find under 'Download):

Will I get notified about changes to SwissSalary?

Yes. You will receive information message each time when the latest Update is released. The PreUpdates will
be continuously available on our website with no mail notification! You will also be notified by mail about the
important PreUpdates!

Can the updates be sent via email?

As a rule, the Updates are only available online. Sending via email is often used in case of problems with some
providers related to the size of files and spam/junk filtering.

Are you familiar with our customer and partner portal?

By following https://webportal.swisssalary.ch you will enter our Customer portal. To log in you will need only
your email address and a password that you will receive from us. If you have not yet received a password from
us, please request it by sending an email at support@swisssalary.ch.

You can change the received password when you first log in to the system.

https://webportal.swisssalary.ch
mailto:support@swisssalary.ch
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At the Customer portal you may not only submit and process new support requests (incidents), but also track
your own open or already answered mail inquiries at any time. In addition, you have access to our Tasks for
further development. You can see which customer requirements have been met and will be delivered with the
next Update or PreUpdate. You can also vote for individual tasks, so that you can actively influence the
development of SwissSalary.

Just try it!

Do you have questions about our website or downloads?

You can send us an email at support@swisssalary.ch or call our hot line +41 (0)31 / 950 07 77 or your partner.
We will be happy to advise you!

6.2.2    Downloading / Refreshing Updates and PreUpdates

6.2.2.1    Instructions (2)

1. Download the objects and manuals according to the descriptions in chapter Instructions.

IMPORTANT NOTES:
q It is NECESSARY that you pass this User Manual on to the relevant employees!
q Make sure that the update version B5050.000 (BAU) / N5050.000 (NAV) is installed in your system. You can

check this in SwissSalary under Company -> Settings -> Organization -> Update (Version) or in RTC-Client
on Organization.

IN CASE YOU HAVE A VERSION OLDER THAN B5050.000 / N5050.000 INSTALLED, PLEASE CANCEL
THE INSTALLATION AND CONTACT US OR YOUR PARTNER!

HINT:
Please back up you data before the update. Generally, it is not required but still useful for security reasons.

2. Unzip the object file with WinZip.

3. Open Microsoft Dynamics NAV and select using Shift+F12 in Object Designer (Tools -> Object Designer).
From NAV 2009 SP1 RTC you must start the Development-Client.

Now you can see all NAV objects in the NAV DB available to you.

4. Select menu File -> Import.

5. Enter the path to the location where you saved the FOB file. The system will try to read the file.

6. You will see this info that MUST be confirmed with OK or No.

mailto:support@swisssalary.ch
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NOTE:
 For PreUpdates a different question appears. ALWAYS open the Import Worksheet!

7. The Import Worksheet will open.

IMPORTANT NOTE:
Here you SHOULD click REPLACE ALL! Click OK to continue the import process.

The RTC-Client (from NAV 2015) appear this message (confirm this with 'Force'):

The RTC-Client (from NAV 2015) ask you to do a synchronization; confirm this message with YES:
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8. The objects will be loaded into your database. After a successful completion of the import the following
message appears:
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In the Classic version:

(Example: the number of objects can vary!)

In the RTC version:

9. Done. The new update has been imported!

IMPORTANT NOTE:
This approach is similarly applied to PreUpdates!

After a successful import of the objects, select them in SwissSalary main menu.

Click menu item Employee (Employee Card). Te system will start automatically the process of update
renewal. Only a staff member with administrator rights should open the main menu for update renewal.
Otherwise, the update will not be successful! After a successful run of the batch you will receive a message
stating that it is complete. 

Under Setup -> Setup -> Organization  or in the RTC-Client-> Organization you will find the history of updates
in which all successfully updated versions are registered. After each Update/PreUpdate you must undergo this
update/renewal process!
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In the Excel file you can see which objects will be created and modified.

Type explication:

1 = Table
2 = Form (no more available from NAV 2013)
3 = Report
4 = Dataport
5 = Codeunit
6 = XMLport
7 = MenuSuite
8 = Page (only RTC version from NAV 2009 SP1)
9 = Query (from NAV 2013)

Important note on MenuSuite:

SwissSalary NAV:
The old menu is no longer available in NAV Version 4.00 or newer. MenuSuite is included in regular update.

In cases of uncertainty, please inform your partner or our support immediately.

6.2.3    Access Autorisations and Roles

6.2.3.1    Instructions (2)

Autorisation and Roles description:

Groups ID Name Description
SWS-ALL SwissSalary -

All SwS-Users
The only user role that must be assigned to every SwissSalary user.
The 'Wage Accounting Process' feature requires that the system should obtain
'indirect' information about all clients (license check, how many employees are
currently accounted for in the entire database. Of course, the payroll staff
member cannot see any data of the restricted clients)The only user role that
must be assigned to every SwissSalary user.

SWS-CONS /
SWS-
INVOICING
(only
SwissSalary
BAU)

SwissSalary -
Consortium
SwissSalary -
Invoicing

This role is used for working in the ARGE module. This permission role allows
full access to ARGE items and ARGE posting journals. This role is suitable for
employees that are only allowed to operate ARGE in payroll accounting.

SWS-EE-
EDIT

SwissSalary -
Edit Employees

This role is the classical assignment for payroll staff members that need to use
all features of payroll accounting. The user can edit, delete, enter data in
SwissSalary; however s/he cannot change payroll master data.

SWS-EE
READ

SwissSalary -
Read
Employees

Similar to the SWS-EE EDIT role, with the exception that data can be viewed
only, and not changed (read-only rights).

SWS-HR
EDIT

SwissSalary -
HR Edit
Employee

PIS (Personal Information System) add-on module. A user with this role can
modify, delete and enter data in PIS. 

SWS-HR
READ

SwissSalary -
HR Read
Employee

PIS (Personal Information System) add-on module. Read-only rights.
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SWS-HR
SETUP

SwissSalary -
HR Setup

PIS (Personal Information System) add-on module. A user with this role can
change settings in PIS. Classical HR wage administrator.

SWS-POST
(only
SwissSalary
NAV)

SwissSalary -
Posting

In accordance with the SOX guidelines, payroll staff member is not allowed to
'post wages'. This user role can be assigned to an employee in the FIBU that
is exclusively responsible for wage posting. IMPORTANT: Of course, this
employee must also be enabled in SwissSalary under Company -> Settings ->
Users.

SWS-SETUP SwissSalary -
Setup

Classical authorization role for wage administrator

SWS-ST
EDIT

SwissSalary -
Edit Salary
Type

Full access for editing wage types. A user with this role can create, modify
and delete wage types.

After each update, permission roles must also be adjusted in SwissSalary (New table access, etc.)

IMPORTANT NOTICE:
q If you have customized individual permission roles in Standard "SWS-*", please remember that they will be

overwritten through the automatic import of the "default" roles.
q Before releasing the system for the user again, add the necessary appropriate permission roles to these new

tables!

Current permission roles can be found on our website in our protected area.

To begin the import in SwissSalary go to Setup -> Setup -> Organization -> button 'Service' -> Rights. In the
RTC-Client in Organization. Select SWS value under Role ID*.

Choose the appropriate path for the .txt file and select Import under Direction in the Options tab. Then click
OK and after some time the default user roles will be adjusted in SwissSalary.

If you have written changes in our default payroll user roles or if you want to make changes to the user roles
manually, you can do this under Tools -> Security (NAV version 3.70 or older) or under Tools -> Security ->
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Roles (NAV 4.00 and newer). Click on the appropriate role and add new tables under Roles -> Permissions
(NAV 3.70 or older) or Role -> Permissions (NAV 4.00 and newer). In the RTC-Client go to Departements->
Administration-> IT Administration-> General-> Permission Sets. If you have questions about these settings,
please contact your local partner.

The following tables have been re-created and must be added to the corresponding roles (if already used):

Table SwissSalary BAU/NAV Name Object Name

9701 (BAU) Cue Setup (SWS-ALL) Batch Setup

3009171 SwS Following Salary Type Following Salary Type

3009187 SwS Blob Link Blob Link

3009188 SwS Blob Entry Blob Entry

3009293 SwS SmartPort Change Field SmartPort Change Field

3009294 SwS SmartPort Posted Ch. Field SmartPort Posted Change Field

3049190 SwS Payroll Chart Setup Payroll Chart Setup

3049191 SwS Payroll Chart Setup Line Payroll Chart Setup Line

3049201 SwS Certificate Certificate

SwissSalary Role Center
Each NAV module knows its own role Center (from NAV 2009 RTC). SwissSalary has developed the Page
3009252 SwS Payroll Role Center. We encourage you to work with this Role Center for the salary. You can
import the Role Center also (XML-file you will find in the Update object).
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7    Update 5050.000

7.1    Update 5050.000 User

7.1.1    Update 5050.000

7.1.1.1    Introduction

Dear SwissSalary Customers, dear SwissSalary Partners,

We are pleased to present to you the manual for the 50th SwissSalary update 5050.000. Your SwissSalary will
be up to date after installing this release.

50th update? That sounds perhaps like an old software. 50 x new features developed and presented, 50 x
innumerable customer requests implemented, 50 x the SwissSalary NAV wage module used in the newest
Microsoft Dynamics NAV environment, many certifications have been passed (swissdec, Certified for Microsoft
Dynamics NAV, etc.). That is not the end even after the 50th update! Every day, a motivated team currently
consisting of 15 employees takes care about SwissSalary and other products like SwissSalary Direct
(employee portal) and SwissSalary EasyRapport (time and activity recording).

We are very grateful to have such a dedicated team working with us that does more than their best every day.
Of course, our special thanks go to more than 800 of our customers with thousands of payroll clients, and
more than 70 SwissSalary partners in Switzerland and neighboring countries. You all give us motivation to
continue developing great features for you even after the 50th update. 

I can assure you that the 50th release is rich with new and great options.

Highlights

q 1. SwissSalary version for Microsoft Dynamics NAV 2016
In the meantime, Microsoft has brought the 9th version of NAV onto the market on October 5, 2015. We
were able to witness its birth live during the Directions EMEA 2015 occasion in Mannheim. We did our
'homework' already, and with Update 5050.000 we can present to you the first SwissSalary version for NAV
2016. If you are interested in this modern, flexible and efficient ERP version, contact your NAV partner today
for a possible upgrade to NAV 2016.

q Net Pay correction
Requested by many customers, the automatic net wage compensation is available now. Very little setup
data is needed, and SwissSalary has already taken care of automatic wage correction in daily allowance
adjustments for you. Please be sure to check our instructions about legitimate application of net wage
compensation.

q  TimeMachine extension – now available in the Area of Wages
SwissSalary has achieved a further milestone with the integration of TimeMachine in the Area of Wages.
Starting from Update 5049.000, TimeMachine is already successfully implemented for withholding tax
calculation and retroactive WT rate corrections. It also serves now for storing wages on the timeline
(retroactive calculation and for the new wages in the future). 

q  SwissSalary Store
The new SwissSalary Store, located under Organization menu item, shows whether your base master data
like withholding tax rates, ZIP codes or bank master data, or even the update version are up-to-date. You
can call up the respective updates and update your base data directly from the store. You must accept the
GTC once to be allowed to use the Store.

http://www.microsoft.com/de-ch/dynamics/erp-nav-ueberblick.aspx
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q  SwissSalary SmartPort
With the help of the new SwissSalary SmartPort we now offer the option to synchronize data between 2
systems (e.g. between an external HR system and SwissSalary, and between SwissSalary Direct and
SwissSalary). The complicated and expensive interfaces are no longer necessary. The address and bank
details changed by the employee online can now be synchronized in the area of SwissSalary Direct
(SwissSalary Direct Plus).

q SwissSalary Direct Plus
You print and send payslips and other documents by conventional mail? Would you like to save postage and
a lot of time immediately, and offer your employees an ultra-modern self-service tool? SwissSalary Direct is
the right choice, then! Many SwissSalary customers already send payslips to SwissSalary Direct. The
employee must register once and voilà. Simply easy, comprehensive, contemporary. Following the launch of
SwissSalary Direct Basis (save payslips and other documents in SwissSalary Direct – CHF
0.50/employee/month), we launched SwissSalary Direct Plus now. For additional CHF
0.25/employee/month, the employee can change their home address and/or bank details. Owing to
SmartPort, this change has arrived into SwissSalary – you can decide whether you want to accept or reject
it.

q SwissSalary News
We want to be even closer and always inform you about new updates, important changes in social matters
and taxation, as well as about events and trainings. For this purpose, we developed the SwissSalary News
platform. With it integrated into SwissSalary Role Center, you can now view our current articles. You will not
miss important news anymore and will stay informed. This service is exclusively available for customers
using NAV 2009 SP1 RTC and later!

And there is even more to come. The 50th SwissSalary update has much more to offer. You can get more
detailed information about all changes on the following pages.

Please make sure that version not older than 5049.000 dated September 30, 2014 was installed
before this update process. If your partner has made company-specific changes to the SwissSalary
NAV objects, you must contact your Microsoft Dynamics NAV partner BEFORE installation.

Information about the manual
Screenshots of individual tasks are primarily created for the newer, role-based versions of NAV 2009 SP1 RTC
and later (Role Tailored Client). If there are deviations from the older Classic client, they are specifically
mentioned in the manual.

Important notes

q SwissSalary BAU customers with NAV 5.0
SwissSalary Update 5050.000 is the last full version for BAU 5.0. NO further developments are planned in
BAU version 5. We kindly request you to migrate from NAV 2015 to the new NEVARIS solution as soon as
possible. Many existing BAU customers already took this step this year, and have since worked with the
platform NAV 2015. If you have additional questions about this topic please contact your NEVARIS support.

q SwissSalary NAV customers with NAV DB versions 3.70, 4.00 + 4.00 SP1
SwissSalary Update 5050.000 is the last full version for these NAV DB versions. By September 2016, we will
release more PreUpdates (5050.xxx) for these versions. Starting from October 2016, there will be updates for
versions after NAV DB 4.00 SP2 only!

q SwissSalary Role Center | RTC clients starting from NAV 2009 SP1
Since the introduction of the RTC Client, SwissSalary has been using a clearly arranged and intuitive Role
Center. However, we have discovered time and again that some of our customers had not been using it.
System Administrator Manual contains important information thereto.

We hope you will enjoy the latest version of SwissSalary!
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Your SwissSalary Team

7.1.1.2    Innovation

7.1.1.2.1    TimeMachine | Timeline in the Area of Wages

Task #6772 | 5049.003

We have presented TimeMachine to you with Update 5049.000 (09/2014). Then, we have implemented the
solution in the area of Income Tax, so that you could make changes/retroactive corrections to the rate on the
timeline.

Now, we have also integrated this timeline in the Salary index. This way, for example, you can record changes
in wages made by trainees and/or record sample wages in the future by clicking the 3 dots. TimeMachine will
open. You enter new wages, wage rates or percents by position with the 'Valid from' date on the left side. The
History on the right side displays the historically recorded wages already accounted for.

Of course, the timeline covers both the future and the past. For example, if you make a retroactive wage
adjustment, enter the corresponding date in the 'Valid from' date field, and the new value in the field.
SwissSalary will calculate the correction and subsequent charges automatically (similar to IT calculation in
case of retroactive corrections).

TimeMachine also works in case of changes during the month, e.g. when changing the trainees' wage during
the month. You can also make multiple entries for the future.

You don't want to work with TimeMachine?
You can make your changes as before, right in the respective field. The input in TimeMachine is correctly
accounted for in the background (current month).

We will extend the timeline to other important fields in further updates/pre-updates. We will keep you informed.
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Task #7048 | 5050.000

From now on, the user ID and the date of mutation are also stored in the TimeMachine table. Consequently, it

can be tracked at any time which user made the change. User ID field and mutation date are also shown in

history.

7.1.1.2.1.1   Net Pay Correction

Initial condition
When employees are absent for the reasons like illness, accident, military service, etc., wage-replacement
benefits are normally provided by third parties (insurance companies) in the form of daily allowances.

If the employer pays the "usual" wage during the absence, wage-replacement benefits are to be accounted for
in the payroll.

If wage-replacement benefits are not subject to accounting in case of social insurance, the deduction base for
contributions reduces so that these wage-replacement benefits and the net wage are therefore higher than if no
such benefit had been processed.

Guidelines for net pay correction (NP Compensation)
q The employer is obligated to carry out daily allowance adjustments
q The higher net wage after an absence meets with incomprehension
q Therefore, there is a possibility to carry out a net wage compensation, provided that it complies with labor

legislation (collective employment agreement, individual employment agreement, OG, etc.)
q For this reason, the wage processing software permits daily allowance adjustments with or without net wage

compensation

Source: Guidelines for Wage Data Processing 20091204, December 18, 2009 edition – swissdec

Starting from Update 5050.000, SwissSalary calculates net pay correction automatically using an iteration.
First, the net wage is calculated without daily allowance adjustments. After the acquisition of daily allowance
adjustments, social security and income tax bases are upscaled and downscaled +/- until the net wage is
back to 1:1, the same as without daily allowance adjustment.

Please be sure to follow the instructions of swissdec that net pay correction may only be used under the
conditions described above. The process of net pay correction has neither particular juridical basis, nor
detailed professional manuals. It is important that net pay correction is implemented not only for individual
employees, but also for a clearly defined group (GAV) or for the whole company. If you want to manage
company personnel with and without net pay correction, you have to duplicate the corresponding daily
allowance salary types (with/without NP compensation).

Settings
It is very easy to set up net pay correction in SwissSalary.

New salary type net pay correction
First of all, you need a new salary type Net pay correction. It can be a copy of the Monthly Wage or Monthly
Wage Correction salary types. Copy one of these salary types and assign number 1160 (default payroll master
data) to the new wage type. Please note that the calculation type is set to negative. Edit the translations. As a
rule, obligations and account assignments remain as in the output wage type Monthly Wage.

The new wage type assignment in the Payroll Master Data
In order that SwissSalary detects which wage type is responsible for net wage compensation, you will need to
record this new wage type once in the payroll master data in tab Base -> field Net Wage Compensation of the
wage type.



Seite 326



Seite 327

Marking daily allowance wage types
Now you have to set the checkmark in the Net Wage Compensation field for Daily Allowance Adjustment and
the corresponding Daily Allowance wage type. Again, we would like to point out that need to duplicate the daily
allowances wage types, as long as you have different considerations in the same client (with/without NW
compensation).

Net wage compensation calculation
You are ready for the calculation of net wage compensation now. SwissSalary calculates the compensation in
a usual billing process automatically. Despite greater computing power required for iteration, we could not
determine in our tests any noticeable loss of performance during the process of wage accounting.

How can the calculation be controlled?
Create a test billing for employees without daily allowance adjustments. Note down the net wage amount.
Finally, record the daily allowance adjustment and create a test billing again. Now, wage type 1160 will be
displayed automatically in the area of Gross Wage with a minus amount. The net amount of wages again
should be the same as without daily allowance adjustment.

Our calculation is carried out by means of iteration of social and private insurance bases, and the withholding
tax base. The bases along with the exemption of daily allowance adjustments are additionally eliminated again
by means of wage adjustment. Of course, this calculation equally applies both to the employer and the
employee. With this additional wage cut and the associated reduction of wage bases, the employee receives
the same net wage as if he had received no daily allowances. Through this additional discharge of wage bases
the net wage compensation in case of some social security funds is not entirely noncontroversial. Important
insurance contributions to social insurance companies are avoided, and additional reduction in the employee's
social security base can lead to the situation when, for example, s/he is no longer sufficiently covered by the
AHV insurance and therefore must register as an inactive person.

Our support has been instructed not to provide legal information to customers and/or partners, whether net
wage compensation should be carried out in particular cases. Individual companies must settle it themselves.
Since there is no legal basis for net wage compensation, it may lead to refunds and back payments in case of
dispute (no legal protection of the employer against employees stipulated in agreements). Of course, if you
have questions about calculation logic, we will provide you with necessary information.
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7.1.1.2.2    SwissSalary Store

Task #6665 | 5049.003

SwissSalary Store is not provided for the SwissSalary BAU solution (version 5.0). The feature is included in
BAU (NAV 2015)!

A payroll accounting solution must be regularly adapted to new realities. For example, in addition to legal
requirements, new withholding tax rates, postal codes, bank master data and/or permissions must be
updated. 

Using SwissSalary Store, we offer the customer an efficient way to keep at all times payroll accounting and
base data up-to-date. Inspired by other app stores, all installed components are listed and displayed
automatically when a component is outdated. The components can be updated in just a few clicks.

When the user opens the Organization mask, the system automatically checks for updates and displays them
accordingly. The following example illustrates outdated permissions (2). You can repeat the query at any time
by clicking Update Status (1).

If you want, for example, to import SwissSalary update, click the three dots button in the SwissSalary field (it
will open the website http://www.swisssalary.ch):

The link will take you to our protected download section (log in) where you will find the update. If the update is
imported successfully, the display will update in the Status column. If there are temporary problems with
Internet connectivity or SwissSalary Store is offline, everything will work as intended. Simply no status will be
displayed. In addition, you can see the respective SwissSalary Store status in the status below. If you confirm
General Terms and Conditions, SwissSalary Store should usually be available.
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7.1.1.2.2.1   GTC

Task #7071 | 5050.000

Now, when you call up an organization, a prompt will appear asking whether you want to accept SwissSalary
GTC.

Place a check mark next to "I accept these GTC" and confirm by clicking OK. This prompt will appear again
when you start the organization, provided that the GTC are subject to changes in future. Once the GTC have
been accepted, the data will be exchanged with SwissSalary Store.

The GTC can be retrieved at any time at http://www.swisssalary.ch/agb.

7.1.1.2.3    SwissSalary SmartPort

5049.003

SwissSalary Store is not provided for the SwissSalary BAU solution (version 5.0). The feature is included in
BAU (NAV 2015)!

The new SmartPort serves as a data synchronization interface, e.g. between SwissSalary Direct and
SwissSalary or between an external HR solution and SwissSalary. If an employee makes changes, for
example, to their address and/or bank details via SwissSalary Direct (Plus), they can be displayed here at the
push of a button (direct sync). Then, the payroll staff member can decide whether to approve the change or
not.

You can add SmartPort in RTC under Customize -> Customize this page. SmartPort can be found in the
Classic Client under Periodic activities.

RTC view (SwissSalary Role Center)
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Changes View (old/new). Here are 2 examples with the change of address and bank details from SwissSalary
Direct Plus.

        
Of course, the same security questions will be asked as in the case of a manual mutation, e.g. when changing
the ZIP code.

Function

Import Under Settings, you can append other external systems (e.g. external HR system). The
Import function is used to synchronize data from external tools..

Direct Sync If you already use SwissSalary Direct Plus, no further settings are necessary. The fields
to be synchronized are already defined. Click Direct Sync and all changes in
SwissSalary Direct will be displayed.

Open Open is used to display the change in an overview screen. Changes are highlighted red
(new). The change can be accepted by clicking Yes, and rejected by clicking No. If you
want to answer the question later, click the cross in the upper right corner and close the
prompt.

Reject You can reject this change right away.

View all Clear filter, all changes are displayed

Protocol The protocol lists all changes and shows whether you have accepted or rejected the
changes.

Settings Path indication for external solutions (e.g. HR solutions) – under development

Search Standard search mask

7.1.1.2.4    SwissSalary News

SwissSalary News can be used exclusively in RTC clients of NAV 2009 SP1 RTC or later. This feature does
not exist in the "old" Classic clients prior to NAV 2009 R2 Classic.
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SwissSalary News is a new information platform for displaying current SwissSalary news. You can also
access all important information that we publish on our website in SwissSalary Role Center. Owing to
SwissSalary News, you will be among the first ones to obtain information about new updates/pre-updates,
manuals, withholding tax rates, trainings or changes in social security practices, etc. and, most importantly,
you will not miss any urgent information anymore.

Similarly to SmartPort, you can add SwissSalary News in RTC under Customize -> Customize this page.

7.1.1.2.5    Report Wage Data Import from Excel | Extension

Task #6160 | 5049.001

Report 3009242 Wage Data Import from Excel (BAU version 5: 5142937) can be added and started manually
under General Reports. This report is not fixed in the menu structure of SwissSalary. The report is used to
import data from Excel directly into the fields of the Staff Card. For example, 3 optional fields with freely
selectable fields of the whole Staff Card can now additionally be imported to pay rises, monthly parts, wages.
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7.1.1.3    Personal

7.1.1.3.1    Personalien

7.1.1.3.1.1   Ländercode ist neu ein Pflichtfeld

Task #6487 | 5049.002

Das Feld Ländercode im Reiter Personalien ist neu ein obligatorisches Feld und muss gefüllt sein. Beim
Prozess Lohn abrechnen wird analog der weiteren Pflichtfeldern geprüft, ob ein Land erfasst wurde.

Falls das Feld leer ist, erscheint folgende Warnmeldung:

Der Ländercode ist nicht die Nationalität des Mitarbeiters, sondern das Land bezüglich der Wohnadresse des
Mitarbeiters. Dies bedeutet, dass auch bei CH-Adressen zwingend immer CH erfasst sein muss. Dies ist
bereits mit der korrekten PLZ-Datei garantiert.

7.1.1.3.2    Register Arbeitsstelle

7.1.1.3.2.1   Nachträgliches Erfassen vom Austrittsdatum

Task #6301 | 5049.002

Wurde im Austrittsmonat vergessen, das korrekte Austrittsdatum zu setzen, kann dieses nachträglich in der
Personalkarte gesetzt werden. Neu wird im Hintergrund auch die Lohnlauf Kopf-Tabelle - Feld Austritt
nachgeschrieben. Diese Tabelle ist für die korrekte Darstellung der Jahresendberichte notwendig. Bisher hatte
ein nachträgliches Setzen des Datums keinen Einfluss auf die Historie mit der Auswirkung, dass die
Jahresendberichte teilweise falsche Zeitperioden auswiesen.

WICHTIG
Das nachträgliche Setzen des Austrittsdatums wird von uns nicht empfohlen. Im Austrittsmonat werden
sämtliche Austrittsberechnungen (pro Rata Berechnungen des Lohnes, der Höchstgrenzen bei ALV, UVG,
QST, Auszahlen des 13. Lohnes pro Rata etc.) automatisiert und korrekt vorgenommen. Fehlt das
Austrittsdatum in diesem Zeitpunkt, erfolgen die Berechnungen falsch oder nicht automatisch. Ein
nachträgliches Setzen ändert an der Falschberechnung nichts mehr sondern setzt nur das korrekte
Austrittsdatum für die Auswertungen.
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7.1.1.3.2.2   Total Dienstjahre

Task #7046 | 5050.000

In der Dienstjahres-Tabelle wird nun jeweils das 'Total' der Dienstjahre angezeigt.

7.1.1.3.2.3   SwissSalary BAU | Personaldimensionen & Lohnklasse

Task #6261 | 5049.002

NEU können auch in der Version BAU fixe Personaldimensionen (z.B. Kostenstellen) pro Mitarbeiter hinterlegt
werden. Dies entspricht der gleichen Logik wie in der branchenneutralen NAV-Version. Datenerfassungen im
Rapportierungsjournal oder Lohnteile, welche keiner Kostenstelle zugewiesen werden, werden auf die
hinterlegte(n) Personaldimension(en) aufgeteilt (für die Übergabe in die FIBU).

Die Einrichtung erfolgt auf der Personalkarte -> Menüband Rubrik 'Personal' -> Personaldimension (in der
Classic 5.0-Version mit F9):

Bitte achten Sie darauf, dass der Anteil nie mit 0.00 (siehe Abb.) erfasst wird, ansonsten erfolgt keine
Aufteilung, bzw. beim Lohn abrechnen erfolgt eine Fehlermeldung. Sie können mehrere Aufteilungen über
mehrere KST erfassen. Beispiel:

KST A = 10
KST B = 50
KST C = 40
Total = 100

Die Aufwände werden durch 100 geteilt x Anteil. Der Gesamtanteil muss nicht zwingend 100 sein, es wird
immer durch den Totalanteil x Anteil gerechnet.

Task #6260 | 5049.002
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NEU kann in der Lohnklasse ein zusätzliches Feld ausgewählt werden für die Erfassung des Lohnansatzes für
die Interne Weiterverrechnung (BBA). Somit ist es möglich, pro Lohnklasse einen fixen Weiterverrechnungs-
Lohnansatz zu definieren, der anschließend pro erfasster Stunde an die BBA weitergegeben wird. Dieser
Lohnansatz wird danach beim Mitarbeiter im Register Lohn auch entsprechend angezeigt und entsprechend für
die Verrechnung genutzt.

Die Einrichtung erfolgt bei den Basislöhnen oder via Personalkarte -> Register 'Arbeitsstelle' -> 'Lohnklasse':

7.1.1.3.3    Register QST

7.1.1.3.3.1   QST-Tarife Kanton TI auswählbar inkl. Text

Task #6264 | 5049.002

Im Januar 2015 hat der Kanton TI für die Grenzgänger mit Wochenaufenthalt neue Tarife veröffentlicht (siehe
untenstehende Info). Die entsprechenden Tarifcodes wurden bereits im PreUpdate 5049.001 veröffentlicht
(jedoch noch ohne Text). In der Personalkarte -> Register QST können diese Tarife inkl. der entsprechenden
Texte ausgewählt werden (ebenso in der TimeMachine möglich).

7.1.1.3.4    Personalliste | Sortierung im RTC

Task #6733 | 5049.003
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Die gewählte Sortierung bleibt neu auf der Personalliste gespeichert. Dies funktioniert nur dann, sofern nach
Standardfeldern wie z.B. nach Personalnummer oder nach Suchbegriff (A-Z) sortiert wird.

7.1.1.3.5    Personalblatt | Individuelle Statistik mit Bemerkung

Task #6801 | 5050.000

In der Personalstatistik kann nun auch die Spalte 'Bemerkung' eingeblendet werden. Die Bemerkungen werden
auf dem Personalstamm angedruckt.

7.1.1.3.6    Name/Vorname bei Form/Pages anzeigen

Task #6441 | 5049.002

Auf folgenden Forms und Pages werden neu neben der Personalnummer auch der Name/Vorname des
Mitarbeiters angezeigt:

- Kinder
- Personaldimensionen
- Bank
- Lohnlaufliste

Somit ist immer ersichtlich, bei welchem Mitarbeiter man sich gerade befindet.
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7.1.1.3.7    Personal-Banken

Task #6837 | 5049.003

Möchten Sie bestimmte Beträge immer auf dieselbe Bankverbindung überweisen? Sie können auf der
Bankverbindung neu einen Lohnarten Filter hinterlegen (auf nur einzelne Lohnarten).

Beispiel:
Der Mitarbeiter wünscht, dass alle Spesen auf eine separate Bank ausbezahlt werden. Der Lohnsachbearbeiter
erfasst bei der Mitarbeiter-Bank alle Spesen-Lohnarten, z.B. ein Filter mit den Lohnarten "3000..3999". Dabei
wird im Rapportierungsjournal sowie in den Lohnteilen der Bankcode automatisch gesetzt. Sie können diesen
Automatismus jederzeit direkt nach der Rapportierung manuell steuern.

Task #6608 | 5049.003

Die Liste Personal-Banken kann mit weiteren Feldern ergänzt werden. Wählen Sie Spalten auswählen.

Sie können neu auch die Personalnummer sowie den Namen/Vornamen auswählen.
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7.1.1.3.8    Lohnteile | Neue Factbox

Diese Neuerung betrifft ausschliesslich die RTC Versionen!

Task #6157 | 5049.001

Im rollenbasierenden Client (RTC) wurde eine neue Factbox mit den aktuellen Lohnteilen eingebaut. Diese
Factbox erscheint auf den folgenden Pages, bzw. kann bei diesen ein-/ausgeblendet werden:

- Personalkarte
- Personalliste
- Rapportierungsjournal

Hier ein Beispiel der neuen Factbox Lohnteile im Rapportierungsjournal:

7.1.1.3.9    Lohnlaufliste | gebuchte Dimensionen

Task #6442 | 5049.003

Direkt über die Lohnlaufliste können Sie pro Lohnlauf die gebuchten Personaldimensionen prüfen.
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7.1.1.3.10    Bescheinigung über Zwischenverdienst ALV | Arbeits- und Absenzstunden werden automatisch
ausgefüllt

Task #6809 | 5049.003

Der Report Bescheinigung über Zwischenverdienst ALV konnte die Arbeits- und Absenzstunden nicht
automatisch anzeigen. Das Formular musste manuell ausgefüllt werden. Nun können Firmen, welche über
tägliche Arbeits- und Absenzstunden im SwissSalary verfügen (z.B. aus SwissSalary EasyRapport oder
Datenimport via offener Datenimport-Schnittstelle), die erfassten Stunden direkt an den Bericht weitergeben.
Dazu wurde die Einrichtung Zeitarten um eine neue Spalte Kurzzeichen ALV erweitert.

Wird an einem Tag eine Abwesenheit mit den Codes A, B, C, D oder E und zusätzlich Arbeitszeit gebucht,
wird dies mit einem "+" angezeigt, also beispielsweise  "A4 + 4". Ansonsten wird entweder der entsprechende
Buchstabe oder das Total der Arbeitszeiten erwähnt, welche mit dem Kurzzeichen ALV in den Zeitarten als
Arbeitszeit definiert wurde.

Die Kurzzeichen von A-E entsprechen der Legende auf dem Report.

7.1.1.4    Lohnarten

7.1.1.4.1    Meine Lohnarten | Erweiterung Spaltenauswahl

Task #6708 | 5049.003
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Betrifft ausschließlich RTC-Versionen mit dem SwissSalary Rollencenter.

Im SwissSalary Rollencenter können Sie die Page Meine Lohnarten auswählen. Wir haben die Spaltenauswahl
erweitert mit folgenden Werten:

q  Kontonr.
q  Kostenart Fibu belasten
q  Gegenkonto Nr.
q  Kostenart Belastung
q  Kostenart Entlastung
q  Lohnausweis (Form. 11)
q  LSE Statistik
q  QST Detail
q  Berechnung Ein-/Austritt

7.1.1.4.2    NBUV-Aufrechnung bei der Quellensteuer

Task #5751 | 5049.001

Einige wenige QST-Kantone verlangen, dass die quellensteuerpflichtige Lohnsumme erhöht wird, sofern der
Arbeitgeber den NBUV-Abzug des Arbeitnehmers übernimmt. Diese Praxis ist nicht in allen Kantonen
verbreitet und widerspricht der rechtlichen Gleichstellung zwischen ordentlicher Steuer (Lohnausweis) und der
QST. Beim Lohnausweis sind vom Arbeitgeber übernommene NBUV-Beiträge sowie auch KTG- und UVGZ-
Beiträge von der Aufrechnung ausgeschlossen.

Wir haben die Berechnung im SwissSalary so angepasst, dass wenn bei der LOA "NBUV Arbeitgeber" das
Häkchen "Quellensteuerpfllichtig" gesetzt wird, dieser Betrag auch in der quellensteuerpflichtigen Lohnsumme
berücksichtigt wird.

Diese Anpassung kann dazu führen, dass nun auch falsch parametrisierte Arbeitgeber-Lohnarten mit irrtümlich
hinterlegten Pflichtigkeiten plötzlich Berechnungen auslösen. Kontrollieren Sie sicherheitshalber Ihre
Arbeitgeber-Lohnarten auf falsche Pflichtigkeiten.

7.1.1.4.3    Lohnartentexte werden auf der Lohnabrechnung zusammengefasst

Task #5929 | 5049.002

Werden Lohnarten wie z.B. km-Entschädigung auf verschiedene Kostenstellen erfasst und mit einem
Zusatztext versehen, erschienen diese bisher als Einzelzeilen auf der Lohnabrechnung. Dies hat meistens zu
mehrseitigen Lohnabrechnungen geführt.

Beispiel:
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Wenn jemand z.B. an 20 Tagen eine Kilometer-Entschädigung erhält, diese täglich erfasst und jeweils die
Fahrstrecke im Text angegeben hat, erschienen auf der Lohnabrechnung 20 einzelne Zeilen (km-
Entschädigung).

NEU werden die Beträge der selben Lohnart komprimiert auf eine Zeile auf der Lohnabrechnung gedruckt, wenn
dies auf der Lohnart entsprechend eingerichtet wird. Die neue Option Zusammenziehen ist in den Lohnarten,
Reiter Pflichtigkeiten, Feld Zusatztext zu finden. In dieser Option finden Sie neu auch die Funktion Einzeiler,
welcher das Häkchen Einzeiler bei Zusatztext ersetzt.

7.1.1.5    Lohnstammdaten

7.1.1.5.1    Register ALV

7.1.1.5.1.1   Höchstgrenzen-Berechnung bei Rückrechnung (Austrittsdatum <= 31.12.2015)

Task #7054 | 5050.000

Dieser Task betrifft die ALV-, ALVZ- und UVG-Höchstgrenzen, welche per 01.01.2016 erhöht werden.

ALV/UVG
bisher: CHF 126'000/Jahr | CHF 10'500/Monat
neu: CHF 148'200/Jahr | CHF 12'350/Monat

ALVZ
bisher ab CHF 126'000/Jahr | CHF 10'500/Monat
neu: ab 148'200/Jahr | CHF 12'350/Monat

Die neuen Höchstgrenzen müssen Sie nach dem letzten Lohnlauf Dezember 2015 bzw. vor dem ersten
Lohnlauf Januar 2016 manuell in den Lohnstammdaten ändern. Ab 01.01.2016 werden die neuen
Höchstgrenzen berechnet. Für rückwirkende Nachzahlungen bei Mitarbeitern mit Austrittsdatum vor dem
31.12.2015 werden weiterhin die bisherigen Höchstgrenzen berücksichtigt.

7.1.1.5.2    Register Sozialfonds

7.1.1.5.2.1   Sozialfonds & KTG | Hyperlinks nun auch im RTC wählbar

Task #6211 | 5049.002

Die Hyperlinks (Internetlinks) in den Lohnstammdaten für KTG und Sozialfonds sind nun auch in den RTC-
Versionen auswählbar.
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7.1.1.5.2.2   Sozialfonds | Representation-Fee (Kanton GE) wurde nicht in die QST-Basis eingerechnet

Task #6587 | 5049.003

Der Kanton GE kennt eine spezielle Regelung der Pauschalspesen, welche anhand der AHV-Lohnsumme mit
Unter- und Obergrenzen berücksichtigt werden. Diese Zulagen wurden nicht korrekt in die QST-Summe
eingerechnet. Dies ist behoben.
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7.1.1.5.2.3   Sozialfonds | Basis AHV mit Freibetrag | Nebenverdienst Freibetrag CHF 2'300

Tasks #6737 & #6572 | 5049.003

Die Grenze von CHF 2'300.00 bei geringfügigem Einkommen (Nebenerwerb) wurde bisher bei Abzügen im
Sozialfonds nicht korrekt berücksichtigt. Im Sozialfonds werden z.B. Abzüge wie die
Mutterschaftsversicherung des Kantons GE sowie weitere Abzüge eingerichtet. Dies wurde korrigiert. Es
werden keine Abzüge mehr vorgenommen, sofern die AHV-Lohnsumme übers Jahr gerechnet die CHF 2'300.00
nicht übersteigt.

7.1.1.5.3    Register QST

7.1.1.5.3.1   Quellensteuer Tarife einlesen | Auswahl der Option hat geändert

Task #6531 | 5049.002

Die Optionsauswahl beim Import der Quellensteuer wurde geändert.

Bisher: Löschen, löschen bis Vorjahr, nicht löschen
Neu: löschen bis Vorjahr, Löschen, nicht löschen

Der Grund dafür ist, dass mit der TimeMachine rückwirkend auch jahresübergreifende Korrekturen gemacht
werden können. Dies funktioniert aber nur, wenn der Tarif des Vorjahres noch im System ist, ansonsten wird
ein falscher Tarif (der aktuelle) gezogen. Somit empfehlen wir folgende neue Standardauswahl: "löschen bis
Vorjahr".

Bitte beachten Sie die kantonal unterschiedlichen Regelungen bei Jahresübergreifenden Korrekturen. Einige
Kantone lassen diese Korrekturen nicht zu. Leider sind wir nicht im Besitz einer entsprechenden Liste.

7.1.1.6    Lohnlauf

7.1.1.6.1    Rapportierung

7.1.1.6.1.1   Mehr Zeichen für Texte

Task #6486 | 5049.002

Das Textfeld in der Rapportierung ist NEU von 40 auf 50 Zeichen verlängert worden. Somit ist mehr Raum für
längere und flexiblere Texte geschaffen worden. Diese Erweiterung ist durchgängig geändert worden für die
Felder folgender Tabellen:

- Lohnarten | Text
- Lohnteile | Text 
- Rapportierungsjournal | Text
- Lohnposten | Text
- Weiterverrechnungs-Posten | Text
- EasyRapport | Texte

7.1.1.6.1.2   EasyRapport Posten holen | Neue Funktion mit Stichdatum bei Austritt

Task #6867 | 5049.003

Diese Neuerung betrifft alle Kunden, welche mit einer integrierten Zeiterfassungslösung arbeiten und am 25.
des Monats die Löhne definitiv verarbeiten. Kunden mit dem Akontolohn-Verfahren sind hier nicht gemeint (für
diese Kunden ändert sich nichts).
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Kunden, welche aus betrieblichen Gründen keinen Akontolohnlauf durchführen können, haben immer die
Herausforderung, dass im Zeitpunkt der Lohnabrechnung nicht alle Zeitdaten des aktuellen Monats zur
Verfügung stehen. In der Regel sind nur die Stunden des Vormonats bekannt. Bei einem Personalaustritt per
Ende Monat hat dies unter Umständen negative Auswirkungen auf die Saldenberechnung bzw. auf die
Auszahlung von Saldenguthaben.

Wir weisen ausdrücklich darauf hin, möglichst mit dem Akontolohn-Verfahren zu arbeiten, da dies im
Zusammenspiel mit der Zeiterfassung die einzig sinnvolle und unkomplizierteste Lösung darstellt.

Bei Mitarbeitern mit Austrittsdatum im aktuellen Monat besteht neu die Möglichkeit, dass alle im EasyRapport
rapportierten Posten übertragen werden, auch wenn das Belegdatum das eingetragene Stichdatum
überschreitet.

Dies ist dank der neuen Funktion Periode Start Tag möglich (Beschreibung unter Abrechnungskreis | Periode
Startdatum). Bleibt das Feld 'Periode Start Tag' leer, werden ausschließlich Daten bis und mit Stichdatum
übertragen ins Rapportierungsjournal. Wird bei 'Periode Start Tag' eine 1 eingetragen, wie im nachfolgenden
Beispiel, so werden ALLE Posten des Vormonats übertragen. Mit dieser Eingabe und der Kombination des
Stichdatums bei 'EasyRapport Posten holen' werden auch Daten des aktuellen Monats ins
Rapportierungsjournal gezogen, insofern ein Austrittsdatum beim Mitarbeiter vorhanden ist. Die Einrichtung des
'Periode Start Tag' erfolgt im Abrechnungskreis, im Register Akonto.
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Beispiel:
Mitarbeiter Peter Muster tritt am 31.08.2015 aus der Firma aus. Für die Lohnberechnung werden gewöhnlich
die Daten bis und mit 31.07.2015 aus z.B. SwissSalary EasyRapport ins Rapportierungsjournal übertragen.
Mit der Eingabe "Periode Start Tag" = 1 werden auch die für August erfassten Zeiten und Abwesenheiten
(Ferien, Überzeitkompensation, Absenzen etc.) ins Journal übertragen. Bei der Lohnverarbeitung Ende August
wird der im Austritt stehende Mitarbeiter bereits definitiv abgerechnet, inklusive der Saldierung aller offenen
Absenzen.

Diese Anpassung hat den Vorteil, dass bei einem Austritt alle Daten zur Verfügung stehen.
WICHTIG: Dies funktioniert nur, wenn der Kunde im Zeitpunkt der Lohnabrechnung (25. des Monats) bereits
sämtliche Absenzdaten bis Ende Monat erfasst hat.

7.1.1.6.1.3   Report Visumskontrolle | zusätzlicher Filter

Task #6535 | 5049.002

Der Report Visumskontrolle wurde um den Filter nur EasyRapport Daten erweitert.

7.1.1.6.1.4   Rapportierungsjournal | neue Spalten wählbar

Task #6259 | 5049.002

Auf Kundenwunsch hin haben wir das Rapportierungsjournal (analog der Lohnteile) mit der Spalte "Name
Vorname" erweitert. Somit kann auf der Rapportierungszeile neben der Personalnummer auch der Name des
Mitarbeiters eingeblendet werden.

Task #6824 | 5049.003

Betrifft ausschließlich Classic Client Versionen (NAV 2009 und älter).

Im Rapportierungsjournal können z.B. Spesen mit der gewählten Bankverbindung ausbezahlt werden. Dazu
kann die Spalte Bank Code ausgewählt werden. Bisher war nicht in jedem Fall ersichtlich, welche Bank die
korrekte Bank ist. Es werden nun zusätzlich die Spalten IBAN und Gültig bis angezeigt zur Auswahl.
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Task #6763 | 5049.003

Nach dem Erfassen mehrerer Rapportierungszeilen im Rapportierungsjournal wurde nach einer beliebigen
Warn- oder Fehlermeldung immer der selbe Name/Vorname angezeigt. Dies ist behoben, es wird nun wieder
der korrekte Name pro Personalnummer angezeigt.

Task #6931 | 5050.000

Im Rapportierungsjournal kann NEU als Info das Feld Herkunftsart eingeblendet werden. Somit kann klar
erkannt werden, wie die Rapportierung erstellt wurde (manuell oder via Datenimport).

Task #7035 | 5050.000

In den Lohnposten sowie im Rapportierungsjournal kann die Spalte Unique Record ID eingeblendet werden.
Somit kann unterschieden werden, ob die Daten manuell oder vom EasyRapport eingeflossen sind.

7.1.1.6.2    Lohn abrechnen

7.1.1.6.2.1   Testabrechnung | keine Infomeldung vor der Seitenansicht

Task #6804 | 5049.003

Beim Erstellen der Testabrechnung wird neu keine Anzeige mehr über die Anzahl abgerechneter Lohnposten
erstellt, sofern nur ein Mitarbeiter abgerechnet wird. Dies steigert die Effizienz in diesem Prozess.
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7.1.1.6.3    Lohn buchen

7.1.1.6.3.1   Buchungstext FIBU ergänzt mit Buchungsmonat (Zahl)

Task #6440 | 5049.002

Der Buchungstext FIBU kann neu mit einem weiteren Parameter übergeben werden: %6 ist neu für den
Buchungsmonat in Zahlen (immer zweistellig).

Bisherige Buchungstext-Optionen:
%1 = Abrechnungskreis
%2 = Buchungsdatum
%3 = Buchungsmonat (Text)
%4 = Buchungsjahr YYYY
%5 = Lohnlauf

Neue Option:
%6 = Buchungsmonat (Zahl)

Beispiel: 
Die Buchungstext-Parameter werden in den Lohnstammdaten gepflegt unter 'NAVIGATE' -> Übersetzung ->
System -> Buchungstext FIBU

Eingabe des folgenden Parameters:

Daraus resultiert dieser Buchungstext (im Feld 'Beschreibung'):

7.1.1.7    Lohnmeldung

7.1.1.7.1    ELM | Bei der UVG-Meldung wird nur 1 Person gemeldet

Task #6244 | 5049.002

Wurde die UVG-Meldung zusammen mit der AHV-/FAK-Meldung übermittelt, wurde bei der UVG-Meldung nur
ein Mitarbeiter (der erste Mitarbeiter) übermittelt. Dies kam in Einzelfällen vor, ist behoben.

7.1.1.7.2    ELM | Lohnausweis-Meldungen 'verschwinden' nach Lohn melden

Task #6242 | 5049.002

Bei der ELM-Meldung der Lohnausweise kam es in Einzelfällen vor, dass die Meldung zwar erfolgreich beim
Endempfänger (= Steuerbehörde) angekommen ist (Bestätigungs-Mail erfolgt), jedoch die Meldung selber in
unserer Lohnmeldung in keinem Stapel mehr sichtbar war. Die erfolgreiche Meldung sollte nach dem Lohn
melden unter "Antwort erhalten" erscheinen. Die Ursache dieses Problems war, dass die Übermittlung der
Lohnausweise länger dauert als bei anderen Meldungen. Damit die Meldung korrekt nach "Antwort erhalten"
verschoben werden kann, benötigen wir eine Rückmeldung des Distributors, welche jedoch in diesen Fällen nie
kam.
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Um dieser Herausforderung vorzubeugen, ist die Meldung neu im Stapel "In Bearbeitung" ersichtlich und wird
mit dem Prozess "Aktualisieren" korrekt in den Stapel "Antwort erhalten" verschoben. Kommt die
Rückmeldung schnell und korrekt, ist dieser Zwischenschritt nicht notwendig und die Meldung erscheint sofort
unter "Antwort erhalten".

7.1.1.7.3    ELM | QST-Meldung Nulldivision bei untermonatigem Ein-/Austritt

Task #7024 | 5050.000

Bei der Übermittlung der Quellensteuer-Daten mit ELM erschien bei der Aufbereitung eine Nulldivision-
Fehlermeldung bei ganz bestimmten Datums-Konstellationen. Die Fehlermeldung erscheint nur dann, wenn
das Ein- und Austrittsdatum um einen Tag verschoben hinterlegt wird, unabhängig des Austrittsmonats.

Hier ein Beispiel einer solchen Konstellation mit Eintrittsdatum Lohnbuchhaltung am 03.07.2015 und
Austrittsdatum am 02.08.2015:
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Erst bei der Übermittlung der QST-Daten wird eine Nulldivision aufgrund des Austrittsdatums erstellt:

Dieser Fehler wurde behoben. Selbstverständlich können untermonatige Ein- und Austritte mit allen möglichen
untermonatigen Datenwerten erfasst werden.

7.1.1.7.4    ELM | QST Lebenspartner Geburtsdatum

Task #6536 | 5049.002

Für eine minimale QST-ELM-Meldung der Lebenspartner-Informationen müssen zwingend folgende Felder des
Lebenspartners erfasst sein:

q Name des Lebenspartners
q Vorname des Lebenspartners
q Geburtsdatum des Lebenspartners

Ohne diese Angaben kann die QST-Meldung via ELM von einem "verheirateten" oder einem Mitarbeiter mit
"Eingetragener Partnerschaft" NICHT übermittelt werden. Wir prüfen diese Angaben bereits bei der Erfassung
bzw. neu auch beim Lohn abrechnen. Bisher gab es spätestens im ELM-Transmitter eine nichtssagende,
englische und rote Fehlermeldung.

Die swissdec hat in den vergangenen Monaten die Prüfmechanismen beim Distributor für einige QST-Kantone
verschärft. Bei diesen Kantonen müssen entgegen der ursprünglichen Meldung, dass Erfassungen der
Lebenspartner-Informationen erst per 01.01.2018 vollständig im System vorhanden sein müssen, sämtliche
Daten zur Einkommenssituation erfasst werden. Wir stehen mit der swissdec in Kontakt um Herauszufinden,
welche Kantone bereits jetzt mehr Informationen benötigen. Leider führt dies bei der ELM-Übermittlung zu einer
Fehlermeldung im ELM-Transmitter.

7.1.1.7.5    Lohnausweis

Task #6300 | 5049.002

Der 2 D-Barcode auf dem Lohnausweis wird ausschließlich mit dem neuen Barcode der swissdec-Version 4.0
gedruckt. Sie benötigen somit den ELM-Transmitter Version 4.0 sowie die Einrichtung in den Lohnstammdaten
auf Version 4.0 (SwissSalary Essentials). Das Drucken der Lohnausweise mit der bisherigen Lösung der
Version 3.0 ist nicht mehr möglich.

Kunden, welche bereits per Anfang Jahr Ihre ELM-Meldungen mit der Version 4.0 übermittelt haben, brauchen
nichts zu unternehmen.
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Task #6266 | 5049.002

Der Hyperlink beim Lohnausweis wird neu sprachabhängig auf diese Links verwiesen:

DE | https://www.estv.admin.ch/estv/de/home/direkte-
bundessteuer/dienstleistungen/formulare/lohnausweis.html
FR | https://www.estv.admin.ch/estv/fr/home/direkte-bundessteuer/dienstleistungen/formulare/lohnausweis.html
IT | https://www.estv.admin.ch/estv/it/home/direkte-bundessteuer/dienstleistungen/formulare/lohnausweis.html

Task #6766 | 5049.003

Der Schweizer Lohnausweis wird auch im Fürstentum Liechtenstein verwendet. Jedoch kennt die
Steuerverwaltung keinen 2 D-Barcode für das automatische Scanning. Bisher wurde nicht geprüft, ob der
Lohnausweis für eine Firma in der Schweiz oder für eine Firma im Liechtenstein erstellt werden muss. Dies
gab jeweils ein Fehler bei der Erstellung des Lohnausweises.

Neu wird der 2 D-Barcode nicht mehr erstellt, sofern die Lohnbuchhaltung auf Liechtenstein gestellt ist
(Lohnstammdaten).

7.1.1.8    Verwaltung

7.1.1.8.1    EasyRapport | Gruppe mit neuem Feld 'gesperrt'

Task #7068 | 5050.000

Neu kann in der EasyRapport Gruppe ein 'gesperrt' Häkchen gesetzt werden. Ist eine Gruppe gesperrt, dann
wird diese bei der Zuordnung der entsprechenden Mitarbeiters ausgefiltert. Dasselbe gilt auch bei der Funktion
'EasyRapport Daten holen'. 

7.1.1.8.2    Abrechnungskreis | Periode Startdatum

Task #6782 | 5049.003

Im Abrechnungskreis kann neu der Periode Start Tag gesetzt werden. Anhand dieses Datums kann der
Abrechnungszeitraum Monats verschoben berechnet werden. So kann beispielsweise wie bisher vom 01.08. -
31.08. neu vom 16.08 bis 15.09 gerechnet werden. Es werden nur Rapportzeilen innerhalb dieses Zeitraumes
berechnet.

Die Einstellung erfolgt im Abrechnungskreis -> Register 'Akonto' -> Feld Periode Start Tag.

Siehe auch die Erläuterungen unter folgendem Menüpunkt: EasyRapport Posten holen | Neue Funktion mit
Stichdatum bei Austritt

https://www.estv.admin.ch/estv/de/home/direkte-bundessteuer/dienstleistungen/formulare/lohnausweis.html
https://www.estv.admin.ch/estv/de/home/direkte-bundessteuer/dienstleistungen/formulare/lohnausweis.html
https://www.estv.admin.ch/estv/fr/home/direkte-bundessteuer/dienstleistungen/formulare/lohnausweis.html
https://www.estv.admin.ch/estv/it/home/direkte-bundessteuer/dienstleistungen/formulare/lohnausweis.html
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Wir empfehlen ausschließlich das Abrechnungsverfahren Akonto, da dieses am flexibelsten und einfachsten
zu bedienen ist.

7.1.1.8.3    Absenzen Anspruch | Sofort Ferien-Kürzung bei Austritt | Berechnung Feiertage

Task #6682 | 5049.003

Viele Kunden haben gewünscht, dass z.B. die Ferienkürzung bei einem Personalaustritt nicht erst im
Austrittsmonat gekürzt wird, sondern bereits im Zeitpunkt der Kündigung, sobald ein Austrittsdatum gesetzt
wird. Wir haben diesen Wunsch nun umgesetzt. Im Absenzen Anspruch kann neu gewählt werden, wann die
Kürzung erfolgen soll.

Option:
q  bei Ereignis (wie bisher erst im Austrittsmonat)
q  sofort (neu, nach Setzen des Austrittsdatums)

Task #6741 | 5049.003

Sofern im Absenzen Anspruch im Reiter Feiertage eine Anspruchs-Lohnart erfasst wurde, gab es eine
Fehlberechnung.

Task # 6681 | 5049.003

Die automatische Ferienkürzung hatte einen Fehler, sofern der Mitarbeiter im gleichen Jahr ein- und
ausgetreten ist.

7.1.1.8.4    Offene Datenimport-Schnittstelle | Vorzeichen per Spalte wählen

Task #6173 | 5049.001

In der Offenen Datenimport-Schnittstelle ist es NEU möglich, dass zusätzlich bei den Feldern Anzahl, Ansatz
und/oder Betrag, mit einer weiteren Spalte das Vorzeichen (oder der Faktor) beeinflusst werden kann. Einige
Zeiterfassungssysteme übergeben in einer separaten Spalte die Information, ob der zu importierende Wert
positiv oder negativ ist. Damit in SwissSalary der Import möglich wird, gibt es neu die Zuordnung Faktor bei
den ob genannten Feldern.

Beispiel mit dem Faktor -1 im Zuordnungsfeld Anzahl. Damit wird der importierte Wert x -1 berechnet.
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7.1.1.9    Berichte

7.1.1.9.1    Absenzenquote | Lohnaufwand in CHF

Task #6828 | 5049.003

Der Bericht Absenzenquote weist die Absenzen in Stunden aus. Auf Wunsch vieler Kunden werden die
Stunden auch mit dem Lohnansatz des Mitarbeiters verknüpft. Somit erhält man neben der Absenzen in
Stunden auch den Lohnaufwand in CHF. Dieses Detail wird pro Absenz und Gesamttotal ausgewiesen.

7.1.1.9.2    Altersstruktur | FTE in Totalen auch in Dezimal anzeigen

Task #6693 | 5049.003

Der Bericht Altersstruktur hat diverse Totale. Bisher wurden die Totale der Spalte FTE im Gegensatz zu den
Einzelposten als Ganzzahl ausgegeben. Mit der Option 'Rekapitulation' ist dies korrekt, in der Auswertung
'Funktion' und 'Mitarbeiter' jedoch nicht. Die Totale werden nun auch korrekt ausgewiesen.

7.1.1.9.3    Berichte Allgemein | RTC | Sortierung nach Text

Task #6732 | 5049.003

Die Sortierung unter Berichte Allgemein wird neu auch gespeichert (rollenbasierter Client). Dies bedeutet, dass
Reports nun auch von A-Z sortiert werden können, was die Übersichtlichkeit massiv steigert.
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7.1.1.9.4    Beschäftigungsstatistik BESTA | diverse Fehler behoben

Task #5851 | 5049.003

Die BESTA-Statistik wurde grundlegend überarbeitet. Es gab in seltenen Fällen Differenzen, wenn die
Auswertung zu einem unterschiedlichen Stichtag erstellt wurde. Dieser Fehler ist behoben.

Task #6776 | 5049.003

Beim Erstellen der Beschäftigungsstatistik erschienen in den Versionen NAV 2013, NAV 2013 R2, NAV 2015
und BAU 2015 unterschiedliche, für den Anwender unerklärliche Fehlermeldungen. Die Fehler sind jedoch nur
dann aufgetreten, wenn ein Häkchen bei der Ausgabe ins Textfile gesetzt wurde. Dieses Problem ist behoben
worden in allen betroffenen NAV-Versionen.

Task #6797 | 5049.003

Ein weiterer Fehler in der Beschäftigungsstatistik betraf die Grenzgänger. In einzelnen Fällen wurde das
Häkchen 'keine Grenzgänger' automatisch gesetzt, obwohl in der Anzahl Grenzgänger vorhanden waren.
Dieser Fehler wurde behoben.

7.1.1.9.5    CH-Lohnstrukturerhebung - LOGIB | alter Bericht entfernt

Task #6411 | 5049.002

Der bisherige Bericht CH-Lohnstrukturerhebung wurde entfernt. Die CH-Lohnstrukturerhebung (LSE) melden
Sie bitte alle zwei Jahre via ELM per Knopfdruck. Die Möglichkeit der Erstellung der LOGIB-Datei ist nicht
mehr möglich. Sie können nach der erfolgreichen Meldung der LSE-Datei via ELM beim Bundesamt für
Statistik eine LOGIB-konforme Datei verlangen. Siehe dazu die weiterführenden Informationen unter folgendem
Link: http://www.ebg.admin.ch/dienstleistungen/00017/index.html?lang=de

7.1.1.9.6    Lohnartenliste A4H und A4Q | Filter auf Lohnlauf möglich

Task #6610 | 5049.003

Die beiden Auswertungen können neu mit dem Lohnlauf Filter gefiltert werden. Somit gibt es neben dem
bestehenden Datum Filter noch einen detaillierteren Filter.

http://www.ebg.admin.ch/dienstleistungen/00017/index.html?lang=de
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7.1.1.9.7    Lohnsumme Holding | Kantonskürzel

Task #6871 | 5050.000

Auf dem Bericht Lohnsumme Holding wird nun ebenfalls der Kantonskürzel angedruckt.

7.1.1.9.8    Personal-Historie | Spaltenbreite der Felder Benutzername und Datum angepasst

Task #6744 & Task #6706 | 5049.003

Im Personal-History-Report wurden die Spalten Benutzername und Datum erweitert, damit auch längere Logins
(Windowslogins) korrekt angezeigt werden können.

7.1.1.9.9    Sunet Absenzen-Schnittstelle | Neu mit Fehlzeitenimport

Task #7076 | 5050.000

NEU kann im SuNet Plus auch eine Absenzen-Schnittstelle genutzt werden, analog wie mit UKA. 

In den nachfolgenden Links finden Sie die nötigen Informationen für den Fehlzeitenimport (detaillierte Doku von
BBT Software AG). Dieser Fehlzeitenimport ist ab der Sunet Version 2041 möglich.

Konfiguration Fehlzeitenimport: 
http://www.sunet.ch/webhelp/de/SunetplusHilfe_Left.htm#CSHID=700140|StartTopic=Content%
2FKonfiguration_Fehlzeitenimport.htm|SkinName=WebHelp

Codemapping Tabellen:
http://www.sunet.ch/webhelp/de/Content/Code-Mapping-Tabellen_Fehlzeitenimport.htm

Fehlzeitenimport:
http://www.sunet.ch/webhelp/de/SunetplusHilfe_Left.htm#CSHID=700141|StartTopic=Content%
2FFehlzeitenimport.htm|SkinName=WebHelp

http://www.sunet.ch/webhelp/de/SunetplusHilfe_Left.htm#CSHID=700140|StartTopic=Content%2FKonfiguration_Fehlzeitenimport.htm|SkinName=WebHelp
http://www.sunet.ch/webhelp/de/SunetplusHilfe_Left.htm#CSHID=700140|StartTopic=Content%2FKonfiguration_Fehlzeitenimport.htm|SkinName=WebHelp
http://www.sunet.ch/webhelp/de/Content/Code-Mapping-Tabellen_Fehlzeitenimport.htm
http://www.sunet.ch/webhelp/de/SunetplusHilfe_Left.htm#CSHID=700141|StartTopic=Content%2FFehlzeitenimport.htm|SkinName=WebHelp
http://www.sunet.ch/webhelp/de/SunetplusHilfe_Left.htm#CSHID=700141|StartTopic=Content%2FFehlzeitenimport.htm|SkinName=WebHelp
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7.1.1.9.10    BAU

7.1.1.9.10.1   ARGE-Weiterverrechnung und Interne Weiterverrechnung | überarbeitet

Betrifft ausschliesslich Kunden der Versionen BAU NAV 5.00 SP1 sowie BAU NAV 2015! 

Task #1584 | 5049.003

ARGE-Weiterverrechnung | Andruck der Lohnklasse pro Mitarbeiter
Im Bericht ARGE-Weiterverrechnung wird neben der Personalnr. und Name Vorname neu auch die Lohnklasse
angedruckt.

Task #6581 | 5049.003

Layout der Berichte ARGE-Weiterverrechnung und Interne Weiterverrechnung angepasst
Das Layout der beiden Berichte wurde für NAV 2015 (BAU) überarbeitet, analog den Berichten im NAV 5.00
SP1 (BAU) (technisch: NAV 2009).

Task #6748 | 5049.003

Diverse Anpassungen am Report ARGE-Weiterverrechnung
Beim Bericht ARGE-Weiterverrechnung wurden die folgenden drei Pendenzen umgesetzt:

q  Der Text bei 'Beschreibung' erscheint nicht mehr doppelzeilig, sondern wird korrekt ausgeschrieben
q  Seitenzahlen und Seitentitel haben teilweise gefehlt, diese werden nun korrekt angedruckt
q  Zusatztexte werden angedruckt

Task #6997 | 5050.000

Neu kann auf dem Report 'Interne Weiterverrechnung' das Gesamttotal unterdrückt werden.



Seite 355

7.1.1.9.10.2   Gesuch BBF SBV 2008 ausgebaut

Betrifft ausschliesslich Kunden der Versionen BAU NAV 5.00 SP1 sowie BAU NAV 2015! 

Task #6735 | 5049.003

Das Formular Gesuch Berufsbildungsfonds SBV 2008 wird schon seit längerer Zeit nicht mehr benötigt.
Gemäss Auskunft des SBV (Schweizerischer Baumeisterverband) gilt ausschließlich nur noch das
Leistungsgesuch Parifonds BAU. Der Report wurde entfernt.

7.1.1.9.10.3   NAV 2015 | PIS Berichte angepasst

Task #6596 | 5050.000

Verschiedene PIS-Berichte wurden im NAV 2015 angepasst und hinzugefügt.

7.1.1.9.10.4   Parifonds Rückerstattung | auch in NAV 2015 möglich

Betrifft ausschließlich die Version BAU 2015!

Task #6439 | 5049.002

Der Report "Parifonds Rückerstattung" kann nun auch im SwissSalary BAU in der Version NAV 2015 gedruckt
werden.

7.1.1.9.11    QST-Berichte und Schnittstellen werden entfernt

Vorinfo für 5050.001

Im Update 5050.000 sind die folgenden QST-Berichte und -Schnittstellen das letzte Mal enthalten:

q  Quellensteuer / Gemeinde
q  Quellensteuer / Gemeinde GR
q  ISEL GE
q  Passerelle VD
q  Bescheinigung TI

Diese Auswertungen bzw. Schnittstellen sind seit der Einführung von swissdec Version 4.0 und dem
automatisierten Senden der QST-Abrechnung nicht mehr notwendig. Die ISEL GE-Schnittstelle darf NICHT
mehr verwendet werden, die Passerelle VD-Schnittstelle wird per Ende 2015 eingestellt. Die Bescheinigung TI
kann neu direkt aus iFonte gedruckt werden.

Bitte beginnen Sie möglichst noch heute mit der monatlichen Meldung der QST via ELM!

7.1.1.10    Fehlerbehebungen

7.1.1.10.1    Personal

Task #5868 | 5049.002

Lohnpostentyp und Layout im RTC korrigiert
In den Lohnposten konnte man in der RTC-Version den 'Lohnpostentyp':

alle Buchungen, Zulagen, Abzug, Spesen, AG Beitrag, fiktive Lohnarten

nicht korrekt filtern. Dieser Bug wurde behoben.
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Zudem wurde das Layout der Lohnposten komplett überarbeitet. Die Analyse erfolgt nun viel einfacher und
übersichtlicher.

7.1.1.10.2    Lohnarten

Task #6239 | 5049.002

In den RTC-Versionen konnte man in der Listenansicht das Feld Anteil 13. Lohn nicht auswählen. Irrtümlich
war ein anderes Feld vorhanden (14. Lohn inaktiv).

Task #7005 | 5050.000

Der Ansatz auf der Lohnart kann mit beliebigen Dezimalstellen hinterlegt werden. Leider wurden diese nicht
richtig ins Rapportierungsjournal übertragen. Beispielsweise wurden statt 5 Kommastellen nur 4 übernommen.
Dies ist nun korrigiert.

Task # 6982 | 5050.000

KST-Einrichtung im RTC ohne Spalte 'Lohnart'
Bei den Lohnarten konnte im Gegensatz zu den Classic-Client-Versionen, in der Bebumatrix Gruppen-
Einrichtung im RTC die Spalte Lohnart nicht eingeblendet werden.

Die Lohnart kann nun auch in allen RTC-Versionen eingeblendet werden. Dies erleichtert die Suche und
Anpassung der Dimensionen auf den Lohnarten.

7.1.1.10.3    Lohnstammdaten

Task #6255 | 5049.002

UKA | UVG-Kundennummer wird nicht korrekt abgefüllt
Die UKA-Schnittstellen referenzierten noch auf die alte UVG Kundennummer. Dieses Feld gibt es nicht mehr.
Die Verbindung zum neuen Feld wurde hergestellt.

Task #2825 | 5049.002

Die Berechnung des Sozialfonds bei einem Rentner, welcher innerhalb des Jahres pensioniert wurde, erfolgte
in Einzelfällen nicht richtig. War als Basis die AHV-Basis berücksichtigt, wurde der Rentenfreibetrag
rückwirkend per 01.01. des Jahres abgezogen für die Basenberechnung (statt erst ab Rentenbeginn). Durch
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die Eingabe des Berechnungsdatums in den Sozialleistungen beim Sozialfonds konnte das Problem temporär
geflickt werden. Die Berechnung wurde überarbeitet und erfolgt nun wieder korrekt.

Task #6112 | 5049.003

Bei Sozialfonds-Abzügen gab es eine Herausforderung bei Rentnern (Freibetrag), sofern diese mehrere
Lohnläufe pro Monat hatten. SwissSalary hat irrtümlicherweise den Abzug vom ersten Lohnlauf wieder
zurückerstattet.

7.1.1.10.4    Lohnlauf

Task #6639 | 5049.003

Mit PreUpdate 5049.002 wurde ein Bug eingeschleust, welcher beim Lohn buchen folgende Fehlermeldung
enthielt:
Personalnummer leer existiert nicht

In seltenen Konstellationen wurde ein leerer Datensatz in den Lohnposten erstellt, welcher manuell gelöscht
werden musste.

Task #6534 | 5049.002

Überflüssige Arbeitgeber-Rückstellungen mit CHF 0 werden nicht mehr geschrieben
Irrtümlicherweise wurden seit der Version 5049.000 zusätzliche Arbeitgeber-Rückstellungen mit CHF 0.00
erstellt, welche keinen Einfluss auf irgendwelche Berechnungen und/oder Auswertungen hatten. Dies war noch
ein Bug aus der swissdec-Zertifizierung der Version 4.0. Ab sofort werden nur noch die Rückstellungen
gebildet, die auch korrekt sind.

Task #6247 | 5049.002

Elektronischer Versand der Lohnabrechnung | Feld auf 50 Zeichen verlängert
Beim Versand der Lohnabrechnung via E-Mail (z.B. via IncaMail) erschien eine Fehlermeldung, sofern der
Benutzername größer als 20 Zeichen war. Das Feld wurde von 20 auf 50 Zeichen erweitert (ab der NAV-
Version 2013). Konsequenterweise wurden in der Folge alle User ID-Felder auf 50 Zeichen erweitert.
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Task #6152 | 5049.001

Bei der Verwendung des Reports Visum Kontrolle erschien eine Fehlermeldung, sofern die Auswahl
EasyRapport Import gewählt wurde. 

Task #6964 | 5050.000

In der BAU-Version NAV 2015 wurden im Rapportierungsjournal der Name der Kostenstellen (Baustellen) nicht
angezeigt bei der Rapportierung.

Task #6269 | 5049.002

In der Version NAV 2013 R2 konnte es vorkommen, dass während der Rapportierung das Journal gewechselt
wurde und dann die folgende Fehlermeldung erschien:

Dieser Fehler trat auf, falls den einzelnen Journalen unterschiedliche Abrechnungskreise zugeordnet waren und
nur dann, wenn das neu ausgewählte Journal noch ganz leer war. Nachdem die Fehlermeldung mit OK
bestätigt wurde, wurde die Seite geschlossen.

7.1.1.10.4.1   Quellensteuer

Task #6185 | 5049.001

Seit Update 5048.000 vom Dezember 2013 werden die Konfessionen als Optionen angeboten. Vorher waren
dies frei definierbare Tabellenwerte. Die Konfessionen sollten ausschließlich im Zusammenhang mit der
Anmeldung von quellensteuerpflichtigen Mitarbeitern verwendet werden. Alle anderen MitarbeiterInnen sollte der
Wert "Andere/Keine" (Standardwert) zugewiesen sein.

Für die QST sind nur folgende Konfessionen von Bedeutung:

- Evangelisch-reformierte Kirche
- Römisch-katholische Kirche
- Christ-katholische Kirche
- Israelitische Kultusgemeinde
- Andere/Keine

Diese Konfessionen sind neu mit der Kennzeichnung (qsP) versehen. Die weiteren Konfessionen werden zu
einem späteren Zeitpunkt aus der Liste entfernt.

Der Text Israelitische Kultusgemeinschaft wurde in Israelitische Kultusgemeinde geändert.
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Task #6146 | 5049.001

Beim Erfassen des Lebenspartners in der Personalkarte (bei verheirateten quellensteuerpflichtigen
Mitarbeitern) gab es im rollenbasierten Client in seltenen Fällen eine Fehlermeldung. Dabei wurde die Karte
komplett geschlossen.

Task #6208 | 5049.001

Wenn bei einem QST-pflichtigen Mitarbeiter das Quellensteuerpflichtig-Häkchen entfernt und neu gesetzt wird,
dann wird auf der Personalkarte -> Reiter 'Personalien' der Kanton von EX auf den entsprechenden QST-CH-
Kanton gestellt. Dies ist kein Problem bei MitarbeiterInnen, welche in der Schweiz wohnen. Falls die
Wohnadresse jedoch im Ausland liegt, muss der Kanton auf 'EX' und der Ländercode z.B. auf DE gesetzt sein.
Die PLZ/Steuergemeinde ist in diesem Fall immer der Arbeitsort des Mitarbeiters.

Der Kanton wird bei dieser seltenen Manipulation nicht mehr zurückgesetzt. Kontrollieren Sie sicherheitshalber
bei Mitarbeitern mit Wohnadresse im Ausland, dass beim Kanton (NICHT QST-Kanton) immer noch EX steht.
Falls nicht, bitte korrigieren.

Task #6241 | 5049.002

Bei QST-pflichtigen Mitarbeitern mit untermonatigem Austritt wurde das QST-Berechnungsdatum für die
Tarifbestimmung (Hochrechnung) gemäß dem Eintrittsdatum der Lohnbuchhaltung verwendet und nicht per
Kalenderbeginn.

Task #6201 | 5049.002

Bei rückwirkenden Quellensteuer-Korrekturen, sofern der Kanton auf der TimeMachine rückwirkend geändert
wurde, führte dies zu Anzeigeproblemen auf den Quellensteuer-Abrechnungen (auf Papier).

Task #6840 | 5049.003

Bei mehreren Nachzahlungen nach einem Personalaustritt (d.h. über mehrere Monate), wurde die Lohnart
bereits in Abzug gebrachte QST nicht mehr berücksichtigt (nur bei der ersten Nachzahlung).

Task #6671 | 5049.003

Der Kanton TI kennt die Berechnungsart Jahr ausgeglichen. Seit Update 5049.000 wurde die Bezugsprovision
des Arbeitgebers nicht mehr berechnet. Dieser Fehler ist behoben.

Task #1610 | 5049.003

Die Quellensteuerabrechnung Kanton hatte in seltenen Konstellationen einen 'Schönheitsfehler' im
Drucklayout. Falls der letzte druckbare Mitarbeiter ganz am Schluss der Abrechnung erschien, wurde am
Ende dieser Seite kein 'Zwischentotal' mehr gedruckt, die Rekap-Daten erscheinen dann auf der nächsten
Seite, jedoch ohne Seitennummerierung.
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Task #6765 | 5049.003

Bei der QST-Abrechnung/Jahr wurde im PreUpdate 5049.002 die Tarifänderung nicht mehr korrekt
berücksichtigt. Auf der Abrechnung erschien nur der QST-Abzug vor der Tarifänderung.

Task #6798 | 5049.003

Ist ein quellensteuerpflichtiger Mitarbeiter im Vorjahr ausgetreten und hat im Folgejahr noch eine Nachzahlung
erhalten, so wurde die QST-Belastung falsch berechnet. Dies ist behoben, der Tarif wird immer im Zeitpunkt
des Austritts gezogen.

Task #6686 | 5049.003

SwissSalary prüft bei beim Lohn abrechnen, ob die QST-Bezugsprovision beim Kanton erfasst ist <>0.

Task #7079 | 5050.000

Quellensteuer mit Periodenausgleich und TimeMachine
Mit der Einführung der TimeMachine gab es Probleme mit der Rückrechnung bei der QST, sofern in einem
Monat mehrere Lohnläufe erstellt wurden.

Zudem funktioniert die TimeMachine neu auch bei der Berechnungsart "Jahr" (Kantone VD, FR, GE und VS).
Das Quellensteuer-Berechnungsdatum wird in einem der nächsten Updates entfernt. Bitte ausschließlich QST-
Korrekturen via TimeMachine ausführen.

Hinweis:
Verwendung der TimeMachine beim QST-Kanton TI noch im Test (nur bei der Berechnungsart Jahr
ausgeglichen).

Task #7080 | 5050.000

Auf der Lohnabrechnung war die Übersichtlichkeit bei QST-Korrekturen nicht gewährleistet. Die
Korrekturmonate wurden durcheinander auf der Lohnabrechnung dargestellt. Neu erscheinen diese pro Monat
aufsteigend sortiert.

Task #7081 | 5050.000

Bei Quellensteuer-Korrekturen wird neu auf der Lohnabrechnung auch bei der Lohnart Quellensteuer Korrektur
der QST-Tarif angezeigt. Dies dient der besseren Übersicht. Sollten Sie den Tarif nicht sehen können, müssen
Sie den Originaltext der Lohnart entsprechend kürzen, der QST-Tarif erscheint am Schluss des Textes.
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7.1.1.10.5    Lohnmeldung

Diese Fehlerbehebung betrifft ausschliesslich die NAV-Versionen von NAV 3.70 - 5.00 SP1!

Task #6207 | 5049.001

Die Anzahl ELM-Meldungen im Status "Freigabe ausstehend" und "Antwort ausstehend" blieben ersichtlich,
obschon erledigt. Beim Löschen mit 'X' waren diese zwar nicht mehr sichtbar, als Anzahl wurden diese aber
immer noch gezählt. Dabei handelte es sich um einen falsch gesetzten Filter im Hintergrund.

Diese Fehlerbehebung betrifft ausschliesslich die RTC Versionen!

Task #6210 | 5049.001

Im RTC blieben in der Ansicht "Freigabe ausstehend" Datensätze hängen, sofern die ELM-Übermittlung in
französischer Sprache vorgenommen wurde. Das Problem war eine fehlerhafte Übersetzung mit einem
Apostroph, welcher sich negativ auf einen Filter ausgewirkt hat.

Task #6252 | 5049.002

Bei Mitarbeitern mit unterjährigem Aus- und Wiedereintritt im selben Jahr wurde die AHV- und FAK-Periode via
ELM nicht korrekt gemeldet. Die AHV- und FAK-Abrechnung auf Papier hingegen hatte immer die korrekten
Daten der beiden Perioden angezeigt. Im XML war nur die 2. Periode (ab Wiedereintritt) verfügbar. Bei der AHV
war dies unproblematisch, da hier trotzdem die ganze Lohnsumme der ganzen Periode gemeldet wurde. Bei
der FAK hingeben wurde konsequent nur noch die 2. Periode gemeldet.

Gibt es neu mehrere Ein-/Austritte und Wiedereintritte im selben Jahr werden die einzelnen Perioden korrekt
via ELM gemeldet.

Task #6319 | 5049.002

Kunden und Partner hatten bei der ELM-QST-Übermittlung im Februar/März 2015 festgestellt, dass der QST-
Betrag falsch via ELM übermittelt wird, sofern für den Mitarbeiter im gleichen Monat zwei oder mehrere
Lohnläufe erstellt werden. In der ELM-XML-Datei wird die QST-Lohnsumme zusammengezogen, der
satzbestimmende Tarif neu gerechnet und die bereits bezahlte QST abgezogen. In den Lohnposten und auf der
Lohnabrechnung ist alles OK, jedoch im XML wurden die beiden Positionen zusammengezählt statt
abgezogen!

Dieser Fehler wurde bereits in einem Hotfix zur Version N5049.001 korrigiert und wurde offiziell mit 5049.002
ausgeliefert.
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7.1.1.10.6    Berichte

Task #6246 | 5049.002

Vergütungsauftrag DTA
Beim Aufruf des Berichts Vergütungsauftrag DTA konnte es zu einem "OutOfMemory"-Fehler kommen, sofern
das Logo auf der Lohnabrechnung zu viel Speicherplatz benötigte.

Der Vergütungsauftrag DTA (Report 3009126) ist ein 2-seitiger Report, welcher einerseits die Anzahl
Zahlungsrecords zählt und ausweist und zusätzlich auch das Firmenlogo aus den Lohnstammdaten andruckt.
Wenn dieses Logo zu gross ist, führt dies zu diesem "OutOfMemory"-Fehler.

Task #6090 | 5049.003

DTA-Datei
In seltenen Fällen kam es vor, dass in der DTA-Datei (ausschließlich bei Kunden mit NAV 2013) ein Problem
aufgetreten ist mit Umlauten. Das Problem konnte gelöst werden, die Umlaute werden wieder korrekt erstellt in
der Datei.

Sollten Sie Probleme mit Umlauten in der DTA-Datei haben, stellen Sie bitte das Datei-Format in den
DTA/EZAG-Stammdaten auf 'ASCII + Umlaute anpassen'.

Task #6308 | 5049.002

Lohnerhöhungsliste | Gruppendurchschnitt wird nicht richtig angezeigt
Bei der Erstellung der Lohnerhöhungsliste wurden die Beträge in der Zeile 'Gruppendurchschnitt' nicht richtig
ausgewiesen. D.h. in der Kolonne Lohnansatz sowie Lohnansatz Betrag wurde der Betrag vom Vorjahr
angedruckt.

Task #6823 | 5050.000

Die Jubiläumsliste wurde überarbeitet. Der Datumsfilter bei der Berechnung pro Rata funktionierte nicht korrekt
und bei der Auswahl der Abrechnungsperiode wurde immer ein Jahr zu viel berechnet.

Task #6332 | 5049.002

Beim Druck der EasyRapport Karte wurde in den RTC-Versionen die zusätzlichen Saldi (Ferien, Überstunden
etc.) nicht angedruckt. Dies wurde angepasst und zusätzlich werden auch die Bemerkungen korrekt
angedruckt.
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Task #6155 | 5049.001

Je nach Eingabe des Datumsfilters auf der Jubiläumsliste wurde eine unterschiedliche Anzahl Dienstjahre
angezeigt mit zum Teil verschiedenen Mitarbeitern.

Task #7004 | 5050.000

Der Bericht  Beschäftigungstatistik/Betriebszählung gab in der Druckausgabe beim Datum im Titel eine
unschöne Anzeige aus. In der Seitenvorschau sah das Datum noch korrekt aus:

Beim Ausdruck wurde die Jahrzahl nicht mehr angezeigt (je nach Version ist die Anzeige unterschiedlich).

Der Titel wird nun in sämtlichen NAV-Versionen korrekt angezeigt.

Task #6314 | 5049.002

Unter Punkt 4.1 der BESTA-Statistik wurde die Anzahl nicht ins Feld gedruckt (Fehler im Layout).

Task #6971 | 5050.000

Beim Parifonds Bau Leistungsgesuch waren in der französischen Ausgabe einige Felder leicht verschoben und
deshalb wurde der Text bei Punkt 1 jeweils abgeschnitten. Das Formular wurde überarbeitet, damit der Text
passt. Zudem wurden die Texte gemäss dem offiziellem Formular angepasst.

Task #7045 | 5050.000

Die Telefonnummer wurde im Parifonds BAU Gesuch nicht richtig angedruckt, wenn die Telefonnummer mit der
internationalen Vorwahl hinterlegt wurde (z.B. +41). Das System kann nun diese internationalen
Telefonnummern mit Vorwahl umwandeln, und die Telefonnummern erscheinen korrekt und ohne Vorwahl auf
dem Formular.
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Task #6245 | 5049.002

In den Versionen NAV 2013, NAV 2013 R2 sowie NAV 2015 wurde bei einigen Reports (KTG-Abrechnung,
UVGZ-Abrechnung sowie AHV-freie Löhne) die Kopfzeilen im "Drucklayout" (und somit auch auf dem
Ausdruck) gar nicht oder nur lückenhaft gedruckt.

Task #6243 | 5049.002

In den RTC-Versionen wurde der Seitenumbruch vom Bericht Persönliches Jahreslohnkonto  falsch angezeigt.

Task #7006 | Update 5050.000

Der Report Persönliches Lohnkonto A4Q zeigte auf der Rekap (Total pro Mandant) falsche Beträge an. Die
Situation traf nur dann ein, wenn bei den Optionen die beiden Häkchen inkl. Spesen LA und inkl. AG Beitrag
LA NICHT gesetzt waren:

Auf der Rekap wurden gewisse Beträge von einer Zeile auf die nächste kopiert, obwohl diese einen ganz
anderen Betrag anzeigen sollten. Ebenso wurden leere Zeilen runter kopiert, obwohl es für die betroffene
Lohnart einen Lohnposten gäbe. Diese Fehler wurden behoben, so dass keine falschen Einträge/Zeilen mehr
auf der Rekap erscheinen.

Betrifft ausschliesslich RTC Versionen!

Task #6588 | 5049.003

Im Bericht Personal Historie war die Sortierung zum Teil unübersichtlich. Es konnte weder nach Datum noch
nach Personalnummer gefiltert werden. Zudem wurde nicht automatisch auf den gewählten Mitarbeiter gefiltert.

Task #6749 | 5050.000

Der Bericht 'Personal PIS Blatt' wurde in der RTC-Versionen überarbeitet und angepasst, damit alle
gewünschten Felder angedruckt werden.
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7.1.1.10.6.1   Lohnabrechnung

Task #6140 | 5049.001

Auf der definitiven Lohnabrechnung (nur bei Verwendung der Akontozahlung im RTC) wurde der Akontobetrag
irrtümlich zweimal ausgewiesen (Anzeigeproblem). Sowohl bei der Zeile Lohnart (i.d.R. 8810) sowie bei der/n
Zeile/n mit der Vergütung auf die Bank.

Der Fehler ist behoben, der Akontobetrag wird wieder korrekt gedruckt:

Task #6253 | 5049.002

In den RTC-Versionen wurde auf den Lohnabrechnungen der Minus Zahltag nicht korrekt angezeigt. Die
Berechnung sowie die Lohnposten waren richtig, jedoch erfolgte kein Andruck auf der Lohnabrechnung.

Task #6218 | 5049.002

Wurde die Lohnabrechnung über den Stapeldruck gedruckt (d.h. mit allen anderen Mitarbeitern), erschien eine
falsche Seitenzahl bei mehrseitigen Lohnabrechnungen.

Task #6103 | 5049.003

Sofern in der Übersetzung der Lohnart eine Zeile angelegt wurde, jedoch ohne Text (leer), so wurde die Lohnart
im RTC-Client auf dem Lohnbeleg gar nicht angedruckt. Jedoch wurde der Betrag im Totalbetrag eingerechnet.

Die Lohnabrechnung in den RTC-Versionen wurde überarbeitet. Neu wird die Lohnart ohne Text auch
ausgewiesen, so dass die Totalisierung nachvollziehbar ist. Im nachfolgenden Beispiel ist dem Personalkarte
der Sprachcode ENU (Englisch) zugeordnet worden.
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Task #6883 | 5049.003

Sofern in den Lohnbemerkungen Texte erfasst wurden mit Prozentzeichen (%) erschien je nach NAV-Version
eine Fehlermeldung. Dieser Fehler trat in Kombination mit einer Neuerung im SwissSalary Direct auf.
Prozentzeichen werden im NAV als Platzhalter verwendet.

Betrifft ausschliesslich Kunden mit der BAU-Version NAV 2015!

Task #7018 | 5050.000

Bei der Lohnverarbeitung mit Akontolohn wurde in einzelnen Fällen die Lohnart 881 = Akontozahlung, doppelt
aufgeführt auf der Lohnabrechnung.

7.1.1.11    Hinweise für unsere SwissSalary NAV-Partner

7.1.1.11.1    Migrations-Report überarbeitet

Task #6562 | 5049.002

Beim Daten-Migrations-Report wurde festgestellt, dass einige Felder im Hintergrund gelöscht wurden und
somit der Report nicht mehr richtig ausgeführt werden konnte. Folgende alte Felder sind ab dem PreUpdate
5049.002 gelöscht:

Table 'SwS Payroll Setup':
"Tmp swissdec V4 Update"                   // DELETED Field 2000
"UVG Kundennummer"         // DELETED Field 431
"UVG Versicherernummer"                        // DELETED Field 432
"UVG Vertragsnummer"                           // DELETED Field 430
"UVG Adresse"                                  // DELETED Field 439
"UVG ELM"                                    // DELETED Field 450
SUVA                                        // DELETED Field 440
"Soll Jahresstunden"                            // DELETED Field 1605
"Lohnausweis Position I"                      // DELETED Field 1650
"Lohnausweis Position J"                       // DELETED Field 1651
"Lohnausweis Position L"                       // DELETED Field 1652
"Lohnausweis Position N"                       // DELETED Field 1653
"Versicherungsnummer errechnen"             // DELETED Field 143

Table 3009171 / 5003911:
IncomeTaxGeneva                       // DELETED Table -> Set to SwS Free

Table 'SwS County':
"IT 2014 Tariff"                                // DELETED Field 24
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Table 'SwS Income Tax County':
"QS Grenzbetrag Provision 2"                 // DELETED Field 15
"QS Bezugsprovision 2"                   // DELETED Field 16

Table 'SwS Salary Type':
"Lohnausweis 11-EDP"                            // DELETED Field 150
Sozialkostenzuschlag                        // DELETED Field 41

Table 'SwS Employee':
"QS Tarif"                                      // DELETED Field 162
"QS Grenzgängertarif"                           // DELETED Field 165
"QS Tarif Genf"                                 // DELETED Field 158
"Schichtarbeit Tage"                            // DELETED Field 300
"Lohnausfall Tage"                              // DELETED Field 301
"Trinkgelder Art"                               // DELETED Field 302
"Naturalleistung Art"                            // DELETED Field 303
"Dienstaltersgeschenk Jahre"                     // DELETED Field 304
Reisetage                                        // DELETED Field 305
"Andere Spesen Text"                       // DELETED Field 306
Geschäftsauto                                    // DELETED Field 308
"Abo bezahlt"                                // DELETED Field 309
"Nichtpauschale Vergütungen"                  // DELETED Field 310
"Mahlzeitbeitrag am Arbeitsort"              // DELETED Field 312
"Einräumung Forderungsrechte"                // DELETED Field 314
"Social Security No. (old) "                     // DELETED Field 23
"LSE Anforderung"                                // DELETED Field 282
"LSE Lohnform"                                   // DELETED Field 285
"LSE Tätigkeit"                                 // DELETED Field 284

Table 'SwS Employee History':
"QS Tarif"                                       // DELETED Field 162
"QS Grenzgängertarif"                           // DELETED Field 165
"QS Tarif Genf"                                  // DELETED Field 158
"Schichtarbeit Tage"                             // DELETED Field 300
"Lohnausfall Tage"                               // DELETED Field 301
"Trinkgelder Art"                                // DELETED Field 302
"Naturalleistung Art"                            // DELETED Field 303
"Dienstaltersgeschenk Jahre"                     // DELETED Field 304
Reisetage                                        // DELETED Field 305
"Andere Spesen Text"                          // DELETED Field 306
Geschäftsauto                                    // DELETED Field 308
"Abo bezahlt"                                // DELETED Field 309
"Nichtpauschale Vergütungen"                  // DELETED Field 310
"Mahlzeitbeitrag am Arbeitsort"              // DELETED Field 312
"Einräumung Forderungsrechte"                // DELETED Field 314
"Social Security No. (old)"                     // DELETED Field 23
"LSE Anforderung"                                // DELETED Field 282
"LSE Lohnform"                                   // DELETED Field 285
"LSE Tätigkeit"                                 // DELETED Field 284

Table 'SwS Salary Declaration Import':
"Versicherten-Nr."                       // DELETED Field 35

Table 'SwS DMS Entry':
"Versicherten-Nr."                        // WAS DELETED
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5049.002

Wir haben die Migrations-Reports neu wie folgt beschrieben:

5050.000

Ab Update 5050.000 führen wir eine Bereinigungsaktion durch bei Tabellen, welche nicht mehr benutzt werden.
Diese werden beim Import-Prozess automatisch gelöscht.

7.2    Update 5050.000 Systemadmin

7.2.1    SwissSalary Homepage | Update-Download

7.2.1.1    Instructions

How you can enter the customer area of SwissSalary?

Link http://www.swisssalary.ch will take you to our website. Click Log In in the upper right corner: 

Log in using your company specific login data. Afterwards press the button Update NAV (SwissSalary NAV
customers) or Update BAU (SwissSalary BAU customers).

This will allow you to download the most current Updates and PreUpdates. If you click on the respective PDF
and/or ZIP icon, you will download the objects and documents.

What additional documents can be downloaded?

In addition to the latest Updates you can download and install the most current PreUpdates in SwissSalary, so
that you are always up to date (recommended).

The library of the latest manuals and other information for SwissSalary will be renewed and extended.

How a file can be downloaded from the Internet?

When you click on the corresponding icon and the download begin (the file you will find under 'Download):

Will I get notified about changes to SwissSalary?

http://www.swisssalary.ch
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Yes. You will receive information message each time when the latest Update is released. The PreUpdates will
be continuously available on our website with no mail notification! You will also be notified by mail about the
important PreUpdates!

Can the updates be sent via email?

As a rule, the Updates are only available online. Sending via email is often used in case of problems with some
providers related to the size of files and spam/junk filtering.

Are you familiar with our customer and partner portal?

By following https://webportal.swisssalary.ch you will enter our Customer portal. To log in you will need only
your email address and a password that you will receive from us. If you have not yet received a password from
us, please request it by sending an email at support@swisssalary.ch.

You can change the received password when you first log in to the system.

At the Customer portal you may not only submit and process new support requests (incidents), but also track
your own open or already answered mail inquiries at any time. In addition, you have access to our Tasks for
further development. You can see which customer requirements have been met and will be delivered with the
next Update or PreUpdate. You can also vote for individual tasks, so that you can actively influence the
development of SwissSalary.

Just try it!

Do you have questions about our website or downloads?

You can send us an email at support@swisssalary.ch or call our hot line +41 (0)31 / 950 07 77 or your partner.
We will be happy to advise you!

7.2.2    Downloading / Refreshing Updates and PreUpdates

7.2.2.1    Instructions

1. Download the objects and manuals according to the descriptions in chapter Instructions.

IMPORTANT NOTES:

https://webportal.swisssalary.ch
mailto:support@swisssalary.ch
mailto:support@swisssalary.ch
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q It is NECESSARY that you pass this User Manual on to the relevant employees!
q Make sure that the update version B5049.000 (BAU) / N5049.000 (NAV) is installed in your system. You can

check this in SwissSalary under Company -> Settings -> Organization -> Update (Version) or in RTC-Client
on Organization.

IN CASE YOU HAVE A VERSION OLDER THAN B5049.000 / N5049.000 INSTALLED, PLEASE CANCEL
THE INSTALLATION AND CONTACT US OR YOUR PARTNER!

HINT:
Please back up you data before the update. Generally, it is not required but still useful for security reasons.

2. Unzip the object file with WinZip.

3. Open Microsoft Dynamics NAV and select using Shift+F12 in Object Designer (Tools -> Object Designer).
From NAV 2009 SP1 RTC you must start the Development-Client.

Now you can see all NAV objects in the NAV DB available to you.

4. Select menu File -> Import.

5. Enter the path to the location where you saved the FOB file. The system will try to read the file.

6. You will see this info that MUST be confirmed with OK or No.

NOTE:
 For PreUpdates a different question appears. ALWAYS open the Import Worksheet!

7. The Import Worksheet will open.

IMPORTANT NOTE:
Here you SHOULD click REPLACE ALL! Click OK to continue the import process.
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The RTC-Client (from NAV 2015) appear this message (confirm this with 'Force'):

The RTC-Client (from NAV 2015) ask you to do a synchronization; confirm this message with YES:

8. The objects will be loaded into your database. After a successful completion of the import the following
message appears:
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In the Classic version:

(Example: the number of objects can vary!)

In the RTC version:

9. Done. The new update has been imported!

IMPORTANT NOTE:
This approach is similarly applied to PreUpdates! After a successful import of the objects, select them in
SwissSalary main menu.

Click menu item Employee (Employee Card). Te system will start automatically the process of update
renewal. Only a staff member with administrator rights should open the main menu for update renewal.
Otherwise, the update will not be successful! After a successful run of the batch you will receive a message
stating that it is complete. 

Under Setup -> Setup -> Organization  or in the RTC-Client-> Organization you will find the history of updates
in which all successfully updated versions are registered. After each Update/PreUpdate you must undergo this
update/renewal process!
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In the Excel file you can see which objects will be created and modified.

Type explication:

1 = Table
2 = Form (no more available from NAV 2013)
3 = Report
4 = Dataport
5 = Codeunit
6 = XMLport
7 = MenuSuite
8 = Page (only RTC version from NAV 2009 SP1)
9 = Query (from NAV 2013)

Important note on MenuSuite:

SwissSalary BAU:
MenuSuite is NOT included in the remaining objects. It is offered as the separate Fob. The companies that
prefer using the "old" main menu version should not import MenuSuite. For the new BAU-Version (NAV 2015)
the two MenuSuites 1059 + 1060 are included.

SwissSalary NAV:
The old menu is no longer available in NAV Version 4.00 or newer. MenuSuite is included in regular update.

In cases of uncertainty, please inform your partner or our support immediately.

7.2.3    Access Autorisations and Roles

7.2.3.1    Instructions

Autorisation and Roles description:

Groups ID Name Description
SWS-ALL
(SwissSalary
NAV and
SwissSalary
BAU - NAV
2015)

SwissSalary -
All Users

The only user role that must be assigned to every SwissSalary user.
The 'Wage Accounting Process' feature requires that the system should obtain
'indirect' information about all clients (license check, how many employees are
currently accounted for in the entire database. Of course, the payroll staff
member cannot see any data of the restricted clients)The only user role that
must be assigned to every SwissSalary user.

SWS-CONS
(only
SwissSalary
BAU)

SwissSalary -
Consortium

This role is used for working in the ARGE module. This permission role allows
full access to ARGE items and ARGE posting journals. This role is suitable for
employees that are only allowed to operate ARGE in payroll accounting.

SWS-EE-
EDIT

SwissSalary -
Edit Employees

This role is the classical assignment for payroll staff members that need to use
all features of payroll accounting. The user can edit, delete, enter data in
SwissSalary; however s/he cannot change payroll master data.

SWS-EE
READ

SwissSalary -
Read
Employees

Similar to the SWS-EE EDIT role, with the exception that data can be viewed
only, and not changed (read-only rights).

SWS-HR
EDIT

SwissSalary -
HR Edit
Employee

PIS (Personal Information System) add-on module. A user with this role can
modify, delete and enter data in PIS. 



Seite 374

SWS-HR
READ

SwissSalary -
HR Read
Employee

PIS (Personal Information System) add-on module. Read-only rights.

SWS-HR
SETUP

SwissSalary -
HR Setup

PIS (Personal Information System) add-on module. A user with this role can
change settings in PIS. Classical HR wage administrator.

SWS-POST
(only
SwissSalary
NAV)

SwissSalary -
Posting

In accordance with the SOX guidelines, payroll staff member is not allowed to
'post wages'. This user role can be assigned to an employee in the FIBU that
is exclusively responsible for wage posting. IMPORTANT: Of course, this
employee must also be enabled in SwissSalary under Company -> Settings ->
Users.

SWS-SETUP SwissSalary -
Setup

Classical authorization role for wage administrator

SWS-ST
EDIT

SwissSalary -
Edit Salary
Type

Full access for editing wage types. A user with this role can create, modify
and delete wage types.

SWS-
TAPBOARD

SwissSalary -
Edit TapBoard

This role allows to use TapBoard ONLY without access to payroll data (for
example, no test calculations can be created, no assignment to personnel
master data can be applied, etc.)

After each update, permission roles must also be adjusted in SwissSalary (New table access, etc.)

IMPORTANT NOTICE:
q If you have customized individual permission roles in Standard "SWS-*", please remember that they will be

overwritten through the automatic import of the "default" roles.
q Before releasing the system for the user again, add the necessary appropriate permission roles to these new

tables!

Current permission roles can be found on our website in our protected area.

To begin the import in SwissSalary go to Setup -> Setup -> Organization -> button 'Service' -> Rights. In the
RTC-Client in Organization. Select SWS value under Role ID*.
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Choose the appropriate path for the .txt file and select Import under Direction in the Options tab. Then click
OK and after some time the default user roles will be adjusted in SwissSalary.

If you have written changes in our default payroll user roles or if you want to make changes to the user roles
manually, you can do this under Tools -> Security (NAV version 3.70 or older) or under Tools -> Security ->
Roles (NAV 4.00 and newer). Click on the appropriate role and add new tables under Roles -> Permissions
(NAV 3.70 or older) or Role -> Permissions (NAV 4.00 and newer). In the RTC-Client go to Departements->
Administration-> IT Administration-> General-> Permission Sets. If you have questions about these settings,
please contact your local partner.

The following tables have been re-created and must be added to the corresponding roles (if already used):

Table SwissSalary BAU
(Version 5)

Table SwissSalary
BAU/NAV

Name Object Name (german)

n.a. 3009190 SwS Store Message SwissSalary Store Nachricht

n.a. 3009290 SwS SmartPort Setup SmartPort Einrichtung

n.a. 3009291 SwS SmartPort Line SmartPort Zeile

n.a. 3009292 SwS SmartPort Entry SmartPort Posten

SwissSalary Role Center
Each NAV module knows its own role Center (from NAV 2009 RTC). SwissSalary has developed the Page
3009252 SwS Payroll Role Center. We encourage you to work with this Role Center for the salary. You can
import the Role Center also (XML-file you will find in the Update object).
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